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1 Introduction

Thisisthe user’s guide for Viz Pilot, which aims to help users of Viz Pilot become familiar with the
system.

Wiz Pilet

This section contains the following topics:

® Customer Feedback and Suggestions
® Customer Support Requests

1.1 Related Documents

For more information about all of the Vizrt products, visit:

® www.vizrt.com

® Vizrt Documentation Center
® Vizrt Training Center

® Vizrt Forum

1.2 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.
com.

1. Click on Contact (top of page).

2. TheVizrt office which is nearest to your location will be shown, or select from the list of Vizrt
offices.

3. Click on the Contact button for the office you want.
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4. Complete the required details in the window that opens.

Note: If this messageisfor Customer Support, and there is a Support Contract in place, then
click on the ‘ For support requests, please visit our support portal’ link in the message window.
A Vizrt representative will contact you as soon as possible.

1.3 Customer Support Requests

Support Requests are supported by Vizrt if customers have avalid Service Agreement in operation.
Customers who do not have a Service Agreement and would like to set up a Service Agreement should
contact their regional sales representative (see Customer Feedback and Suggestions).

When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to
make sure that Vizrt Support can give the quickest and best solution to your Support Request.

This section contains the following topics:

® Before Submitting a Support Request
® Submitting a Support Request

1.3.1 Before Submitting a Support Request
Before a Support Request is submitted make sure that you:

Read:

® Therelevant User Guides
® Therelease notes

and Check:

® That the system is configured correctly
® That you have the specified hardware, tested and recommended versions
Always refer to your Vizrt Service Level Agreement document.

1.3.2 Submitting a Support Request

When completing a Support Request, add as much information as possible.

Content of a Support Request
The report should contain information about these topics:

® Problem description: Include a good description of what the problem is and how to reproduce it.
Specify your workflow. Remember to use simple English.

® Screen shotsand illustrations: Use these to simplify the message. These are extremely useful for
Vizrt Support.

® Software configuration: Add exact versions of software (-build) used. Thisis also extremely
important information.
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® System locale: Specify the Region and Language settings of the system.

® System log files: Send the system log files (see Viz Log Files).

® Crashlogfiles: Send the error report and crash log files (see Crash Log Files).

® System Configfile: Send the system config files (see Viz Config Files).

® Hardware configuration: Add exact versions of hardware used, especialy for Viz Engine.
Optional:

® System setup: Describe differencesin the installation, if any, from the recommended setup.

® System Network: Add a description of how the network, bandwidth, routers, and switches are
configured.
Always refer to your Vizrt Service Level Agreement document.

To submit a Support Request:

On the www.vizrt.com page, click on Support.

Click on Report a case.

Click on LOG IN to login to the Customer and Partner portal.

At the top of the Case Management page, click on Report a Case.

In the online form compl ete the required minimum information (shown by ared asterisk) and click
SAVE.

6. Inthe saved Support Case that opens, compl ete the various text boxes and upload any required
documents, files, etc. (see Content of a Support Request).

Totrack the status of open support tickets, login to the Customer and Partner portal. Add
information or communicate about the cases directly with the support team.

ardwbdpE
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2 Viz Pilot System

b .

The Viz Pilot system provides an optimal environment to create, manage and deliver high volumes of top-
quality content to live and taped news, sports, election and other broadcast productions, independently of
the design department.

The Viz Pilot system can serve as the core content control system for broadcasters that require speed,
consistent look, and a streamlined workflow for their graphics and video content.

Graphics templates that are used in the Viz Pilot system are built in Template Wizard. Vizrt’ s superior 3D
renderer, Viz Engine, is the output source for Viz Pilot driven graphics, video embedded in graphics and
fullscreen video.

The Viz Pilot system has two main rolesin the broadcast production line:

® Content Creation: The Viz Pilot system provides a unique and easy solution for the creation of
graphics and video content. Data can be entered either directly into Director, or through our
Newsroom Integration using Viz Pilot News. Data can then be added to a playlist for playout
automation.

® Playout Automation: The playlist in the Viz Pilot system allows playout of graphics and video in a
seamless way. Playlists are typically created in newsroom systems or Director, and can be monitored
and played out using Director or other third party control applications. Elements can be triggered in
Director, through GPI or third party integrations.

This section contains the following topics:

® System Overview
® Workflow
® Words and Expressions

2.1 System Overview
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2.1.1 Workflow
Control room
Creative Department Operators trigger playlists of
Design scenes in Viz Artist and create graphics and video in Viz Pilot

flexible templates in Template Wizard / =
ﬁ , Viz Engine

Newsroom
Journalists populate templates with -
graphics & videos using Viz Pilot News
in their native newsroom system

On Air
Compaosite graphics
and video in real-time
in SDYHD/ 4k SDI
and IP streams

A common workflow using Vizrt's MOS (Media Object Server Communications Protocol) integration can
be described as follows:
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1. A user adds stories to the newsroom system using the newsroom system client, Viz Pilot News.
2. In addition to creating stories, graphics, video clips and images can be added to the stories using
Viz Pilot.
®* New data elements created by Viz Pilot are added to the Viz Pilot database
® The newsroom system client adds the data element information to the story
3. Whenever anewsroom playlist is monitored by a control application, the newsroom system is
requested to send information about the playlist to Viz Gateway which sends the playlist to the
Media Sequencer
4. Based on the information received from the newsroom system, the Media Sequencer is able to
retrieve the data elements from the Viz Pilot database, which were created by Viz Pilot, and
present them as a playlist to the control client
®* When aplaylist is made available to the control client it can monitor the playlist and receive
al changesto it from the newsroom system and the Viz Pilot database
5. Oncethe playlist is monitored the control client operator can take the graphics on air

Note: Media Sequencer stores all playlists/shows making it availableto all control
applications.

2.1.2 Client-Server Mode

The Viz Pilot system is built on a client-server software model where Director connects to the Viz Pilot
Database (Oracle database or Graphic Hub) for templates and content, and the Media Sequencer for

playout.

® The Viz Pilot system can use either an Oracle database or a Graphic Hub as the back-end server.

®* TheViz Pilot system requires a Media Sequencer for communication with Viz Engine and other
systems.
On the server side, the database serves all clients storing and retrieving content data for the control,
delivery and playout of videos, maps, audio, graphics and so on, on the Viz Engine.

Viz Pilot News has its own Timeline Editor for adding graphics to video clips fetched from Viz One. The
Viz One integration enables playout of fullscreen and/or embedded video clipsin graphics on the same
renderer.

The overview aso shows a newsroom setup using the MOS protocol (ref. MOS Gateway). Other protocols
are of course supported aswell (e.g. Video Disk Control Protocol).

Note: Connections to different components depend on the system setup, hence, not al possible
combinations of connections are shown in the overview.

2.2 Words and Expressions

The following are a number of common words and expressions used throughout this document:
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Background scene: A background scene contains logic that enables an operator to toggle the states
of multiple front scenes. A typical background scene also contains back plates and transition effects
for each state of the front scenes. For example; A lower third may be on-air at the sametimeasa
bug, and the lower third may be taken off-air without taking the bug off-air or reanimating it.
Component: In Template Wizard, components are used to create text fields, buttons, drop-lists,
database connections etc.

Controal plugins: A graphics scene can contain all sorts of objects that can be controlled from a
template such astext, back plates, images, colors and more. The graphics designer uses control
plugins to expose objects to make them editable in atemplate. When importing the scene to
Template Wizard the exposed objects with control plugins appear as list items with check boxes.
Control Object: Every scene with control plugins must have one instance of the control object
plugin at the root level of a scene tree. Control Object reads the information from all other control
plugins. When a scene isimported to Template Wizard, it reads the information about other lower
level control plugins through Control Object.

Data element: A data element is atemplate that is filled with data. A data element holds areference
to its template (original) just as the template holds areference to its scene. A data element is contains
aset of data and references to where data (e.g. images and video clips) can be found. In most cases it
is the data element that gets played out on-air, and not the template.

Front scenes: A front sceneis a standard scene that makes one part of atransition logic scene.
Newsroom Component: In a Newsroom Computer System (NCS), the Newsroom Component
(NrC) isused to add data elements to astory. The user istypically ajournalist working on a story.
The newsroom component is an embedded application in the NCS that connects to a database of
templates. The templates can be filled with text, images, video and maps. Vizrt's newsroom
component is known as Viz Pilot News.

Scene: A sceneisbuilt in Viz Artist. It can be a single scene, or one part (layer) of a combination of
scenes (transition logic).

Template: A templateis a customized interface created in Template Wizard. The templateisused in
Director or Viz Pilot News to create data elements that are added to a playlist for playout. A template
is based on one or severd (transition logic) Viz Artist scenes.

Transition Logic Scene: A set of scenesbuilt in Viz Artist. Consists of a background scene and one
or several front scenes. It contains one scene that controls the state of or toggles a set of scenes
(layers). The layered scenes are used by the controlling scene to toggle in and out the layered scenes,
using pre-configured or customized transitions effects, without the need to take scenes aready on-
air, off-air. For example; A lower third may be on-air at the same time as a bug, and the lower third
may be taken off-air without taking the bug off-air or reanimating it.

Viz Artist: The design tool where the graphics scenes and all animations are created.

Viz Engine: The output engine used for playout of graphics, video, images, SDI sound and sound
effects.
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3 Installation

This section describes how to install the Viz Pilot system, and how to choose between the different setup
types and components. In addition, it describes how to run Viz Pilot’ s database scripts.

The latest official releases of all Vizrt softwareis accessible on Vizrt's FTP server.

This section contains the following topics:

® Viz Pilot Components

® Software Requirements

® Viz Pilot System Installation

® Newsroom Integration Installation
® Control Room Client Installation
® Template Design Client Installation
® Unattended Installation

® Video Codecs Installation

® Pilot Data Server Installation

® Crop Service Installation

® Script Runner Installation

® Preview Server Installation

® Pilot DBA Installation

® Getting Started after Installation

3.1 Viz Pilot Components

Viz Pilot system refers to the entire system, consisting of Viz Pilot News, Director, Template Wizard, the
Viz Pilot database and so on. The Viz Pilot system consists of multiple applications, but you can divide
the main areas of use into; control room, newsroom and template design.

In addition you have the Pilot Data Server, Object Store (image database), Thumbnail Generator, and
more; which act as service providers to the main areas of use.

Director depends on several systems to be able to function in a control room. Most important are the
Media Sequencer and the Viz Pilot database. The basic setup therefore consists of a connection to aMedia
Sequencer and the Viz Pilot database. For actual playout you will also need aViz Engine with a
connection to a Graphic Hub for content creation and graphics playout. Any graphics or images added to a
playlist must be available to the Viz Engine.

A common setup is also to run Director with a newsroom system connection. A newsroom connection
allows Director to fetch playlists made available by the newsroom system. This effectively means that the
Director operator will only monitor and control the playout of the playlist elements, and not create them.

Additionally, for playout of video clips a connection to Viz One for search and transfer of video clipsto
Viz Engine can be used.
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Note: The Media Sequencer is, amongst other things, used to configure connectionsto Media
Sequencer Configuration. The Media Sequencer may beinstalled locally or on a separate server (see
Command Line Startup Options).

The table below describes the main components that can be installed as part of aViz Pilot system.

3.1.1 Viz Pilot Components

Type Description

Director The Director control room client is the main application for managing the
graphics (and video) playout of both the MOS rundowns and any other
playlist. The user of the client has full control over templates, data
elements and content. Manual editing and playout of all mediaavailablein
the Viz Pilot system, including playout of scenes from the Graphic Hub, is

possible.

GPI drivers The General Purpose Input (GPI) drivers allow for external control of Viz
Pilot.

Inifile Editor Editor for Viz Pilot’s configuration files.

Local preview plugin Thisisused for local previewing of scenesin Director and Viz Pilot

News. Note that instead of this component, it is recommended to use the
Remote Preview or Remote Snapshot Preview. See Viz Engine Preview
Configuration.

Local documentation Locally installed documentation for the Viz Pilot system.

Object Store The Object Store helps store and retrieve images, sounds and video clips
to and from the file share (stills and person information), and the Viz Pilot
database (thumbnails), for use in templates.

Oracle Drivers If the Viz Pilot database is configured to run on an Oracle database, the
Oracle Instant Client is used for accessing the database.

Quick CG A system tray application that allows quick creation of character
generated (CG) data elements.
Spellcheck plugin Installs a set of default dictionaries that uses the Hunspell spell checker.

By default the installer includes the following OpenOffice dictionaries:
Arabic (both North Africaand Middle East), English (both United
Kingdom and United States of America), French, German, Norwegian
(both Bokmaal and Nynorsk), Russian and Spanish. See OpenOffice.org.
Dictionaries are UTF-8 formatted by Vizrt.

Template Wizard Template Wizard is used to create templates for use within the Viz Pilot
system, and in some cases for Viz Trio and Viz Ticker.

Viz Pilot News Viz Pilot News integrates into the newsroom system allowing journalists
to add graphicsto the story.

3.2 Software Requirements

This section describes the software requirements for the Viz Pilot system.
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® Supported Versions and Operating Systems

3.2.1 Components

This section contains the following topics:

® System Requirements

® Viz Pilot Database Requirements - Oracle

® Viz Pilot Database Reguirements - Graphic Hub

® Director Requirements

® Viz Pilot News Requirements

® Template Wizard Requirements

® Pilot Data Server Requirements (including Script Runner Service and Thumbnail Generator)
® Crop Service Requirements

® Viz Engine Preview Server Requirements

3.2.2 System Requirements
Minimum client system requirements

® Windows7

1 GHz 32-hit (x86) or 64-bit (x64) processor

® 1GB RAM (32-hit) or 2 GB RAM (64-hit)

® 40 GB hard drive with at least 15 GB of available space

Supported client operating systems

® Windows 10 Enterprise

¢ Windows 10 Pro

® Windows 8 Enterprise 64-hit

® Windows 8 Pro 64-bit

® Windows 7 Professional 64-bit (recommended)
® Windows 7 Enterprise 64-bit

® Windows 7 Ultimate 64-bit

Supported server operating systems

® Windows Server 2012 R2 Update

® Windows Server 2012 R2

® Windows Server 2012
A specific version and service pack of an operating system will not be supported after the officia
Microsoft support end date. Thisisthe latest date of support from Vizrt. Earlier support end dates
will be announced in release notes for new versions of Viz Pilot.
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Minimum supported versions of software components Viz Pilot depends on

® Database, one of:
® Graphic Hub 3.0 (with Graphic Hub REST 2.0), or
® Oraclellg

® Media Sequencer 4.0

® VizEngine3.3

Recommended server system requirements

This depends on the overall system configuration and should be worked out together with your local
support.

3.2.3 Viz Pilot Database Requirements - Oracle

Viz Pilot Database Requirements

In this case the Viz Pilot database is an Oracle database server. Usually two database servers are installed
where oneis used for manual failover. Viz Engine graphics datais stored on the Graphic Hub.

Viz Pilot Database Administrator Reguirements

The Pilot Database Administrator tool (Pilot DBA) isasmall application used for installing, upgrading,
exporting, importing, and setting various parameters for the Viz Pilot Database. It is purely a DBA tool,
and should therefore only be used by database administrators.

3.2.4 Viz Pilot Database Requirements - Graphic Hub

In this case the Viz Pilot database is a Graphic Hub, accessed via a Graphic Hub REST server. For full
installation and migration information, see the Graphic Hub User’s Guide.

Migration from Oracle to Graphic Hub

To move data from Oracle to Graphic Hub, the schemain the Oracle database must be Viz Pilot 6.x or
later. To upgrade the schema use the Pilot DBA (see Database Administration). Once the schemaiis 6.x or
later, import the data into Graphic Hub.

Once the data has been imported to Graphic Hub, the schema version will follow the Graphic Hub version.
Any required schema updates will happen the first time the Graphic Hub is started after a version upgrade
for the selected data directory.

The Pilot Database Administrator tool (Pilot DBA) isno longer required once you have migrated to
Graphic Hub.

New Installations
For fresh installations, install Graphic Hub as described in the Graphic Hub User’s Guide.
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3.2.5 Director Requirements

The table below lists the machine specifications for atypical newsroom system setup, where Director is
the control application receiving the playlist.

Component Requirement
Software Viz Pilot
Media Sequencer

Optional: Viz World Client (32-bit), TimeCode Monitor, Viz PreCut.

Optional: If you are using alocal Viz Engine to preview video clips from
Viz One, Viz Engine must be installed with video codecs (e.g. MPEG-4
codec and Haali Media Splitter).

Optional: Windows Media Player 11 for video clip preview in Object
Store.

Note: Local preview plugin supports 32 and 64bit versions of Viz Engine.
If both 32 and 64 bit versions are installed, the 64 bit will be used
regardless of which version is the newest.

Local drive access

Accessto Oracle client files and folders, is using Oracle database.

Network access

Mapped drive to Object Store still store folder

Director getsits Viz One connection parameters from the Viz Pilot database.

Vizrt recommends the use of remote preview that has no need for alocal Viz Engine or graphics cards on

the client machine.

3.2.6 Viz Pilot News Requirements

The table below describes abasic setup of Viz Pilot News for journalists and editors.

Component

Requirement

Software

Viz Pilot
Optional: Object StoreViz World Client (32-bit) 12.0 or later
Newsroom system client

Optional: If you are using aloca Viz Engine to preview video clips from
Viz One, Viz Engine must be installed with video codecs (e.g. MPEG-4
codec and Haali Media Splitter)

Optional: Viz EasyCut or Viz PreCut for video clip editing.
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Component Requirement

Note: Local preview plugin supports 32 and 64bit versions of Viz Engine.
If both 32 and 64 bit versions are installed, the 64 bit will be used
regardless of which version is the newest.

Local drive access Read access to Oracle client files and folders, if using Oracle.

Network access Mapped drive to Object Store still store folder.

Vizrt recommends the use of remote preview that has no need for alocal Viz Engine on the client
machine; hence, local preview is not recommended.

Viz Pilot News getsits Viz One connection parameters from the Viz Pilot database.

3.2.7 Template Wizard Requirements

Template Wizard is an easy-to-use software wizard, visual template editor, design and scripting tool. It is
used to create, manage and categorize templates for graphics, with images, maps and video. Template
Wizard can also be used to create control templates for Viz Trio and Viz Ticker3D.

Template Wizard can be installed as a stand-alone product for editing and running Viz Pilot templates
without aViz Pilot Database server, for example for use with Viz Trio or Viz Ticker3D. In this case no
Oracle Client isrequired, and the use_dat abase setting in the ContentPilot.ini file (under the
[TEMPLATE_WIZARD] section) must be setto ‘n'.

Itis possible to install Template Wizard on the same machine as Viz Artist; however, it is recommended
toinstall it on a separate design client for template designers.

Template Wizard specifications

Component Requirement

Software Media Sequencer

Optional: Windows Media Player 11 for video clip preview in Object
Store

Optional: Viz World Client (32-bit)

Template Wizard connects to the Media Sequencer for testing and previewing of template graphics. The
Media Sequencer connection defaults to localhost. To use adifferent host set the command line option -
mse <host> in Template Wizard' s target path.
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3.2.8 Pilot Data Server Requirements

Pilot Data Server

The Pilot Data Server isinstalled as an application layer on top of the Viz Pilot database. It acts as an
application server for accessing the Viz Pilot database and other services. The Pilot Data Server may be
asked to handle requests from scripts to provide information on data elements, or to provide Preview
Servers the information needed to resolve which scene and datais to be rendered by the Preview Server.

The Script Runner Service comes packaged with the Pilot Data Server. Thumbnail Generator is an
optional component, which is enabled by default.

Script Runner Service

The Script Runner Service provides users with a simple way to use the Update Service without needing to
create their own service. See Update Script Editor.

Thumbnail Generator

The Thumbnail Generator isaWindows service. As data elements are created or changed, it automatically
generates thumbnails of them. The thumbnails are stored in the Viz Pilot database.

Thumbnail Generator requires a Preview Server, which is used to serve the thumbnails in the data element
feed.

Pilot Data Server specifications

Component Requirement

Software Pilot Data Server

Service(s) Vizrt Pilot Data ServerVizrt Script RunnerVizrt Thumbnail Generator
Operating system Refer to the Viz Pilot Release Notes

3.2.9 Crop Service Requirements

Crop Service

The Crop Serviceisatool that allows for basic cutting and zooming of images, and allows users to
quickly add new images to a data element.

Crop Service specifications

Component Requirement

Software Crop Service

Service(s) Vizrt Crop Service

Operating system Refer to the Viz Pilot Release Notes
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3.2.10 Viz Engine Preview Server Requirements

The Preview Server is used in situations where one or more Viz Engines provide frames for snapshot or
thumbnail generation. It is used by the Viz Trio client or Viz Pilot to fetch previews of overlay graphics,
for example for the Timeline Editor or the Thumbnail Generator.

The Preview Server can run on the same machine asaViz Engine, but it is also possible to specify
additional Viz Enginesin order to spread the load.

Preview Server can manage a pool of Viz Engines. Clients can query it for aViz Engine that matches a
specific video mode. It provides load balancing, video mode matching and can be used to create a
redundant renderer pool. The pool of Viz Enginesis configured on the Preview Server Web Interface.

For full information on requirements, see the Preview Server Administrator’s Guide.

3.3 Viz Pilot System Installation

This section describes the stepsin the installation process for the Viz Pilot system:

® |nstalling software components with Viz Pilot Setup Wizard
® Configuring the setup with Viz Pilot Configuration

3.3.1Viz Pilot Setup Wizard

The Viz Pilot Setup Wizard installs the necessary Viz Pilot components on your machine.

Note: Theinstaller migrates any configuration settings from older versions of Viz Pilot, for example
Database information. This appliesto theinstaller for Viz Pilot 7.1 and newer and only migrates from
versions 6.0 and up. Settings from the most recent version of Viz Pilot will be migrated in the event
multiple versions are installed on your machine. For example, settings from Viz Pilot 7.0 will migrate
but not from version 6.1 if both are installed.

1. Click the Viz Pilot installer (*.msi) file to start the Viz Pilot Setup Wizard.

2. Inthe Welcome panel, click Next.

3. Inthe Destination Folder panel, define the location of the Viz Pilot program files, and then click
Next.

4. Inthe Product Features panel, select one or more relevant Viz Pilot Components to install, and
then click Install.
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The Viz Pilot News integrates into the newsroom system allowing journalists to add
graphics to the story,

This feature requires 24MB on your hard drive.
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Tip: Various components are needed for different setups. For example, on a Template Wizard
work station or newsroom work station, only a selection of the Viz Pilot Components are
needed. For more details, see Newsroom Integration Installation, Control Room Client
Installation, and Template Design Client Installation.

5. After the Viz Pilot Setup Wizard has finished installing all relevant features, continue the
installation process by configuring your setup in the Viz Pilot Configuration Tool.

3.3.2 Viz Pilot Configuration

During installation, after installing all the relevant Viz Pilot Components using the Viz Pilot Setup Wizard
, the Viz Pilot Configuration Tool automatically opens.

Inthe Viz Pilot Configuration Tool, you can define the relevant settings for your Viz Pilot setup, for
example:

® To configure the database connection

® To configure the Media Sequencer connection
® To configure preview settings

® To configure newsroom settings

® To configure Template Wizard settings
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3.4 Newsroom Integration Installation

This installation type applies to a newsroom work station, where Viz Pilot News is integrated with one or
more newsroom or NLE systems. The software is normally integrated to newsroom systems as an
embedded component. When using Viz Pilot News together with Vizrt’s Graphics Plugin for NLE, thisis
the installation type that should be used.

Note: When installing Viz Pilot News for use in a Java or web based newsroom system, the Oracle
Instant Client should not be installed.

Note: Asmost newsroom computers running Viz Pilot News do not have administrator rights, you
may need to install it using RunAs parameters, install the software from the command line, or use the
Run asadministrator context menu option available to Windows 7 users. Note that you must have
administrator rights for this to work.

The Viz Pilot newsroom installation includes the following Viz Pilot Components:

®* VizPilot News

® Object Store

® Documentation

® Oracle Drivers

® | oca preview plugin
® Spell check plugin

® Quick CG

Note: The Local preview plugin can be removed if you prefer a setup using aremote Viz Engine
for preview. Also, the Oracle Drivers can be removed if already having an instance of the Oracle
Instant Client installed.

See Also

® Viz Pilot System Installation
® To configure newsroom settings

3.5 Control Room Client Installation

The Control Room Client Installation is normally installed for control room operators that manage the
playlists for playing out graphics on air.

The Viz Pilot control room installation includes the following Viz Pilot Components:

® Director

® Object Store
Quick CG

Spell check plugin

32



® Template Wizard

Note: The Director must have a Media Sequencer running, and it is recommended to run this on
the same machine.

See Also

® Viz Pilot System Installation

3.6 Template Design Client Installation

Thisinstallation type applies to a Template Wizard work station, where template designers create and
manage the graphics templates.

The Template Wizard installation includes the following Viz Pilot Components:

® Template Wizard
® Director

® Object Store

® Documentation
® |nifile Editor

® Oracle Drivers

® Spell check plugin

See Also

® Viz Pilot System Installation
® To configure Template Wizard settings

3.7 Unattended Installation

The Unattended installation type is an automated installation technology that allows you to install or
upgrade a system with minimal user intervention. Unattended installations are typically used during large-
scale roll-outs when it would be too time consuming and costly to have administrators or technicians
interactively install the system on individual computers.

This section contains the following topics:

® Relevant Files and Settings

® Viz PFilot Configuration in non-GUI Mode

® Creating a Configuration Bundle

® |nstalling a Configuration Bundle

¢ Unattended Installation from the Command Line

® Remote Unattended Installation using Active Directory
® MSI Properties

® Pilot Data Server Unattended Installation
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3.7.1 Relevant Files and Settings

The Viz Pilot system is configured through a combination of local configuration settings on each
workstation running the client software, and the list of VCP parameters available in your Pilot Data Server
web interface.

Thelocal configuration is defined various places. First there are several configuration files stored in the %
PROGRANMDATA% Vi zrt\Viz Pil ot x.y\Confi g folder.

In addition, there are a number of Registry keys that also contain relevant information:

® HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node\ \ [vi zrt]\ Acti veX X.y

¢® HKEY_LOCAL_MACHI NE\ SOFTWARE\ Wow6432Node\\ [ vi zrt]\vi z| content pil ot
X.y

¢ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node\\ [ vi zrt ]\ Previ ew Engi ne
To apply apreviously prepared configuration to a Viz Pilot installation, we have created a
mechanism called a Configuration Bundle (referred to as just bundle after this point). A bundleisa
zip-file that, in addition to some metadata (version information, and so on), contains a copy of al the
configuration files and configuration values from the Registry. This bundle can then be read by the
Viz Pilot Configuration Tool and applied to the current system.

3.7.2 Viz Pilot Configuration in non-GUI Mode

The Viz Pilot Configuration Tool’s primary usage is to present the user with a GUI to configure various
aspects of the Viz Pilot Components. It is automatically opened during aregular installation, and can later
be opened manually at any point.

The Viz Pilot Configuration Tool aso has anon-GUI mode of operation, and thisiswhat is used to
manage bundles. When installing a bundle it requires elevated privileges, so it must be run from a CMD
shell with elevated privileges. To do this:

1. Pressthe Windows key, and then type cmd.

2. Right-click the entry cnd. exe and from the menu that opens, select Run as administrator.
Y ou should now have a command prompt that is elevated. This can be verified by looking for the
Administrator: prefix in the window title.

Tip: If you want to create abundle, it can be run from anorma CMD shell without selecting the Run
as administrator option.

Navigate to the install ation folder where you installed Viz Pilot, and then to the sub-folder Configuration.
If the default paths are used on a 64-bit system, thiswill be %°r ogr anti | es(x86) % Vi zrt\ Vi z
Pil ot x.y\Configuration.YoucanthenrunPi | ot Confi guration. exe --hel ptosee
the help text for the program. The help text will point out which options require elevated privileges.

If you are running an option that requires elevation from anormal CMD shell, an error message will be
displayed.



All operations performed by the configuration program are logged in the file %4°r ogr anDat a%
\Vizrt\Logs\Viz Pilot x.y\configuration.l| og.By default, only important messages are
shown on the console, but if you want to see the same verbose output you can append - - ver bose to any
command line used.

3.7.3 Creating a Configuration Bundle

When creating a bundle, the first thing you need to do is to configure one workstation to the correct state.
This probably means several cycles of changing configuration settings and testing the changes before the
configuration is acceptable.

When thisis done you create a configuration bundle by running Pi | ot Confi gur ati on. exe --

cr eat ebundl e=%JSERPROFI LE% Deskt op\ confi g. zi p. Thiswill create a zip-file called
config.zip on the current user’ s Windows desktop. Note that if the file already exists, the Viz Pilot
Configuration Tool will exit with an explanatory error message. In that case, either delete the existing file
or modify the filename before running the command again.

Thefile created isanormal zip file. You can unzip it with normal toolsif you want to see what
configuration isincluded. If you for example do not want to distribute the keyboard settings, you can
delete thisfile from the bundle.

Note: Be precise when editing bundles manually, and always test your changes thoroughly before
rolling them out.

3.7.4 Ingtalling a Configuration Bundle

If you have a bundle and want to apply the settingsin it to your current workstation, you use the Viz Pilot
Configuration Tool’s option installbundle like this: Pi | ot Confi gur ati on. exe --

i nst al | bundl e=%JSERPROFI LE% Deskt op\ confi g. zi p. Thiswill overwrite any loca
configuration with the one from the bundle.

Note: Applying settings from a bundle will remove settings that exist locally, but not in the bundle.
For example, if the bundle does not have akeyboar d. cf g file, but the local system does, the local
configuration file will be deleted. The same applies to registry values under the keys mentioned
earlier.

3.7.5 Unattended Installation from the Command Line

Sincethe Viz Pilot system is distributed as a Microsoft Installer package, the standard M S tool has been
used to facilitate an unattended installation. The command nsi exec. exe can be used for this. Thiswill
not be afull tutorial on how to use msi exec, but the options specific to the Viz Pilot system’sinstaller
will be covered.
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To run an unattended installation with the default options and showing just a progress-bar Ul, run the
following command:

nsiexec /qb /i VizPilot-x.y.z.z.nsi

Thiswill run the installer in the Basic Ul mode (which means just showing the overall progress bar and
not displaying the Viz Pilot Configuration Tool) and install it in the default folder. Of course, installing
with the default settingsis not always the desired behavior, so we provide hooks for selecting the install
location, setting the list of components to be installed, and supplying the installer with a configuration
bundle to install.

This section contains the following topics:

® |nstalation Location

® Feature Selection

® Configuration Bundles

® |cons on the Windows Desktop
® Putting it al Together

Installation Location

The directory where the bulk of the software will beinstalled to is controlled through an MSI property
caled INSTALLDIR. By default, thisis either Y“@PROGRAMFI LES% Vi zrt\Viz Pilot x.yifno
earlier version of Viz Pilot has been installed, or aternatively the installation folder of the earlier Viz Pilot
version. Some files will beinstalled outside of thisfolder, either in the Windows system folder or the %
PROGRAMFI LES% Vi zr t \ Comrmon folder. These files cannot be moved by changing the
INSTALLDIR property.

To overridethe INSTALLDIR property using nsi exec you append | NSTALLDI R=" C:
\the\correct\fol der" tothensi exec command line. For example:

nsiexec /gb /i VizPilot-x.y.x.x.nsi |NSTALLDI R="D:\ Software\Viz
Pilot x.y"

If an earlier Viz Pilot version is already installed, this will move the installation to the new folder in the
same way as selecting a new folder when running the installer interactively would do.

Feature Selection

It isnot required to install all the features of the Viz Pilot system’ sinstaller when running unattended.
Selecting which features to be installed is based on listing up the names of the features. Since these are not
easily extracted from the MSI, we supply alist of them below. Similar to how you set the install location,
you supply acomma-separated list of the required featuresin a M S| property named ADDLOCAL on the
command line;

nei exec /gb /i VizPilot-x.y.x.X.nsi ADDLOCAL="Director,GPlDrivers"

Thiswill install Viz Pilot’s Director component and the drivers for GPI integration, but nothing else.
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Viz Pilot Components in Unattended I nstallations

FeaturelD

What will beinstalled

Common

Common files for all the features.Note: Thisis aways automatically
installed and need not be specified.

Documentation

The PDF and HTML documentation

Director

Director control room client

TimecodeM onitor

Timecode Monitor

TrioPlugin Viz Trio Data Resource Plugin
VizPilotNews Viz Pilot News
TemplateWizard Template Wizard

ObjectStore Object Store

InifileEditor Inifile Editor

OracleDrivers Oracle Drivers

GPIDrivers GPI Driversfor Director

LocalPreviewPlugin

Local Preview Plugin for Director and Viz Pilot News

SpellcheckPlugin

Spell check plugin

SpellcheckPluginDictionaries

Default dictionaries for the Spell check plugin

QuickCG

Quick CG

Configuration Bundles

It is aso possible to specify a configuration bundle during an unattended install. Again, thisis done
through M Sl properties, this time a property named CONFIGBUNDLE.

nsi exec /gb /i VizPilot-x.y.x.x.nsi CONFI GBUNDLE="%JSERPROFI LE%
\ Deskt op\ confi g. zi p"

Thiswill install Viz Pilot in the default location, with the default set of features, and the configuration
fromtheconfi g. zi p bundlelocated on the current user’s desktop.

Note that when specifying remote paths in the CONFIGBUNDL E property, network drive mappings on
Windows are on a per user basis, and adrive named Z: might not (depending on your specific setup) exist
for the user running the installation. To avoid issues, specify remote resources with a UNC path (for
example\ di st - server\ vcp\ confi g. zi p) and make sure the network shareis readable by the
machine account.

Icons on the Windows Desktop

To place icons on the current user’ s desktop during installation, use the MSI property
INSTALLDESKTOPSHORTCUTS. For example:
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nsi exec.exe /gb /i VizPilot-x.y.x.x.nmsi | NSTALLDESKTOPSHORTCUTS=1

Putting it all Together

All these options can of course be specified together to customize the installation to your specifications.
For example:

nmsiexec /gb /i VizPilot-x.y.x.x.nmsi CONFlI GBUNDLE=" %JSERPRCFI LE%
\ Deskt op\ config.zi p" ADDLOCAL="Vi zPi | ot News" | NSTALLDI R="D:
\Software\Viz Pilot x.y"

3.7.6 Remote Unattended Installation using Active Directory

There are multiple ways of doing remote unattended installations of software packagesin Windows
networks. The distribution of software through Active Directory and Group Policy Objects has been
chosen as an example. The techniques used here can be adjusted to match your specific setup.

We have used Windows Server 2012 R2 in this example, so the exact names of the tools used might be
different if using another version of Windows Server.

This section contains the following topics:

¢ Background

® Creating a Transform

® Creating a GPO with an Applied Transform for Distributing Viz Pilot
® Troubleshooting

Background

In aWindows domain, settings for different client computers are distributed in Group Policy Objects.
These are self-contained units of configuration. One of the things they can specify isthe installation of
packages in MSI format, which iswhat we will use.

One limitation hereisthat you cannot define arbitrary M S| properties like you could on the command line
examples using msi exec. exe, so we need to use an aternative configuration method. MSI provides a
mechanism called atransform. A transform is a collection of changes applied to an installation. By
applying atransform to a base installation package, the installer can add or replace datain the installation
database. The installer can only apply transforms during an installation. The tools used to create GPOs
allow the specification of atransform to apply to a package, so this gives us an opportunity to apply our
customizations.

Creating a Transform

We will show one way of creating atransform using afreely available tool, Orca.

First, start Orca

In the File menu, click Open.

Navigate to the Viz Pilot installer, and open it.

Select Transform > New Transform.

Thetitle of the Orca window should now say (transformed by Untitled).

PwWNPE
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Locate the Property table in the listing on the left-hand side, and select it.

Right-click the property list and select Add Row.

Enter aproperty name of | NSTALLDI R.

In the next window, enter thevalueof E: \ Vi zrt\Viz Pilot Xx.y.

This sets the installation location.

9. Right-click again and add a row with the name ADDLOCAL and value Vi zPi | ot News,

hj ect St ore.
Thisis acomma-separated list of feature IDs that will be installed. In this example weinstall Viz
Pilot News and the Object Store client, but nothing else (including the bundled Oracle Instant
Client libraries.)

10. Repeat this procedure (if required) for the CONFI GCBUNDLE property.

11. When you are satisfied with the new values in the property table, select Transform > Generate

Transform.

Save the transform file to the preferred location.

© No O

Creating a GPO with an Applied Transform for Distributing Viz Pilot

We will now show how to use the transform, a configuration bundle and Viz Pilot MSI installer to create a
GPO. We use Windows Server 2012 R2, so the exact steps might vary with different versions of the
Windows Server.

First you need to prepare a network share that will host the MSI, transform and configuration bundle. This
network share must be readable by the target client’s computer account, because when running the install
unattended, no interactive user will be logged in and lending their access credentials to the installer
process. One way of doing thisisjust to set the share as read-only to Everyone, but the details and best
way of doing thiswill be different in various networks.

In this example, we will use the UNC path \ ser ver\ sof t war e to represent this share. Put al three
files on this share. The three paths are:

® \server\software\ Vi zPi | ot-X.y. X. X. msi

® \server\software\transform nst

® \server\software\config.zip
Y ou might end up having multiplet r ansf or m st and confi g. zi p pairsto support different
sets of configuration in your setup.

First, we need to create a GPO representing our software installation.

1. Start the Group Policy Management tool.

2. Place the GPO in the Group Policy Objects container.

We are using the domain structure, so this container is preferred here, but there might be a better
location for it in your domain.

Right-click the Group Policy Objects container, and select New.

4. Giveit adescriptive name, for exampleVi z Pil ot install ation.

w
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5. Click OK.

6. Right-click the GPO we just created in the Group Policy Objects container, and click Edit.

7. Inthe Group Policy Management Editor window that opens, navigate to Computer
Configuration > Policies > Softwar e Settings.

8. Right-click it and select New > Package.

9. Using thefile selector that appeared, navigate to the installer file.

Note: It isimportant that you access it through the network share, even though it might also
be visible through the local disk.

10. Inour case we navigateto and select \ ser ver\ sof t war e\ Vi zPi | ot - X. y. X. X. i .
11. Inthe box that appears, click Advanced.
The properties windows for this package will now be shown.
12. Gotothe Modificationstab and click Add.
13. Navigate to and select the transform file.

14. Click OK.

15. Closethe Group Policy Management Editor window.
Y ou now have a GPO that is configured to install Viz Pilot, but it needs to be assigned to a set of
clientsto take effect. In our case, al our relevant clients are in the Clients container on the top
level of the domain, and we will link the GPO to this container.

16. Inthe Group Policy Management window, right-click the container in the list on the left hand
side, and then click Link an Existing GPO.

17. Select the GPO you just created in the list, and click OK.
The clients should now install the software on the next reboot.

Troubleshooting

Using this method of installing software has one major drawback; there is no reporting back to a central
location about installation issues or configuration errors. For installation issues related to the MSI installer
itself, you will need to enable general logging of al MSI installations. If theinstaller finishes, but
something iswrong in the configuration, the Viz Pilot Configuration program logs to the file %
PROGRAMDATA% Vi zrt\ Logs\Viz Pilot x.y\configuration.l| og.

3.7.7 M Sl Properties

® |INSTALLFOLDER: Thelocation Viz Pilot will be installed to. Note that various support files are
not affected by this, for example files that must be deployed to the Windows system folder or the
filesin %°ROGRAMFI LES% vi zr t \ Conmon.

® CONFIGBUNDLE: The path to a configuration bundle that should be applied to the system during
installation.

® ADDLOCAL: Thelist of feature-namesto install.

® INSTALLDESKTOPSHORTCUTS: If thisis set to any value, the installer will place shortcutsto
installed programs on the current user’ s desktop.
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3.7.8 Pilot Data Server Unattended I nstallation

Pilot Data Server configuration values can be provided on the command line when performing an
installation, avoiding the need to enter these manually in the installer GUI. Specifying the values on the
command lineis primarily used during a silent/unattended installation, which can be done using the
Windows Installer parameters, quiet or passive. Refer to Microsoft’s Windows Installer documentation for
more options.

See dlso Pilot Data Server Installation.

Pilot Data Server with Graphic Hub Database
Toinstall Pilot Data Server with a Graphic Hub database use the following parameters:

¢ CONNECTI ON_METHOD=" GH" : Indicates that the Pilot database is running on a Graphic Hub
® (CGH_HOST: Hostname of the Graphic Hub REST server
® (CGH_PORT: Graphic Hub REST port
® (GH_USER I D: Username for accessing the Graphic Hub REST server
For example:

nei exec /i <path/to/ msi> CONNECTI ON_METHOD="GH' GH HOST="1ocal host "
GH _PORT="19398" GH USER | D="Guest" /qui et

Pilot Data Server with Oracle Database

Toinstall Pilot Data Server with an Or acle database use the following parameters:

® CONNECTI ON_METHOD=" Or acl e": Indicates that the Pilot database is running on Oracle

® (ORACLE_USERNANME: Oracle database username

® ORACLE_PASSWORD: Oracle database password

® ORACLE_DATA SOURCE: Oracle data source containing Oracle server host and the database (or
instance) name
For example:

nei exec /i <path/to/ msi> CONNECTI ON_METHOD="COr acl " ORACLE_USERNANME="
pi | ot 700" ORACLE_PASSWORD="pi | ot 700" ORACLE_DATA SOURCE="bdvcpdb
/vizrtdb" /quiet

3.8 Video Codecs Installation

If you are previewing proxy versions of video from Viz One using Viz Engine (i.e. Viz Engineinstalled
on your control client machine) you will have to install video codecs. These are not part of Vizrt's
standard installation.

IMPORTANT! Dueto licensing requirements, Vizrt does not provide the codecs required for local
preview. Users must obtain and install their own codecs.

Note: Codecs are only required when local preview is done, asin the case above. Playout of the high
resolution versions do not require a codec installation.
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The following procedures will guide you through the necessary installation steps:

® [|nstallation Options
® Toinstal codecsfor local preview
® To set apreferred decoder

3.8.1 Installation Options

Codecs are available from several suppliers. The list below includes severa suggestions:

® FFDShow MPEG-4 video decoder and Haali Media Splitter
® LAYV Filtersvideo decoder and splitter
® MainConcept video decoder and splitter

IMPORTANT! On Windows 7 machines, the default installation of the LAV filters resultsin
the LAV splitter and the Windows video decoder being used. This can lead to problems, so
customers must avoid this situation by ensuring that the LAV decoder is selected using the
Windows 7 filter tweaker tool. See how To set a preferred decoder.

Toinstall codecs for local preview

The example below sets up support for h.264 playback using the FFDShow MPEG-4 codec package and a
Matroska Splitter from Haali.

Note: You need to have your own license for clip playback as FFDShow does not come with a
decoding license.

1. Make sure you do not have any other codec packages installed on the machine that interfere with
FFDShow or the media splitter.
2. Download the Matroska Splitter from Haali
Download the Windows 7 DirectShow Filter Tweaker
Download the FFDShow MPEG-4 Video Decoder
® Make sure you have alicense to use the codec
® Make sure you download a 32-bit version of the codec
Uninstall older 64-bit versions of the M PEG-4 codec
Install the M atr oska Splitter from Haali
Install the Windows 7 DirectShow Filter Tweaker
Install the FFDShow M PEG-4 codec
® After installing the FFDShow codec package make sure that no applications are excluded,
especially Viz Engine (thereis an inclusion and exclusion list in FFDShow).
9. Set your MPEG-4 32-hit decoder to FFDShow (see how To set a preferred decoder)
® You should now be able to preview video clips from Viz One

> w

o No O

To set apreferred decoder

1. Run the Windows 7 DirectShow Filter Tweaker
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2. Inthediaog box click Preferred decoders

Preferred DirectShow decoding filters in Windows 7 [ﬁj
32-bit decoders: +  B4-bit decoders: -~
| H.264 V| H.264
Microsoft @ Microsoft
@) ffdshow IUSE MERIT
USE MERIT E | XVID A

3. Set your MPEG-4/H.264 * 32-bit decoder to * FFDShow and click Apply & Close
4. Click Exit

3.9 Pilot Data Server Installation

Viz Pilot’s Pilot Data Server acts as a server for accessing Viz Pilot’ s database and other services. The
Data Server must beinstalled in order to use features such as Crop Service, Template Tagging, Update
Service, Person Search, search on Viz One, Thumbnail Generator and Timeline Editor. It is aso necessary
when using Graphic Hub as the Viz Pilot database, or for integrating with Viz Story.

3.9.1Toinstall the Data Server

1. Click the Data Server installer file (*.msi) to start the Data Server Setup Wizard.

In the Welcome panel, click Next.

3. Inthe Destination Folder panel, define the location of the Data Server program files, and then
click Next.

N

4. Inthe Setup Database Connection panel, define the following settings:
® Connect string: Connection string (<host nane>/ <servi ce nane>) totheViz Pilot
database.

Note: When installing the Data Server on a new system, the default database
configuration setting pointsto | ocal host/ vi zrt db.

® Username: Viz Pilot database username.
® Password: Viz Pilot database password.

Note: Thiswill allow you to edit all database settings for all clients connected to the
same database.

5. Click Next.
6. Inthe Ready toinstall panel, click Install.
7. Inthe Completed Setup Wizard panel, click Finish.

43



3.9.2 Notes

® |f Crop Service Installation isrequired, it must be installed separately, after the Data Server.

® Thumbnail Generator can be installed as an optional component.

* |f support for multiple Viz Pilot database schemas is required, separate Data Servers must be
installed on separate machines.

3.9.3 Firewall Exceptions

In order for Data Server to be accessible from other machines, Windows firewall exceptions are required.

Data Server adds the following inbound rules to the Windows firewall during installation: allow
connections on port 8177, 7373, and 9876. These are removed when Data Server is uninstalled.

See Also

® Pilot Data Server
® Data Server Release Notes

3.10 Crop Service Installation

The Crop Service hasits own installer, but in order to use the Crop Service, the Pilot Data Server must

also be installed, see Pilot Data Server Installation.

‘Note: The Crop Service is a64-hit application, soit must be installed on a64-bit machine. To
simplify configuration, it is recommended that Crop Service be installed on the same machine as Pilot
Data Server.

Note: A Pilot Data Server must be installed before the Crop Service. The Pilot Data Server and Crop
Service must have the same version number (major.minor).

® Runthe Crop Serviceinstaller: Vi zrt Pi | ot Cr opSer vi ce- x64- X. y. nsi

3.11 Toinstall the Script Runner

® Runtheinstaller: VCPScri pt Runner | nstal | er _x.y. nsi

3.12 Preview Server Installation

The Preview Server isrequired in situations where the Viz Engine must provide frames for snapshot or
thumbnail generation. The Preview Server isused by Viz Pilot News to fetch previews of overlay graphics
for the Timeline Editor.



See Also

® |nstallation section of the Preview Server Administrator’s Guide

3.13 Pilot DBA Installation

The Pilot DBA is used by Database Administrators (DBAS) in order to install, maintain and upgrade the
Viz Pilot database.

Thereisno installer for Viz Pilot’s Database Administrator (Pilot DBA) tool. The tool can be downloaded
from Vizrt's FTP asa ZIP archive. It islocated in the same directory asthe Viz Pilot installer.

Pilot DBA and al script files are bundled into a ZI P file. Please unzip al filesinto one folder, for
example, C: \ 't enp\ Pi | ot DBA.

3.13.1 Toinstal Pilot DBA

1. Extract the ZIP archive to a preferred directory.
2. Create a shortcut for the desktop and/or the start menui.

3.14 Getting Started after Installation

After installing and configuring the Viz Pilot Components relevant for your setup, it istime To start the
Director.

3.14.1 To start the Director

%)

1. Start Media Sequencer.

2. Configure Director’s Database parameters in the local initialization file to connect to the Viz Pilot
database.

Double-click theicon on the desktop, or

4. Select the program from the Start menu:

w

(All Programs > Vizrt > Viz Pilot x.x > Director X.x)
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4 Configuration

This section describes how to configure the Viz Pilot system.

In order to have aworking Viz Pilot system, most of the applications must be configured to use aMedia
Sequencer, a database and a Viz Engine for playout and preview.

This section contains the following topics:

® Viz PFilot Configuration Tool

® Viz Engine Preview Configuration
® |nitialization Files

® Configuration Files

® Database Configuration

® Oracle Database

® Graphic Hub Database

® Database Parameters

® Working without a Database Connection
® Registry Settings

® Digplay Font

® Storage and Backup

® LogFiles

¢ Port Numbers

4.1 Viz Pilot Configuration Tool

The Viz Pilot Configuration tool can be opened from the Windows Start Menu (Viz Pilot Configur ation)
or the desktop icon.

B3

Tip: Aspart of the Viz Pilot installation process, this window is automatically opened after the Viz
Pilot Setup Wizard has finished installing al relevant Viz Pilot Components. Also, it is possible to
open the Viz Pilot Configuration in non-GUI Mode.

The available tabs and settings in this window reflects the installed Viz Pilot Components. For example, if
the Template Wizard isinstalled, the Wizard tab is available, and so on.

46



'k Viz Pilot Configuration

General Preview Mewsroom Wizard
F?I Database
Connection method
Oracle 51D Oracle TNS Graphic Hub

Hostname

System identifier (S10)
VIZRTDB

Username
PILOT

Password
PILOT

() Media Sequencer

Media Sequencer hostname
lecalhost

This section describes the configuration options that can be performed in the various panels of the Viz
Pilot Configuration tool:

® Genera
® Preview
® Newsroom
® Wizard

4.1.1 General

To view the Genera panel, click the General tab in the Viz Pilot Configuration Tool.

In this panel it is possible to configure settings related to the database and Media Sequencer.

The Oracle SID connection type alows for adirect connection to an Oracle database, with hostname
and system identifier (SID), without a configured tnsnames.ora file on the system.

The Oracle TNStype allows for a connection to an Oracle database, with just aTNS dlias, if thereis
a correctly configured tnsnames.ora file on the system.

® The Graphic Hub type allows for a connection to a Graphic Hub database.

Note: Asthe databaseis key to any Viz Pilot system setup, doing thisright isimportant. If you
do not have the correct information at hand, please contact your database administrator before
making any modifications to the database settings.
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Note: Database settings cannot be changed from inside Director, you must use the General tab in
the Viz Pilot Configuration Tool.

This section contains the following topics:

® To configure the database connection
® To configure the Media Sequencer connection

To configure the database connection

Inthe Viz Pilot Configuration Tool’s Gener al panel, enter the details for the type of connection you
require:

Oracle database:

® Oracle SID: This option alows you to configure a connection string. Enter avalid Hostname and
System identifier (SID) (default is VIZRTDB), database User name (default is PILOT) and
Password (default is PILOT)

® Oracle TNS: Configure a TNS connection. Enter avalid TNS alias and directory TNS path for the
Oracle configuration file thsnames.ora. For more details, see Database TNS Alias. Enter the database
Username (default is PILOT) and Password (default is PILOT)
‘Note: If the default port number (1521) is not used, add it as an extension to the hostname:

<hostname>: <port number>.

Tip: Inorder to use Viz Pilot’ s database locally, configure an Oracle Instant Client during
installation.

Graphic Hub database:

® Graphic Hub: Configure a Graphic Hub connection. Enter the Graphic Hub REST hostname and
Port (default is 19398), and the User name for the user that has been configured in the Graphic Hub
for Viz Pilot connections (default is Guest).
‘Note: InViz Pilot 7.0, the username must not have a password. The user and its group mustbe
active and the user needs at least user write access. For information on how to manage users and
security, see the Graphic Hub User’s Guide.

To configure the Media Sequencer connection
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() Media Sequencer

Media Sequencer Host
localhost

® |nthe Viz Pilot Configuration Tool’s General panel, enter the M edia Sequencer Host name (or IP
address).

Note: To change the database connection for the Media Sequencer, go to Tools > Media
Sequencer Configuration > Database Tab.

4.1.2 Preview

To view the Preview panel, click the Preview tab in the Viz Pilot Configuration Tool.

The Viz Pilot system alows for preview of template graphics in two ways, Remote Snapshot Preview
using aremote Viz Engine (recommended) and L ocal Preview using alocally installed Viz Engine
(requires alicense). The settingsin this panel defines the preview in the Director and Viz Pilot News.
Database settings apply to al clients that do not have preview configured locally.

Note: The Local preview option isonly available if the Local preview plugin has been installed as one
of the Viz Pilot Components.

To configure preview settings

1. IntheViz Pilot Configuration Tool, click the Preview tab.

#¢ | Viz Pilot Configuration
General Preview MNewsroom Wizard
Preview

Remote Disabled

Override database settings

Hostname

Port

2. Select whether the preview should use a L ocal or Remote host, or if the preview functionality
should be Disabled all together.
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3. Optional: Select the Override database settings box.
Thiswill override the Viz Engine settings specified in the database.

Note: A Remote preview without the Override database settings means that the remote host
and port istaken from Viz Pilot Parametersax_pr evi ew_host and ax_previ ew_port.

4. In aremote preview setup, enter the Viz Engine preview Hostname (or |P address) and the Port
number.

Tip: Multiple renderers can be defined as a comma separated string. For example <host>,
<host>, ... or <host>:<port>,<host>:<port>, ... . If hosts are defined without a trailing port
number, it is recommended to set the default port in the Port field. If no port number is set, it
will default to 6100.

Note: Configuring the preview settings will add the settings to your local machine’ s registry.
If you have multiple newsroom clients, it is possible to have all clients using the preview host
settings, by adding them to your Database Parameters.

4.1.3 Newsroom

To view the Newsroom panel, click the Newsroom tab in the Viz Pilot Configuration Tool.
To configure newsroom settings

1. IntheViz Pilot Configuration Tool, click the Newsroom tab.

k Viz Pilot Configuration

General Freview MNewsroom Wizard

MO5s
Owernide database MOSID

2. Select the Override database M OSI D box.
3. Enter avaid MOSID.

Tip: The MOS ID can be obtained from your Newsroom Computer System. The default MOS
ID isPILOT. Note that most newsroom systems generate case sensitive MOS IDs.
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Note: Theinstaller in Viz Pilot 5.7 and earlier had the option to set some Advanced INEWS
settings during installation, in order to configure VizDM and iNews Control Air Device
Manager. These are no longer included in the installer, but the values (insertBCSTag,
BCSDeviceName, UseVCPDM, BCSTemplateName), can still be accessed as Registry
Settings.

Note: For amanual configuration of the MOS ID in Director, see the ContentPilot.ini’s MOS
section. Viz Pilot News configures the MOS ID using the following registry value:
HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node[ vi zrt ]\ Acti veX Xx.

y\ Tenpl ateFi | | er\ nosI D

4.1.4 Wizard
To view the Wizard panel, click the Wizard tab in the Viz Pilot Configuration Tool.

The settings in this panel definesthe list of available Viz Engines in the Template Wizard.

Note: Thistab isonly available if Template Wizard has been installed as one of the Viz Pilot
Components.

1. IntheViz Pilot Configuration Tool, click the Wizard tab.
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k Viz Pilot Configuration

General Preview MNewsroom Wizard

Viz Engines
Hostname Password (optional)

localhost

2. Definethe Hosthame and Passwor d (optional) of your Viz Engines.
Working with Template Wizard you will connect to aViz Engine - which again connectsto a
Graphic Hub - in order to work with the scenes you wish to create templates for. The default
hostnameislocalhost. If you have aViz Engine installed locally, there is no need to modify this
hostname. If you want to connect to remote Viz Engines you simply add the hostnames (or IP
addresses).

4.2 Viz Engine Preview Configuration

4.2.1 Loca Preview

Local preview usesalocal Viz Engine. It also requires the Viz Engine Preview Plugin which is not
enabled by default, but can be enabled/disabled in the Viz Pilot Configuration Tool.

See
® Configuring Local Preview

Remote Preview:
Remote preview uses aremote Viz Engine. This can either be areal time or a snapshot preview.

See

® Configuring Remote Preview for the Newsroom and
® Configuring Remote Preview in Director.
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® Thereal time preview option uses Viz Engine with areference monitor for animated and snapshot
still previews, and is the recommended solution for graphics designers, template designers and
control room operators.

® This option works best using an additional Viz Engine as this will give you an option to pass
through your video input.

® Asan dternativeto the extra VViz Engine you may also run two Viz Engine instances on one
physical machine provided you have two graphics cards (in adual channel setup).

* Asafinal aternative you may also configure the Viz Engine used for program output to feed
still previews using port 50010. This kind of remote preview can be configured from the
Profile Configuration window in Director.

‘Note: In control roomsit is recommended to use a stand-alone Viz Engine with areference
monitor for full graphics and video preview.

® The Remote Snapshot Preview option uses a shared Viz Engine with the option of showing stills,
animations and preview points, and is the recommended solution for multiple simultaneous users (e.
g. for thumbnail generation and newsroom and non-linear editing users).
The Remote Snapshot Preview option allows you to see aframe by frame preview. Either selected
frames or frames of preview points added to the scene by the graphics designer. This option does not
support preview of your video input.
It is recommended to add the pilot1l _tag on the scene’ s default (main) director in order to set a
specific preview or generation point. The same goes for transition logic scenes that must have the tag
set for the foreground scenes. The pilotl tag is case sensitive and MUST be lowercase.
Y ou may use Director’ s built in Remote Preview (CTRL+P) window for a Remote Snapshot
Preview. This option is configurable from the Director Preferences window and must not be
confused with Viz Pilot’ s Preview plugin which requires alocal Viz Engine (see Configuring Local
Preview).

See Also

® Viz Engine Preview in the Newsroom
® Viz Engine Preview in Director
® Viz Engine Preview in Template Wizard

Configuring Local Preview

Local preview requires the Viz Engine Preview plugin and aViz Engine. Theloca Viz Engine used for
preview rendering should preferably have the same configuration and hardware setup as the Viz Engine
used for program rendering. Local preview is not a recommended setup if the machine does not meet the
hardware requirements.

By default the Viz Engine Preview plugin is not enabled, but can be enabled/disabled in the Viz Pilot
Configuration Tool.

If you are using Viz Engine to preview video clips from Viz One, Viz Engine must be installed with
Video Codecs Installation. Note that the setup procedures of Video Codecs installations are only relevant
for Viz Engine when used for previewing low resolution proxy versions of video clips stored on Viz One.
Playout of the high resolution versions do not require this additional configuration step.
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Portsfor Local Preview

For local preview it is recommended to configure a Viz Engine to use the default port 6100. If local
preview isarequirement, it is recommended to use the Viz Preview License server to minimize the need
for hardware license dongles.

If the port number is changed, Viz Engine must change its communication port aswell. Use Viz Config to
set the new communication port number.

To configure local preview

1. First, see how To add a Viz Engine, and then perform the following steps:

2. Add the newly created Viz Engine to your channel and check the Viz Preview check-box. Use
localhost as your hostname.

3. Click Close

To automatically login to Graphic Hub

IMPORTANT! Users MUST configure Viz Engine To automatically login to Graphic Hub, as
Director and/or Template Wizard are unable to do this.

Prerequisite: For automatic login to work, aninitial login to a Graphic Hub viathe Viz Engine must be
performed before using this preview method. During this process, the Hostname, Hub and User must be
typed in. For more information see the Viz Artist User’s Guide.

1. Start Viz Config
2. Inthe Database section enable Auto Login
3. Click Save and close Viz Config

4.2.2 Configuring Remote Preview for the Newsroom

This section contains the following topics:

® Portsfor Remote Preview

® To enable remote preview in Viz Pilot News

® To configure remote preview for Viz Pilot News
® Viz Engine Configuration Recommendations

Ports for Remote Preview

The recommended option isto configure a second Viz Engine to use the default port 6100 (which will
give you areal-time preview on areference monitor).

For remate preview where you want to support multiple users aremote Viz Engine can be configured to
use preview port 50008 (which will give you a client-side still/snapshot preview).

For remote preview where you need to use the same Viz Engine for both program and preview rendering
you can use port number 50010 (which will give you a still/snapshot preview on areference monitor).



By default Viz Engine uses port number 6100 for both program and preview rendering. If a port number is
changed Viz Engine must change its communication port aswell. Use Viz Config to set the new
communication port number. Note that thisis not required for the multiplexing ports (50008 or 50010).

To enable remote preview in Viz Pilot News

By default, Viz Pilot News uses Remote Preview, and thisis enabled by default during installation.

If the Local Preview option has been used previously, ensure that it is disabled in the Viz Pilot
Configuration Tool, otherwise the local preview will start instead of remote preview.

To configure remote preview for Viz Pilot News

1. Gotothe PFilot Data Server Web Interface

2. Click the Settings tab

3. Click the VCP Parameters tab

4. Addor edittheax_previ ew_host andax_previ ew_port parameters.

® ax_preview_host: <hosthame>
® ax_preview_port: 50008

Two or more hosts can be specified in CSV format, typically using a comma as a separator. Example:
ax_preview_host = myenginel,myengine2. The feature is only for basic |oad balancing, and does not add
redundancy. All hosts must serve the same content.

Viz Engine Configuration Recommendations

Recommendations for the Viz Config settings for the actual Viz Engine used as a Remote Preview for Viz
Pilot News.

® Setup aViz Engine VGA version
® Useadl the default configuration
¢ Under Memory Management in Viz Config, set the following:
® Free Image Data (settings depends on the graphics Card) can stay on = No
® Freelmages=0On
® FreeFonts=0n
® Free Memory Threshold (MB) =300

Some minor memory and speed gain is achieved by:

® Turning off audio (Audio Settings > Audio Active > Off)

® Deactivating Virtual Studio (Camera> Virtual Studio > Deactive)

® Setting the Output Format lower than house standard (e.g. from 1080i to PAL 16:9)
® Turning off pluginsthat are not used
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4.2.3 Configuring Remote Preview in Director

This section contains the following topics:

® To enable remote preview in Director

® To configure remote preview in Director

® To configure remote still preview in Director

® To configure Remate Snapshot Preview in Director

To enable remote preview in Director

By default, Director uses Remote Preview, and thisis enabled by default during installation.

If the Local Preview option has been used previoudly, ensure that it is disabled in the Viz Pilot
Configuration Tool, otherwise the local preview will start instead of remote preview.

To configure remote preview in Director

1. First, see how To add a Viz Engine, and then perform the following steps:
2. Add the newly created Viz Engine to your channel and check the Viz Preview check-box
3. Click Close

To configure remote still preview in Director

Still Preview allows you to use the program output to get a still preview, typically on areference monitor.
To achieve this the Media Sequencer creates a copy of the scene being read and sends commands to your
program output renderer asking for a snapshot of the scene while the current scene on air isbeing
rendered.

onfigure Viz Engine

VizEngine2
50010
Still Preview ﬂ

_ 0 | Goncel |

1. Createtwo channels, one for program and one for preview

2. Configure the same render engine twice as seen in how To add aViz Engine

3. For the second render engine set Port to 50010 and the M ode to Still Preview

4. Click Ok

5. Add the program renderer to the program channel and the still preview renderer to the preview
channel
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Warning: This setup requires sufficient ring buffer on the program renderer in order for the
rendered still preview not to cause the scene on air to drop frames; hence, this setting is

To configure Remote Snapshot Preview in Director

Start Director
Select Director Preferences from the Options menu
Select the Remote Preview option in the Director Preferences window
Enable the Use this server option to override the database settings
® Host: <hostname>
® Port: 50008
5. Optional: Enable the Always show “ Animate” button option, and set a preferred poll interval
(seconds) for how often images should be retrieved from Viz
6. Optional: Configure size and position of the remote preview window

APWDNPRE

Note: If the Viz Engine Preview plugin is enabled, local preview will start instead of remote
snapshot preview. The plugin can be disabled in the Viz Pilot Configuration Tool.

4.3 Initialization Files

The following initialization files are used with the Viz Pilot system.

File Description

ContentPilot.ini Most Viz Pilot components use this .ini file. The default fileis stored in
the program folder during installation as Cont ent Pi | ot . i ni . See
ContentPilot.ini

objectstore.ini Object Store may useits own ini file for reading and connecting to the Viz
Pilot database. See Object Store Initialization File.

Modified files are stored in %°PROGRAMDATA% Vi zrt\Viz Pilot x.y\Config

In most cases, you can use the Viz Pilot Configuration Tool to make changesto the INI files. If required,
they can be opened with the Initialization File Editor, or aregular text editor, however thisis strongly
discouraged.

4.3.1 Initialization File Editor

IMPORTANT! In most cases, you can use the Viz Pilot Configuration Tool to make changesto the
INI files, so you will not need to use the Inifile Editor.

Note: The Inifile Editor is not available as part of Viz Pilot News instalation. It is available with
Director if the feature Inifile Editor has been installed.
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To edit theini files, it is recommended to use the IniFile Editor located in the Viz Pilot program folder:

® Windows 32-bit: 94°r ograntil es®A Vizrt\Viz Pilot x.y\IlnifileEditor.exe
® Windows 64-bit: %°r ogr anti | es(x86) % Vizrt\Viz Pilot x.y\InifileEditor.

exe

BUTTON_BOX
DATABASE
FEEDBACKLANGUAGE
GEMERAL
GP1

- IMPORT_SEQUENCE
LANGLUAGE
MOMITOR
MOS
MOS_GATEWAY
ORIGIN_MOMITOR
PARAMETERS
PATH

-PILOT
SEQUENCER
56l
TEMPLATE_WIZARD
VIDEOQ
viZ
VIZ_IO

The left pane displays the sections, which organize the entriesinto logical groups. The right pane displays
the entries within each section. The entries are also known as keys.

New section...: Adds a new section to the INI file.

New key...: Adds a new entry (key) to the section.

New description...: Adds anew description to the section or key.
OK: Confirms any changes made and closes the editor.

Cancel: Cancels all changes and closes the editor.

4.3.2 ContentPilot.ini

ContentPilot.ini contains many settings, organized into the following sections:

Button Box
Database
Genera

GPI

Import Sequence
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® | anguage

® Parameters

® Path

® Pilot

® Sequencer

* SGl

® Template Wizard
* Viz

IMPORTANT! Do not modify any settings that are not described in this document. Do not
modify any settings unless required.

Button Box

Settings pertaining to the use of a button box with Viz Pilot.
® enabled: Set'Y or N to enable or disable button box.
Database

® |ogin: User ID for the database connection

® pwd: Password for the database connection

® utf8: Sets whether or not the program and database should use UTF8 font encoding. This value
should not be modified.

® nls lang: Setsthe language to use. If UTF-8 is used for the database, the NLS_LANG environment
setting must be here. Thisvalue is required and should not be modified.

® name: This entry must contain the connection string for the database in the form: “hostname/instance
name”. If a database client (e.g. Oracle Client) is used enter the TNS name.

General

® diff_tool: The path to atext compare tool executable can be entered here. Thiswill enable the
possibility to compare script files when conflicts between local scripts and repository scripts appear.
® imageheight: Setsthe default thumbnail image height generated by TnG.

GPI
This section contains settings dealing with GPI triggering of Director.

® enabled: Enable GPI triggering? Y or N.

® poll: Number of milliseconds between each poll of the GPI port.

¢ delay_interval: Number of milliseconds before repeating a GPI trigger.
® use Ipt: Usethe LPT port for GPI triggering? Y or N.
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® send_to_cockpit: Send the trigger to the cockpit? Y or N. If set, Viz Pilot will send arecall message
tothe Viz 10 when a GPl is received.

¢ allow_combination: When sending atrigger to the cockpit, the allow_combination specifiesif for
instance GPI 3, should be sent as GPI 1, and GPI 2.

Import Sequence

Settings for enabling import of playlists from file (advanced).

® enabled: If setto Y it will enable the menu Playlists.
¢ default_file: Setsthe default file to import.

Language

® font: Setsthe application’ s template and data list font. By default this setting will be set using the
operating system font; however, in many cases other fonts, such as Arial Unicode M S, are used for
language localization purposes (for example Arabic, Hebrew or Cyrillic).

Note: The font setting does not affect Viz Pilot News, which hasits font settings configured in
theregistry.

Parameters

® datapool_visible: Enable or disable the Datapool component in Template Wizard.

® basic_properties: Comma delimited list of additional propertiesto show in the basic properties tab
in Template Wizard.

® plugin_folder: Folder where Template Wizard will look for VcpExp.bpl.

Path
This section specifies a set of file and folder paths that the Viz Pilot system needs to know about.

® picture: Definesthe picture archive path.

® production: The directory where the images for today’ s production are placed - excluding the date.

® autosave: The directory where automatically saved template records are stored.

® tmpbmp: The directory where temporary bitmaps are stored.

® scene node: Specify anode that should automatically be selected when viewing the scene tree from
Viz Enginein Viz Pilot.

® image node: Specify an image that should automatically be selected when viewing images from Viz
Enginein Viz Pilot.

® object_node: Specify an object that should automatically be selected when viewing objects from Viz
Enginein Viz Pilot.

® sounds. The directory where WAV files are initially looked for.

® shared: The directory where the shared image disk is mounted on the Unix system. Used for
specifying the Unix path to the shared image server. For instance on windows the drive is often
mapped as K:\ but on a Unix system it would be \shared\images.

® fileopen: Setsthe default folder when opening image files.
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Pilot
These settings have to do with the general behavior of the Viz Filot system.

® restrict_characters: Restrict characters when saving data.

® |egal_characters: The characters that will be permitted in the names of saved dataif
"restrict_characters=Y". If thisvalue is empty then there is no restriction on the data name regardless
of the "restrict_characters" setting.

® liveupdate_timer: Thetime in milliseconds between each time atemplate’' s Live Update event-
handler is called. (If the template has Live Update.)

¢ dateformat: The date format for saved data.

® unique_names: Whether or not it is permitted to save several data elements with the same name.

® autostart preview: When setto Y, the Viz Pilot system will automatically start Viz [preview
enging] if itisinstalled.

® plugins. The directory where the plugins for the Viz Pilot system are located. Normally, thisvalueis
empty, otherwise it should be the path to the directory.

® UTF8: SettoY for UTF8 support in the Viz Pilot system.

® |ogcount: Number of rolling log files (default 0). Affects both the Viz Pilot system’slog and macro
log files.

® |ogsize: Maximum size of the log file in bytes (default 512000). Affects both the Viz Pilot system’s
log and macro log files.

® |ogfile: Override the Viz Pilot system log file name (default vep_yyyymddThhmss. | 0g).

® |ogdir: Override the directory the Viz Pilot system log files are put in. Default locations are:

® 0PROGRAMDATA% Vi zrt\Logs\Viz Pilot x.y
® macrologfile: Override the macro log file name.
® macrologdir: Override the directory the macro log files are put in.

Sequencer

® hostname: Setsthe hostname of the Media Sequencer when oneis specified during installation. If no
host is specified it is set to localhost.

® |ocktoprofile: When set to a specific profile users will not be allowed to select other profiles or open
the profile configuration in Director.

SGI

This section can be used to add new Viz Engines that can be used by Template Wizard. Click the *New
key *button in the Inifile Editor and enter the new key value, e.g. machine2 and so on.

® machinel: The host name of the Viz Engine to connect to. More machines can be added to the list:
machine2, pwd2 etc.
® pwdl: Onair password for the Viz Engine. Note that thisis not supported on Viz Engine 3.5 or later.

Template Wizard

® linelayout_visible: Enables the Prefix and Customize options in the Wizard tool that sets the number
of prefixesto be used when generating a template with a table style layout.
® datapool_visible: Enable or disable the use of the datapool component in Template Wizard.
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® basic_properties; Commadelimited list of additional properties to show in the basic properties tab.

® use database: If disabled the Template Wizard will operate without a database connection. This can
be useful when creating file-based templates with Template Wizard. For example, for on-the-road
template work, and template user interface design for Viz Ticker 3D and Viz Trio. See Working
without a Database Connection.

® diff_tool: The path to atext compare tool executable can be entered here. Thiswill enable the
possibility to compare script files when conflicts between local scripts and repository scripts appear.

Viz
Settings regarding how the Viz Pilot system interacts with Viz Engine.

® onairpwd: Setsthe Register ON AIR password for Director users.

® data_timeout: Setsthe Viz Engine connection timeout in milliseconds for receiving data from Viz
Engine. Default is 60000 milliseconds (60 seconds). Thisis helpful if you are loading a scenethat is
very complex or loads alot of datathat will take time to render (e.g. a map scene).

Viz 10
Viz IO (input/output) specific settings.

® enabled: Enablesthe Viz 10 connection. Y or N.

® host: The machine hostname (or I1P) of the Viz IO machine.

® port: The Viz IO communications port.

® auto_reconnect: In case the connection to the Viz O is cut, this flag indicates whether to
automatically try and re-establish the connection. (It will try after 30seconds, then after 1 minute,
then after 2 minutes, then after 4 minutes.)

® offset: Used to offset the incoming triggers by a fixed number.

4.4 Configuration Files
The following configuration files are installed with the Viz Pilot system.

The default files are stored in the program folder with namesin the format xxx. def aul t . xxXx.

Any changes are stored to filesin “PROCGRAMDATA% Vi zrt\Viz Pilot x.y\Config

File Use

components.cfg Default Component Palette settings for Template Wizard
custom_components.cfg Custom Component Palette settings for Template Wizard
extra_components.cfg Custom Component Palette settings for Template Wizard
keyboard.kbd Keyboard Configuration for Director

vtw_keyboard.kbd Keyboard Configuration for Template Wizard
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4.5 Database Configuration

Most features of the Viz Pilot system require a database connection, usually an Oracle database. However,
Viz Pilot 7.0 and later support using Graphic Hub as a database.

® Oracle Database
® Graphic Hub Database

4.5.1 Comparison of Oracle Database vs Graphic Hub Database

® Oracleisdesigned for performance when handling large amounts of data. Graphic Hub is designed
for ease of use and low maintenance costs.

® There are more options for tuning and customization with Oracle. Graphic Hub just works out of the
box.

® The main reason for using Graphic Hub as the database, is ease of setup and maintenance. Typical
Viz Pilot systems already have a Graphic Hub, so by moving the database into it, instead of Oracle,
there’ s one less component to install and maintain.

® Graphic Hub comes with its own tools for maintenance tasks, like importing and exporting data,
backup and replication. With Graphic Hub there’ s no need to keep a dedicated database
administrator.

® Object Storeis not supported by Graphic Hub.

4.6 Oracle Database

This section describes how to manually configure the Oracle database connection, it contains the
following topics:

® Oracle Database Configuration During Installation
® Database Setup Options

® Database Initialization File Configuration

¢ Database Registry Settings

® Database Service Namesand SID

® Database TNS Alias

® Database Client

4.6.1 Oracle Database Configuration During Installation

Configuration

The Oracle database needs to be configured in the following places:

1. For client applications, use the Viz Pilot Configuration Tool, either during the Viz Pilot System
Installation , or afterwards. See To configure the database connection.

2. For the Pilot Data Server, use the installation interface during Pilot Data Server Installation.

3. For the Media Sequencer, in Director go to Tools > Media Sequencer Configuration > Database
Tab.
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Workflow Options

Note: For existing installations with Oracle, we recommend that the Media Sequencer connects to
Oracle directly.

InViz Pilot 6.x and earlier, the Media Sequencer connected directly to Oracle for change notifications
and to fetch Pilot data

In Viz Pilot 7.x an aternative setup has been introduced. The Pilot Data Server now exposes al the data
needed by the Media Sequencer through its REST interface. It also provides Change Notifications using
the Stomp protocol. It is possible to configure the Media Sequencer to connect to the Pilot Data Server
instead of the Pilot database.

4.6.2 Database Setup Options

There are several ways to configure the database connection settings. The following sections describe the
configuration options for Director and Viz Pilot News. Configurations for Director aso apply for
Template Wizard and Object Store.

Initialization File
In this case, ContentPilot.ini isused by al the Viz Pilot system components, except Viz Pilot News, which
uses registry settings.

Sinceit is possible to connect to the Viz Pilot database by only using an INI file, thet nsnanes. or a
file may be omitted.

If the database username and password is changed (default is PILOT/PILOT), they too must be set under
the Database section of theini file. See Database Initialization File Configuration below.

Initialization File and Registry
The combination of an initialization (INI) file and registry settings, allow the use of aTNS dlias. Thisis
helpful if the database setup is used by more than one application.

For more information see Database TNS Alias.

Initialization File and Environment Variable

Aswith the Initialization File and Registry combination, an INI file and an environment variable allows
theuse of aTNS dlias.

However, this could potentialy affect the use of Database TNS Alias es for other database clients. If more
than one tnsnames.ora fileis used, it is recommended that the files are merged when setting the
TNS ADMIN as an environment variable. If thisis not desirable, add the TNS ADMIN to the registry.

Registry
Only Viz Pilot News can use database Registry Settings alone.



4.6.3 Database Initialization File Configuration
To set the database properties for the INI file

1. Start the Initialization File Editor.
2. Select ContentPilot.ini, and click Open.
3. Select the Database section and enter the following parameters:
® |ogin: database login string (PILOT)
® pwd: database password string (PILOT)
® utf8: Sets Director encoding for al database communication. Set Y (Y es) to use the
recommended and default UTF-8 encoding, or N (No) to use the local Oracle client’s
encoding setting.
® nls lang: definethe NLS_LANG environment variable here.
® name: database name (either the Database TNS Alias or the SID).
The SID can be combined with ahostname/ / <host nanme>/ <SI D>. Thisis useful
because the database host is, in most cases, not the same host as for the client applications.
When using atnsnames.ora file, use the TNS name (default: VIZRTDB).

4.6.4 Database Registry Settings

If connection properties are entered during installation, all applications will have their Registry Settings
already set for each application.

4.6.5 Database Service Names and SID

A SID isaunique name that uniquely identifies the database instance where as a service name is the
Database TNS Alias that is given when users remotely connect to the database. The Service nameis
recorded in the tnsnames.or a file on the clients and it can be the same as the SID, and it can also be given
any other name.

A service nameis afeature in which a database can register itself with the listener. If adatabase is
registered with alistener using a service name then the service name can be used as a parameter in the
tnsnames.orafile. Otherwise a SID can be used in the tnsnames.orafile.

With Oracle Real Application Clusters (RAC) there will be different service names for each database
instance.

Service name specifies one or more names for the database service to which this instance connects. It is
possible to specify multiple service names in order to distinguish among different uses of the same
database. It is also possible to use service names to identify a single service that is available from two
different databases through the use of replication.

So, SID is aunique database system identifier while service nameisan alias.

If the Viz Pilot system is running without a tnsnames.orafile all database connection parameters must be
specified in the initialization (INI) file. Database configuration can be done during the Viz Pilot System
Installation . Reconfiguration can now be done after installation by running the Viz Pilot Configuration
Tool.
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Note that Viz Pilot News does not use an INI file, hence the database connection parameters need to be
applied during installation. These settings can be edited using the Viz Pilot Configuration Tool, or by
manually editing registry settings (the latter is not recommended).

® | ocal database: <SID>
® Remote database: <hostname>/<SID>
® Remote database: <hostname>/Service name

4.6.6 Database TNS Alias

Oracle’ s Transparent Network Substrate (TNS) technology provides a network of applications above the
existing networks of computers. Although TNS technology can be complex to setup, it is useful when
more than one machine connects to a particular database, and makes switching over to another database
instance more efficient. Switching can be done manually, or automatically as part of a standby database
system.

The TNS technology is configured in atnsnames.ora file, that can be placed locally, or in a centralized
location to manage all of the Viz Pilot system’ s database connections. It contains connection information
for one or more databases.

In order to make use of TNS, acombination of the Viz Pilot system’sinitialization file settings and
registry settings are used.

This section contains the following topics:

The tnsnames.orafile

® NI File Settingsfor TNS alias

® Registry Settingsfor TNS alias

® Toset TNS ADMIN asalocal variable

The tnsnames.orafile

The tnsnames.orafileitself contains client side network configuration parameters, and defines incoming
database requests. It contains al service names. This file also describes each domain name, with protocoal,
host, and port information.

A tnsnames.ora file maps TNS names to connect descriptors (usually ADDRESS and
CONNECT_DATA). The TNS name usually becomes a shorter and more readable alias for the somewhat
cumbersome service name.

Note that when using an Oracle Instant Client a tnsnames.ora file needs to be created manually. Place the
filein adirectory with read access. For other Oracle clients, the default thsnames.ora__ file can be found in
the Oracle client folder.
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A client needs a connect descriptor in order to connect to an Oracle instance. The thsnames.ora file can
define more than one database so that a backup database can be used in afail situation. Oracle uses the
normal TCP communication between the clients and the database.

® | ocal database: <SID>

® Remote database: \<hosthame>\<SID>

® Remote database: \<hosthame>\Service name
The example below uses two hosts. These settings are needed if the database server is set up with a
standard Oracle failover mechanism. When failing over a standby solution (not Data Guard) both
serverswill for a short period of time be unavailable. To avoid disconnect problems on clients a
configuration is needed to make sure clients try to reconnect long enough to get reconnected. This
can be accomplished with a connect descriptor as shown below.

Note: Always check with the current Oracle documentation for current recommendations regarding
failover setups.

Example of atnsnames.ora file for a standby failover setup:

# Generated by Oracle configuration tools.

VI ZRTDB =
( DESCRI PTI ON =

( ADDRESS = (PROTOCOL = TCP) (HOST = SomeHost 1) (PORT = 1521))

( ADDRESS = (PROTOCOL = TCP) (HOST = SomeHost 2) (PORT = 1521))

( CONNECT_DATA =
( SERVER = DEDI CATED)
( SERVI CE_NAME = SorreNane)
( FAI LOVER_MODE =
(TYPE = SESSI ON)
( METHOD = BASI C)
(RETRI ES = 180)
( DELAY = 5)
))

® Host: Preferably host, or an | P address

® Service name: Database service name (e.g. VI ZRTDB. t vchannel . pl ace)
The ADDRESS_LI ST property lists the server addresses. When a server is in standby mode the
database is not open and does not register the service name with the listener. This meansthat if the
client tries to connect to the standby server it will be rgjected and try the other server instead.

( ADDRESS LI ST =
( ADDRESS
( ADDRESS

1521))
1521))

( PROTOCOL
( PROTOCOL

TCP) ( HOST
TCP) ( HOST

SomeHost 1) ( PORT
SomeHost 2) ( PORT
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The FAI LOVER _MODE property tells the Oracle client to fail over the session and ignore any currently

open cursors. The sub-parameters say that it will use basic failover (not preconnect) and at failover time
will retry 180 times waiting 5 seconds between each retry (15 minutes). This should be enough time for
the switch to happen.

( FAl LOVER_MODE =
(TYPE = SESSION) (METHOD = BASIC) (RETRIES = 180) (DELAY = 5)

INI File Settings for TNS alias

The TNS aias name must be set in the name property under the Database section in the ContentPilot.ini
file (see Database Initialization File Configuration).

AUTHORIZATION ogil [pilot
BUTTON_BOX |

FEEDBACKLANGUAGE name IVIZRTDE
GEMERAL -

GPI
IMPORT_SEQUEMNCE
LANGUAGE

IMPORTANT! In order for the TNS settings to work for Director, Template Wizard and Object
Store, the name key must contain the same TNS name alias as in the tnsnames.orafile (e.g.
VIZRTDB).

Registry Settingsfor TNS alias
The TNS_ADMIN string in the registry holds the path to the tnsnames.ora file. Thisallows al of the Viz
Pilot system’ s clients (that is, Director, Template Wizard, Object Store and Viz Pilot News) to use the
tnsnames.ora file, and avoids potential conflicts with other applications using alocal environment
variable.

® |f you do not have any conflicting database connections there is no need to configure the TNS path.
The standard environment variable TNS_ADMIN is the recommended option (thisis the standard
Oracle setup).

® |f you need to set a new/custom path, in cases where you are dependent on connections to two
different databases, it can be added in the General tab of the Viz Pilot Configuration Tool, see To
configure the database connection. This path is then added to registry and will only be used by the
Viz Pilot components.
An alternative optionis To set TNS_ADMIN as aloca variable, which is described below.
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Toset TNS ADMIN asalocal variable

An aternative to using the Viz Pilot Configuration Tool isto add alocal Windows environment variable
called TNS_ADMIN, with the same value as the config tool option. The difference is that the config tool
will only affect the Viz Pilot system, while the environment variable will affect all applications on the

machine using an Oracle client. Also see how to make best use of the Initialization File and Environment

Variable.
System Restore Automatic Lpdates R emaote
- — =y
Mew System Variable @
Yariable name: THS_ADMIN
Yariable value: Z:\Program Files\vizrthCommonOracle
[ (0] 4 l [ Cancel ]

Syskem wvariables

Yariable Yalue ~
CLASSPATH .H:\Program Files)Javaijrel.6.0_0Silib. ..
ComSpe: H:WIRDOW S svstem 32 omd exe

FP_NO_HOST C... MO
MUMBER_OF P... 2
05 Windows_MT b

| mew || Edt || Delete |

[ Ok ] [ Cancel ]

4.6.7 Database Client

The Oracle Instant Client can be selected as one of the components to add when installing the Viz Pilot
system. In this case, a separate installation of an Oracle client is not needed, and the database
configuration for Viz Pilot News can be done during the installation. However this Oracle Instant Client is
only recommended for use with Viz Pilot News, but not Director.

If Oracle's Runtime Client is aready installed, it is not necessary to install Oracle’s Instant Client.

Note: If Viz Pilot News is embedded in a Java-based newsroom system it is recommended to use
Oracle's Runtime Client.

By default al of the Viz Pilot system’s applications will use the Instant Client found under “. . .
\vi zrt\ Comon\ Or acl e”, so ho registry entries are needed unlessiit is desirabl e to disable the use of
the Instant Client and use afull Runtime Client.

Note: Media Sequencer must use the Oracle 11g Runtime Client.
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.................................................................................................................................................

to use atnsnames.orafile, aregistry entry or a system environment variable, called TNS_ADMIN, must
be entered.

To use atnsnames.orafile with Instant Client

1. Open Registry
2. Search for theregistry key
® Windows 32-bit: HKEY _LOCAL_MACHI NE\ SOFTWARE\\ [ vi zrt ]\ vi z| cont ent
pilot x.y
® Windows 64-bit: HKEY _LOCAL_MACHI NE\ SOFTWARE\ Wow6432Node\ \ [ vi zrt]
\viz|content pilot x.y
3. Add thefollowing string valueto TNS ADMIN
® Windows 32-bit: %°r ogr anti | es% vi zrt\ Common\ Or acl e
® Windows 64-bit: %°r ogr anfi | es(x86) % vi zrt\ Cormon\ Or acl e
® This setsthe path to the location of the tnsnames.orafile.

To disable Instant Client and use Runtime Client

1. Open Registry
2. Search for the registry key
® Windows 32-bit; HKEY LOCAL_MACHI NE\ SOFTWAREA \ [ vi zrt ]\ vi z| cont ent
pilot x.y
® Windows 64-hit: HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node\ \ [ vi zrt ]
\viz|content pilot x.y
3. Addtheinteger value IGNORE_IC with 1 as parameter.
® |f set to 1 the application will ignore the Instant Client (if installed) and just use the Runtime
Client (if installed).

To override the default Oracle client

1. Open Registry
2. Search for the registry key
® Windows 32-bit: HKEY_LOCAL_MACHI NE\ SOFTWARE\\ [ vi zrt ]\ vi z| cont ent
pilot x.y
® Windows 64-bit: HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node\ [vi zrt]
\viz|content pilot x.y
3. Add the following string value ORACLE_HOME:
® Windows 32-bit: %°r ogr anti | es% vi zrt\ Common\ O acl e
® Windows 64-bit: 9%°r ogr anfi | es(x86) % vi zrt\ Cormon\ Or acl e
® ORACLE_HOME will be added as an environment variable, and the Oracle client this path
pointsto will be used.
4. Add thefollowing string value OCIDLL:
® Windows 32-bit: %°r ogr anti | es% vi zrt\ Cormon\ Or acl e\ oci . dl |
® Windows 64-bit: %°r ogr anfi | es(x86) % vi zrt \ Common\ Or acl e\ oci . dl |
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® TheOCIDLL string can be used to specify which library the application will use.

IMPORTANT! An override should only be set if the Viz Pilot system requires a
different version of the Oracle client than other programs residing on the same machine.

4.7 Graphic Hub Database

This section describes how to manually configure the Graphic Hub database connection, it contains the
following topics:

® Graphic Hub Database Configuration
® Troubleshooting Pilot Database on Graphic Hub

Graphic Hub comes with its own tools for maintenance tasks, such asimporting and exporting data,
backup and replication, automated cleanup tasks for Viz Pilot data elements and the Viz Pilot change log,
and an integrity check. For more information see the Graphic Hub User’s Guide.

4.7.1 Graphic Hub Database Configuration

Configuration

The Graphic Hub database needs to be configured in three places:

1. For client applications, use the Viz Pilot Configuration Tool, either during the Viz Pilot System
Installation , or afterwards. See To configure the database connection.

2. For the Pilot Data Server, use the installation interface during Pilot Data Server Installation.

3. For the Media Sequencer, in Director go to Tools > Media Sequencer Configuration > Database
Tab.

Note: For a detailed procedure, see the section Viz Pilot Database Management in the
Graphic Hub User’ s Guide.

Workflow

InViz Pilot 6.x and earlier, the Media Sequencer connected directly to Oracle for change notifications
and to fetch Pilot data.

InViz Pilot 7.x an alternative setup has been introduced. The Pilot Data Server now exposes al the data
needed by the Media Sequencer through its REST interface. It also provides Change Notifications using
the Stomp protocol. It is possible to configure the Media Sequencer to connect to the Pilot Data Server
instead of the Pilot database.

4.7.2 Troubleshooting Pilot Database on Graphic Hub

When using a Graphic Hub as the Pilot database:
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® Graphic Hub and Graphic Hub REST are both needed. They install separately and must both be

running.

® The Media Sequencer, the clients, and the Pilot Data Server all need network access to Graphic Hub
REST.

® The Media Sequencer needs access to the Pilot Data Server aswell, if it is configured to go directly
to Oracle.

® |naddition to the existing log files, there is a so one specificaly for the Graphic Hub client in client
applications (Viz Pilot News, Director, Template Wizard) and the Pilot Data Server. Thelog is
located in %PROGRAMDATA%/vizrt/Logs/GraphicHub and %PROGRAMDATA%/vizrt/Viz GH
Pilot. For more details, see the Graphic Hub User’s Guide.

® The Status Indicators in Director which indicates the status of the database connection of the Media
Sequencer (bottom right), however the indicator may be green even if the database the Media
Sequencer is connected to is different from the one that Director is connected to (for example
Director connects to Graphic Hub, while the Media Sequencer connectsto Oracle). In this case
things will not work and the configuration must be changed.

® Media Sequencer 4.0 or later isrequired for Viz Pilot 7.x. If you are connected to an older Media
Sequencer, the Media Sequencer configuration’ s Database tab in Director looks the same as prior to
Pilot 7 (see Media Sequencer 3.x and earlier).
For troubleshooting on the Graphic Hub side refer to the Graphic Hub User’s Guide.

4.8 Database Parameters

Use the Pilot Data Server to configure settings for the Viz Pilot system’ s applications. Applied changes
usually require the affected application to be restarted.

Y ou can access al database parameters from the Pilot Data Server’s VCP Parameters page (i.e.
htt p://<host name>: 8177/ setti ngs).

4.8.1 Viz Pilot Database Parameters

® activex_preview_timeout: Setsthe timein milliseconds Viz Pilot News will wait for aremote
preview Viz Engine connection before continuing. Default is 10000. Can be overridden by the local
registry setting PreviewTimeOut.

® activex_preview_socket_timeout: Setsthetimein milliseconds Viz Pilot News will wait for alocal
preview Viz Engine connection before continuing. Default is 10000. Can be overridden by the local
registry setting PreviewSocketTimeOut.

® ActiveXShowClipsTab: Enables or disables the Clipstab for Viz Pilot News. Allowed parameters
are 1 or 0. Default isOn (1).

® ActivexShowStillsTab: Enables or disables the Stills tab for Viz Pilot News. Allowed parameters
arel or 0. DefaultisOn (1).

® ActivexShowTemplatesT ab: Enables or disables the Templates tab for the Newsroom Allowed
parametersare 1 or 0. Default is On (1).

® app_server: Setsthe Pilot Data Server URI.
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ax_dataelement_timer_enabled: Setsthe default behavior for showing or hiding the Graphic Event
Timing optionsin Viz Pilot News when Saving an Element. When enabled (1) it will show the
timing editor, and when disabled (0) it will hide the timing editor. This setting can be overridden by
enabling the ShowGraphicEventTiming setting for the Template |nformation Component in Template
Wizard on atemplate by template basis.

ax_disable_data_overwrite: When turned on (1) this disables the Save button in Viz Pilot News;
hence, only the Save As button is active. When on, this also unchecks the Add to Library checkbox
in the Template Save Dialog Box for all saved elements.

ax_disable media_drag: When turned on (1), this disables the dragging of clips and stills from the
media search tab to the rundown. Default (0), i.e. dragging from the media search tab is alowed.
ax_disable overlay_saving: When turned on (1), this disables Viz Pilot News from creating overlay
timelines. i.e. when aclip is opened from the media tab, there will not be any previously saved
graphics on the timeline. Overlay saving is enabled by default (0).

ax_enableM ediaSendToRundown: Enables (1) the Add to Rundown context menu option when
adding media elements to the rundown. Thisis only useful if the newsroom system does not support
drag and drop operations.

ax_use_custom_gui_dlg: Enables (1) the Viz World Map Editor (WME) to be embedded within the
user interface of Viz Pilot News. This parameter is by default not set in the database.
clip_default_itemchannel: If avalueis set, it is used as the default channel for video clips. The
valueis used in theitemChannel element in the MOS XML, and will appear in the Viz Trio playlist
and in the NCS. This parameter is empty by default.

If avideo or timeline element is reopened from the NCS rundown, the itemChannel chosen in the
rundown will not be reset to the default again, even if the element is updated and overwritten.
crop_service uri: Setsthe URI of the Crop Service.

croptool_max_image_area: Sets maximum size of a cropped image that will be served by the Pilot
Data Server. Anything larger will be resized, while still respecting the aspect ratio of the crop.
Maximum size applies even if no cropping is done. Image size = width x height in pixels.

delete data from_activex: If setto Y (yes) it will enable the user to delete data elements using Viz
Pilot News. DefaultisY.

image_share: Specifies the path the Resource Panel (for templates) should use when saving a
cropped image (KUNC or W ndows pat h>)

live_update_interval: Specifiesthe interval used by Template Wizard' s Update Script and the
Media Sequencer, to periodically send updates to the update service while on air. (See Using the
Update Script Editor).

preview_server_uri: Setsthe URI of the Preview Server. This machine, with Viz Engine and
Preview Server installed, istypically identified as your frame server.

Director reads this setting during startup, and uses it to set the Preview Server to be used by the
playlist to fetch thumbnails for the elements. The setting will be written to the /config/preview_server
/host nodein VDOM.

shared_curious_server: Setsthe hostname or IP address of the Viz World Server. It isnot
configured when set to <server>. See also Director’s Viz World Preferences preferences.
spellcheck_dict_filename: Sets the filename for the dictionary file (.dic) and affixation file (.aff) for
the spell checker. This parameter is mandatory and by defualt isen_US.

For example, if spellcheck_dict_filename is set to my-special-en_US, then the spell checker will look
for the two files my-special-en_US.dic and my-special-en_US.aff

Several spell checking dictionaries have been included as part of the Viz Pilot system’sinstallation.
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The dictionaries are installed in the default location: %°r ogr anti | es(x86) %

\vizrt\ Cormon\di cts

Other dictionaries can be downloaded from OpenOffice; however, these must be UTF-8 formatted.
Contact your local Vizrt representative if there is aneed to convert and use another dictionary for
spell checking purposes.

spellcheck_dict_path: Setsthe path to the dictionary files for the spell checker. By default this
parameter is empty, which means the default location is used (%°r ogr anti | es(x86) %

\vi zrt\ Conmon\ di ct s).

If the files are not located under the default location, use afull path, mapped drive or UNC path.

Note: In order to define a non-default location, the following conditions must be met: (1)
spellcheck_dict_path must end in a path separator; (2) both the .aff and the .dic files must be
present in the path; (3) spellcheck _dict_filename must be set. Otherwise the default location is
used.

vos allow_edit_from_dll (optional): Enables or disables the toolbar in Object Store. When disabled
it will disallow registering and editing of images and person information when Object Storeis used
with Viz Pilot News and Template Wizard. This option can be added to the database. Values are Y
for allow edit and N for disallow edit.

VOS PASSWORD: Shows the encrypted Object Store password that is used to enforce access
control when using the Object Store Settings window. Isonly visibleif access control has previously
been enabled. This setting can be used to reset the password by deleting it; however, it cannot be
used to change the password. See Object Store Settings.

4.9 Working without a Database Connection

Certain features of the Viz Pilot system can be used without a database connection.

4.9.1Viz Pilot News

To run Viz Pilot News without a database connection (NODB mode), set the following registry setting
with type DWORD (32-hit) Value:

HKEY_LOCAL_MACHI NE\ SOFTWARE\ Wow6432Node\ [vi zrt ]\ Acti veX x.
y\ Tenpl ateFiller\NODB = 1

Only the Mediatab will be enabled and media files will appear for all the asset search providers.

4.9.2 Director

When running Director in NODB mode, you can work with the following functionalities:

The Mediatab is available, however media objects cannot be searched.

Playlists can be opened and run.

Template Wizard can be opened, and templates can be created and saved.

Object Store can be opened and you can perform image or person searches. A person created with an
image can be saved. A person without an image can also be saved, but will not appear in a person
search in Director.
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® Thefollowing tabs are not available: Templates, Data, Viz, Files.
To set Director in NODB mode, add a-nodb flag at the end of the target path in the shortcut
properties (see Command Line Startup Options).

® Windows 64-bit: " %°r ogr ani | es(x86) % vi zrt\Viz Pil ot x.
y\ Vi zContent Pi | ot . exe" -nodb

® Windows 32-bit: " %°r ogranfi | es% vizrt\Viz Pilot x.y\VizContentPil ot.
exe" -nodb

4.9.3 Template Wizard

Use Template Wizard without a database connection. This can be useful when creating file-based
templates, for example, for on-the-road template work, and template user interface design for Viz Ticker
and Viz Trio

To set Template Wizard in NODB mode, set the following fieldsin the [ TEMPLATE_WIZARD] section
of ContentPilot.ini:

use_pi cturedb=n
use_dat abase=n

4.10 Registry Settings

The table below shows the default registry settings and some others that might be useful for Director and
Viz Pilot News. Before altering registry settingsit is recommended to check with alocal Vizrt
representative or support person. It is also recommended to test changes before applying themto a
production system.

Registry settings that are not covered are either legacy settings and no longer supported, or are not to be
changed. The table below covers those settings that can be changed during installation or manually using
the Registry Editor.

Start Windows' registry editor (regedit.exe) and open the following path to edit your parameters:

® Windows 32-bit: HKEY _LOCAL_MACHI NE\ SOFTWARE[ vi zrt]
® Windows 64-bit: HKEY_LOCAL_MACHI NE\ SOFTWARE\ Ww6432Node[ vi zrt]

4.10.1 Registry Settings

Key Name Description

ActiveX\ DataBroker DatabaseName Sets the database name for Viz Pilot
News. Supported values are TNS
name alias, connection string or a
full TNS connection string.

Password Sets the database username

UserName Sets the database username
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Key

Name

Description

ActiveX\ TemplateFiller

BCSDeviceName

Sets the name for the device that is
connected to the Avid INEWS
Control Air (formerly known as
iINEWS Broadcast Control System
(BCS)). Default device nameis cg.

BCSTemplateName

Sets the template name. Default is
pilotdata. This must be configured
in Avid INEWS. See aso
BCSDeviceName.

insertBCSTag

Set thisto 1 to insert the BCS values
in the INEWS production cue. If
using MOS, set thisto 0. See dso
BCSDeviceName.

mos|D

MOS IDs are created by Newsroom
Computer System administrators.

NODB

Disables (1) the database
connection. Default is enabled (0).
See Working without a Database
Connection.

PreviewDisabled

Enables (0) or disables (1) both
local and remote preview for Viz
Pilot News.Default is enabled (0).

PreviewHost

The preview host is set during
installation. This setting will
override the database settings, and
can be hostname or | P address.For
failover, PreviewHost can have
more than one host and port number
defined.<host> definesthe Viz
Engine hostname for remote
preview.lf <host> is set without a
trailing <port> then the
PreviewPort number must be set.
Parameter:<host><host>,<host>,
<host> ...<host>:<port>, <host>:
<port> ...

PreviewPort

By default set in the database. This
setting will override the database
settings. Default ports are 50008
(multiple connections) and 6100
(single connection).<port> defines
the Viz Engine port number for
remote preview.

76



Key Name Description
PreviewSizeX By default set by Viz Engine. This
setting overrides the aspect ratio set
by Viz Engine.
PreviewSizeY By default set by Viz Engine. This

setting overrides the aspect ratio set
by Viz Engine.

PreviewSocketTimeOut

Viz Pilot Newswill wait for a
socket connection to the local Viz
Engine before continuing. By
default the
“activex_preview_socket_timeout”
setting (see Database Parameters)
would be set in the database if
needed; however, the same setting
can aso be set in the registry to
override the database setting.
Recommended default valueis
10000 ms.

PreviewTimeOut

By default set in the database. This
setting overrides the database
parameter setting for
“activex_preview_socket_timeout”
(see Database Parameters). Default
valueis 10000 ms.

StartBlank

Enables (1) Viz Pilot News to start
without fetching the data elements
for each template; hence, this setting
can be used load and start Viz Pilot
News faster. Default is disabled (0).

use utf8

Enables (1) or disables (0) the use of
UTF8 when writing to the database.
ItisNOT recommended to disable
UTF8 if the database configured to
use UTF8. Default is enabled (1).

UseVCPDM

Enables (1) Viz Pilot Newsto be
used with the Viz Device Manager.
Default is disabled (0).See aso
BCSDeviceName.

Preview Engine

ShowConsole

Enables (1) the Viz Engine console
to always be visible when using
local preview. This setting will
override the user preference. Default
isdisabled (0).
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Key Name Description

Viz Pilot ORACLEHOST Oracle database hostname. Note that
INI file settings will override
registry settings.

ORACLESID Oracle database SID. Note that INI
file settings will override registry
settings.

TNS ADMIN Alternative to afull connection

string. If aTNS namefileis
configured, setting the path may be
used to set adifferent location than
Oracle sdefault location, and to
avoid conflicts with similar database
connections defined as alocal
environment variable.

4.11 Display Font

The template and data list font settings for Director is set in the initialization (INI) file ContentPilot.ini,
but in registry for Viz Pilot News.

® *font: *Setsthe font for Director. This parameter by default set to MS Sans Serif, but can be
changed.

* *| istDisplayFont: * Sets the font for Viz Pilot News. This string value is not set by default, and can
therefore be used to override the operating system defaults.

4.11.1 To set the display font for Director

1. Open the ContentPilot.ini file
2. Select the LANGUAGE section and set a new Unicode *font * parameter.
3. Savethefile, and restart Director for the changes to take effect.

4.11.2 To set the display font for Viz Pilot News

1. Open Registry
2. Search for the key:
® Windows 32-bit: HKEY _LOCAL_MACHI NE\ SOFTWARE\\ [ vi zrt]
\ActiveX\ Tenpl ateFill er
® Windows 64-bit: HKEY _LOCAL_MACHI NE\ SOFTWARE\ Wow6432Node\ [vi zrt]
\ActiveX\ Tenpl ateFill er
Add the string value ListDisplayFont with the desired font name as parameter.

4.12 Storage and Backup

This section gives general recommendations on storage and usage of control room and newsroom
configuration data.
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® VizPilot Data
® Media Sequencer Data

4.12.1 Viz Pilot Data

In addition to information stored on the Media Sequencer and in Viz Pilot’ s database, the Viz Pilot system’
sINI files and playlists are important to backup when needed. INI files are used for local configurations
for the application itself, third party integrations, and overrides of database settings. All of the Viz Pilot
system’s playlists, both local and newsroom playlists, can be exported and imported for backup and
transfer to other Viz Pilot system installations.

4.12.2 Media Sequencer Data

Thefile default.xml is a Media Sequencer file. The file holds a stored copy - of the memory held
information - over control application client settings, user data for graphics templates, references to scenes
on the database, stillsin the still store and video clips.

For a backup it is recommended to set up the system, then save a copy of the _default.xml _remotely to
more easily set up a new build of asimilar machine in the event of a system failure.

The default.xml file stores all persistent data, and at regular intervals the Media Sequencer creates a
backup file named default.xml.1, which again replaces the file default.xml.2. In afailure situation where
default.xml may get corrupted, default.xml.1 is used to create a new instance of default.xml. If default.xml.
lisalso corrupted it will try to use default.xml.2.

Microsoft Windows XP:

® C. \Docunents and Settings\All Users\Application Data\Vizrt\Mdia
Sequencer
Microsoft Windows Vistaand 7:

%°r ogr anDat a% Vi zrt\ Medi a Sequencer

4.13 Log Files

This section contains the following Topics:
® VizLogFiles
® Crash Log Files

® Viz Config Files
® Modifying the Log File Settings

4.13.1Viz Log Files

Viz Pilot System log files
The default location is;

® OPROGRAMDATA% Vi zrt\Logs\Viz Pilot x.y\pilot.log
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Note: If this path is empty, check the ContentPilot.ini, as the default path may be overridden by
the logdir setting in the Pilot section of theini file.

Y ou can also access the logs from the Main Menu > File > View Log.

The logging level can be set using an environment variable PILOT_LOG_LEVEL. This accepts the values
0-4 where a higher number means a more verbose log. Default level is 3.

Database log files
See Database Error Logs.

Other log files
Other useful log files include the Media Sequencer logs, and the Viz Engine logs.

4.13.2 Crash Log Files

Eurekalog files (.elf)
Eureka Log filesfor Viz Pilot News, Director and Template Wizard can be found here;

® oProgranmData% Vi zrt\Logs\Viz Pilot x.y

Crash Dumps

If using Windows 7 or later, it is possible to generate crash dumps automatically, by setting certain
registry keys, as described in Collecting User-Mode Dumps.

All of the Viz Pilot system’s client applications are 32-bit. When collecting a crash dump of a 32-bit
application on a 64-bit Windows, you need to use the 32-bit version of the Windows Task Manager,
otherwise the dumps will not be readable.

The Windows task manager will normally beinstalled in:

® 32-hit version; C:\Windows\SyswWOW64\taskmgr.exe
® 64-bit version; C:\Windows\System32\taskmgr.exe

4.13.3 Viz Config Files

Viz Pilot System config files

Most of the Viz Pilot system’s components use the Cont ent Pi | ot . i ni file. Object Store may useits
ownobj ectstore.ini file

The INI files are stored here:

® %rogramData% Vizrt\Viz Pilot x.y\Config
For more details see Initialization Files.
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Viz Engine config files

The Viz Engine files are stored here:

® Windows 64-bit: %°r ogr anti | es(x86) % Vi zrt\ Vi z3
® Windows 32-bit: 94°r ogr anti | es% Vi zrt\ Vi z3

Media Sequencer config files
Thedef aul t. xm filesare stored here:

® Windows Vistaand 7: %4°r ogr anDat a% Vi zrt\ Medi a Sequencer Engi ne
® Windows XP: C:\ Docunents and Settings\All Users\Application
Dat a\ Vi zrt\ Medi a Sequencer Engi ne
For more detail s see Media Sequencer Data.

4.13.4 Modifying the Log File Settings

The default location can be overridden using the LOGDIR and LOGFILE settingsin the ContentPilot.ini
file

The maximum size and number of rolling log files can also be configured in theini file (LOGSIZE,
LOGCOUNT).

Thelog level can be changed by using the following command line parameters:

® nover bose setslog level to low.
® extra_verbose setsloglevel to high

4.14 Port Numbers

A summary of the required ports and connectionsiis listed below. For detailed information, contact
Customer Support.

Thetable below lists all default server and listening port numbers that are used.

4.14.1 Listening port numbers

Listener Port(s) Descriptions and Comments

Oracle database 1521 For clients that connect to aViz
Pilot database running on Oracle.

Graphic Hub REST 19398 Graphic Hub REST default port. For

clients that connect to aViz Pilot
database running on a Graphic Hub.

Script Runner 1981
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Listener

Port(s)

Descriptions and Comments

Used to communicate with the
Update Service.

Viz Pilot News

6220

Used by the Graphics Plugin for
NLE to establish a connection to
Viz Pilot News.

Viz Pilot

6484

Socket connection used for
controlling Director using macro
commands.

Viz Preview License server

7452

For Viz Pilot News using an
unlicensed Viz Engine for local
preview with a connection to the
Viz Preview License server (is not
the same as the Preview Server).

Pilot Data Server

8177

Used when connecting over HTTP
using the REST interface.

Preview Server

54000

(21098)

Used when connecting over HTTP
using the REST interface.Redirects
to port 21098 when using a browser.

Viz Engine

6100

6700

6800

14300

Ports are used by Media Sequencers
that connect to a Viz Engine
program and/or preview channel.Viz
Engine' s default program and
preview port is 6100.In asingle
channel setup where both program
and preview output is on the same
machine, the default preview port is
set to 6800 to separate the program
and preview channels. In adual
channel setup, the default program
ports are 6100 and 6800 for channel
1 and channel 2, respectively.lna
dual channel setup, when used for
stereo production, the default
program ports are 6700 and 6800 for
channel 1 (left eye) and channel 2
(right eye), respectively.Alternative
port used to avoid conflicts with
port 6100 (e.g. when using Viz
Multiplexer). Port 6100 is normally
used by renderers that are on air,
hence, it is recommended to use
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Listener

Port(s)

Descriptions and Comments

another port.Port 14300 is an
optional port. The default 6100 may
also be used if the renderer is not
used on air.
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5 Director Configuration

This section describes how to configure Director:

® Command Line Startup Options

® Profile Configuration

® Media Sequencer Configuration

® Enable Fullscreen Stillstore Images

5.1 Command Line Startup Options

5.1.1 Startup Options

The Media Sequencer is used to create, store and play out data elements. A Media Sequencer can be
installed on a separate machine, but it is recommend to run it on the same machine as Director.

For failover or backup you can specify which Media Sequencer the Director should usg, it is
recommended that a unique desktop shortcut is created for each Media Sequencer that can be used.

SIS

Connect to Connect to Connect to
M5 1 Ms2 M5 3

Target: t Pilot Bx\VizContent Pilot .exe” -mse <hostname:

Edit the properties of each shortcut, and add the following:
® -mse <hostnane>

In ascenario where it is needed to switch from one Media Sequencer to another, it is useful to have the
same profile setups on each Media Sequencer so that fail situations are easier to handle.

5.1.2 Command Line Options

The following command line options are supported by some or all of the Viz Pilot system’s applications.
Command line options are added to the program’ s target path.

¢ All: Director, Object Store, and Template Wizard
® Dir: Director
® TW: Template Wizard

Command Default Apps. Description
-db <dbName> -u <dbUser> -p VIZRTDB All
<dbPassword>




Command Default

Apps.

Description

Specifies the Oracle
database to connect to.
dbName can be either a
TNS dlias or connect
string. Usesthe TNS
aliasVIZRTDB if
nothing elseis
specified. Note: Do not
use both -db and -gh at
the same time.

-gh <URI> -u <dbUser> -p
<dbPassword>

All

Specifies the Graphic
Hub database to
connect to. Note: Do
not use both -db and -
gh at the same time.

disable_auto_open_recent_playlists

Dir

Disables automatic
loading of the last
opened playlists on
startup

-inifile <filename> |localhost

Dir TW

Director and Template
Wizard support both
full path references and
single file names. The
latter assumes that the
ini fileislocated in the
%ProgramFiles% folder
or %
PROGRAMDATA%
\Vizrt\Viz Pilot x.
y\Config|

-nodb

Dir

Run Director in NODB
mode (see Working
without a Database
Connection)

-mse <hosthame> localhost

Dir

Setsthe Media
Sequencer to be used. If
no parameter is defined
it will try to usealocal
Media Sequencer.

-showcommands <none>

Dir

Displays the Director
Commands window.
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5.2 Profile Configuration

3

Profile Configuration

Profiles

Device Channels

Viz Engines

Profile1

Profile2

Viz Video ‘
Name Program Preview |Program Preview Allocated

‘

[
* O VizEng1:6100

|
4

* O VizEng2:6100

B VizEng1:6100

0 VizEng1:6100

O VizEng2:6100

| Add Viz.

Video Devices

|New F‘rcrfle| | New Channel

Add Video...

An important part of the profile configuration isto create profiles for different purposes. For example;
Profile Setups can be created where different channels have the program and preview function. This
makes it fast and easy to switch between different output settings.

This section contains the following topics

Categories and Channels
Profile Setups

Forked Execution
Configuring Profiles
Configuring Channels
Configuring Devices

5.2.1 Categories and Channels

To set the default channel for atemplate
A default channel can be set for atemplate.

1. In Template Wizard, add Categories and Channels.

2. Map the new category to the desired channel.

3. In Template Manager, edit atemplate variant and select the required Category from the drop-
down list. See Working with Variants.
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4. In Director, create adata element from the template and drag it to the playlist.
® The default channel of the item isthe channel selected in step 2.
“Tip: The default channel can also be passed on to anewsroom system if required. See
To get the data element’ s default channel

Note: When setting categories and channels to filter playlists, the channel configuration
configured in Template Manager must correspond with the actual channel name.

Note: Any Legacy template that does not use Control Object is unable to assign itself to
the correct program channel; hence, it will always default to the default program channel
in the profile configuration, and disregard information in the Categories and Channels

setup
5.2.2 Profile Setups
Profile Program Preview
Main A B
Backup B

A typical example for when it makes sense to use different profiles would be a backup configuration
where a switch from amain to a backup renderer is needed. For example if two output renderers are
named A and B, where A is program and B is preview, a profile named “Main” will then have channel A
as program and channel B as preview.

A profile named “Backup” could, if the renderer acting as program (A) in the “Main” profilefails, have
channel B as program.

Note that a channel can be designated as a Program or Preview channel by selecting the check box in the
appropriate columns (Program or Preview); however, the program and preview channels are reciprocally
exclusive - only one channel can be set to program, and only one channel can be set to preview. If for
example A is set to program and B is set to preview, and then C is set to program, A will no longer be set
as program.

GPI
Another example of typical use of profilesiswhen playout is controlled through a General Purpose Input

(GP1), for instance through hardware such as a vision mixer.

When GPI is enabled, the external cursor (the GPI system’s cursor) will be shown in any client that is
using the same profile as the external system. A typical setup would be that one Viz Trio clientisin the
same profile as the GPI system, and functions as a“prepare station” for the producer sitting at the vision
mixer desk. Data elements are then made ready and displayed on a preview visible to the producer, and
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then the elements are triggered from the vision mixer. This configuration needs a separate “GPI” profile
that is not used by other control application clients. Other clients can be in other profiles and produce
content to the same output channels. However, they need to be on other transition layers or on another Viz
layer so that they will not interfere with the graphics controlled by the external system.

VDCP

If you are browsing the Cliplist for clips on other video devices (that support the Multiport Video Control
Protocol (MVCP)) you may add these clips for manual playout in any playlist regardless of the profile
configuration{..

5.2.3 Forked Execution

This section describes how forked execution can be used with Standal one scenes and Transition logic
scenes. Forked Execution also replaces the execution of Visible containers.

Standal one scenes

Forked execution supports standal one scenes by executing the same graphics with different concepts on
two or more render engines. Concepts are defined per channel when working with the Viz Pilot
Configuration Tool.

As an option you can also use this setup to handle fail situations by having the same graphics concept
rendered on both engines.

Transition logic scenes

As with Standal one scenes, forked execution supports setting concepts for Transition Logic scenes. In
addition Transition Logic scenes, by defining channels with different render engine setups, can show
different states of the same scene on a per engine basis. All states are synchronized for al engines (at all
times) in order to achieve an artifact-free and smooth morphing of the graphics from one state to the other.

If for example you have three render engines you can set up arange of channels with different
combinations of render engines per channel.

Channel and Engine Combinations

Channel Viz Engines
A 12,3

B 13

C 1

D 2,3

E 2

If for example you have a scene with four layers each layer can be controlled separately from the other
layers (see table below). By setting a state per layer you can achieve a varied output depending on the
channel used and how that channel is configured in terms of render engines (see table above).

® |ayer 1: Shows and hides a geometry (e.g. a cube)
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® |ayer 2: Shows and hides a geometry (e.g. a cube)
® | ayer 3: Positions the geometries.
® Layer 4. Animatesthe layer 1 geometry by showing the next image or alogo.

Statesfor layer 1 Statesfor layer 2 Statesfor layer 3 Statesfor layer 4

Show cube Show text Position left Next image

Hide cube Hide text Position right Show logo

<ignore> <ignore> Position center <ignore>
<ignore>

With the aforementioned scene layers and configured channels you can have the following output on each

of the three engines.

Channel

Layer state Output on Viz Engine 1, 2and 3

Channel C(Viz 1)

Show cubePos |eftShow textShow
logo

Channel D(Viz 2,3)

Show cubePos rightShow TextShow
Logo

Channel E(Viz 2)

Pos centerHide text

Channel A(Viz 1,2,3)

Next image

Channel A(Viz 1,2,3)

Next image

Channel A(Viz 1,2,3)

Show textNext image

Channel A(Viz 1,2,3)

Show logo
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Channé Layer state Output on Viz Engine 1, 2and 3

Channel B(Viz 1,3) Hide cube
|,.'|'Il
Visible containers

Director still supports (although it is depr ecated), a behavior similar to that of forked execution. By
designing a standal one scene where each root container is a variant of the other, you can configure each
render engine To render specific scene containers (by name). In effect a scene with two or more root
containers can have one or several containers assigned and rendered visible by one render engine.

Channel E(Viz 2) Hide cube

Due to potential performance issues when using large textures (e.g. HD) this option is no longer
recommended. Concept and variant design of standalone and transition logic scenes is therefore the

recommended design convention.

5.2.4 Configuring Profiles
To open the profile configuration

1. Select Tools from the main menu, and then Profile Configuration (CTRL+M), or
2. Right-click the profile on the status bar (lower-left) and select Profile Configuration... from the

context menu.

To add anew profile

e

Profiles Device Channels
Profilel Name
Profile2
Mew Profile
Mew Profile Mew Channel

® |n the Profile Configuration window click the New Pr ofile button, enter a new unique profile name,
then press Enter.
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To rename a profile

1. Right-click the profile and select Edit Profile Name, or double-click it and enter the new name.
2. When finished editing the name, press Enter or click the cursor outside the Profileslist.

To delete aprofile

® Right-click the profile and select Delete Profile, or select it and press the Delete button.

Note: The Media Sequencer requires a profile to be present in the system. If al profiles are
deleted, an empty vizroom1l profile is automatically added.

Set password for a profile

Password protected profiles display alock icon next to them in the profileslist. A password is required to
be able to select these profiles.

To create or change a password for a profile:

1. Right-click the profile and select Set Password For Profile
2. Typethe password in the Change Password dialog

Sorting the Profileslist

1. Right-click the profileslist or aprofile name and select Sort/Sort List
2. Choose one of the following sorting options:

. ® Unsorted: Thelist retainsits original order
® Ascending: The profiles are sorted alphabetically in an ascending order
® Descending: The profiles are sorted a phabetically in a descending order

The chosen profile sorting option is remembered upon restart.

5.2.5 Configuring Channels

This section contains the following topics:

® To add an output channel to the Channels list

® To add a concept override for a channel’ s output device
® To rename an output channel in the Channels list

® Toremove an output channel from the Channels list

® Toremove an output from the Channels list
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To add an output channel to the Channelslist

| Mew Channel |

® Click the New Channel button, or drag and drop a Viz Engine or video device to the Channels list.

To add a concept override for a channel’ s output device

v N | | |

¥ O VizEng1:6100
Concept: | MEWS |

¥ O VizEng2:6100
Cancept: [NEWS_SPORT |

1. Expand the channel’s output device and append the concept name.
® Thiswill override any concepts set elsewhere

2. Click OK
To rename an output channel in the Channels list

® Right-click the channel and select Edit Channel Name from the context menu, or double-click the
name.

To remove an output channel from the Channels list

Edit Channel Mame

¥ O VizEng1:61

* O VizEng2:610

® Right-click the channel entry and select Delete channel from the context menu, or select the channel
and press the Del ete button.

To remove an output from the Channels list

® Right-click the Viz Engine or video device and select Delete Output, or simply select it and press
Delete.
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Allocated

Device Channels

Mame ‘ R HEEE Allocated ‘

Program Preview | Program Preview
v [ ] v [ ] v

* O VizEng1:6100

B VizEng1:6100

® Checking the Allocated check-box allocates video devices for the clipsin the playlist. For two
channels with a video device each, the Media Sequencer will enable transfer of al clipsto all video
devices. Theclipsin the playlist are, based on the allocation, played out in agiven order (e.g. A, B,
A, B) to allow back to back playout. For video devices that are able to playout back to back this
allocation is not necessary.

5.2.6 Configuring Devices

This section contains the following topics:

® ToaddaViz Engine

® Toadd avideo device

® Toedit aViz Engine or video device

® TodeleteaViz Engineor video device
® To enable scene transitions

® Toenabledtill preview

® To render specific scene containers

® To set adifferent font encoding

Toadd aViz Engine

Configure Viz Engine

=i [VizEng]| |
Port

Mode [ Standard N
SRR (No storage) N

* Deprecated Settings

Ok | Cancel |

1. Click the Add Viz... button in the .Profile Configuration v8.1 window to open the Configure Viz
Engine dialog box.
2. Enter the hostname and port (default port is 6100).
3. Optional: Select Mode
® Scene Transitions: See how To enable scene transitions
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® Still Preview: See how To enable scene transitions
4. Optional: Select aViz One storage (Asset Storage)
5. Optional: In Deprecated Settings, select Visible containers and/or Font Encoding
6. Click OK.

® A statusindicator will show if the renderer is on-air.

Note: The Asset Storage drop-down lists the available Viz Engine storage points where
the Viz One files can be sent for playout.

To add avideo device

Configure Video Device X

Type Wiz Engine ¥
Host or IP VizEng2

= 6100

Asset Storage

a*

(Mo storage)

Fullscreen .
4

Clip Channel 'IE

se Transitions

I
4

Alternate Clip Channe

Fullscreen Scene

1. Click the Add Video... button in the .Profile Configuration v8.1 window to open the Configure
Video Device dialog box.
2. Select the video server Type
®* VizEngine
® MVCP Compatible: Multiport Video Control Protocol, see Cliplist
® Dummy Server: A dummy server can be part of achannel used for timing GFX in Timeline
Editor. Used when it is necessary to adjust timing based on lowres clips.
3. Enter the Host or | P address and the port
® Default port for MVCP is 5250
® Default port for Viz Engineis 6100
4. Select Asset Storage. Select a publishing point from the list, so that clips or data elements are
transferred to the right location (the specified Viz Engine) for playout
5. Enable/Disable Fullscreen mode
® When Fullscreen is enabled, which is the default behavior, stand-alone video clip elements
are played out full screen in the back layer. Graphicsin the middle or front layer will still
play.
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® When Fullscreen is disabled stand-alone video clip elements will only replace the current
video clip without triggering animations or transition effects.
6. Select Clip Channel (only relevant for Viz Engine)
"Note: Viz Engine 3.6 and later supports up to 16 clip channels which can be used for playout.
A clip channel might be unavailable for various reasons, for example, it is configured to be
inactivein Viz Config, or the license only covers alimited number of clip channels.

Select whether or not to Use Transitions

Select Alternate Clip Channél

Optional: Enter the Fullscreen Scene

10. Click OK.

® A statusindicator will show if the video deviceison-air or online.

© o N

To edit aViz Engine or video device
® Right-click the device and select Edit from the context menu, or simply double-click it.
To delete aViz Engine or video device

® Right-click the device and select Delete from the context menu, or simply select it and press the
Delete button.

To add an output to the Channels list

¢ Simply drag and drop aViz Engine or video device onto the channel in the Channelslist, or select
it and select Add to profile (creating anew channel) or Add to selected channel.

To enable scene transitions

Transition Effect scenes are madein Viz Artist and can be applied to data elements to create custom
transition effects from one scene to the other. If an effect is specified, the effect will be shown when the
sceneistaken on-air. Effects are typically wipes, dissolves, aphafadesand so on.

Configure Viz Engine X

Hostname VizEng]
et 6100
MWode

“*

Scene Transitions

Asset Storage

a*

(Mo storage)

* Deprecated Settings

Ok Cancel

1. Configure the Viz Engine settings as seen in how To add a Viz Engine
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2. Set the Modeto Scene Transitionsto allow the renderer to copy (or snapshot) the scenes to
create atransition effect between them.

3. Click OK

4. Add the program renderer to the program channel

To enable still preview

See Configuring Remote Preview in Director.

To render specific scene containers

Configure Viz Engine #* | Configure Viz Engine
Hostname |‘-.-"izEng'| | Hostname |‘-.-"izEng£ |
Port Port
e [standard o ILaEE [standard N
I |[N::| storage) ¥ | R T |[N::| storage) ¥ |
* Deprecated Settings * Deprecated Settings
Visible Containers Visible Containers
TCP LOWER
Add | | Delete | Add | | Delete |
Font Encoding | UTF-8 ~ | Font Encoding |UTF-3 o |
Ok | Cancel | Ok | Cancel |

Before configuring your Viz Enginesto render specific scene containersit is recommended to read the
Forked Execution section for further explanation.

Configure the Viz Engine settings as seen in how To add a Viz Engine

Click the Deprecated settings button to expand the editor

Click the Add button to enter the scene’ s container name that should be rendered visible
Optional: Repeat step 3 to Add other containers

Click Ok

ak~owbdpE

To set adifferent font encoding

1. Configurethe Viz Engine settings as seen in how To add a Viz Engine
2. Click the Deprecated settings button to expand the editor
3. Select the Font encoding

96



® Font encoding: Sets the font encoding of the Viz Engine. The encoding can either be set to
UTF-8 or ISO-8859-1. Default is UTF-8.
4. Click Ok.

5.3 Media Sequencer Configuration

The Media Sequencer Configuration window is used to configure the Media Sequencer enabling Director
to connect to other devices. This can for example be a newsroom integration with connectionsto Viz
Gateway, a connection to the Viz Pilot database, a GPI configuration of a GPI card on the Media
Sequencer and so on.

Open it from the main menu > Tools > Media Sequencer Configuration.

This section contains the following topics:

® Database Tab

® VizOneTab

®* MOSTab

® Genera Purpose Input (GPI Tab)

® Video Disk Control Protocol (VDCP Tab)

5.3.1 Database Tab

Main menu > Tools > Media Sequencer Configuration > Database.
The Database tab sets the database connection for the Media Sequencer.

If the information was added during the Viz Pilot System Installation the information is made available in
this window; however, it must be manually applied.

The properties available depend on whether you are using Media Sequencer 4.0 and later or Media
Sequencer 3.x and earlier.
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Media Sequencer 4.0 and later

% Media Sequencer Configuration - B

Database Viz One MOs GPIL VDCP

If using Media Sequencer 4.0 or later, the Database tab allows you to configure whether the Media
Sequencer will fetch data elements directly from an Oracle database or via a Pilot Data Server.

Note that:

® |f Director is connected to a Graphic Hub, the Media Sequencer must connect to a Pilot Data Server
that is connected to the same Graphic Hub as Director.

® |f Director is connected to an Oracle database, the Media Sequencer must connect to the same
schema on the Oracle database, or connect to a Pilot Data Server that is connected to the same
schema.

Properties and Parameters

® Pilot Data Server: Connect to the database through a Pilot Data Server. Enter the host name and
port of the Pilot Data Server
® Oracle: Connect to an Oracle database directly.
® Connection String: The connection string for Oracle, e.g. pi | ot / pi | ot @host nane>
/ <Sl D>.
® Schema: The name of the Oracle schema, e.g. PI LOT.
®* |Immediately remove deleted elements. Elementsthat are deleted from the database will be
removed from the Media Sequencer.
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Media Sequencer 3.x and earlier

% | Media Sequencer Configuration = =

J Database | Viz One MOS GPI VDCP

Connection String:

PILOT/PILOT@vizpilot/vizrtdb |

Schema

[PILOT |

Apply Reszet

Database encoding:
AMERICAN_AMERICA.AL3I2UTFE

Application client encoding (change in INI file):
UTF-8

If using Media Sequencer 3.x or earlier, the Database tab sets the database connection for the Media
Sequencer and contains the following Properties:

® Connection string: Use aregular connection string or a TNS name alias.
® Example 1: pilot/pilot@<hostname>/<SID>
® Example 2: pilot/pilot@<tnsname alias>
¢ Schema: PILOT
¢ Database encoding: The current database and application client encoding settings. The application
encoding settings can be changed in the ContentPilot.ini file if the database has another Unicode
encoding than UTF8; however, it is recommended to use Unicode encoding UTF8 on both ends.

To apply the Viz Pilot Database settings

1. Select the Media Sequencer Configuration option from the Tools menu.
2. Select the Database tab, and enter the database settings.
3. Click Apply.

5.3.2VizOneTab

Main menu > Tools > Media Sequencer Configuration > Viz One.
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% | Media Sequencer Configuration =

Database Viz One | MOS GPI VDICP

[[] Enable the viz One handler

Service document URI: |h1:tl::|:,-’,-"u’iZl::lr‘|E,.-’tf'lirli:h::tar‘t'g.-',-f

Aszet search providers can be configured here:
hitp: //bgogapds: 81 77 Asettingz#S earch

The Viz One tab sets the Viz One connection for the Media Sequencer. The Viz One connection enables
the Media Sequencer to request transfer of mediato Viz Engine for playout.

Note: Director and Viz Pilot News get their Viz One connection parameters from the Viz Pilot
database.

Properties and Parameters

®* EnabletheViz Onehandler: Enables Media Sequencer to handle Viz One transfer requests.
® Service document URI: Sets the service document URI which describes the services the search will
provide.

To apply the Viz One settings

Select the M edia Sequencer Configuration option from the Tools menu

Select the Viz Onetab

Click the asset search provider link

From the web page (under Search Providers) copy the relevant asset search provider URL and
pasteit into the Service document URI field in the Viz One tab.

5. Click Apply.

AW PE

Working with Viz One

The Viz Pilot system (5.6 and later) is able to connect to media providers and repositories, such as Viz
One, that support the Pilot Data Server REST API.

In order to successfully connect to Viz One do the following:

1. Install and configure your media provider (e.g. Viz One)
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2. Ingtall and configure your Pilot Data Server by configuring Viz One as a search provider (see To
configure search providers (Viz One))

3. Configure Director’s Viz One Tab connection (see Media Sequencer Configuration) in order for
Media Sequencer to request transfer of video files from Viz One to your configured Viz Engine
for playout

4. Configure your Viz Engine to enable transfer of video files over FTP from Viz Oneto Viz Engine
for playout

5. Configure your Director’s output channelsin order to playout video clips from the Viz Engine
storage points where Viz Onefiles are sent for playout (see Profile Configuration).

In case you are using Viz Engine to preview video clips from Viz One locally you a so need to
install Video Codecs Installation (e.g. MPEG-4 codec and Haali Media Splitter).

53.3MOS Tab

Main menu > Tools > Media Sequencer Configuration > MOS,

% | Media Sequencer Configuration - =

Database Wiz One | MOs GPI VDICP

[] Enable Gateway Cenfiguration:

—Viz Gateway Connection

Start Stop Restart

—Viz Gateway Connection Config

0] El: Messages per second limit (0=disabled)

Viz Gateway Host iz Gateway Port

| | [10840 |
MOS ID NCS ID

[PILOT | |coLumBus |

[] send status changes back to NCS

]

Apply | Reszet |

Close

The MOS tab enables the Media Sequencer to connect to Viz Gateway. If configured to use Viz Gateway
1.0, the newsroom system and Viz Gateway must be pre-configured with an NCS ID and MOS ID. For
connections to Viz Gateway versions 2.0 and later, only the Viz Gateway host and port number is needed.

e

Note: MOS IDs are configured on the NCS server, and are usually case sensitive.
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Properties and Parameters

® Enable Gateway Configuration: When selected, enables the user to configure the Viz Gateway
connection.
® Viz Gateway Connection: The controlsin the Viz Gateway Connection section allows a start, stop,
and restart action to be performed on a Viz Gateway connection.
® Start: Starts a connection to Viz Gateway.
® Stop: Closes aconnection to Viz Gateway.
® Restart: Restarts a connection to Viz Gateway.
® Viz Gateway Connection Config: Define Viz Gateway connection settings
® Messages per second limit (O=disabled): Sets how many messages per second should be sent
from Viz Gateway to the NCS. Thisis done to prevent flooding of the NCS. 0 disables the
message throttling allowing unlimited messages per second
® Viz Gateway Host: IP address of the Viz Gateway host.
® Viz Gateway Port: Connection port for the Viz Gateway.
® MOSID: ID of the connecting MOS device.
® NCSID: ID of the Newsroom Control System (NCS).
® Send status changes back to NCS: Sends new status changes to the NCS.
® Send channel assignment changes back to NCS: Sends changes to the NCS.

IMPORTANT! A database connection must be established in order for the MOS integration to
work. See how To apply the Viz Pilot Database settings for details.

To configure a Viz Gateway connection

1. Start Director.

Select Profile Configuration from the Tools menu (see Profile Configuration).

3. Click the MOS tab, and enter the appropriate settings collected from the newsroom system and the
Viz Gateway host.

4. Click OK and check that the status indicator (G) appears in the lower right of Director’s status
bar.

5. Click the Playlists button in the Resource Panel, and check that MOS Playlists are added to the list
of available playlists.

N

5.3.4 General Purpose Input (GPI Tab)

Main menu > Tools > Media Sequencer Configuration > GPI.
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G Media Sequencer Configuration - b

Database Viz One MOS GPI WDCP

[[] sShow advanced

—GPI Settings
Box type: |SRC-8 ﬂ| Catabits: |8 ﬂ|
Port: | j| Parity: | None j|
Base entry: |,.-’S'5-’S,-’gpi | Flowcontrol: |N0r|e ﬂ|
Baudrate: |11[] j| Verbose []
Reversed input order [ ]
Stopbits: | 1 j|
GPI action Server/Client Server Command Macro Com... Profile  Description -
DHO Server take_and_adwvance default take and goto next
DH1 Server next default goto next element
DH2 Server previous default goto previous element |2
DH3 Server take_current default take current element
DH4 Server
DHS Server
DHE Server
OH7 Server
DLO Server
DLl Server i
Apply Reset

Close

The GPI tab allows the Media Sequencer to be configured to handle GPI commands. The commands can
be handled by the Media Sequencer itself (Server Command) or forwarded to Director (Macro Command).

Both server and client side commands are profile specific, meaning that the profile determines which
Director client and potentially which Viz Engine(s) that should execute a client and/or server command. It
istherefore very important to assign the correct profile for each GPI action as they refer to unique profiles
configured per Director client.

For example; A Director hasits own profile with two Viz Engines (program and preview) and receives a
client command from a GPI on the Media Sequencer. The command executes some logic on Director that
issues commands to the program renderer. If the correct profile is not set, such commands might end up
on the wrong Director and potentially on the wrong program renderer. The same would happen if the GPI
action was defined as a server command; however, it would then trigger commands from the Media
Sequencer to the Viz directly and not through Director.
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This section contains the following topics:

Properties and Parameters
To assign a Server Command
To assign a Client Command
To add a macro command

Properties and Parameters

Show advanced: Displays all the settingsin the GPI tab.
Box Type: Select the type of GPI box that is being configured. The Box Type can be set to SRC-8,
SRC-8 11l or Seal evel.
Port: Setsthe port that the GPI box is connected to. The Port can be set to COM1-COM 17, or None.
Base Entry: Thisisthe node in the Media Sequencer’ s data structure where the systems look for the
GPI actions. The base entry is by default set to /sys/gpi.
Baudrate: Sets the maximum rate of bits per second (bps) that you want data to be transmitted
through this port. The Baudrate can be set to 110-921600. It is recommended to use the highest rate
that is supported by the computer or device that is being used.
Stopbits: Setstheinterval (bps) for when characters should be transmitted. Stopbits can be set to 1,
1.5, or 2.
Databits: Sets the number of databits that should be used for each transmitted and received
character. The communicating computer or device must have the same setting. The number of
databits can be set to 5, 6, 7 or 8.
Parity: Changes the type of error checking that is used for the selected port. The communicating
computer or device must have the same setting. The parity can be set to:
® Even: A parity bit may be added to make the number of 1'sin the data bits even. Thiswill
enable error checking.
® Odd: A parity bit may be added to make the number of 1'sin the data bits odd. Thiswill enable
error checking.
® None: No parity bit will be added to the data bits sent from this port. This will disable error
checking.
® Mark: A parity bit set to O will be added.
® Space: A parity bit set to 1 will be added.
Flowcontrol: Changes how the flow of datais controlled. The Flowcontrol can be set to:
® None: No control of dataflow.
¢ XonXoff: Standard method of controlling the flow of data between two modems. XonX off
flowcontrol is sometimes referred to as software handshaking
® Hardware: Standard method of controlling the flow of data between a computer and a serial
device. Hardware flowcontrol is sometimes referred to as hardware handshaking.
Verbose: If enabled, Media Sequencer’s GPI handler outputs log information. Thisinformation is
useful for debugging.
Reversed Input Order: Note that this check box isonly availableif Box Typeis set to SRC-8. If
enabled, the signal line that originally triggered GPI action DLO/DHO will now trigger GPI action
DL7/DH7, the signal line that originally triggered GPI action DL1/DH1 will now trigger GPI action
DL6/DH6, and so on.
Commands and actions list:
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GFPL... Server/Cli... Server Command Macro... Profile  Description -

DHO Server take_and_adwvance default take and goto next
DH1  Server next default goto next element
DHZ  Server previous default goto previous element |E

take_current faull:u take current element

OH4  Server -
default

DHS Server Erofile?
DHE  Server *

DHY Server
Lo Server
(]I Server

Apply Fe=set

® GPI action: Shows alist of the available GPI actions.
® Server/Client: Shows adrop-down list box in every row. This determines whether the selected GPI
action will apply to the Media Sequencer (Server option) or the local Director (Client option).

® Server Command: Shows adrop-down list box in every row, where the action to be performed on
this GPI line can be selected. Server commands are GPI actions that apply to the Media Sequencer.
When right-clicking an item in the playlist, the Playlist menu opens. In this menu, select Cursors,
and then Set Next. An arrow appears next to the selected element in the playlist, which indicates that
thisisthe current GPI cursor. The server commands can be set to:
® take and_advance: Runsthe Start operation on the current element, and then shifts to the next
element in the playlist.
® take current: Runsthe Start operation on the current element (the element with the cursor).
® next: Shiftsto the next element in the playlist.
® previous: Shiftsto the previous element in the playlist.
® continue: Runs the Continue operation on the current element.
® out_current: Runsthe Take Out operation on the current element.
® Macro Command: Macro commands are silent GPI actions. Clicking the ellipsis(...) button opens
the Add Command window.
®* Profile: Setsthe profile to be used for the GPI action. This profile must match the profile set for the
playlist that isto be triggered by the GPI actions. The drop-down list shows the profiles configured
on Media Sequencer.
® Description: Shows the description of the GPI action, as it was specified in the Add Command
window.

To assign a Server Command

1. Select aGPI action, and select Server in the Server/Client column.
2. Select aServer Command.
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3. Select aProfile.
4. Click Apply.

To assign a Client Command

1. Select aGPI action, and select Client in the Server/Client column.
2. Select or create aMacro Command.

3. Select aProfile.

4. Click Apply.

To add a macro command

TR e

DH3

Command || |J

Description | |

Ok | Cancel

1. Select the Macro Command column, and click the small ellipse (...) button to open the Add
Command dialog box.

2. Enter the command in the Command text field, or alternatively click the ellipse (...) button to
open the Predefined Functions window.

5.3.5 Video Disk Control Protocol (VDCP Tab)

Main menu > Tools > Media Sequencer Configuration > VDCP.
Using Video Disk Control Protocol (VDCP), the Media Sequencer acts like a server that controls the
graphics through the VDCP protocol. The Media Sequencer sets up a connection with a video controller,

over which VDCP commands are sent, and in this way the video controller is able to communicate with
the playlist or show.

== Viz Engine /

Media Sequencer 7 Viz Pilot
video VDCP handl Playlist/sh
s andler & - avlist/show
Controller |,,,,..ud Y y
vDCP -t
protacal

Note: The VDCP protocol defines recommended serial settings, but if you need to use different
settings please refer to the Media Sequencer manual’s VDCP section, and in particular the section on
Electrical and Mechanical Specifications, for information on how to configure this.
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This section contains the following topics:

* VDCPTab
® VDCP Properties and Parameters
®* VDCP Macros

VDCP Tab

The VDCP tab aways shows an up-to-date status, where changes made by others are shown live. All
changes are immediately propagated to the Media Sequencer.

To open the VDCP Tab either:

® (o to the main menu: Tools > Media Sequencer Configuration > VDCP tab
® Select Configure VDCP from the playlist’s context menu in Director ***
® Once VDCP handlers have been defined, click the VDCP Indicator button at the bottom of each

playlist ***
. ® Not availableif using the deprecated Legacy Playlist style.
% Media Sequencer Configuration - b
Database Viz One MOS GPI VDCP I_
VDCP handler: vdcp_client change add delets
The VDCP handler is currently DISABLED . It needs to be started for any Enable handler
configuration changes to take effect.
SETTINGS
Port: Profile:
| comi | | |default | ~]

Elernent identifier:

| name | - |

[ Use & byte IDs
TARGETS

Primary:

B Playiista x) 2 B

Fallback:

TARGET CANDIDATES
B Playliste }()
S
B PlayiistC x)
e
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VDCP Properties and Parameters
The configuration consists of the general VDCP settings, and the selection of which playlist to control.

® VDCP handler: Thisdisplaysthe currently selected VDCP handler. Y ou can change, add or delete
multiple VDCP handlers.

® Enable/Disable handler: The handlers can only be modified when they are disabled.

® Port: Select the appropriate COM port for the selected VDCP handler.

® Profile: Select the profile to use. The profile defines the Viz Engines and video devices where the
command isto be executed. In the VDCP handler, the configured playlist must be active on the
configured profile. (See aso Profile Configuration).

® Element identifier: Use either the element’s name or description asthe VDCP ID. The Nameisa
unique identifier, assigned to each element by the Media Sequencer, whereas the Description is the
textual description of the data element, as entered when the item was created in Director/Viz Trio.

® Use8bytelDs: Allow the use of 8 character IDs. For more information about 8 byte IDs and the
Media Sequencer VDCP plugin see the “8 characters identifiers” section in the Media Sequencer
User’'s Guide.

® Targets: Select the Director playlists or Viz Trio shows which will be the Primary and Fallback
targets.
When the vdcp_client handler receives a command over the VDCP protocoal, it iterates over the
primary target collection, looking for the element with the specified ID. If amatching itemis
found, the command is executed on it. If no match is found in the primary target collection, or if
thereis no primary target collection specified, then it searches the fallback target collection. If there
are still no matches, then an error is returned over the VDCP protocol, and it is also reported in the
Media Sequencer logs.
Click the buttons next to the primary and fallback target slots to select a playlist or show. Double
click adlot to clear it.
A ‘Path not found’” warning, or a missing playlist/show icon, indicates that the selected playlist or
show isinvalid (eg. playlist has been deleted)

® Target Candidates. Suggests some of the playlists and shows that are available. If you do not find
the one you want, use the buttons next to the Primary and Fallback target dots.
Drag a candidate to atarget dot or double click one to make it the Primary target.

VDCP Macros

The following macros provide easy access for turning the VDCP control on and off for an open playlist.
They only work with the VDCP handler called vdcp_client. Note that using the VDCP macros will restart
the VDCP handler.

vdcp:clear _all _targets, vdcp:clear _prinmary target, vdcp:
clear_fallback target, vdcp:set_playlist_as_primry_target, vdcp:
set _playlist_as fallback target, vdcp:set _primary target, vdcp:
set _fall back_target

5.4 Enable Fullscreen Stillstore Images
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File Edit Options Tools VizEngine Playlist Windows Help

Templates | Data

Flaylists |f B Coming up test [E=R(ECH =)
E I—E_l El |:" l?l Eﬂ @ [(nou)ncept> E

Viz Files

Cue  Take Continue Takeout Initplaylist v CleanUp

Description | Template Id | Channel | Concept | Variant | Available |

Scene Image

Material Fant
> stillstore [PROGRAM] [PROGRAM] @ 100%
£ IMMAGINI_scherm
METEQ-2016
NETVENTURE
Pre-Sales_Demos -
F—— v
lorenzov... robertous...
michelem... quglielmo... E— Q‘ Y[(mmw} e+ =, ® Playlist Active VDCP OFF

Em

NIC TN robe rtogi....

sagoma fabriziov...

When searching for still images within Director, whether it is media from Object Store, Viz One, Viz
Engine or just from the file system, Director allows the user to drag and drop any still image into the
playlist for playout without the need for a graphics template.
However, current limitations with Director’s Graphic Hub integration require a default stillstore scene to
be present in order to enable playout of fullscreen stillstore images. The stillstore scene must be named
vizrt_stillstore, and must be placed in Graphic Hub’s data (root) directory.

This section will explain how to Create a Stillstore Scenein Viz Artist with the required elements and
parameters, and how to Move the Stillstore Scene to the Graphic Hub Root to Graphic Hub's data (root)
project folder.

5.4.1 Create a Stillstore Scenein Viz Artist

Vizrt provides a basic stillstore scene which can be imported and used, however, in order to get the look
and feel required to match the overall theme it is recommended to further improve the scene.

In addition it is also recommended to utilize Object Store's functionality to add keywords to images that
are used for fullscreen playout. Fullscreen images a so have afixed ratio to comply with the final design
and desired outpuit.

The scene example below describes the required elements and parameters for the stillstore scene.

To create a stillstore scene

1. Start Viz Artist
2. Add aGroup container to the scene tree
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3. Click Built Ins__on the main menu, and then press the CTRL +2 keysto open the * Container
Plugins *view
4. Select the Control folder
5. Add the Controll mage plugin to the group container
® Set Controllmage's Field identifier attribute to 1.
® Adding acontrol plugin automatically adds the ControlObject plugin to the group
container.
Add an image to the container
Rename the group container to object (lower case)
Optional: Design your scene
Savethe scene asvizrt_stillstore
10. Continue To move the stillstore scene to the Graphic Hub root using the Graphic Hub Manager

© o N

5.4.2 Move the Stillstore Scene to the Graphic Hub Root

Graphic Hub is the graphics database where all scenes created in Viz Artist 3.x are stored and fetched for
play out on Viz Engine. Graphic Hub also has a tool named Graphic Hub Manager (GHM) that is used to
manage the database(s).

File Size  Type

EIESEmers and folders 7 'L, Search vizrt_stillstore 5,17KB SCEME

=l 1-VizDbServer @localhost{admin)
i
—

o P FaUlt

To move the stillstore scene to the Graphic Hub root

1. Start Graphic Hub Manager

2. Loginasadmin
® The standard out-of-the-box password for administratorsis VizDb

3. Open the project or folder containing the vizrt_stillstor e scene

4. Select the scene, press CTRL and drag and drop it onto Graphic Hub's data (root) project folder
® Alternatively copy and paste it using the keyboard keys or context menus

Note: Director’s stillstore sceneislocated in the scenes to_be dragged to_root project
folder.
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6 Newsroom Integration

Newsroom integration is usually handled by Viz Pilot News. This part of the Viz Pilot systemisan
embedded client that runs within the newsroom system client.

An alternative isthe Quick CG tool for creation of *cg like elements which also can be installed on
newsroom system clients.

Both are used by journalists to fill templates with content and store them as data elements. The data
elements are then put into a running order/rundown, created using a newsroom client, and made available
to Director for monitoring and playout through Viz Gateway or Viz Device Manager.

Depending on the features selected during installation, Viz Pilot News allows you to search for templates,
still images, audio and video clips. Templates can be opened and saved as data elements. Stills and videos
can be searched for and added to templates; however, they can aso be added directly into the newsroom
story for fullscreen playout.

Preview of graphics and graphics with video is either available aslocal or remote preview. For remote
preview, low resolution video clips are used instead of high resolution video clips.

The Quick CG tool is simpler, but more efficient when creating data elements that only contain text (e.g.
lower thirds).

This section contains the following topics:

® Viz Pilot News

® Order Management

¢ Timeline Editor

® Feld Linking and Feed Browsing

®* Maps

® Viz Engine Preview in the Newsroom
® Quick CG

¢ Table Editor

6.1 Viz Pilot News

The user interface of Viz Pilot News allows you to fill templates with text, still image(s), video clip(s) and
audio, or simply add them directly to the newsroom system for full screen graphics display, still image or
video clip.

This section contains the following topics:

® Template Search

®* Template Editor

Working with the Template Editor
® Media Search
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6.1.1 Template Search

The Template Search tab allows usersto search for and open templates, and save them as unique data
elements.

This section contains the following topics:

® Template and Data Element Panes

® Functions

® Context Menus

® Search bar

® Newsroom workflow without database connection

Template and Data Element Panes

Concept{ XN ~ | OS] = o= i|»
Template name -
CLOCK R | o = jrae =
Banner sty . e S, i
L3IRD — ——
Chart Pie Graph
Headline
0715
basic 3 Eﬁﬁ_ = N =
T ] _* e —
15toppoint
25toppoints Sports Scatter Line
v|a| B EQ v|a

The Template pane (left) shows all templates based on the selection made in the concepts drop-list.

To open atemplate, double-click or press CTRL+SHIFT+O to open atemplate by name or

CTRL+SHIFT+I to open atemplate by ID.

‘Note: If template tags have been defined, then templates are grouped by tag namein thelist view.
Tags are defined on the Tag Settings page of the Pilot Data Server Web Interface. Templates can be
tagged in Template Wizard.

The Data Element pane (right) shows all data elements based on the selected concept. Click atemplate to

show data elements based on the selected template. Data el ements that have been saved as library

elements are suffixed with an asterix (*), (see Saving an Element).

‘Note: Mediafilesthat are added to atemplate are searched for through Object Store and not by using
the Mediatab.
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Functions

Function Description

b= hd The Concepts dropdown shows all template concepts available on the
database. Select a concept to see icons for that concept.

g The Refresh buttons, for the template pane and data element pane, refresh
the window, and reload all templates/data el ements available on the
database. Keyboard shortcut: CTRL+SHIFT+R

r = 1 === The Switch View buttons switch the template pane and data element pane
between list and icon view. When viewed as a list, templates are sorted by
Tag name.When viewing all templates (Concept: <All>) genericicons are
used.

ﬂ Clicking the Infor mation button displaystypica version information, the
connection parameters used by Viz Pilot Newsto connect to the Viz Pilot
database, and alink to the list of Third Party Component Credits.

ﬂ ﬂ The Arrow buttons switch between the template editor view, and the
template and data element lists. Keyboard shortcut: CTRL+SHIFT+L
ﬁ ﬂ When the Finish button is clicked, you can select whether or not the data

elements view will hide data elements that are marked as finished.
Keyboard shortcut: CTRL+SHIFT+N

E’E Use the Calendar button to filter results based on date range. Select from
- Last 24 hours, Last week, Last month, Custom date range.

ﬁ|ﬁ|ﬁ|ﬁé‘ 10/09/2014 ~|| to [12/09/2014 +|

shortcut: CTRL+SHIFT+D

.Keyboard

Context Menus

Context menu for templates pane:

® Refresh: Retrieves new and updated data el ements from the database.
® Copy: Not available for the template view.

® Show icon/list view: Toggle between icon and list view.

® Font: Setsthe font’stype and size.

Context menu for data elements pane:

® Refresh: Retrieves new and updated data el ements from the database.

® Sorting: Setsthe sorting for the data element view. Options are; Sort by data el ement name
(CTRL+N) and Sort by creation date (CTRL+D).

® Show only library elements: Displays only data elements that are saved as library items. For details,
see Saving an Element.
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® Copy: Copiesthe dataelement’s XML source such that it can be pasted into a newsroom story item
or text editor.

® Delete: Deletes the selected data elements.

® Show icon/list view: Toggle between icon and list view.

® Font: Setsthe font'stype and size.

v|al

Below the template and data element panes are the search fields. Typing into them will search the
respective pane for matching templates or data elements.

When searching for templates, Viz Pilot News will automatically display all data elements related to a
template. When searching the data elements, it will select the first element matching the search criteria.

Newsroom workflow without database connection

The video workflow using Viz Pilot News will still work if the connection to the Viz Pilot databaseis
unavailable.

If the Viz Pilot database is unavailable, it is possible to:

® authenticate with a previously authenticated host (eg. Viz One),

® search for videos,

® add the video to a newsroom story,

® preview the video in timeline editor,

® open existing timeline items and make changes (no preview is available).

If the Viz Pilot database is unavailable, it is not possible to:

® add graphicsto video elements using the timeline editor.
To attempt to reconnect to the database, close and open Viz Pilot News, and then click the
Reconnect button in the Templates tab.
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6.1.2 Template Editor

The Template Editor allows data elements to be created from templates, and previewed. The editor is
made up of a Control Bar, Template Pane, and Preview Pane. Y ou can set additional properties when
Saving an Element. Many of the functions can be performed using the Keyboard Shortcuts for Template
Editor.

The image below shows a saved data element with remote preview enabled.

SingleStock conest] M) varariz[osraur_<] 4 e | <]
T #

Group v ][ Petiesh |
Secuily |(Choose security) - Apple

Decimalzabz 2 « FRel 2 - Update
Iz data from

N/A

na X NA

Comments

Control Bar

The control bar shows the status and the name of the template, as well as the available concepts and
variants, save options, preview, information and back buttons.

When the status of a saved data element is orange (as above), it indicates that the element has been saved
to the database and is ready to be added to a running order/rundown in the newsroom system. Usually a
drag & drop operation will add the data element to the news story; however, this may be different
depending on the newsroom system.

1 EI.
There are two save buttons; Save and Save As @ ﬂ . The Save As button will show the save dialog
and let you create a new data element using the data entered into the currently open template or data
element.

Use the Save button to save changes to the existing data element that is currently open. In casethisisa
library element, the save dialog will appear, to help you avoid accidentally changing it. To overwrite it
select the Add to library checkbox and click Overwrite.

The back button ﬂ takes you back to the template and data element lists.
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Template Pane

The fields and layout that you see in the template pane are designed by template designers, using
Template Wizard. It can therefore look many different ways, with or without elements such asimages,
buttons, text boxes, map selectors, etc. It is recommended to create an internal reference document for
your workplace which describes the templates available for everyone, and how a user should work with
them.

Preview Pane

Enable or hide the preview using the Preview button ﬂ .

When performing preview using aremote Viz Engine, the preview window can be detached, giving more
space for the template. The local preview window is always detached.

The context menu of the preview pane includes the settings for detaching the preview pane, aswell as
size and optimization settings, and safety boundaries. For details, see Viz Engine Preview in the
Newsroom.

Saving an Element

(7 save |

|NewDataEIemenﬂ Save as new
[ Finished [ Add o libram

v Graphic Event Timing ——
I at [mm:zs]; I;I —

Event Lenagth [mm:ss]: I;I

Viz Pilot News hasits own save dialog for setting additional properties.

If the Template Spell Checker has been enabled, the save operation will open the spell checker prior to the
save dialog. Spell checking is enabled by the template designer using Template Wizard.

® Finished: If the data element is made in different revisions and you want to indicate that thisisthe
final one, select the Finished check box. Thisinformation will be stored in the database and can be
shown in the Finished column in the playlist (1 for finished and O for not finished). This setting has
no impact on the element, other than displaying the value in the Finished column.

® Addtolibrary: Select this checkbox if the data element will be used often and you want to prevent
it from being deleted. The data element will be saved as a library element, and all concept and
variant information is kept. This prevents the data element from being deleted in Director when using
Options > Delete Data Items. Library elements can still be deleted manually, and if the original
template is deleted in Template Wizard, all data elements based on the template will also be deleted,
including library elements.
The Add to library checkbox will by default be unchecked. To Overwrite an already existing library
element, select the Add to library checkbox, click Overwrite and click Yesin the confirmation dial og.
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Note: Data elements that are saved as library elements, will appear with an asterix (*) after their
name in the data element list (see Template and Data Element Panes).

Note: In order for the flag to be visible, it must be turned on in the Database Parameters (
ax_dat ael enent _ti mer _enabl ed) or in Template Wizard (Template Information
Component > Advanced Properties).

When checked, the following additional settings are available:

® |n at: Setsastart time (mm:ss), MOS-itemEdSart. Timing is relative to the story/group the
element is apart of, rather than the complete playlist. The value appears in the Timecode
column of the (MOS) playlist when opened in Director.

® Event length: Setsthe duration (MOS-itemEdDur) which tells the newsroom system how long
the graphics will be on air. The value appears in the Duration column of the (MOS) playlist
when opened in Director.
When an element from a MOS rundown is opened in Viz Pilot News, the timing fieldsin the
save dialog will be populated with the timing information from the MOS XML. If the element
is saved back to the rundown, the timing information will still be present in the XML.

Note: In order for Viz Pilot News to generate the timing information in the MOS XML, the
data element must be saved just before the item is added to the rundown. If you have
reopened the data element, or you it drag directly from the list of data elements, the timing
information will not be available.

Keyboard Shortcuts for Template Editor

Keys Description

CTRL+ALT+C Copy adata element from the data element list, or an open element in edit
mode.

CTRL+ALT+S Saves the data element as a new data element. See also CTRL+S.

CTRL+C Copies a data element from the data element list. Seealso CTRL+ALT+C.

CTRL+D In data element view you can sort according to a data element’ s creation
date.

CTRL+N In Template Search you can sort according to template name.ln data
element view you can sort according to data element name.

CTRL+SHIFT+D Toggles the Calendar button, exposing the start and end date fields.

CTRL+SHIFTHI In template view you can open atemplate by ID.

CTRL+SHIFT+L Switches to the template editor view, and back to the Template Search and
data element view.

CTRL+SHIFT+N Toggles the Finish button, so that the data elements view will only show
data elements that are not marked as finished when saved.

CTRL+SHIFT+O Opens atemplate by name when in Template Search.
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Keys Description

CTRL+SHIFT+P Toggles the preview. See also Maps and Remote Preview in the
Newsroom.

CTRL+SHIFT+R Refreshes the template and data el ement panes, and reloads all templates

/data elements avail able on the database.

CTRL+SHIFT+S CTRL+S

Saves the data elements. See also CTRL+ALT+S.

CTRL+SHIFT+1 Toggles the image search filter.
CTRL+SHIFT+2 Toggles the audio search filter.
CTRL+SHIFT+3 Toggles the video search filter.
CTRL+SHIFT+4 Toggles thefilter.

6.1.3 Working with the Template Editor

This section contains the following topics:

® To create adata element
® Torename adata element
® To edit adata element

® To add an open data element to the newsroom story
® To copy an open data element

® To copy adata element from the data element list

® To change a concept and/or variant

® To preview avideo in atemplate

® To get the data element’ s default channel

To create a data €lement

arwNeE

Click OK.

To rename a data el ement

Double-click atemplate from the Template pane to open it in the editor.
Make the necessary changes to the data (e.g. text, images, video clips).
Click the Save button.

In the Saving an Element, enter a name for the data element.

1. Double-click to open a data element in the editor, and click the Save As button.
2. Inthe Saving an Element, enter aname for the data element.
3. Click Overwrite Existing.

To edit adata element

1. Search for and select a data element and double-click it to open it in the editor.
2. Make the necessary changesto the data (e.g. text, images, video clips).

3. Click the Save button.

4. Click OK.
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To add an open data element to the newsroom story

Y ou have three options for adding a data element to a newsroom story:

1. Drag and drop the orange icon (top-left) onto your newsroom story
k

2. PressCTRL+ALT+C to copy it to your clipboard and paste it into your newsroom story

3. Open an already saved data element and drag and drop the green icon onto your newsroom story
k

To copy an open data element

® Open adataelement and press CTRL+AL T+C to copy it to your clipboard and paste it into your
newsroom story

To copy adata element from the data element list

® Select adataelement from the list and press CTRL+ALT+C (or CTRL+C) to copy it to your
clipboard and paste it into your newsroom story

To change a concept and/or variant

1. Inthe editor, simply use the Concept or Variantdrop-list to select a new concept and/or variant.
2. Click Saveto save the data element.

To preview avideo in atemplate

Once avideo item has been added to the video placeholder:

1. Right-click the video placeholder and select Preview from the context menu
2. Thevideo and any graphics elements that have been added are previewed in the Timeline Editor
Preview window.

To get the data element’ s default channel

A default channel can be set for atemplate, which can be passed to the newsroom system when items are
added to the rundown.

1. Ensurethat adefault channel has been defined for the template (see To set the default channel for
atemplate).
2. InPilot Data Server's VCP Parameters, set the parameter ax_add_i t encthannel to enabled.
3. Create a data element from the template and drag it to the rundown.
To turn off this feature, disable the parameter ax_add_i t enthannel .

119



6.1.4 Media Search

This section contains the following topics:

Search and Result Panes
Media Context Menu

Details View

Search and Filter Options
Filter Media by Person Name
Media Search Errors

Search and Result Panes

Tallship Race 16

SWUPMBXZZLTTWMEG
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19/08/2014 ~

.
 News.
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ACCOMODATIONS Tallshio 16 Lmov b
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ADMINISTRATION Norway trade [BC2014
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AMBULANCE SERVICE

AMIMAL ILL-TREATMENT
AMIMALS

ART

ASTROMNOMY -

All rights Vizrt

The Media tab allows users to search for media assets (i.e. still images and video clips) that can be added

directly to the story (e.g. afull screen video clip).
Media information resides on storage systems such as Object Store and Viz One. Object Store
traditionally stores still images and person information. Viz One stores video, audio and video stills. The
Mediatab combines the sources into one.

The left pane shows the Search and Filter Options and alist of categories, while the right pane displays the
search results, and optionally, the item details.
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In order to reduce network load and to increase the speed of the search, the media search will display the
first 15 results from each provider (e.g. Object Store or Viz One) and then ask for more if needed when
scrolling. The most recent assets are displayed first. If the number of resultsislarge, it is recommended to
refine the search.

Note that searching Viz One currently only supports free text search, while Object Store search supports
free text, setting from and to dates and use of one or multiple keywords.

If multiple Viz One systems are in use, all of them will be searched and the search results will be
combined according to the ID of theclip. i.e. If the same clip is available on multiple Viz One systems, it
will only appear once in the search results.

Note: Depending on the data available from each provider, the status bar will display either
ProviderName=N of M shown or ProviderName=N found, where N will increase as more items are
fetched. If aprovider does not provide sufficient information, the status bar will display

Provider Name=unknown.

Media Context Menu

Sort By 2 Name
Add To Rundown Name (Descending)
Copy Cirl+C Registration Date

Show Extra Metadata Registration Date (Descending)

v Show Details View

Font ...

Launch Viz PreCut
Launch Viz EasyCut

Preview

Open in Timeline Editor

¢ Sort By: Displays a sub menu with sort options.
®* Name/Name (Descending): Sorts by namein ascending and descending order.
® Registration Date/ Registration Date (Descending): Sorts by registration date in ascending
and descending order.
¢ Add to Rundown: Enables newsroom systems, that do not support drag and drop operations, to add
media elements to their rundowns. In order to use this menu option, the database setting
ax_enableM ediaSendToRundown (see Viz Pilot Database Parameters), must be added to the
database and enabled.
® Copy (Crtl+C): Copy the selected item. It can then be pasted to the rundown.
® Show Extra Metadata: Switches the mediaiconsto display meta data such as complete filename,
creation date, and clip length and so on.

121



Tallship 23 Statsraad 1
~ Tallship 23 Statsraad 1

P ] Y QawL

® Show Details View: Displays metadata of the selected mediaitem in a separate window. Right click
to view the pane at the bottom or on the side of the Media pane.
® Font: Setsthe font’stype and size.

¢ Launch Viz PreCut: Opens the selected video clip in Viz PreCut for editing.

¢ | aunch Viz EasyCut: Opens the selected video clip in Viz EasyCut for editing.

® Preview: Previewsimages using the Windows Picture and Fax Viewer or the default browser. Is
only available for Object Store and Viz Oneitems.

® Openin Timeline Editor: Opens the Timeline Editor that enables you to add graphics placeholders
to avideo clip’stimeline.

Details View

Display an item’'s metadata by selecting Show Details View from the context menu in the search results.

The Details View shows the metadata that is received from the asset search provider. The type of data
available can vary, and can be configured in each asset search provider.

The Details View can be placed at the bottom of the search pane, or to the right. Use the context menuin
the Details View to change the location.

Tallship Race 16

Shown on right
Show on bottom h

. Mews
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Search and Filter Options
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Both Object Store searches and Viz One searches support free text, keywords and from and to dates.
Combine the use of filters, text search and keywords to narrow down your results.

® Search field: Combo box for entering a search criteria. Previously entered search criteriaare
remembered per session.

® Type- Stills, Audio, and Video: Filters the search result displaying only images, audio or video,
according to which filters are enabled/disabled.
Use CTRL+click to select multiple types.

® Type - Person: Filtersthe search result displaying only picturesthat are defined as person (i.e.
profile) images in Object Store. See also Filter Media by Person Name.
"Note: The Person Filter button is only availableif a RestVOS Search Providersis configured. If
using standard Object Store, search for person name by typing in the Search field.

® Date: Filter results based on date range. Select from Last 24 hours, Last week, L ast month,
Custom date range. Filters the search result based on registration dates.
For Viz One searches, the default date used to search is the CreationDate (date the item was created
in the Viz One), however this can be configured to use other dates from the metadata, for example
PublicationDate. For more information on how to configure the search, see the Viz One
Administrator’ s Guide.

® From/To: When the Custom date range button is selected, the From and To dates are presented.
IA red background indicates that the from-date specified is later than the to-date.

® Keywords: Filters the search result based on keywords. Templates that use the RequiredK eyWords
property will have the relevant keywords pre-selected in the list. Keywords are configured for each
Service Provider. See Required Keywords. A warning is displayed if the image selected isn’t valid.
If multiple Viz One systems are in use, all of them will be searched and the search results will be
combined according to the ID of the clip. i.e. If the same clip is available on multiple Viz One
systems, it will only appear once in the search results.
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Filter Media by Person Name

Templates | Media

O from  [02/05/2013 |
O To |16/05/2013 |

Keywaords -
[ALL] L
ACADEMIES

ACCIDENTS

ACCIDENTS AT SEA

ACCIDENTS AT WORK

ACCIDENTS IM SPACE
ACCOMODATIONS

ACCOUNTS

1. Click the Person Sear ch icon.
Enter part or al of the person’s name in the Sear ch field.
3. Click Go.
® The search results are grouped by person. The number of items found for each personis
shown below the thumbnail .
4. Click the thumbnail of the desired person to view al of the images of that person.
5. Click Back to select a different person or to search again.

N

Note: This Person Filter function is only available if RestVOS Search Providers are
configured. If using standard Object Store, search for person name by typing in the Search
field.

Media Search Errors

® Startup Error: An error occurred during startup. The host (or Viz Pilot News) will need to be
started again to clear the error.
® Search Error: An error occurred during a search. Try doing the search again.

6.2 Order Management

This section contains the following topics:

® Order Management in Viz Pilot News
® Sample Fields for Work Orders
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® To submit aWork Order from Viz Pilot News
® Order Status and Warnings

6.2.1 Order Management in Viz Pilot News

The Order Management System is designed to close the gap between the newsroom users ordering
content, and another department in the building fulfilling these requests. The Order Management System
is built on top of Viz One, Vizrt's media asset management solution.

If you cannot find the media you need during a Media Search, and you have Order Management
configured (see To configure Order Management), you can submit an order.

Order Management comprises three levels, of which the first two are managed in Viz One, and the third is
submitted from Viz Pilot News:

1. Projectsarethetop level of awork order system. Examples of a project are National Elections, a
single show called The Evening News, or an entire facility. Typically a management role creates
and manages Projects.

2. Requests: A Project may have one or more Requests associated with it. An example of arequest
could be a set graphic, a lower-third, a highly stylized video, or a Viz Scene.

3. Work Ordersarethelowest level and where tasks get done. It is where mediaisfiled, approved
or rejected. One or more work orders can be associated with a Request.

An example of awork order would be all variants of alower-third required for the project. Work
Orders are generated by templates inside the Newsroom plug-in. Templates can contain one or
more clip/image selectors.

Users are notified viaiNEWS Top Line Message and/or e-mail as their requests are processed.

6.2.2 Sample Fields for Work Orders

Name Description

Mandatory Values

Requestor User name of the requestor.This can be overridden and does not have to
be the same as the user creating the project

Project * Name of the Project this work order shall be associated with

Request * Name of the Request that this work order shall be associated with

Mediatitle Title of the Request

Send notification Enables/disables notifications for the Request

Optional Values

Description Additional information about the Request
Air dateftime Date and time the work order airs
Contact information Information that the user who is fulfilling the request can use for getting

in touch with the requestor. For example: call mein edit bay 3or _| am
out of office, use alternate contact._Information not available in the
corporate directory typically goes here
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Name

Description

Also notify

separates multiple email addresses

Other people who shall be notified as the Request is processed. Semicolon

Note: * Projects and Requests must have MOS Enabled set to Yes to appear in the Newsroom plug-in

drop-down

6.2.3 To submit aWork Order from Viz Pilot News

1. Open atemplate or data element which has an image component
2. Click the image component to open the Mediatab
3. Perform a search and inspect the results. If you cannot find a suitable asset, click the Order button

below.

[ From| 0/22/2013 ||
[To ¥ 10/ 6/2013 -]

Keywords
[ALL]

zzq replictest

VYMECOMS

[ /2]

Matt's test

VWMECOMS

[ /02

Matt's Test 2

Matt's Order for Bill and

EEEE  wwmeowms || [@WEER  wmeEoms
sample_Portrait_Stretch | Jonasi? - Still

WMEDOMS=16 of 63 zhown

L Order

|I )l

Ma item selecte

Cancel

4. If prompted, log-in to the system

Dromain | Internal accounts

User

FPassword

Login

5. Inthe Order meny, fill in at least the mandatory fields (indicated with a star *) and select either
Submit or Submit and Attach File(s).
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Note: Usersin Viz Pilot News create Work Orders, while Projects and Requests are
configured in Viz One.

Create Work Order

Select request

Reguestor &y STEM+admin

Project * I

Reqguest * I

Air Date/Time *
Due Date/Time *

Segment

Media Title * I I

Reguest Details

) &)
@&

M=
(i) ()

(i) (W)
G
B&)

Contact Informat...

Send notification

Alzo E-mail

| Cancell

6. If you selected Submit and Attach File(s), browse for filesin the Order window. Y ou can
optionally add comments about each file in the Comment column. When ready, click OK.
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B Order =

Filename Uploaded Size Comment
imagel.png 3/3/15 6.4 KiB two yellow labs X
Browse ar Drop

imagel.png uploaded successfully.

Ok

Note: Dropping afile on the Order form to attach it, is not available in Viz Pilot News. Use
Browse to locate and attach afile.

7. Back in the Templates editor, the media selector icon changes to Order

Templates | Media

oOTS Concept:| Concept X ﬂ| |H-—'|| !| I |*
Wariant: Default Bl

8. Savethe template and insert into the newsroom rundown. Once the order isfulfilled, any materia
needed to air this dataitem is automatically associated.

IMPORTANT! When re-opening a saved dataitem where awork order has been placed but
not yet fulfilled, the Order icon will not be seen. Instead ared border stating the mediais
invalid, is displayed.
Previoudly, until a order was fulfilled-and-approved (both), the asset was not assumed fully ready
and could not be cropped or displayed. Starting with Viz Pilot 6.0 fulfilled-and-approved will for
convenience reasons be treated the same way. Creating a data element with a fulfilled-but-not-
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approved asset, you will now get the yellow warning border but the item can be cropped and
displayed. However, if you later reopen the same data element, the system no longer know
anything about it being an order (since it has been used) so the warning border will not show up
even if the order is till unapproved.

6.2.4 Order Status and Warnings

Get Image Get Image

The status of the order can be any of the following (as shown from left to right in the image above):

® No order submitted (Get Image placeholder)

® Submitted (Order placeholder)
On pending items, you can right-click and select Open in Studio to open a browser with information
about the order, including name and ID.

® Fulfilled but not yet approved (yellow warning notification)

® Approved

® Invalid (red error notification over placeholder), for example File not found
The status of an order is refreshed when a a data element is opened. Hover over the warning/error
notifications to read the full message text.
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6.3 Timeline Editor

> | [+ |[w |[@|[oo][ 1 ][t |[1 |[~[ | [IL] Taliship... 53758
[15] [2.2] 4
Default ol
[2.7]
.‘ ) | Cancel |

Thetimeline editor is used to add graphicsto avideo timeline. The editor is available to Viz Pilot News
users.

In short you search for avideo using Viz Pilot News and preview proxy versions of the video clips. When
you have found/edited the video, it is possible to open the video in the built-in timeline editor.

The timeline editor offers basic functionality for adding graphics to the video timeline. The graphics are
added using data elements that are saved to the Viz Pilot database (normal graphics workflow).

When using data elements, the timeline editor will add them as placeholders on the video timeline. The
placeholders will display snapshots of the graphics as video overlays (fetched from the Preview Server).
The placeholders can of course be manually adjusted on the timeline.

A story item containing clip and graphics references from the timeline editor will appear asagroup in the
playlist. Issuing a Take command on the group will trigger the video clip and timed graphics.

This section contains the following topics:

¢ Timeline Editor Functions

¢ Keyboard Shortcuts for Timeline Editor
Working with the Timeline Editor
Timeline Editor Preview Mode
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6.3.1 Timeline Editor Functions

This section contains the following topics:

® Editor Control Bar Functions

® Timeline Editor Functions

® Multiple Tracksin the Timeline Editor
® Set Timeline Name

Editor Control Bar Functions

The editor is divided in two; a control bar and a preview window.

> |+ || m|B@|oo| 1| [ |[]|=]||»|mashp. 53/58
| L [2.2 L
Default Lol

Timeline Editor Functions

The control bar contains the following functions.

Function Description
[ I | | Play or Pause the clip. <SPACE>
o) Adjust the volume of the clip
-+ Add graphicsto the timeline. <INSERT>
(] Delete the currently selected graphics from the timeline. <DEL >
U Scrub marker (cursor). Drag to scrub the clip.

Click the poster frame marker to jump the cursor to the marker. The
preview window will display the frame that will be used as the poster

frame.
]| Set poster frame to the current position of the cursor. <P>
cO When selected, the video will loop during playout. Note that graphics will

not loop. <CTRL + T>

Set the mark-in point to the current position of the cursor. <I>

131



Function Description

]

[ Set the mark-out point to the current position of the cursor. <O>
1= Jump the cursor to the mark-in point. <SHIFT + >
=[ Jump the cursor to mark-out point. <SHIFT + O>
I Play from mark-in to mark-out. <SHIFT + SPACE>

Drag the Zoom control to increase or decrease the time scale shown on
the timeline. <Mouse wheel> or <CTRL + ‘+'>/<CTRL +‘-'>

Set timeline name. The Set Timeline Name button appears when you
hover over the video title.

The Timeline Editor supports progressive download. The Buffering
indicator is displayed above the timeline. It is gray above timeline
sections where buffering has not yet been done, while green where the
mediais buffered locally.

Multiple Tracksin the Timeline Editor

> | |+ || ® || @E|oo| 1| [ || 1| =[||I»l Talship..00/38
.

Clock

oTs o752

The Timeline Editor supports multiple tracks for transition logic scenes. This allows graphics to overlap
and play out correctly, but requiresthat all data elements are based on the same transition logic set.

The tracks reflect the layers in the transition logic scene. A track is displayed in the timeline editor if an
element using that layer has been added.

Graphics from the same layer should not be overlapped, and the timeline editor will indicate a possible
conflict by coloring the graphics placeholders red, as shown here:
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Position elements on thetimeline with snapping
Graphics ‘snap’ to each other if they are on the same track.

To reproduce:

1. Open avideo with multiple graphics on the same timeline.

2. Drag one graphic towards another.

3. They snap together once they get close enough. This means the elements’ in and out points (or
vice versa) line up on the timeline, as shown here:

Set Timeline Name

After adding graphicsin the timeline editor you can give a timeline name to the resulting composite
element. If thetimeline nameis set, it is put into the MOS element (mosAbstract node), otherwise the
video title will be used. The timeline name will be displayed in the newsroom story and in the playlist.

Reopening aMOS item in a newsroom system that supports updating the items, will also update the
existing name.
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Note that opening an existing item which has atimeline name, will keep that name when editing, but it
won't show up as a changed name next to the label. Thisis so that you can override it again or set it back

to empty to use the previously set name.

The atom xml generated by the timeline editor will have the timeline name set as the atom:title (this

remains empty if not set).

Y ou can:

® Hover over the video title/timeline name to see them in full.

Tallship race promo

5.8/58 58/58

MyTingﬁneName
bl

i Video title

Tallship race promo

[] =y Video title []

Tallship race prome

Timeline name

MyTimelineMame

Close | Close

® Set or edit the timeline name, by either:
® Right-clicking the video name and select Set timeline name.

® Hovering over the video name and pressing the Set timeline name button .
® Clear thetimeline name by right-clicking the video name and selecting Clear timeline name.

6.3.2 Keyboard Shortcuts for Timeline Editor

Key Description

Mouse wheel Zoom in and out

CTRL +‘+ Zoomin

CTRL + ‘- Zoom out

CTRL +°0O Reset zoom

Insert Add new graphics

Enter Open selected data element for editing

Del Remove currently selected graphics from timeline
Space Play/Pause

Arrow Move focus to next or previous graphic item

CTRL + Arrow

Move graphicsin small steps back and forth on the timeline

CTRL + SHIFT + Arrow

Move graphicsin big steps back and forth on the timeline

SHIFT + Arrow

Select multiple graphics

CTRL + ALT + Arrow

Increase or decrease duration of graphic by a small amount

CTRL + ALT + SHIFT +
Arrow

Increase or decrease duration of graphic by alarge amount
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Key

Description

CTRL +L

Move the selected graphics next to the one to the left

CTRL +R

Move the selected graphics next to the one to the right

CTRL + ALT+L

Stretch the selected graphics next to the one to the left

CTRL +ALT+R

Stretch the selected graphics next to the one to the right

CTRL +H Sets video position to start of the clip

CTRL +E Sets video position to end of theclip

CTRL+T Activate looping of the video

, Scrub backwards one frame. (If frame rate not provided in the asset, scrub
back 0.02 seconds)
Scrub forwards one frame. (If frame rate not provided in the asset, scrub
forward 0.02 seconds)

CTRL +, Scrub backwards 1.0 second

CTRL +. Scrub forwards 1.0 second

P Set poster frame

I Set mark-in

O Set mark-out

SHIFT +1 Go to mark-in

SHIFT + O Go to mark-out

SHIFT + Space Play the mark-in to mark-out area.

SHIFT + drag the infout

marker bar

Move the bar between the in and out points to move both points at the
sametime.

6.3.3 Working with the Timeline Editor

This section contains the following topics:

® To add graphicsto avideo clip timeline

® Timeline Update Service

® Viewing an Asset Stored in Viz One

® Known Limitations

To add graphics to avideo clip timeline

1. InViz Pilot News, click the M edia tab to search for videos.
2. Right-click the video item, and from the context menu select Open in Timeline Editor.
3. To add graphics, click the Add button

® Thiswill open the Template and Data Elements view.
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4. Select atemplate or already saved data element, and click OK.
® Clicking OK will prompt the template or data element to be saved.
® Afteritissaved you will see agraphics placeholder on the timeline.
5. Adjust the placeholder to set the desired duration of the animation.
6. Optional: Repeat steps 3 and 4 to add more graphics.

7. Drag and drop the timed video and graphics onto your story.
k
° : Depicts an item that can be added (by drag and drop) to a newsroom story.

® OK: Saves areopened story item back to the story.
® Cancdl: Cancels any changes.

Note: Graphics may be overlaid on the timeline; however, graphics that use the same
layer (front, middle, back or transition logic layer) will not play out correctly.

Timeline Update Service

When avideo timeline (standal one video or video composite element) is opened in the Timeline Editor, it
will check if a Timeline Update Service (TUS) is defined in the system. If defined, it will POST the
playable relative timeline to the TUS.

TUS s called both when opening a video from the results of a media search, and also when opening a
video or composite element from a rundown in a newsroom system. In this case the TUS might already
have run on the video when it was previously created by Viz Pilot, but it is still run again.

The TUS s provided by the customer themselves, and isan HT TP service that complies with an API. Viz
Pilot will invoke the relevant URL and will expect the result to follow the given protocol.

The API prescribesan HTTP service, listening on the configured URL for POST requests with the
media type Atom Feed (app! i cati on/ at om+xm ; t ype=f eed), with content as defined by the
Playable Relative Timeline for mat, and responding with content of the same for mat.

® Tosetup TUS:
® TheTUSis provided by the customer.
® Specifications for the playable relative timeline format can be accessed from the Documentation
page of the Pilot Data Server itself.
® Toconfigure TUSinthe Pilot Data Server:
® Browsetohttp://<Pil ot Data Server host:port>/settings#Paramnms
® Settineline_update_service totheURL that Viz Pilot isexpected to (HTTP) POST
Playable Relative Timeline documents to. The response is expected to be a document in the
same format with any updates.
® Touse TUSonce configured:
® Open Viz Pilot News and search for videos. When you preview avideo in the Timeline Editor,
the courtesy graphic is displayed.
® Example:
® One of the use casesfor TUS is adding courtesy graphics. In this case the TUS could return an
updated playable relative timeline, with a courtesy graphic added, or return the same timeline it
was given if no changeswere made. If novalueissetinti nmel i ne_updat e_servi ce,
then no courtesy graphic is added (thisis the default behavior).
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Viewing an Asset Stored in Viz One

As soon as anew asset is published by Viz One and shows up in a search result, it can be opened in the
Timeline Editor.

For Viz One assets that have been fully ingested and processed by Viz One, the Timeline Editor will
provide afull preview. However, if Viz Oneisstill processing the asset (ingesting the high-res video or
creating the proxy video), the Timeline Editor will provide a preview based on the information available
toit at the time.

While Viz Oneis processing the asset:

The timeline duration reported by the Timeline Editor will equal the high-res video duration reported
by the asset, at the time of opening it in the Timeline Editor.

If no proxy video is available from the asset, then the Timeline Editor will open with ablank video
preview area, with all video preview related controls (play, pause, volume) disabled.

If thereis a proxy video, but its duration (as reported by the asset) is shorter than the high-res video,
then video preview will only be available for the first part of the timeline. Seeking beyond that is
possible, but the video preview will not be updated there.

It is possible to add graphics and in/out points even where there is no video preview. These areas are
marked on the buffer indicator line with moving black and white stripes.

The Timeline Editor sets the out point to the length/duration of the currently available portion of the
video. If the high-resis still growing when the timeline is opened in the Timeline Editor, then this
out point will be somewhere in the middle of the final video.

Note: Different Viz One installations may behave differently, with regards to the details the
Timeline Editor relies on, depending on version and configuration. For more information on Viz
One, contact Vizrt Customer Support at www.vizrt.com.

Known Limitations

® Graphics may be overlaid on the timeline; however, graphics that use the same layer (front, middle,

back or transition logic layer) will not play out correctly. The timeline editor will always indicate a
possible conflict by coloring the graphics placeholders red. To use overlapping graphics based on
transition logic scenes, see Multiple Tracks in the Timeline Editor.

® Current limitations on the Media Sequencer will cause the following behavior:

® |f youissueaTake onatimed group (1), and while that group is played out issue a Take on
an graphicsin another layer (2), the Media Sequencer will, when issuing the timed Take Qut
command (for the timed graphics), take out the last taken element instead (2).

® Hence, it is currently not recommended to take other data elements on-air while atimed group
is being played out.
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¢ |nvalid Timeline! The element is not fully inside the area marked by the In and Out points.
Timelines which have elements which are outside or intersecting the Mark In/Mark Out points
cannot be saved or dragged to the rundown.
In the image below, the first timeline shows a normal element, while the second timeline contains an
element which intersects the In/Out points and so the timeline cannot be saved or dragged.

® |f loading timeline elements (overlay graphics), or calling update service (Timeline Update Service)
takes more than 2 seconds, an abort button is shown on the loading screen. Clicking the abort button
will cause the video to be loaded with amissing or incompl ete timeline with overlay graphics,
depending on which of the two operations was aborted.

Default

Default

r QK Close

6.3.4 Timeline Editor Preview Mode

> ]e0 I el ] [0 [ rmn 00s38

Ok

A basic version of the Timeline Editor is available for previewing video elements from within atemplate
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or data element. Video preview and scrubbing is available, however the controls for timeline
manipulation are disabled.

v

The Preview option is avail able from the context menu of the video element.
Preview is only available if the image component in the template listsisVideoMediaSearch init’s
ImageSources, and is only enabled if avideo asset is actually selected.

6.4 Field Linking and Feed Browsing

Viz Pilot supports browsing tab-field values from external sources. Instead of editing tab-field values
manually, values from an external feed can be selected.

This allows the user to pick an item from a feed and have the corresponding data applied to fields in the
template, instead of manually typing in information.

This section contains the following topics:

®* Workflow

® Overview

® Feed Browsing

For afull description of Field Linking, see the Feed Linker Component

6.4.1 Workflow

Field linking in Viz Pilot is atwo-step procedure:

1. Field Linking: Linking the fieldsin atemplate to various parts of data that will come from entries
in afeed. Thisisasetup step that is usualy done once for atemplate.
In Template Wizard, create templates using the Feed Linker Component.

2. Feed Browsing: After field linking has been set up and saved for atemplate, the Feed Browser
will be available.
In Viz Pilot News, click on the Feed Linker button to open the Feed Browser window. The Feed
Browser lists the items from the feed source defined in the template. Select an item from the list.
The datais then mapped to fields in the templ ate.
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6.4.2 Overview

Feed URIs can be defined in the control object of the scene designin Viz Artist. Additionaly, the feed
URI for atab-field in atemplate can be defined from within Viz Pilot. Each page then uses the feed
browser to edit the tab-field value. The specified feed URI in Viz Pilot overwrites any existing feed URI
from the control object. A reimport of the scene does not reset the specified feed URI by the field
definition specified in control object.

A tab-field in general has several properties. Each property relatesto a control plugin in the scene.
Properties are grouped under atab-field by a naming convention.

Example: The Control Text plug-ins specifying the field identifiers 1.name, 1.score and 1.image will
form atab-field 1 with the properties name, score and image. Selecting afeed item for the tab-field 1
should apply the parts of the selected item to the properties name, score and image at once. The

individual property values should be editable as usual. The feed item selection works as apurefill-in

Feed Types
The feed browser supports two types of feeds:

®* FHat feeds
® Hierarchical feeds (folder structure)

Tabfield Grouping

To be able to set multiple tabfield values from the same feed entry, the tabfields must be grouped together.
Thisis done by giving them the same prefix followed by the period character. For example, the following
tabfield names will generate two groups of tabfields (candi dat el and candi dat e2):

candi dat el. nane candi dat el. i nage candi dat e2. nane candi dat e2. i mage
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6.4.3 Feed Browsing
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Feed Browser

Given avalid Field Linking URL (see Feed Linker Component), the elements can be browsed and selected
in the Feed Browser window.

Choose either the thumbnail view or thelist view. Right-click the items to Refresh or Sort the items or to
Resize/Zoom the thumbnail view.

Feed Browser Authentication
The feed browser supports basic HTTP authentication. The server must return a HT TP header based on

the HTTP standard, like this:
WNM Aut henti cate: Basic real m"..."

The Pre-authenticated hosts configured in the Pilot Data Server aso apply to the Feed Browser when
hosted in a Viz Pilot application (see Search Providers).

Searching and Filtering

If the feed supports OpenSearch then the search box will be enabled and all searches will be done on the
server. If not then the search box will be alocal text filter box.
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6.5 Maps

Viz Pilot News also integrates with Viz World which allows you to add animated and/or still maps to your
graphics.

For more information on how to work with maps, please refer to the Viz World User’s Guide.

6.6 Viz Engine Preview in the Newsroom

Local preview uses alocal Viz Engine, while remote preview uses aremote Viz Engine.

® | oca Preview in the Newsroom
® Remote Preview in the Newsroom

6.6.1 Local Preview in the Newsroom

(@' Local Viz Engine Preview =}
5 5 i

o] [BB] [ [oo] o [] [e] 5] m) e B

Size

B e

¥ Close Alt+F4

| Keepaspect
v Show consale

Local Preview is afeature that must be selected by enabling the Viz Engine Preview plugin in the Viz
Pilot Configuration Tool. See Configuring Local Preview.

Properties and Parameters

® Start: Animates the scene.

® Continue: Continues to animate the scene to the next stop point or completes the animation of the
scene.

® Stop: Stopsthe scene.

® Step Backward: Steps the scene backwards frame by frame when it is paused.

¢ Timefield: Shows the current timeframe for the scene.

142



® Title Area: Shows the boundaries of the defined title area (green rectangle).

¢ Bounding Box: Shows the boundaries of the scene's objects.

® Safe Area: Shows the boundaries of the defined safe area (purple rectangle).

¢ Show Commands: Opens a console window that shows the Viz commands. The console window
can be enabled by default by adding the ShowConsole registry setting.

® Restart: Restartsthelocal Viz Engine.

Context Menu

® Keep agpect: Sets and keeps the correct aspect ratio according to the Viz output format settings
when the window is resized.

® Show console: Shows the Viz console, showing all commands sent to and processed by Viz.

¢ Alwayson top: Floats the preview window on top of al other application windows.

6.6.2 Remote Preview in the Newsroom

Always on top
Show Safe Area
Show Title Area
Detach preview
Set Size as Default

Optimize Speed
w Quality

BB BENews

Unlike Remote Preview using Director, Remote Preview using Viz Pilot News does not animate the scene.
The scene, according to the time set in the scrub field, is rendered on aremote Viz Engine and snapshots
are sent back to Viz Pilot News. Low resolution video clips are used instead of high resolution video
clips.

Open the preview by clicking the View icon ﬂ in the Template Editor or pressing Ctrl+Shift+P.

To configure Remote Preview see Configuring Remote Preview for the Newsroom.

Menu Bar

The menu bar contains the following functions:
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® Start: If the graphic has two or more tags on its timeline, this asks Viz Engine for a snapshot of the
scene from the first tag on the default director.

® Continue: If the graphic has two or more tags on itstimeline, this asks Viz Engine for a snapshot of
the remaining tags on the default director.

® Key: Showsthe key signal of the graphics.

* Timefield: Shows the current timeframe for the scene. Allows the user to scrub the scene manually.

® Tag field: Showsalist of the scene’ s director tags (not stop tags) on the default director. These tags
are used for previewing the scene.
If the scene contains tags, and fields in the template are linked to these tags, then editing the field
will result in the preview jumping to the corresponding point in the animation. For more information
on creating tags in scenes, see the section *Working with Eventsin a Director’ in the Viz Artist User’
sGuide.

® Close (X): Closes the preview window.

Context Menu

® Alwayson top: If the preview window is detached from Viz Pilot News, this option enables the
preview window to stay on top of other application windows.
¢ Show Safe Area: Shows the boundaries of the defined safe area (purple rectangle).
® Show Title Area: Shows the boundaries of the defined title area (green rectangle).
® Detach preview: Detaches the preview window from the newsroom system window (see, Always on
top).
® Set Size as Default: This option sets a new, customized, default preview window size.
® Optimize: Displays the optimization options.
® Speed: Uses an agorithm for calculating the image resolution which resultsin low quality
images that are faster across the network.
® Quality: Usesan agorithm for calculating the image resolution which resultsin high quality
images that are slower across the network.

6.7 Quick CG

The Quick CG (character generator) is asmall and easy to use tool to create an embedded M OS object to
be used in a newsroom story.

This section contains the following topics:

® Quick CG Functions
® Working with Quick CG

6.7.1 Quick CG Functions
Type CG data |D’ f ¥
|<::E>:t ID>-<textfieldl =/ <textfield2| | Ok
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® Type CG data: Usesthe Externa 1d combined with the data needed to fill the text fields for the
graphics.
The Media Sequencer interprets the entered values by sorting the control object fields of the template
alphanumerically according to control object ID. It then applies the first value to the first field, the
second to the second, and so on.
Use the delimiters dash (-) and forward slash (/). For example: 200- Fi r st Nanme/ Last Nane
/ Desi gnati on.

Note: Check for blank spacesin the input. There must not be a space before the dash. A space
anywhere else will be included in the value.

® Auto-pasteto Editor: When selected, it enables the Quick CG to auto-paste the generated XML
output to a previously selected editor (for example a newsroom story editor).

® Settings: Opens the Settings dialog box to configure another activation key. Available options are;
Disabled, Ctrl, Alt, Shift, Home, End, Insert, Num Lock and Scroll Lock.

®* Minimize: Minimizes the application to the taskbar. Reopen it by double-pressing the assigned
activation key.

® OK: Initiate the generation of the XML needed to create a proper MOS object that can be added to
the newsroom system. If Auto-paste to Editor is selected, it will paste the XML directly to the
previously selected editor (for example a newsroom story editor).
The MOS object (XML data) is placed on the clipboard.

<nos>
<nosl t enBr owser Progl D>VCPAXFi | | er. VCPTenpl ateFil |l er<
/ mosl t enBr owser Pr ogl D>
<nosl| t enEdi t or Pr ogl D>VCPAXFi | | er. VCPTenpl ateFi | | er<
/ nmosl t enEdi t or Progl D>
<nos| D>PI LOT</ nos| D>
<obj | D>EMBEDDED</ obj | D>
<npsAbstract> FirstNanme Last Nane Desi gnati on</ nosAbstract >
<cr eat edBy>SoneUser </ cr eat edBy>
<creat ed>2007-11-12T13: 05: 05</ cr eat ed>
<descri ption> FirstNane Last Name Desi gnati on</descri pti on>
<nosExt er nal Met adat a>
<npsScope>PLAYLI ST</ nosScope>
<nosSchenma>htt p: //wwv. vi zrt. coml nosCbj / enbedded<
/ mosSchema>
<nosPayl oad>
<enbedded it enp
<ext ernal _i d>200</ external _i d>
<fields>
<fiel d>FirstNane</fiel d>
<fi el d>Last Name</fi el d>
<fi el d>Desi gnati on</fi el d>
</fields>
</ enbedded_itenr
</ nosPayl oad>
</ mosExt er nal Met adat a>
</ mos>
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When the MOS object (XML data) is added to anewsroom story editor, it is possible to double-click
it and save it as a data element using Viz Pilot News, if needed.

6.7.2 Working with Quick CG
To open Quick CG

® Double-press the assigned activation key (default is CTRL).

To create a CG data e ement
Type CG data ||> i ~
|200-FirstName/LastMame/Designation  |£ @K}

1. Enter the template’'s External I D followed by a dash.

Enter the data separated with aforward slash.

3. Select newsroom story editor, and click the Auto-paste to Editor button (first button (upper-
right)).

4. Click OK to add the XML output to the editor, or

5. Paste it manually into the editor by pressing the CTRL+V keys.

N

6.8 Table Editor

# (textl (D1) Image 1 (D2)
AW vaar ¥l GLOBALS/IMAGES/HEADSHOTS/vaar

2 |[Oyvind ifis GLOBALS/IMAGES/HEADSHOTS/ oyvind
3 [Gerd ] GLOBALS/IMAGES/HEADSHOTS/gerdD9
4 |Kari Fl GLOBALS/IMAGES/HEADSHOTS/karil0
5 Wenche B GLOBALS/IMAGES/HEADSHOTS/wenche
6 [Beruta I GLOBALS/IMAGES/HEADSHOTS/ beruta0é
7 |E5ias ¥ GLOBALS/IMAGES/HEADSHOTS/ esias003
8 |E|i gz GLOBALS/IMAGES/HEADSHOTS/eli
9 |Bjerg I8 GLOBALS/IMAGES/HEADSHOTS/bjorg002

If ascene contains a Control List plug-in and the Table Editor Component, a table editor will be shown
for that tab field when the sceneis edited in Viz Pilot News or Director. Changes made in the table editor
will immediately be updated in the preview window.

6.8.1 Cell Editors

The cells have different editors depending on the data type they display. In addition to text fields, the table
editor can show the following specia editorsin the table cells.
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® |mage Cells: The drop-list shows alist of all images currently available for a specific column. This
provides a quick way of choosing images when many cells are to show the same image. The browse
button to the right opens the image pool.
EI I vizrt/documentation + -

® Number Cells: Scenes with exposed numbers, with and without decimals, get a small text editor
with a spin button functionality. Click the spin buttons, use the arrow keys, or enter them directly on
the keyboard to change the value.

® Checkbox Cells: For Boolean values, such as hide and show, a checkbox will be displayed.

6.8.2 Navigation and Sorting
To move between the cells, use the arrow keys on the keyboard.
The table can be sorted manually by clicking on the header bar of the column to sort by. Rows can be

rearranged manually by drag and drop. Click on the row once and hold the mouse button to drag and
drop it to its new location.

=] ¥Yiz/image//vizrt/tutorial /It Viz Weather 25
TR Viz /image/vizrt /tutorial /It Viz Engine 21
& Viz fimage fvizrt ftutorial /1o Yiz Trio 33

6.8.3 Customizing a Table View

I I I

#|a_1(2) |Games v E I'J
1 Manchester Utd 38 Description
2 |Chelsea a8 wa_1(2)
3 |Arsenal 38 v Games played (3)
4 [Liverpool 38 v Wen i?

v Draw (5}
3 |Everton 33 v Lost (6)
6 |Aston Villa 38 i

v Auto Width
7 |Blackburn 38 Enable Sorting

I8 [Portsmouth 38

Insert Row Ins
Insert M Rows ...

Edit Row

Delete Selected Rows  Del

Select All Ctrl+a
Cut Cirl+¥
Copy Ctrl+C
Paste Ctrl+v

Save Settings
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Right-clicking on the table header row opens the Table Editor’ s context menu, which contains the
following items:

#. Shows the row number
Description: Shows the description field. Descriptions can only be edited in Viz Artist by the
designer.

<Column names>: Columns can be hidden or shown by selecting or unselecting the column name.
Auto Width: When disabled the column width can be set manually.

Enable Sorting: Enables manual sorting of the table.

Clear Sorting: Clears any sorting and takes the table back to itsinitial state.

Insert Row (Ins): Inserts asingle row.

Insert N Rows...: Allows for multiple row insertion. The maximum number of rows allowed isset in
the scene design.

-,

Mumber Of Rows To Insert

.I -

-

Ok | Cancel |

Edit Row: Edit the row data.

Delete Selected Rows (DEL ): Deletes selected rows. For multiple select use CTRL + Left mouse
key or SHIFT + Arrow keys up or down.

Select All (CTRL+A): Selectsall rows.

Cut (CTRL+X): Cutsrows out of the table. Press CTRL+V to re-add the row(s).

Copy (CTRL+C): Copies rows from the table. Press CTRL+V to add the new row(s).

Paste (CTRL+V): Adds the cut or copied rows to the table.

Save Settings: Saves the column setting for an active template.

Note: The number of rows that can be inserted or deleted depends on the configuration of the
plug-in. See the Chart and List plug-insin the Viz Artist User’s Guide.

148



7 Director

Director is Viz Pilot’s control room application.

B Director ve.0.0 - User: NDW - Database: bgowep1/vizridb - MSE: localhost - oK
Fili Eﬂl_Fﬁ{ﬁm Teck Iuinsn_'-m Playlat  Windows  Halp

17.02.201%

03.03.301% 2 Eil Bojangles Robinson

BN Taltehip 09 Palican_Losdan 2 sl

B Bil Bojangles Robinson and Shirlsy Templemsf
BN ChelsesBadpeinimptiond 1 Gk

BN Taltshig £ Pelican_Lordan_2mof

This section contains the following topics:

Director Main Menu
Director Configuration
Director Preferences
Director Tools
Export and Import in Director
Viz Engine Preview in Director
Status Bars
Resource Panel
® Templates
Data
Playlists
Viz
Files
Trio
Media

149



* Cliplist

7.1 Director Main Menu

7.1.1 FileMenu

The File menu contains the following commands:

® Reconnect to Database: If the connection to the database for some reason islost, and the connection
should be re-established, click Reconnect to Database. It is also advisable to reconnect if the
application has been running unattended for along time.

® Refresh Scripts. Reloads al the scriptsin the database.

® New Playlist: Creates a new Playlist Window.

® View log: Opensthe View Log dialog box.

® Exit: Shutsdown Director.

7.1.2 Edit Menu

The Edit menu contains the Cut, Copy and Paste commands, which can be used to edit text.

7.1.3 Options Menu

The Options menu contains the following commands:

® Datalist: Displaysthe data elementsin the database:
® Show Last Two Weeks: Displays data elements created the last two weeks.
® Show All: Displays al data elements.
¢ Show X Day(s): Displays data elements that has been used the last X days.

¢ Delete Data Items: Opens the Delete Data Items dialog box.

¢ Keyboard Configuration: Opensthe Keyboard Configuration dialog box.

® Preferences. Opensthe Director Preferences dialog box.

® Hints: Enables/disables hintsin the Status Bars. Hints are displayed when the pointer is hovered over
items such as the Viz Gateway connection icon. Hints are enabled by default.

Default Gateway status: running . EGatewa\,.-' status: Funning L

Delete Data Items

| [kelete [ata ltems
Concept:
| <Al jl
Templats Type:
| <l jl
Delats all files older than (M/D/v): L DS/ete |
| a/17/2007 | Close
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This function will permanently remove data elements from the database that are not tagged as Library
elements. Library elements must be deleted manually.

® Concept: Setsthe concept from where the data elements should be deleted. Selecting Al
consequently deletes al data elements of all concepts for al templates that are not saved as library
elements.

® Templatetype: Setsthe template type from where the data elements should be deleted. Selecting All
consequently deletes all data elements of templates that are not saved as library elements within the
selected concept.

* Delete All FilesOlder Than: Deletes data elements, except those tagged as Library elements that
are older than the given date. Thisdate is by default set one week back in time.

7.1.4 ToolsMenu

The Tools menu contains the following commands:

® CameraControl (CTRL+W): Opens the Camera Control dialog box.

® |mport MOS message file...: Opens the Select MOS Message File To Import dialog box. This
enables users that need to manually export a playlist from a newsroom system, to have the playlist
sent to the Media Sequencer through Director.
Browse for and select the exported newsroom playlist to be added to the Media Sequencer, and click
Open.

® Template Wizard: Opens Template Wizard. This menu option is only enabled when Template
Wizard (template design tool) isinstalled alongside Director.

¢ Show Command Console: Opens the Commands window, see Show Command Console.

®* Media Sequencer Configuration: Opens the Media Sequencer Configuration window. All
configuration options available through this window are stored on the Media Sequencer.

® Profile Configuration... (CTRL+M): Opens the Profile Configuration window. Profile
Configuration is used to configure the Viz profiles that are used for playing out graphics and video.

® Post Render Device: Opens the Post Render Device window.

® TimeCode (TC) Monitor: Opens the Timecode Monitor window. This option isonly available if
video playout isintegrated.

® Export: Opensthe Export from Director window.

® |mport: Opensthe Import into Director window.
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Camera Control

Camera Control =
Cam 2 Cam 1 Cam 4 Cam § Cam §

Cam 1

13 14 15 16 17 18

19 20 21 22 23 24

Virtual cameras are set up in Viz Artist. The Camera Control in Director controls the virtual cameras, so
that image sequences may be used together with the templates. In avirtual studio system, this window will
call matrix setups as they are defined in the Viz 1O setup. If no virtual studio is available, button 1: 16 will
cut between virtual cameras 1: 16.

Select Camera Control on the Tools menu, or pressthe CTRL+W keysto use the Camera Contral.

7.1.5Viz Engine Menu

The Viz Engine menu contains the following commands:

® Show CMD ON (SHIFT+CTRL+C): Shows the Viz Engine console window on the program
channel, and verbose all commands being sent and received.
® Show CMD OFF (SHIFT+CTRL +F): Hides the Viz Engine console window on the program
channel.
® Cleanup Renderers: Unloads all scenes, images, and fonts from both program and preview
channels, and resets them to their initial state.
® Commands. Controls the playout of the loaded scene:
® Start: Runsthe scene on the selected program channel.
® Continue: If the scene contains stop points, and the current state is at a stop point, click
Continue to run the animation from this stop point until the next.
® Stop: Stops the running animation.
® Reset: Resets the animation to its start state.
® Clear: Clearsthe layers of the loaded scene:
® All Layers: Clearsall layers.
® Front Layer: Clearsthefront layer.
® MiddleLayer: Clearsthe middle layer.
® Back Layer: Clearsthe back layer.
® | ocal Viz Engine Preview: OpensaLocal Preview in Director window.
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® Remote Preview (CTRL +P): Opens a Remote Preview in Director window.

7.1.6 Playlist Menu

This menu option isonly visible when a playlist is open. In Director it is possible to import a playlist from
an XML file. The XML file must be created with references to templates and data that will be inserted into
the playlist, thus creating new data elements during import. A template reference is areference to the
external ID registered for atemplate using Template Wizard' s template manager tool.

The Playlist menu contains the following commands:

¢ XML Filler: Use this option import aplaylist file (XML file).
® Open: Creates anew playlist based on the content of the XML file.
¢ Add: Appends the content of the fileto anew or existing playlist.
® Clear Playlist: Clearsthe playlist by removing all elementsin it.
® Saveto database: Savesany playlist held by the Media Sequencer to the database. Imported
playlists are added to the Media Sequencer that Director is currently connected to.
Toimport aplaylist that has been saved to the database, go to the Resource Panel > Playlists tab >
DB Exported Tab. Double-click the exported playlist. The playlist is opened and listed under the
imported node by its save name.

XML example

The XML example below contains the name of the playlist, a group and three elements with an external
ID (t enpl at el D). External IDs are configured in Template Wizard' s template manager tool per
templ ate.

<?xm version="1.0""7>
<playlist>
<nanme>Nane of playli st</name>
<group visible="true" name="G oup nane">
<event >
<tenpl at el D>100</ t enpl at el D>
<dat aNanme>Dat a El enent Nane 001</dat aName>
<comrent/ >
<dat a>
<fi el d>Fi rst Nane Last Nane 001</fi el d>
<fi el d>Desi gnati on 001</fiel d>
</ dat a>
</ event >
<event >
<tenpl at el D>100</ t enpl at el D>
<dat aNanme>Dat a El enent Nane 002</ dat aNanme>
<coment/ >
<dat a>
<fiel d>Fi rst Nane Last Nane 002</fiel d>
<fi el d>Desi gnati on 002</fiel d>
</ dat a>
</ event >
<event >
<tenpl at el D>100</ t enpl at el D>
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<dat aName>Dat a El enent Nane 003</ dat aNane>

<comment/ >

<dat a>
<fiel d>First Nanme Last Name 003</fiel d>
<fi el d>Desi gnati on 001</fiel d>

</ dat a>

</ event >
</ group>
</ playlist>

7.1.7 Windows Menu

The Windows menu options are commonly used to quickly cascade or tile the playlist windows.

The Windows menu contains the following commands:

® Cascade: Arranges all open playlistsinto a cascaded stack, and displays the playlists in the Work

area.
® Tile: Arrangesall open playlists horizontally from the top of the screen to the bottom, and displays
an equal part of all the playlists.
® Hideresourcebar (CTRL+B): Hides the Resource Panel. Alternatively, use the keyboard shortcut
CTRL+B. The Control panel is displayed by default.

7.1.8 Help Menu
The Help menu contains the following commands:
® Director Help (F1): Opens the online version of the Viz Pilot User’s Guide (this document). A local
copy can be accessed from the Windows Start Menu.

® About: Opens the About window that contains information about the installed Viz Pilot version. A
link to the list of Third Party Component Creditsis also available.
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7.2 Keyboard Configuration

Keyboard Configuration

Shortout | Keyoode Commmands |*

gui

mos

playlist

script

viz
reset_viz_engine
start_local_preview
set_onair Alt+Ctrl+ A
show_viz_commands Alt+Ctrl+C
hide_viz_commands &lt+ Ctrl+F

+ [+ F [+

register_onair Ctrl+0O
unregister_onair
get_preview Ctrl+pP
Import... Export... (0] 4 Cancel

The Keyboard configuration window allows the user to define macros assigned to specific key
combinations, pre-defined functions and VB Scripts. The latter is an option to further enhance and adapt
the commands. It is also possible to configure specific key combinations to trigger GPI actions from
Director.

Select Keyboard Configuration from the Options menu to open this window, which displays a selection
of the configured commands. A full list of the Predefined Functionsis available by selecting the Add
Macro option in the context menu.

The recommended alternative to GPI triggering using the LPT portsin Director isto add a GPI card to the
Media Sequencer machine. This allows the user to trigger client side macros and pre-defined functions
forwarded by the Media Sequencer to Director or server side commands to the Media Sequencer using its
pre-defined commands.

7.2.1 Keyboard Configuration Window

The Keyboard Configuration columns:

® Shortcut: Displays the macro name.
® Keycode: Displays the keyboard shortcut.
® Commands: Displays the shortcut command.

The Keyboard Configuration buttons:

® |Import: Opens the Open window where a previously exported KBD (keyboard) file can be
imported.
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® Export: Opensthe Save As window where the current settings can be exported as a KBD file.
® OK: Savesthe keyboard shortcut configurations, and closes the window.

File location: PROGRANMDATA% Vi zrt\ Vi z Pil ot x.y\Config\keyboard. kbd
® Cancel: Closes the window.

The context menu contains the following options:

Add M acro: Opens the Macro Shortcut window, where a new macro can be created.

Delete Macro: Deletes the currently selected macro. Alternatively, click the keyboard shortcut
CTRL+Deélete.

Remove Shortcut: Deletes the shortcut key code of the currently selected macro. Alternatively, click
the keyboard shortcut Delete.

7.2.2 To work with macros and shortcuts

To add a macro command, select Add Macro... .from the context menu to open the Macro Shortcut
window, then enter the key combination, macro category:macro name and commands
To edit amacro command, double-click it to open the Macro Shortcut window.

To delete amacro command, select it and then either pressthe CTRL+DEL keys, or select Delete
M acr o from the context menu

To remove a macro command shortcut, select the macro and then either press the DEL key, or select
Remove Shortcut from the context menu

7.2.3 Macro Shortcut
Edit Macro Shortcut @

Enter Key: |Ctr'|+5hi1"t+N| |

Macro name: |rna|:rc:5:New w/ Script Editor |

Global [#]

Description: |New Template and Show Script Editor |

Macro commands

Macro Commands | WB Script

gui:new_template -
gui:show_scripteditor

Show Macros... Save as New Ok Cancel

The New/Edit Macro Shortcut window is opened by selecting Add Macro from the Keyboard
Configuration Window context menu, or double-clicking an existing macro.

The Macro Shortcut window contains the following fields and buttons:
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® Enter Key: Setsthe keyboard shortcut for the macro.

® Macro Name: Displays the macro category (e.g. macros:, gui:, viz: ) and the name of the macro. If a
folder was selected when the Macro was opened, the category name will automatically be displayed
in the Name text box. The category name can be set or changed in the Name field by adding the
category and macro name separated by a colon (<macro category>:<macro name>).

®* Note: If acategory is not added to the name it will be placed in the macros category. It isalso
possible to add new categories by defining them in the macro (e.g. foo:bar).

® Global: Makes the macro work also when no playlist is open.

® Description: Description of the macro.

® Macro Commands. The names of the selected Predefined Functions are displayed.

® VB Script: A text field where script code can be entered. This provides the possibility to further
enhance and adapt the commands.

Macro Commands | VB Script

1 snb BEunScript

F Pme ] I
= encer code nere

3 b';ffe:'_c:'_ea:'

4 buffer put "-1 RE}-IDERER’TREE’ETLELES_sh;ft’Z‘RA‘-ISFCR
5 SET O 43 av
-]
7 end sub
L4 b

IMPORTANT! The function stub named RunScript must be used as the main script or entry
point for other scripts; hence, it cannot be renamed or removed.

® Show Macros: Opens the Predefined Functions window.
® Save As New: Savesthe macro as a new instance.

® OK: Savesthe macro, either as a new or modified macro.
Cancel: Closes the window, without saving any changes.

7.2.4 Predefined Functions

27 Predefined Functions

Functions:

=+ Commands # I IRun specific MSE element
+ camera
t channelcontrol
= control
‘run_element{ElementPat:
run_element_with_context(E -

Add Close
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In the Predefined Functions window alist of functionsis accessible to the user. Additional information is
displayed in the right-hand column.

Tip: User information for each language is stored under %°r ogr anti | es(x86) % Vi zrt\ Vi z
Pil ot x.y\scriptdocs

7.3 Director Preferences

Selecting Preferences on the Options menu opens the Preferences window. The Preferences dialog is used
to set parameters for Director and the Viz Pilot database.

This section contains the following topics:

® Startup Preferences

® Genera Preferences

® Viz Connection Preferences

® Playlist - Genera Preferences

® Playlist - Colors Preferences

® Playlist - Filters Preferences
® Tocreate anew playlist filter

¢ Remote Preview Preferences

® VizWorld Preferences

® Spellcheck Preferences

® Resource Plugins Preferences

7.3.1 Startup Preferences
Preferences [_Jﬂh
- General Startup
~Viz ;Dr'r'e':tmn [] allow multiple copies of Director to be loaded
- Playlist

- General []
- Colors _ _
_____ Filters [ ] Disable Autc Open Of Recent Playlists

® Allow multiple copies of Director to be loaded: If enabled, multiple copies of Director can be
loaded simultaneously.

® Autostart local Viz Engine preview: If enabled, alocal instance of Viz Engine will automatically
start when Director is launched.

¢ Disable Auto Open Of Recent Playlists: When checked, any opened playlist(s) will not be opened
when restarting Director.
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7.3.2 Genera Preferences

Prefersnces [iE-J

- Startup .
i General settings
- \iz Connection [ ] confirm before closing Director
- Playlist
- General [] Hide resource buttons
- Colors . .
Filters [] show Viz host name in status bar
R_ernute Preview [] Opentemplates in a new window
~Viz World
- Spellcheck [] automatically close templates after saving

- Resource Plugins :
g ] Send cpen template to preset viz channel

Custom number of days to show in data list:

Crop tool save path: | | Browse |

Media Sequencer Engine

Hostname: | |

Mote: For the change to take affect, yvou need to restart
Director

® Confirm before closing Director: If enabled, the user must confirm that Director should close.

® Hideresource buttons: If enabled, the buttons on the Buttons panel will be hidden. The different
views can still be selected through the Drop-Down list.

® Show Viz host namein status bar : Shows the Viz Engine hosthame on the status bar.

® Open templatesin a new window: If enabled, the template will be opened in a separate window.

® Automatically close templates after saving: If enabled, templates will be closed automatically
when being saved.

® Send open templateto preset viz channel: Sends the open template to the preset Viz Engine
channel.

® Custom number of daysto show in datalist: Shows dataitems that has been used the last number
of days.

® Crop tool save path: Setsthe path for the image saved when using the Crop tool in Viz Pilot News.
See Image Component.

® Media Sequencer: Setsthe hostname of the Media Sequencer machine.

7.3.3 Viz Connection Preferences

Preferences [i_E-J
- Startu . . .
5----Gener§| iz Engine Connection Timeout
® iz Connection -
E--Pla'flist Mormal operation timeout: |1CIUUU |
. - General -
- Colors Check connection timeout: |SUU |
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® Normal operation timeout: When browsing for datafrom Viz, and if Viz is not sending a response
within X ms, an error report will be displayed. By default the Normal Operation Timeout value is set
to 10.000 ms (10 sec).

® Check connection timeout: Right-clicking the Viz Connection icon on the Status bar, makes the
Check Connection operation available. If Viz Engine does not respond within X ms after checking
the connection, the Viz Engine connection icon turns red. By default the Check Connection Timeout
valueis set to 500 ms.

7.3.4 Playlist - General Preferences

Prefersnces I,ﬂhJ

- Startup .
- General Playlist
- Viz Connection ] use playlist from <= 5.7 (deprecated)
E_]..
- General ] confirm before itemn is deleted
- Colors _
‘. Filters [] Loop playlist
~Remote Preview [ 1 Preview templates automaticall
- Viz World = &
- Spellcheck ) [] Play =ound when MOS playlist goes inactive
- Resource Plugins
[ 1 allew only cne ocpen playlist
[] Image bar navigaticn
[] Fade non-zelected images
[ 1 image bar on top
Cursor position
) 50 %

® Useplaylist from <=5.7 (deprecated): If enabled, the old (deprecated) playlist will be used.
Otherwise, the new playlist will be used.

® Confirm beforeitem isdeleted: If enabled, the user must confirm that the del ete operation should
be carried through.

® | oop playlist: Loops dl the elementsin the playlist.

® Preview templates automatically: Opens the selected element in the playlist automatically.

® Play sound when MOS playlist goesinactive: Plays a sound whenever the newsroom (MOS)
playlist goesinactive.

® Allow only one open playlist: Makes sure that only one playlist can be open at atime. When
opening aplaylist, other open playlists will be closed.
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® |mage bar navigation: Selects the corresponding element in the playlist when athumbnail on the
Image bar has been selected.

® Fade non-selected images: Fades all images, except for the selected thumbnail .

® |magebar on top: Shows the Image bar at the top of the playlist.

® Cursor position: When the playlist’s cursor is active (see playlist Legacy Playlist Context Menu), it
decides where in the window the cursor stays in the situations described above. The position can be
adjusted by moving the slider control.

7.3.5 Playlist - Colors Preferences

Note: These settings are only relevant for the deprecated playlist. The new playlist which is available
with Viz Pilot 6.0 and later does not use background colors, but other, non-configurable visua clues
for a subset of the below categories. To select which playlist you will use, go to Playlist - Genera

Preferences.
Preferences LJﬁ
- Startup .
- General Playlist colors
~Viz Connection O L Status Colors:
=N F’_la'y’liSt Initialized — —
-~ General O Uninitialized atus | Color
Colors aborted [ clRed
- Filters O Locally Last Flayed cued clyellow
- Remote Preview cuing cllime
-\iz World O Selected done clSilver
- Spellcheck . playing clSkyBlue
- Resource Plugins Faulty Color not w ==
O Group - EEEE -
B cFurple
O Runnable group B ciT=al ]
O Warning clSilver r
: B clRed
O HETIE clLime
O Played clellow -
O Composite
O Global Last Played
O Global Last Cued Add | Delete |
Default Colors
DK | Cancel |

The Colors window displays status colors of the different elementsin the playlist. The element colors can
be customized. To change the color of an element, click the colored circle adjacent to an element label. In
the Color window that opens, pick a color, and then click the OK button.
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Some of the notable Playlist Colorsthat can be configured are:

¢ Runnable group: Refersto timeline editor groups (runnable groups). Makes it possible to color
video timeline groupsin the playlist differently than other groups.

® Global Last Played/Cued: Refersto data elements played or cued by the Media Sequencer based on
commands issued by other control clients or through a GPI.

® Default Colors: Loadsthe default color settings.
The Status Colorslist refersto the Status column in the playlist. To add a color to an Media
Sequencer status, click the Add button. Select the Status column of the new entry that appearsin the
Status Colors list, and then type the appropriate status name. Then select the Color column of the
entry. In the drop-down list that appears, select acolor.

® Add: Adds anew color to a Media Sequencer status.
® Delete: Deletesacolor.
Alternatively, click the ellipsis (...) button to select a color using the Color Picker.

When creating a category in Template Wizard, it is possible to use that category to set which category a
template belongs to, and eventually which channel it is played out on. Note that the channel name
configured in Template Wizard must correspond with the profile configured for Director. See Categories
and Channels.

A category can be used to filter the different template variants. For example a Lower third (straps) filter,
or afullscreen filter. In some cases the graphics are played out on different renderers. Thus the channel
configuration adds a usable feature to differentiate the output.

To filter by category in the Playlist Window, select Subcategory in the Playlist Filter and Filter Editor.

7.3.6 Playlist - Filters Preferences

Note: These settings are only relevant for the deprecated playlist. Filters for the new playlist can be
configured by using the filter button on the toolbar of the playlist. To select which playlist you will
use, go to Playlist - General Preferences.
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#

Preferences ﬁ
- Startup .
- General Playlist filters
- \iz Connection Filters:
= Playlist | Lower3rd ﬂ|
= General _
o Colors New... Edit | Delete |
- Remote Preview
- \iz World
- Spellcheck |L¢:|Wer3rd |
- Resource Plugins
Show [Filter
available
= pilot
] FullScreen
Thirds
[] Hide empty groups
Aoply Zance|

g

® Filters: Displaysthe available operator defined filters.

®* New: Makesthe categories and Name field available to create anew filter.

® Edit: Makes the settings belonging to the selected filter editable.

® Delete: Deletes the selected filter.

® Name: Displays the name of the filter.

* Hide empty groups. Hides empty groups.

® Apply: Appliesthe new or modified filter settings.

® Cancel: Cancelsthe recent filter settings.
The images below depict the same playlist. The first shows a playlist with three data elements. The
second shows the same playlist with the Lower3rd filter (see Legacy Playlist Toolbar) turned on.

] [u] [o] [u] o] [2) P5] [P 68 BA coomt conon -

mnlumw Losd  Initishire Cleanup -

Hame Channel Template Wariant
I Lower3rd element | CHAMMEL 1 « Lower3rd_template [Dafault] «
0 Fullscreen element [MAIN] Bullet_w_image_te...[Default]
0 0TS element [MAIN] OT5_template [Default]

o] (o] 18 [ [E = € E [T o

mknusﬂrw&mmdtdm NS ke  Fiter -
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] [m] [o] [u] ] [b) PO] [P 88 BH comt comon -

Continue Take Ot Cip Load H'l:lm Cleanip -
| .."!"“ | Channel |"Fariant

CHANMNEL 1

Select the Director Preferences option on the Options menu.
Select Filters under the Playlist category.

Click New... to add a new filter.

Select the category, or categories, which the filter appliesto.
Click Apply, and confirm the diaog to save the new filter.

akrwbdpE

Note: All category and channel configurations are saved to the Viz Pilot database. Filter
configurations are saved to the Media Sequencer.
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7.3.7 Remote Preview Preferences

Prefersnces

é?ﬂr;ggl Remote Preview
-\iz Connection Server
El- P:la'fliSt [f] Use this server (override database settings)

gslr;?;al Hest:  |vizEngine2 |
- Filters Port: (50008 |

- Remote Preview

~\iz World Animate

- Spellcheck [] Always show "Animate" button

- Resource Plugins

Poll Interval (sec):

Size and pos

Width: |512 |

(Recommended min: 512)
[[] Open as child window
X 1100 |
Wi |D |

Remote preview is afeature that is used to see snapshots of scenes rendered on aremote Viz Engine, and
should not be mistaken for the preview channel.

Note: If the Viz Engine Preview plugin is enabled, local preview will start instead of remote preview
(snapshots). The plugin can be disabled in the Viz Pilot Configuration Tool.

® Usethisserver: Enablesthe user to set host and port parameters locally in order to override the
remote preview configurations on the database.

® Host: Defines the external Viz Engine host name.

® Port: Setsthe external port number. Recommended port is 50008.

® Alwaysshow “ Animate”’ button: Enables the Animate button in the Remote Preview window.

® Poll Interval (sec): Sets how often Viz Engineis polled for a new snapshots of the previewed scene.

® Width: Setsthe width of the preview window.

® Open as child window: Opens the window within the Work area.
® X: Setsthe X coordinate. 0 is the value in the upper left corner.

For more information see also the Configuring Remote Preview for the Newsroom configuration.
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7.3.8 Viz World Preferences

.
Zeca— =
- Startup =
- General Viz World Settings
D‘;‘:Z ?DQHEEUD” Wiz World Server hostname for maps
+- Playlis . .
- Remote Preview (comma separate when multiple serverz):
g Viz World 10.200.100.75 | Reset |
- Spellcheck
- Resource Plugin

® VizWorld Server: Sets the hostname or | P address of the Viz World Server.

7.3.9 Spellcheck Preferences

e \
Prefersnces @

- Startup
- General Spellcheck

- Wiz Connection Spellcheck dictiocnary path

= Playlist |<local> |
- General
- Colors Spellcheck dicticnary filename

- Filters len_us |
- Remote Preview

- Viz World
® Spelicheck Rezet |

® Spdicheck dictionary path: Sets the path to the dictionary files for the spell checker. If empty, the
default dictionary location isused: %°r ogr anti | es(x86) % vi zrt\ Cormon\ di ct s

® Spellcheck dictionary filename: Sets the filename of the dictionary files. For example en_USrefers
to the affix file en_USaff and dictionary file en_USdic.
For full details on setting these parameters, see spellcheck _dict_path and spellcheck _dict_filename
in the Database Parameters.

Note: Spell checking can only be enabled for TTWUniMemo (Unicode Memo Component) and
TTWUniEdit (Unicode Edit Component) components.
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7.3.10 Resource Plugins Preferences

e
Prefersnces u

- Startup
- Genearal Flease select what resource plugins you want to load on startup
I (=
; [ Trio

- General

- Colors

- Filters
- Remote Preview
- Viz World
- Spellcheck
- Resource Plugins

® Trio: Enablesthe Trio resource panel.

7.4 Director Tools

This section contains the following topics:

®* View Log

® Show Command Console
® Post Render Device

® Timecode Monitor

7.4.1View Log

'. o View Log: C\ProgramData‘\Vizri\Logs\Viz P rector-2014-08-22-115138.log )

=== | ogfile created 22/08/2014 11:51:38: Version: 6.0.0 build 20006 ===

22/08/2014 11:51:38,799:  Startup parameters: "C:\Program Files (x8&)\Wizrt\Viz Pilot
22/08/2014 11:51:38,800: IniFile: C:\ProgramData\Vizrt\Wiz Pilot 6.0\Config\ContentPi
22/08/2014 11:51:38,935: <<< Entering TirmMain.FormCreate =>>

22/08/2014 11:51:38,935: Display splash screen

22/08/2014 11:51:28,991: Reading ini-settings from C:\ProgramData'\Wizrt\Wiz Pilot 6.0
22/08/2014 11:51:38,999: Deleting old log files

22/08/2014 11:51:39,000: Initializing MSE connection object

22/08/2014 11:51:39,000: Connecting to MSE @ localhost
22/08/2014 11:51:39,032: Creating MSE Gateway data module
22/08/2014 11:51:39,033: Creating Profile Status monitor
22/08/2014 11:51:39,033: Creating MVCP server connection monitor
22/08/2014 11:51:39,034: Loading MSE settings

22/08/2014 11:51:39,034: Creating Playlist Listing Controller

1 il

Open from the main menu: File > View Log.
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The View Log window displays the log messages that have been generated by the system. Individual log
messages are al so displayed as Status Information in the Errors Window.

Thefull log files can be accessed. Default log file locations are as follows:

® OPROGRANMDATA% Vi zrt\Logs\Viz Pilot x.y
Eureka Log files (.elf crash log files) for Director, Template Wizard and Viz Pilot News can aso be
found in this directory.

See Also
® |LogFiles

7.4.2 Show Command Console

)
A commands 2O

RESULT: OK

COMMAMND: gui:show_playlists

RESULT: OK: Playlist Path=,directony/playlists
COMMAND: playlist:collapse

RESULT: OK

COMMAMND: guishow_playlists

RESLILT: OK: Mo init peformed, empty PlayListPath
COMMAND: playlist activate

RESULT: OK

COMMAMND: playlist start

RESULT: OK: TakeSelected

playlist:activate _v || Execute

E plavlist:activate
playlist:active_playlist_storage_path
plavlist:add_selected_dataitems
playlist:append_last_in_group [
playlist:clear
playlist:clear_all_user_settings
playlist:close

plavlist:collapse i

The Commands window can be used to see the macro commands that are executed when different user
operations are performed. The window is aso helpful in learning the different macro commands.

To show Commands
® Select Show Command Console from the T ools menu.
To run acommand

® Enter the name of the command (e.g. gui : new_pl ayl i st) in the combo box, and then click the
Execute button to run the command.
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To lookup commands using apropos

The Commands window has alookup function named apropos that is helpful when searching for
information about a command.

1. Open the Commands window
2. Enter eg. apr opos run_el enent and press Enter
® Thefollowing result should appear:

COMVAND: nmmai n: apropos run_el enent

RESULT: control:run_elenent(restString ElenmentPath) : Run
specific MSE el enent

control :run_el ement _wi th_context(string El enentPath, string
Cont ext Narme, string ContextValue) : Run specific MSE el enent
where ContextNane is a comma separated |ist of Names and
Cont ext Val ues their val ues

7.4.3 Post Render Device

Post rendering is used to create images or video files of graphical scenes. The files can be used for playout
on Viz Engine. Selecting avideo plugin will create one file; however, selecting an image plugin will
render an image according to the configured frame rate. For example; Rendering a scene for five seconds
will result in 125 images if the frame rate is 25 frames per second (fps).

Rendered data elements can be full screen graphics or graphics with Alphavalues such as lower thirds and
over the shoulder graphics.

This section contains the following topics:

® Post rendering window
® To post render a scene
® To setup arender device

Post rendering window

rﬂ Post Rendering E]@“
Host name | J| Connected From: _

Plugin |VideuRenderer j|
Format |Fu|| Frame j|
Codec |uncampressed j| RGB || RGBA
FPS 25 -

= o] [g]

Cutput path |vcpclip | =]
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The post render devices are automatically setup and do not need any configuration. Any changes to the
device settings will be maintained between recordings.

® Host name: Displays the render engine that is configured in the profile configuration. To change the
render engine, open the Profile Configuration.

® Plugin: Setsthe renderer device. Options are defined by the installed codecs on the render engine.

® Format: Setsthe format of the clip. Available options are Full Frame, Fields Top, Fields Bottom,
Full Frame/Interlaced Top and Full Frame/Interlaced Bottom.

® Codec: Setsthe codec to be used.

® FPS: Setsthe frames per second. Available options are 25, 30, 50, 60, 29.97 and 59.94.

® Qutput path: Setsthe filename. A full or relative path can be added. If no path is given, thefileis
stored in the Program Files folder, or, for Windows 7 and later, the Virtual Store folder on the
rendering machine (%L OCALAPPDATA%\Virtua Store\Program Files\Vizrt).

® From: Setsthe start time in seconds.

® To: Setsthe end timein seconds.

® RGB: Setsthe pixel format to RGB.

® RGBA: Setsthe pixel format to RGBA which includes the alpha channel (blending/transparency).

® Record button (circle): Starts the rendering process of the selected data el ement. Clicking the
Record button will run the recording process according to the duration interval set using the From
and To parameters. Controlling the data el ement is possible during the recording.

® Stop button (square): Stops the rendering process before the configured stop time.

To post render a scene

1. Open adataelement.

2. Open the Post Rendering window.
3. Set the output parameters.

4. Click the record button.

To setup arender device

® Rendering is automatically configured.

Note: For more information about how to use the Device Manager in Viz Artist, seethe Viz
Artist 3.x User’'s Guide.
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7.4.4 Timecode Monitor

5 TC Monior i ocaos e Convece] A ==

Viz PGM

nature-2.mxf + Avd 2¢h
Video PRW B

00:00:14:16 00:01:39:09

Video PGM

profil: PR R4 ©

Selecting Timecode Monitor on the Tools menu opens the TC Monitor window. Timecode Monitor
monitors the timecode and the video server channels; hence, it will only work if the system is configured
to be integrated with a video server or Viz Engine. Director uses the Multiport Video Control Protocol
(MVCP) to communicate with atrandator (Xlator) which again communicates with the video server.

For more information on supported video server setups, please contact Vizrt (see Customer Feedback and
Suggestions).

The Timecode Monitor displays three columns: Channel, Status and Armed.

® Channel: Name of the Channel. Video channels appear as light grey rows, with progress information
in the Status column. Non-video channels are shown as dark grey rows without status.
® Status. The name of the current item, followed by any cued item, is displayed above the progress
bar. Current Location time and Remaining time are shown below the progress bar. The progress bar
changes colour to indicate status:
® Green: Video playing
® Red: Video playing, less than 10 seconds remaining
¢ Blue: Video finished
®* Armed: Displaysthe armed state of an element on a channel. This feature is not used in Director.
Therowsin thelist can be shown or hidden using the context menu on each item:

® Hide: Hide the selected channel
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¢ Show All: Show all channels
At the bottom of the window is the zoom function to adjust the display size, and the Profile selector
which displays the current profile name, and allows selection of other profiles.

The Timecode Monitor opensin full screen by default. Press the ESC key to exit full screen mode.

IMPORTANT! In order to monitor video clips that are embedded in graphics, the Viz channel must
also be defined as a video device channel.

7.5 Export and Import in Director

This section contains the following topics:

® Export from Director
® Import into Director

7.5.1 Export from Director

In the Pilot Exporter window, playlists, templates and data elements can be exported to file. This option
supports export of al the included templates, concepts, scripts, standalone and transition logic scenes.
Data elements can exported as part of aplaylist, or individualy. Playlists and all parts of the templates are
exported to an XML file, and the related scenes are exported asa Viz archive file (.via).

This section contains the following topics:

® Pilot Exporter Window
¢ Example Export Folders

Pilot Exporter Window

Note: Pilot Exporter is not available while using the Legacy Playlist. To enable Pilot Exporter, you
must first enable the new Playlist Window. Go to _Options > Preferences > Playlist > General > Use
playlist from <= 5.7 _and uncheck this option. (See Playlist - General Preferences).

To export:

1. ConfigureaViz preview channel in Profile Configuration.

2. Select Tools > Export to open the Pilot Exporter window.

3. Drag Playlists and Templates from the Resource Panel onto the Pilot Exporter window, and click
Next.
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% Pilot Exporter = |- B S|

L
- ~ P '] - -
% Lontrot_List Image_timing

Pp=_ PFPlaylistB

— B

Cancel Mext

4. Enter apath and filename for the exported XML file (See Example Export Folders).

Optional: Check the Create Viz Archive Export option to export Viz scenes. Enter a path and
filename for the exported Viz archive.

IMPORTANT! The Viz Engine archive file can only be created if the Viz Engineis
connected and On Air, and the specified path exists on that machine.

Pilot Exporter ==
2 Configure
Export sethngs

Please select the path and name of the file you wish to export the selected
data to.

z Archive Export
CAPilotExport-20160525-115353.via

: Viz Engine to be used to export scenes: localhost

Back Export

Viz Engineto be used to export scenes: The Viz Engine machine on which the Viz Archive
Export will be created. Exporter selects the Viz Engine according to the following rules

1. If the currently active profile has a preview channel defined, use that Viz Engine, otherwise use
the program channel.

2. If the channel is configured with multiple Viz Engines, use the one at the top of thelist.
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If the profile is modified after the Export window has been opened, but before the Export button is
clicked, then the export runs against the reconfigured channels. Changing the profile settings
during the actual export will not change which Viz Engine the export uses.

5. Click Export, and then check the progress and status of your export.

% Pilot Exporter = |- B S|

3 Export
Watch progress

V' Playlist: PlaylistB

v DataElement: test

v Template: Control_List_Image_timing

v Writing archive: C:\PilotExport-20160525-115353 xml

v Exporting Viz Archive (this may take a few minutes): C:\PilotExport-20160525-115353.via

Export successful.

Copy to clipboard Back Close |

6. Click Close.

Example Export Folders

Export of templates and scenes will be exported to different folders, unless a shared export folder is
mapped on both the control and render machines.

Normally, the Pilot archive file (.xml) will be placed on the user’s machine, and the Viz archive file (.via)
will be placed on the Viz Engine (see the table below).

When exporting graphics, a preview channel must be configured and used.

Path Filename Comments

C:\temp\ archivexml Pilot archive filename. In this
example, the temp folder must be
present on the users machine, and
the user must have write access.

C:\temp\ archivevia Viz Engine archive filename.The
_ Viz Engine archive path
(archive) automatically defaults to match the
(archive.eva) Pilot export path, above. In this

example, the temp folder must be
present on the Viz Engine machine,
and the Viz user must have write
access. If thefile extensionis
missing Viz will automatically add
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Path Filename Comments

one (e.g. archivevia). If thefile
extension is not correct according to
Viz, Viz will replace the extension
with the correct one (e.g. archive.txt
will become archive.via).Note that
thereis no feedback from the Viz
Engineif the path does not exist and
the file is not created.

Not specified archivevia In this example, the archive will be
placed on the Viz Engine, inthe Viz
3.x program folder:Windows 7: %
LOCALAPPDATA%
\ Vi rtual St ore\Program
Files\Vizrt\Viz3}}
W ndows XP: {{%
Prograntil es% Vi zrt\ Vi z3

\\host\ archivevia The Viz machine must have write
access to the UNC path.

7.5.2 Import into Director

In the Pilot Importer window, playlists and data elements can be imported from file, including the
templates, concepts, scripts and transition logic scenes that are required by them.

Note: The folder structure used for organizing the templates must be the same in the import
environment as it wasin the export environment. Also, resources (such as images used by data
elements etc.) must be accessible in the same location (file path) in both export and import
environments.

Pilot Importer Window

To import playlists, templates and scenes:

1. Select Tools> Import to open the Pilot Importer window.
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i

Pilot Importer | =l=] [g]

Import-file:
CAUsers\anj\Desktop\Pilot_template\NightLivexml|

Archive contains 1 playlist, 1 template and 1 data element that can be imported.

Note: Scenes, in the form of Viz archive (.via) files, cannot be imported using the Pilot
Importer. However, they can be imported directly into Viz Artist or Graphic Hub. Seethe Viz
Artist User’'s Guide and Graphic Hub User's Guide.

w

Click Next.

4. Select the templates, data elements and playlists to be imported. In the search toolbar the user can
filter on templates, data elements and/or playlists using the designated buttons, or type in a search
based on name, modified date or template name.

Pilot Importer EI

2 Elements

Select elements

0 data elements, 1 playlist and 0 templates selected.
Q | 5

OTS Image p_ Nightlive
0 1 —_ B

Import

5. Click Import, and then check the progress and status of your import.
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i "

Pilot Importer =[5 S

Import
Import to database

Reading archive: C s\anj\Desktop\Pilot_templateiNightLivexml
Importing template "0

Importing element "0

Data element and Template import completed

Importing playlist "MNightLive"

Import completed.

To clipboard

6. Click Done.

7.6 Viz Engine Preview in Director

Local preview uses aloca Viz Engine, while remote preview uses aremote Viz Engine.

® | oca Preview in Director
® Remote Preview in Director

See Also

® Viz Engine Preview Configuration
® Viz Engine Preview in the Newsroom
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7.6.1 Local Preview in Director

=

@ Local Viz Engine Preview = . "EDE:

Local Preview meansthat aViz Engineisinstalled locally on the Director machine for preview purposes.
It also requires the Viz Engine Preview Plugin which is not enabled by default, but can be enabled
/disabled in the Viz Pilot Configuration Tool.

See Configuring Local Preview.

Theinterface is the same as used in Viz Pilot News, see Local Preview in the Newsroom.
To seealocal preview

Set alocal Viz Engine (i.e. localhost) as the preview renderer in the Profile Configuration.
From the main menu select Viz Engine > Local Preview, or press CTRL +P.

Open aplaylist.

Right-click the playlist and check the Auto preview option (which allows preview to be sent as
soon asaniteminthelist is selected).

5. Click adataelement and it will be sent to the preview window.

AW PRE
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7.6.2 Remote Preview in Director

Remote Preview meansthat a Viz Engineisinstalled remotely on another machine for preview purposes.

This option allows you to see aremote “snapshot” preview (still or animated) of atemplate or data
element. Animated means that a series of frames are fetched from the preview renderer on-the-fly; hence,
it isnot areal-time rendering. However, if you have a reference monitor connected to your Viz Engine's
DVI/VGA output you may use the preview window’s control buttonsto play or scrub the graphicsin real-
time.

To configure Remote Preview, see Configuring Remote Preview in Director.

This section contains the following topics:

® Properties and Parameters
® To see aremote snapshot preview

Properties and Parameters

® Start: If the graphic has two or more tags on its timeline, this asks Viz Engine for a snapshot of the
first frame or the first tag on the main (default) director. If the scene, or foreground scenein
transition logic terms, has a pilot1 tag it will by default jump to that tag on the director and show that
frame.

¢ Continue: If the graphic has two or more tags on itstimeline, this asks Viz Engine for a snapshot of
the remaining tags on the default director.

® Key: Showsthekey signal of the graphics.

* Timefield: Shows the current timeframe for the scene. Allows the user to scrub the scene manually.
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® Tagfield: Shows the scene s director tags on the Default director. These tags are used for
previewing the scene, and are not actual stop points. Proper stop points enable the use of Continueto
trigger the animation and should not be used for creating tags for preview purposes.

® Animate: AsksViz Engine for a series of snapshots according to the Remote Preview Preferences
configuration under Director Preferencesthisin turn is played out in sequence in the preview
window in order to animate the scene.

® Title Area: Shows the boundaries of the defined title area (green rectangle).

¢ Safe Area: Shows the boundaries of the defined safe area (purple rectangle).

® Copy: Copiesthe current snapshot onto the Windows clipboard.

® Save: Savesthe snapshot asa PNG file.

® Error: Showsthe error log for the current session.

® Connection: Shows the current Viz Engine connection status.

To see aremote snapshot preview

1. Right-click in the playlist and from the context menu select Auto Preview
2. From the main menu select Viz Engine > Remote Preview, or press CTRL +P
3. Open aniteminthe playlist
® Thiswill send apreview to Viz asking for the first frame of the scene or the frame of the first
preview tag

7.7 Status Bars

(a:_ vizPGM | ] vizPvw | BB Video PYW
Ic‘l'}efault good: Commands processed @g E

The Status bar is positioned at the bottom of the window, and consists of:

1. Profile and Channel Information
2. Status Information
3. Status Indicators

7.7.1 Profile and Channel Information

Profile Context Menu

Profiled

'D' Viz PGM Profile Configuration... M EE Video PVW
Profilel

Right-clicking the profile name will open the Profile Context Menu:

* Profile(s): Showsthe available profile name(s), and indicates the current profile.
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® Profile Configuration: Opens the Profile Configuration window.

Channél Context Menu

Viz PYW

'0 bgodecenginel G

[ | 0%
I 1%

I
= bgodocenginel G

W
P Provier | BN
O vizeem | L2 vizPvw |

Profilel

Right-clicking the Viz Channel will display a context menu for setting the channel as a program or
preview channel. In addition it will display the Viz Engines that are configured for that channel and their
current status.

Clicking on the refresh icon next to the Viz Engine name refreshes the status indicator and current
memory usage bars.

Clicking the Channel indicator when it is disconnected (status: red) makes the system try to reconnect (see
the Profile Configuration window).

7.7.2 Status Information

Status information is positioned to the lower left.

Profilel Active profile - right click to change

Profilel MSE Database connection : Connected

Profilel error: connection failed, please check settings.

Status information gives feedback on different objects in the Director user interface and from connected
systems. Theinformation is divided in the following two categories:

® General information: General information is displayed when a pointer is positioned over objectsin
the user interface that contain information relevant to the user. When the Hints area displays general
information, it remains its default color (grey).

® Error information: Error information is displayed if errors occur. When the text field displays error
information, the text field background color turnsred. Error information is also displayed in the
Errors Window.

7.7.3 Status Indicators
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L vizeem | vizPvw | [PE Video PYW

default good: Commands processed = E

Status Indicator Items

[tem

Description

()

M edia Sequencer’s database connection: Indicates status of the Media
Sequencer’s connection to aViz Pilot database. Hover over theicon to
display more information about the connection.Green: The Media
Sequencer is connected to a Viz Pilot database (see the Media Sequencer
Configuration configuration window). Note however that it will be green
even if the database the Media Sequencer is connected to is different from
the one that Director is connected to (for example Director connects to
Graphic Hub, while the Sequencer connects to Oracle).Red/Orange:
Indicates a problem with the Media Sequencer’ s database connection.
Check its configuration by double clicking on the icon and/or check the
Media Sequencer logs.Gray: The Media Sequencer is not configured to
connect to aViz Pilot database, or information about the status of the
connection is currently not available. Check the Media Sequencer’s
configuration by double clicking on the icon.

Viz Gateway: Green if the Media Sequencer is connected to Viz
Gateway. Red if thereis no connection. Clicking the indicator whenitis
disconnected (status. red) makes the system try to reconnect (see the
Media Sequencer Configuration configuration window).

Matrix: Greenif Director is connected to Viz 1O. Red if thereis no
connection. Clicking the indicator when it is disconnected (status: red)
makes the system try to reconnect.

Viz One: Green if the Media Sequencer is successfully connected to Viz
One. Red if the configuration is not working properly (e.g. failed Viz One
search). In serious situations, where the Viz Oneis unavailable, an
additional pop-up error message will appear. In this case, videos that have
already been transferred to Viz will still work, but any new videos will not
be transferred.Double-clicking the indicator opens the Media Sequencer
Configuration configuration window.

Errors. Turns red when errors occur. Clicking the button opens the Errors
Window. Errors that occur are saved in the Errorslog, and displayed in
the Errors window.

O

Viz Channel: Displaysthe status of the Viz channel’s Viz Engine(s).See
Profile and Channel Information.

Video Channel (clapperboard): Shows whether the Media Sequencer is
successfully connected to a Viz Video Engine, Viz Engine or other video
servers for video playout. See Profile and Channel Information.

182



Errors Window

rﬂ Errors E]@W

made because the target machine actively refused it. -
error: connect tcp to localhost: 6100 (0x0000274d) Mo connection could
made because the target machine actively refused it.
error: connect tep to localhost:6100: (0x0000274d) No connection could
made because the target machine actively refused it.

Close Clear log

The Errors window contains two buttons.

® Close: Closesthe Errors Log dialog box.

® Clear Log: Removes dl the error messages from the log window, but not from the log file. The
Errors window also closes, and the Errors button is hidden until there is new error log information to
display.

7.8 Resource Pandl

TemplatE5| Cata Blaylists Wiz Files |
Cliplist Media Clesign Trio
MSE Flaylists DB Exported
M ame I State
£ MOS Flaylists
Mew playlist 10:74 A [jir] Inactive

Director can be configured to access up to nine different resource pools. The resource panel is positioned
to the left in the main program window. The buttons and the drop-down menu can be used to open various
resource pooals.

Templates and Data give access to all graphics templates and data elements stored on the Viz Pilot
database. Data elements are templates that are filled out by users of the system (e.g. journalists or
operators).

Playlists give access to all playlists stored on the connected Media Sequencer. They are either manually
created, or MOS monitored by Director when created from a Newsroom Computer System (NCS).

Selecting Viz opens access to elements on the Graphic Hub (viaa Viz Engine).

Files gives access to the local computer’s file system. This should be used with caution as selected files
have to be accessible from all devices using them (including Viz Engines).

Cliplist connects to video servers over the MV CP protocol.
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Media gives you access to the media repository of Object Store and Viz One. The Media tab enables the
operator to search for and add image and video items directly into the playlist or to the templates/data
elements through drag and drop.

Selecting Trio gives accessto Viz Trio's show folders and shows that are stored on the same Media
Sequencer that Director is using. Accessing the shows enables the user to drag and drop Viz Trio pages
into a Director playlist.

The Designtabisnot in use.

7.8.1 Resource Search
33| Find: | |ﬂ ﬂ

Typing the first |etters of the name of aresource in the search area, marks the resource that correspond to
the lettersin thelist.

The resource search applies to the Templates, Data, Playlists and Trio.

7.8.2 To show the Search Area

1. Right-click aresource list, and select Find, or

2. Pressthe keyboard shortcut keys CTRL +F

3. Enter the search criteria, and navigate up and down with the arrow buttons to find the next or
previous resource matching the search criteria.

7.9 Templates

Templates are built using Template Wizard. Templates are used to add content to the graphics and to a
certain extent control the look and feel.

This section contains the following topics:

® Template Panel

® Concepts and Variants

® Template Control Buttons
® Template Save Dialog Box
® Template Spell Checker

® Timeline Editor Preview
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7.9.1 Template Panel

Concept:

|Demo j]

Select template:

M ame Image -
T
Edit Template
Find Crl4F
e L Somimages

maps_largetemplate

perzaninfo "
33| Find: | |ﬂ ﬁ

Data stored on the Viz Pilot database with references to atemplate and sceneis, when it is displayed in
Director, called a Data element. Data el ements added to a Playlists are stored on the Media Sequencer for
playout, and are consequently stored with references to the templates and scenes.

A templateis used to populate one or many data elements in order to have elements with differing content
(e.g. text, images, video), and differing control parameters than another Data elements.

Additionally, atemplate, and consequently a data element, may belong to one or many concepts (e.g.
Sports and News scenes) and belong to one or many variants of a scene (e.g. Sports lower and top thirds).

Note: All (<All>) templates are listed the first time Director is started. The next time Director is
started it will remember which concept was selected and start with that concept template listing.

Context Menu - Templates

Context menu for the columns:

® Auto Width: When enabled (selected) Auto Width expands the columns and distributes them
evenly.

® Enable Sorting: When enabled (selected) Enable Sorting enables the user to sort the list (ascending
/descending).

Context menu for the resources:

¢ Edit Template: Opensthe template in Template Wizard for editing.

® Find: Displays the Resource Search.

® Show Images: Adds the Image column to the Template list, and shows thumbnails of the scenesin
this column.
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Working with Templates
To open atemplate

® Double-click atemplate to open it, or right-click and select Open from the context menu.
To select aconcept and variant

1. Open atemplate from the resource panel.
2. Inthetemplate’s window click the Concept and Variant drop-list, and select a concept and variant.

7.9.2 Concepts and Variants

I Templates Crata Flaylists WIE

Cliplist Media

« [>] [&] PB] [
Back Start Load Continue Tak

Templates

Concept:

| Sports j]
Select template:
M ame

-
—

Edit Ternplate
Find

Ctrl+F

Show Images

Tip: Thetemplate list is aphabetically ordered (ascending). Click the Name column to reverse the
order (descending).

The concept drop-down list in the resource panel displays all available concepts, and is basically used to
filter the templates that belong to each concept. When saving a template, the data element will be stored
with the selected concept and variant. These can be changed later on by the operator when the data
element is added to the Playlists or by opening the Data element and selecting a different concept and

variant.

~ VisualDataTools vizlengine 3.0 Plugins [ EENISUSNDSEIIGEER. Viz|Engine 3.0 Plugir
Make your case visual Make your case visual
‘Whiual Dats Tooks 210 Vil Data Tools

m o
100 4 9% 95
» 3 50

L]
I

I|IIII|I _— |III| _—
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Concepts are essentially a means of reusing content for graphics that have the same properties. Having the
same properties enables the template designer to create one template for several scenes that have the same
properties. The operator is then able reuse the parameters saved with the data element and switch concepts
and variants without re-entering the data for each Data element in the Playlists.

When using a newsroom system for story creation the journalist is able to select which concept or variant
a specific story isto be aired with. Thiswill save time before a story is put on air, and consequently
pushes the deadline for when a story isready for playout to near real-time.

In addition the control room operator has the freedom to override these settings, in order to reuse any
content, as long as the template supports the concept and variant to be used.

Note: Concepts and variants are created and organized by the template designer using Template
Wizard. Templates are stored on the Viz Pilot database.

7.9.3 Template Control Buttons

Each template has the same set of control buttons and options.

al (v (& R (D= %

T
Back Start Load Continue Take Qut | Sawve Close

® Back: Rewinds the sceneto frame 0.

® Start: Runsthe scene from the current frame

® | oad: Loadsthe scene.

® Continue: Continues the scene from the stop point.

® Take Out: Takes the scene to the out state stop point. If the sceneis based on transition logic, the
sceneis cleared.

® Save: Opensthe save dialog saving the current data added to the template. Will also open the spell
checker before the save dialog if spell checking is enabled and misspelled words are used.

® Close: Closesthe template.

7.9.4 Template Save Dialog Box

rﬂ Save [ﬂ_f-y

|NewDataElemenﬂ Save as new

] Finished [] &ddte library

Cancel

® Description: In the text box, type a description that uniquely identifies the data el ement.

® Finished: If the settings are final, select the Finished check box. Thisinformation will be stored on
the database. If a data element is finished it can be shown in the Finished column in the playlist
displaying either 1 for finished and O for not finished.
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® Addtolibrary: Select this checkbox if the data element will be used often and you want to prevent

it from being deleted. The data element will be saved as a library element, and all concept and
variant information is kept. This prevents the data element from being deleted when using Options >
Delete Data Items. Library elements can still be deleted manually, and if the original template is
deleted in Template Wizard, all data elements based on the template will also be deleted, including
library elements.

The Add to library checkbox will by default be unchecked. To Overwrite an already existing library
element, select the Add to library checkbox, click Overwrite and click Yesin the confirmation dialog.

Note: Data elements that are saved as library elements, will appear with an asterix (*) after their
name in the Data element list.

Save as new (Alt+S): Creates a new data element.
Overwrite (Alt+O): Updates a previously created data element. If the data element is new, the
Overwrite button will not be available.

® Cancel: Cancels the save operation.

7.9.5 Template Spell Checker

-

Spellchecker Dictionary: en_US from localhost

LInknown word

What not to write

Suggestions:

not -
ont
net
it
it
newt
snot
kot
note
]
sot

Change

Change All

Skip

Skip Al

............................................

rot

............................................

The template spell checker processes the text as part of the save operation. If spell checking is enabled the
spell checker dialog will appear.

Spell checking is enabled by the template designer using Template Wizard. Spell checking can be enabled
in Unicode Edit Component and Unicode Memo Component text fields.

® Change: Changes the marked (red) word with the suggested word moving on to the next misspelled

word. When done the spell checker opens the save dialog.

® Change All: Changes all misspelled words that are the same as the checked word in one operation

moving on to the next misspelled word. When done the spell checker opens the save dialog.
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® Skip: Skipsthe marked (red) word moving on to the next misspelled word. When done the spell
checker opens the save dialog.

® Skip All: Skipsal misspelled words and opens the save dialog.

® Cancd: Stopsthe spell checking operation going back to the template editing view. The save dialog
is not opened.

Note: When creating multiple data elements based on the same template (without closing it), the
spell checker will remember previous spelling corrections and automatically apply them to new
data elements before they are saved.

7.9.6 Timeline Editor Preview

Timeline Editor Preview in Director

% Image_Video = Eel =1
T
wl (p| |&] b D, P
Back Start Load ContinueTake Qut  Save Close

Concept: |News ﬂ| Variant: |Default

A basic version of the Timeline Editor is available for previewing video elements from within atemplate
or data element. Video preview and scrubbing is available, however the controls for timeline manipulation
are disabled.

Context menu for avideo in atemplate or data el ement
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The Preview option is available from the context menu of the video control.
Preview is only available if the image component in the template listsisVideoMediaSearch init’s
ImageSources, and is only enabled if avideo asset is actually selected.

See Template Wizard Components for information on image components.

7.10 Data

Concept:

|News j

Template name:

|<All> ~|

| M amne I Template | D ate I Image
Mew_Barz_ 001 Chart 10.09 2009 e s e
15:39:48 —
b\ Open I e
. ... AR, ..............
Refresh

Mews_Lower3rn
Show Library Items Only

Find Ctrl+F
Delete
Mews_Super_0
Show images
Show termnplates

Show dates

The data elements view enables the user to see alist of all data elements or see afiltered view by selecting
concept and/or template from the drop-lists.

Data elements are described with name, template name, date of creation and a thumbnail (if the
Thumbnail Generator is used).

Data elements are based on templates and can be created by the Director operator; however, in most cases
data elements are created using Viz Pilot News, for example by journalists. Data elements are then used to
populate the playlist.
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Data elements that have been saved as library elements are suffixed with an asterix (*), (see Template
Save Dialog Box).

This section contains the following topics:

® Context Menu

® To create adata element
® Toedit adataelement

® To delete adata element

7.10.1 Context Menu

Context menu for the columns:

® Date: Shows the date and time the data element was created.

® Template: Shows the template the data element is based on.

® Auto Width: When enabled (selected), Auto Width expands the columns and distributes them
evenly.

® Enable Sorting: When enabled (selected), Enable Sorting enables the user to sort the list (ascending
/descending).

Context menu for the resources:

® Open: Displays the selected data element in the Work area.

® Refresh: Refreshes the elementsin the Data list.

® Show Library Items Only: Shows only the elements that have been created in previous versions of
Director, and that are stored in the library.

® Find: Displays the Resource Search.

* Delete: Deletes the selected data element. A confirmation dialog box appears when trying to delete
library elements.

® Show images: Displays the Image column.

® Show templates: Displays the Template column.

® Show dates. Displays the Date column. This column is displayed by default, and the data elements
are sorted by date. Clicking the title area of the Date column reverses the sorting.

7.10.2 To create a data element

1. Open atemplate from the Templates resource list.

2. Fill the template with data (e.g. images, text and so on).

3. Click the Save button.

4. Enter anamein the Template Save Dialog Box and click the Save as new button.

7.10.3 To edit a data element

1. Double-click the data element, or
2. Right-click it, and select Open.
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7.10.4 To delete a data element

1. Select the data element and press the Delete button on the keyboard, or
2. Right-click it, and select Delete.

7.11 Playlists
The Playlists panel displays the available playlists on the Media Sequencer.

This section contains the following topics:

® Playlists Panel
® Context Menu
® Working with the Playlists Panel

7.11.1 Playlists Panel

MSE Flaylists DB Exported
[Name | Created | Profile | State |
Dremo Playlist 1 26,05, 2016 13:30:3 default Active: default
-l 9 F-:ulder.-'l'-.
...................................................................... 3EI 0E 5016 1455 2 defaul atve defou
F'IayllstE 14:5... 30.05.2016 14:56:4 default Active: default
-1 &= MO5 Playlists
+ ] OCTOPUS?
1 TENPS
PlayliztB 02032015 14:25:4 |nactive
PlaylistC 0203201514265 |nactive
] i | BN

MSE Playlists Tab
Media Sequencer playlists can be created in two ways:

1. Createplaylistsin Director by right-clicking inside the M SE Playlists tab and selecting New
Playlist.
2. In most cases, playlists are created by newsroom systems that are monitored and played out by
Director or other control applications such asViz Trio or Viz Multichannel. These appear in the
folder MOS Playlists.

The newsroom playlists are stored on the Media Sequencer, and updated through the Viz Gateway
or Viz Device Manager. Viz Gateway supports most newsroom systems that support the MOS
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protocol. Viz Device Manager only supports Avid iNEWS Control Air.

MOS Playlists can be opened in Director once the Viz Gateway Connection has been configured
in Tools > Media Sequencer Configuration > MOS Tab.

Options:

Right click on the column headers in the M SE Playlists tab to select which columns you want to view (
Created, Name, Profile, State)

Right-click in the list to access:

®* New Playlist, New Folder
® Open, Open in New Window
® Activatein current profile/ Deactivate

Note: When the state is set to active, and the playlist contains video clips, the Media Sequencer
will trigger transfer of video clipsto Viz.

DB Exported Tab
Listsall Media Sequencer playlists that have been saved to the database.

Toimport aplaylist in Director that has been saved to the database, double-click aplaylist. The playlist is
opened and listed under the imported node by its save name.

Imported playlists are added to the Media Sequencer that Director is currently connected to. It is not
possible to overwrite a previously imported playlist when importing.

(Playlists are saved to the database by going to Playlist Menu > Save to database)

7.11.2 Context Menu

Context menu for the columns;

® Created: Displaysthe Created column. This column shows the date and time that the playlist was

created.

®* Name: Displays the Name column. The name column shows the name of the playlist. Nameis
enabled by default.

® Profile: Displays the Profile column. The column shows which profile each playlist is configured to
use.

® State: Displaysthe State column. Possible states are Active or Inactive.

® Auto Width: When enabled (selected), Auto Width expands the columns and distributes them
evenly.

® Enable Sorting: When enabled (selected), Enable Sorting enables the user to sort the list (ascending
/descending).
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Context menu for the resources:

® New Playlist: Creates anew playlist in the Playlists resource list.

®* New Folder: Creates anew folder in the Playlists resource list.

® Open: Displaysthe selected Playlists.

® Openin New Window: Displays the selected playlist in a separate window.

® Activatein current profile: Activates and monitors the selected playlist in the current profile, and
enables the Media Sequencer to trigger transfer of video clipsto Viz.

® Deactivate: Deactivates and stops monitoring of an activated playlist.

® Find: Displays the Resource Search.

® Rename: The selected playlist may be renamed.

® Delete: Deletes the selected playlist. Alternatively, use the keyboard key Delete (Ddl).

Note: New Playlist, New Folder, Rename and Delete operations can only be performed on
Director playlists or folders that group Director playlists.

7.11.3 Working with the Playlists Panel

This section contains the following topics:

® To create anew playlist

® Toopenaplaylist

® To add adata element to a playlist

® To set the same concept for the whole playlist

® To select aconcept and variant using the playlist

To create anew playlist

1. Right-click the Playlists Panel, and from the Context Menu select New Playlist, or
2. Select New Playlist on the *File *menu.
® Thiswill set the focus on the new playlist.

To open aplaylist

1. Double-click aplaylist namein the Playlists resource list, or
2. Right-click the Playlist entry, and from the Context Menu select Open.

To add a data element to aplaylist

1. Select the Data resource panel.
2. Drag and drop the data element(s) onto the playlist.
® |f the element is dropped over an existing element, the new element is positioned above the
existing.
® If the element is dropped in an empty section of the Playlist, the new element is positioned at
the bottom of the list.
3. Arrange the order of the elements by drag and drop.
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To set the same concept for the whole playlist

1. OpenthePlaylists.
2. Select the concept from the Concept dropdown on the toolbar.

To select a concept and variant using the playlist

1. Open the Playlists where the Data element was added.

2. Select the Data element, and then select the new concept and variant from the element’s Concept
and Variant column.
See also how To select a concept and variant.

7.12Viz

Templates Cata Flaylists Wiz Files Cliplist | Media
Soene Image EEam Material Font
-1 Objects -
-1 PixelFX
-1 RealFx
-] Scripting
-] shaders
-~ TextFx
-0 - |
=-CJ Images
=1 LiberoVision -

Aoy 4 Fogm | Vsl DainToos Ao 4 Fogm

[ Maig paur e visual

.'fﬂwhm ) ' tase vis il mﬂ#!hl}ll

Chart_wariant=Scatter Chart_variant=Pie Chart_wariant=Bars
Vi Duta Toots artgmiinan | Wi Din Tools artgeniman [ Wi Dan ool g 1 e
mﬂ#'\lhuﬂ mﬂ#uhml mﬂ#!huﬂ :

*nwow o o

Chart_wvariant=Line Chart_variant=Graph Chart_variant=5tock

The Viz button refers to the currently configured Viz Engine preview channel and its Graphic Hub
connection. By clicking the Viz button, Director is able to show the different scenes, images, objects,
materials and fonts available to Viz Engine.
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The Viz panel (akathe treeview browser) also has arange of buttons/tabs that displays different views of

different items/objects available to Viz Engine. The display area shows the directory and the contents of

the currently selected folder. Below there are some options for refreshing the views and sorting the order

of thelisted items.

‘Note: Viz images can be played out as fullscreen stillstore images; however, this requires astill store
scene. See Enable Fullscreen Stillstore Images.

® Scene: Shows available Scenesin Graphic Hub. Server relates to the Server - Scenesoptionin Viz
Artist.

[ Scens = Image D Geom Material [A Font

05_MP5_MLE 0¥_ARTIST_ENGIME_TRIO

28 o -
O Mame O Date B
[ ] rReverse =

® |mage: Shows available Imagesin Graphic Hub. Image relates to the Server - Images option in Viz
Artist.

[ Scene %= Image D Geom Material [A] Font

1 Garden_Flower ~
£ Hotred_Sports v
flanaer flovwer L8, fower L3 flower L2

(3 Name () Date [=
|:| Reverse A

® Geom: Shows available Geometry Objects on Graphic Hub. Geom relates to the Server - Objects
optionin Viz Artist.
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® Material: Shows available Material (colors) on Graphic Hub. Material relates to the Server -
Material and - Materials Advanced optionsin Viz Artist.

[ Scene = Image O Geom Material [A] Font

+ 1 wizMultichannel -
- &5 Wizhile
Iil NewScenes

new_matel... pellow areen blue

O Mame O Date B
[] rReverse =

® Font: Shows available Fontsin Graphic Hub. Font relates to the Server - Fonts optionin Viz Artist.

[ Scene = Image L Geom Material [A] Font
- &3] |[FONT Y
1 02200
1 aharoni r
o’ =
ABCabc1Z ABCabc123 —
Helvetica-Bald -Futura-Bald-Blur-1
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-. -
O Mame O Date B
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7.13 Files

|E2 k: \\viz-xw4300\objectstore - |
[= ke
(B images v Show Thurnbnail
£ bmp Show Text
v Auto Refresh
Refresh |
[

The Files view alows the user to use external images from local and remote locations. The drop-down list
basically shows the local drive and whatever drives are mapped to the computer. The display area shows
the external images found for each location.

Double-clicking an image will open a preview of the image.

7.13.1 Context Menu

® Show Thumbnail: Displays thumbnail images instead of text.
® Show Text: Displaystextual information regarding picture instead of thumbnails.
® Auto Refresh: Automatically displays the content of the folder selected in the Folder list.
"Note: External images can be played out as fullscreen tillstore images; however, thisrequiresa
till store scene or Image with Name and Title Linking component. See Enable Fullscreen
Stillstore Images.

Tip: Andternative to using the Files browser is to use isFileOpen in an image component
instead.

7.14 Trio

Viz Trio resources can be used in a Director playlist. Viz Trio has all its shows and pages (similar to
Director’ s data elements) stored and organized on the Media Sequencer.
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This section contains the following topics:

® Trio Pandl
® Context Menu

7.14.1 Trio Pandl
Show view
Show l Elements l
= Viz Trio Show.show
Demo Shows | | Wiz Trio Show with concepts.show

When clicking the Trio button, the Show tab is selected by default. The left pane displays the folder(s) that
organizes the different shows stored on the Media Sequencer. The right pane lists the show(s) organized
under each show folder. A show contains pages (data el ements).

Elements view

Zhaw Elernents l
Mame Description -
= MyPageGroup MyPagesroup
1201 Ministers in talks for...
1801, showTemplates ... Nelson B, Mandela/1,..
1200 Lower 3rd: Headline...
1250 Loawer 3rd: Headline...
1300 Lower 3rd: w/lmage...
1400 OTS: Text & Immage
1500 OTS in BACK layer: ...™
£ Find: | = Find Mext | < Find Previous
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Marne Description
=IMyPageGroup MyFagesroup
1201 Ministers in talks for ...
1301 Melson R. Mandelasl...
Zn01 Boeing 737-200 fPart,. .
ShowTemplates |
7.14.2 Context Menu

Context menu for the columns:

® Name: Shows the names of the elements.

® Description: Shows a description of the elements.

® Auto Width: When enabled (selected), Auto Width expands the columns and distributes them
evenly.

® Enable Sorting: When enabled (selected), Enable Sorting enables the user to sort the list (ascending
/descending).

Context menu for the resources:

® Show Templates: When selected, Show Templates will display all templatesin the currently
selected show as well as all the pages.

To open a show
® Double-click ashow (e.g. Viz Trio Show.show) to see its pages (data el ements).
To add elementsto a playlist

® Drag and drop pages (data elements) from the Elements view onto the playlist.

7.15 Media

The Mediatab allows users to search for media assets (i.e. still images and video clips) that can be added
directly to the story (e.g. afull screen video clip).

Mediainformation resides on storage systems such as Object Store and Viz One. Object Store
traditionally stores still images and person information. Viz One traditionally stores video, audio and
video stills. The Mediatab combines the sources into one.

This section contains the following topics:

®* MediaTab

® DetailsView

® Search and Filter Options
® Drag and Drop Support

® Order Management
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7.15.1 MediaTab

Media Tab with search results list and Details View:

e
=2
el

[ | 28/08/2014
[ | 11/09/2014

AGREEMENTS
AGRICULTURE
ALPINE

AMBULANCE SERVICE

Tallship Race 16
SWUPMBXZZLTTWMFQ

= News

Tallship_16_1.mov bergen Nonwvay
trade IBC2014

HES

The top pane shows the Search and Filter Options and alist of categories, while the bottom pane displays
the search results and, optionally, the item’ s metadata.
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Search results are limited to a 100 hits per source (e.g. Object Store or Viz One) in order to reduce
network load and to increase the speed of the search. The most recent assets are displayed first. If your
results exceed 100 it is recommended to refine the search.

Note that searching Viz One currently only supports free text search, while Object Store search supports
free text, setting from and to dates and use of one or multiple keywords.

If your search does not find the media you need, and you have Order Management configured, you can
submit an order.

Note: Depending on the data available from each provider, the status bar will display either
ProviderName=N of M shown or ProviderName=N found, where N will increase as more items are
fetched. If aprovider does not provide sufficient information, the status bar will display

Provider Name=unknown.

Context Menu for Search Results

Sort By L}, J Mame

Show Extra Metadata P T,

Show Details View Registration Date

Registration Date (Descending)
Launch Viz PreCut

Launch Viz EasyCut

Preview

M edia search results context menu:

® Sort By: Displays a sub menu with sort options.
® Name/Name (Descending): Sorts by name in ascending and descending order.
®* Registration Date/ Registration Date (Descending): Sorts by registration date in ascending
and descending order.
® Show Extra Metadata: Switches the mediaiconsto display metadata such as complete filename,
creation date, clip length and so on.
® Show Details View: Displays metadata of the selected mediaitem in a pane next to the Media pane.
® | aunch Viz PreCut: For items stored in Viz One, this opens the selected video clip(s) in Viz PreCut
for editing.
¢ | aunch Viz EasyCut: For items stored in Viz One, this opens the selected video clip(s) in Viz
EasyCut for editing.
® Preview: Previewsimages using the Windows Picture and Fax Viewer. |s only available for Object
Store items.
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Media Search Errors

® Startup Error: An error occurred during startup. The host (or Viz Pilot News) will need to be
started again to clear the error.
® Search Error: An error occurred during a search. Try doing the search again.

7.15.2 Details View

Display an item’s metadata by selecting Show Details View from the context menu in the search results.

The Details View shows the metadata that is received from the asset search provider. The type of data
available can vary, and can be configured in each asset search provider.

The Details View can be placed at the bottom of the search pane, or to the right. Use the context menu in
the Details View to change the location.

Tallship Race 16

Shown on right
Show on bottom k

28/08/2014
11/09/2014

AGREEMENTS
AGRICULTURE
ALPINE

AMBULANCE SERVICE

Both Object Store searches and Viz One searches support free text, keywords and from and to dates.
When the Search box is minimized, only the Search field and Type filters are displayed. Combine the use
of filters, text search and keywords to narrow down your resullts.
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® Search field: Combo box for entering a search criteria. Previously entered search criteriaare
remembered per session.

®* Type- Stills, Audio, and Video: Filters the search result displaying only images, audio or video,
according to which filters are enabled/disabled.
Use CTRL+click to select multiple types.

® Type - Person: Filtersthe search result displaying only picturesthat are defined as person (i.e.
profile) imagesin Object Store. See also Filter Media by Person Name.

Note: The Person Filter button is only available if a RestVOS Search Providersis configured. If
using standard Object Store, search for person name by typing in the Search field.

® Date: Filter results based on date range. Select from Last 24 hours, L ast week, Last month,
Custom daterange.
Filters the search result based on registration dates. For Viz One searches, the default date used to
search is the CreationDate (date the item was created in the Viz One), however this can be
configured to use other dates from the metadata (e.g. news.eventDate, asset.recordingDate, asset.
publicationDate, asset.retentionDate).

® From/To: When the Custom date range button is selected, the From and To dates are presented.
|A red background indicates that the from-date specified is later than the to-date.

® Keywords: Filters the search result based on keywords. Templates that use the RequiredK eyWords
property will have the relevant keywords pre-selected in the list. Keywords are configured for each
Service Provider. See Required Keywords.
Note that in Director, the Media Search is not bound to a specific template or data element, which
means that the search results cannot be limited to what' s relevant for a specific component in a
template. This means that all images show up in the search, but you are not allowed to drop them on
the image component if they do not respect to the keywords filter.
Still store images can be played out as fullscreen stillstore images; however, this requires a still store
scene. See Enable Fullscreen Stillstore Images.

If multiple Viz One systems are in use, all of them will be searched and the search results will be
combined according to the ID of the clip. i.e. If the same clip is available on multiple Viz One systems, it
will only appear once in the search results.

If your search does not find the media you need, and you have Order Management configured, you can
submit an order.

Drag and Drop Support

When selecting media assets from a search, both images and video can also be inserted with “ Drag and
Drop”, i.e. select the media and drag it using the mouse to the receiving media container.

In addition to resources from media searchesin Viz Pilot, external applications can be programmed to be a
provider of mediaresources using Drag and Drop. The required API for thisis specified in the Appendix,
see Integrating Drag and Drop from External Applications.
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7.15.4 Order Management

The Order Management System is designed to close the gap between the newsroom users ordering
content, and another department in the building fulfilling these requests. The Order Management System
isbuilt on top of Viz One, Vizrt's media asset management solution.

For more details see Order Management and how To configure Order Management.
To submit aWork Order from Director

1. Follow the procedure for To submit a Work Order from Viz Pilot News.
The only differenceisthat to begin submitting a work order, you drag the Order icon to the image
component in the template, rather than clicking an Order button.

130305_AR_4C_02jpg| 14_FLHX_R.jpg - PROMO

7.16 Cliplist

_ EETTEERE

Video server| bgovizvideol

1100090211000015307 #
movie/mxt/dv100 00:02:02:16
1100090211000024507

movie/mxt/dv100 00000959
1100090212000105607

movie/mxt/dv100 O00:00:29:10
1100090212000237207

movie/mxt/dv100 o0 10:32
1100090212000239207

movie/mxt/dv100 O0:00:13:24
1100090212000241207

movie/mxt/dv100 00004022
1100090219000355507 -

Director is able to monitor clips on avideo device (that supports the Multiport Video Control Protocol
(MVCP)). With MV CP support, operators can add clips to any playlist, trigger the clips manually for
playout, and monitor the playout status using the Timecode Monitor. The Timecode Monitor displays the
timecode, video server channels and clip duration. Video servers are added using the Profile Configuration
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8 Playlist Window

The playlist window in Director is used to add items (playlist elements such as full-screen images, videos,
template based scenes and so on) and to edit how items are ordered, grouped and played out.

New items can be added to the playlist in Director, or they can be added from external applications such
as Newsroom systems. The playlist and its elements can be configured in the playlist window.

A new playlist is created by clicking File > New Playlist or by the context-menu (right-click) in the
playlists overview window in Director. Each playlist can be separately Activated or Deactivated as
required.

This section contains:

® How do | open the playlist window?
® Organizing the Playlist

® Using the Playlist

® MOSPlaylists

8.1 How do | open the playlist window?

1. Start Director
0O More \/
Best match
Director 7.1
Desktop app
Apps >
g Maps
Documents >

| Recent Directories

dir

2. Click the Playlists Panel
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Eile Edit Options Jools Viz Engine Playlist Window

Templates

:: .

PlayLists

Mew playlist 2:24 PM [mac]

3. Double-click aplaylist item.
PlayLists

Mews [200BRZENPS 7] Inactive

Mark new playlist ODBR2ENPS 7vM] agractive
Hew playlist 2:39 P [mac] Active: Mark profile
MHew playlist 3:24 P [mac] Inactive

4. Theitem opensin the playlist window.

Fibe EditOpﬁon;Tooh Viz Engine Playlist Windows Help

Note: InViz Pilot 6.0 and later, the Playlist Window described here is the default, and the L egacy
Playlist is deprecated. Y ou can select which playlist to use in the Playlist - General Preferences
options.
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Note: Live Update of templates from Template Wizard has been superseded by Update Services. If
you need to use Live Update, you must also use the Legacy Playlist.

8.1.1 Areas of the Playlist
Demo Playlist 1 =N o>
20 2] B [ #H] [2 “@Easic o
Cue Take Continue Take out Init playlist | CleanUp .
@Es:cripﬁon | Template Id | Channel | Concept | Variant | Available
i Butterfly news item 11404 [PROGRAM] [Basic] [Defauli] & 100%
4 & 0TS headshot 1 11400 [PROGRAM] [Basic] [Default] 0 100%
B ARTS.muxf [PROGRAM] & 100%
b G Sports & 100%
& Vizrt Command 10045 [PROGRAM] + [Basic] #  [Default] =+ @ 100%:
Search Q| ‘)T-m filter> ¢ |+ =) - O Playlist Active ~ VDCP OFF
1. Playlist Tool bar
2. Concept selection
3. Playlist Columns
4. The Playlist Pane displays all items and groupsin the playlist. See also Using the Playlist.
5. Playlist Search field
6. Playlist Filter and Filter Editor
7. Thumbnail View
8. Playlist Status indicates the current playlist status. Clicking it activates/deactivates the playlist.
9. The VDCP button indicates the current VDCP status. Clicking it opens the Video Disk Control

Protocol (VDCP Tab) where you can configure VDCP parameters as well as stop or start the
VDCP handler.

8.2 Organizing the Playlist

Use the shortcut menu in the playlist columns described below to organize a playlist.
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8.2.1 Playlist Columns

After opening the playlist window (see How do | open the playlist window?) right-click a column header
(the Description column header is right-clicked in the image bel ow) to expose a shortcut menu with
options for hiding and showing all columnsin atemplate.

4| My New Rundown [2008R2ENPSTVM]

]

Init playlist

Descrinti : ——
escription % l‘/ Available lFarmel | Cc

Begin Time

+ Channel
« Concept
v Description
Duration
Effect
End Time

Laver

Tip: Click on itemsin the shortcut menu to select which columns should be displayed. Drag the
columns to rearrange them.

® Available: Displaysthe status of external resources needed by the Viz Engine (e.g. transferred video,
and if it isavailable on the video playout engines). Errors are shown as tooltips.

® Begin Time: Shows the activation start time for a group (format hh:mm:ss).

¢ Channel: Shows which output channel an element should be sent to. Various elements can be sent to
different output channels. The output channels can be set directly in the column. By default the main
[PROGRAM] output channel is selected, but this can be overruled by setting an alternative channel
for this element only or in atemplate (that all data elements made from it will have). By creating a
group and placing elements within it, all elementsin the group will be organized by having the same
channel. The Channel column is presented by default.

® Concept: Shows which concept(s) the playlist element is associated with.

® Description: Shows the description of the element. By default this will show the path of the scene
(or the element name of a stand-alone mediafile). May be edited in-line in the playlist.

® Duration: Showsthe length of the element.

® Effect: Opensthe Choose Effect dialog, which makesit possible to select a transition effect between
two pages.

¢ End Time: Showsthe activation end time for a group (format hh:mm:ss).

® | ayer: Allowsloading of graphicsin separate layers on Viz Engine (front, middle, back). For
example, alower third can be shown in front of avirtual studio set or any other background, or a bug
can be shown in the front layer while alower third is shown in the middle layer. This column is
presented by defaullt.
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® | oaded: Shows the loaded status (in memory) of the scene and images used for aplaylist element of
that scene. Errors are shown astooltips.

® | oop: Displays aloop information column.

® Mark In/Mark Out : Sets mark in/out times for video clips.

® MOSObjAir: Two states are possible: READY or NOT READY, as defined by the MOS protocol
(see www.mosprotocol.com). If READY no change to default, if element or group marked NOT
READY element will be skipped during playout.

® Playout Mode: The user can specify how groups should be played out and can choose between
None, Duration and Timecode. See Using the Playout Mode for more information.

® Story #: Shows the story number for storiesin MOS playlists. Thisis only supported from the ENPS
newsroom system.

® Template Description: Shows the template description (e.g. name).

¢ Template ld: Showsthetemplate ID.

® Timecode: Thetimecode is an offset time on format hh:mm:ss:ff. It indicates that an element should
be played out relative to the parent group or video. Thisis used for instance in composite groups
with avideo and overlay graphicsthat is played out on atimeline.

® Variant: Select aconcept’s variant from the drop-list (see the Concept column).

8.2.2 Other optionsin the playlist column shortcut menu

The last four items on the playlist window shortcut menu allow you to set default playlist layout, among
other things.

Note: Unlike the other options in the menu, selecting/de-sel ecting them does not hide or show
columnsin the playlist window.

[
My New Rundown [2008R2ENPSTVM] =n o x|
[E/
Init playlist | CleanUp v
Description + Available jprel | Concept | Variant | Avail:|
Begin Time
« Channel
+ Concept
«  Description
Duration
Effect
End Time
Layer
Loaded
Loop
Mark In
Mark Out
MQOS ObjAir
Story #
vos: @Active  HOST: 10. Template Description DN: 00:30:00 JPDATED: 10:40:58 AN
[search v Templateld st Active VDCP OFF
Timecode

Variant

Use Default

Auto Fit Columns

Enable Sorting
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® Storeas Default: Select this option to use layout and Playlist Pane settings for all new playlists.

® Use Default: Revertsto the default layout.

® Auto Fit Columns; Automatically fits all displayed columns to the given width of the playlist.

® Enable Sorting: Enables sorting. Click a column header to sort items. Items cannot be rearranged by

dragging

8.3 Using the Playlist

This section includes the following topics:

® Playlist Pane

® Playlist Cursors

® Playlist Tool bar

® Playlist Filter and Filter Editor
® Playlist Search

® Thumbnail View

® Playlist Status

8.3.1 Playlist Pane

When the playlist is active, you can double-click an item to bring up the template/form where you can fill
out information and/or take the item to air. Drag items to rearrange them or add them to groups.

Right-click an item to bring up the playlist shortcut menu:

ﬂ Director w7.1.0 - User: mac - Database: bgovep 1 fvizndb - MSE: localhost @
File Edit Options Jools iz Engine Playlist Windows Help

Take
Continue
Take Cut
Road
Prepare

Initiakize -

CleanUp

Schedule Playlist

Stop Plyist Playlist item
Set external GPI cursor ShOﬂCUt
Auto Preview me n u

«  Sync with Program Channel

Configure VDCP

Remave

Create Group

Tree

® Stop or Pause the video.
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® Cue: Preparetheclip for playout so thefirst frame isready in the player.

® CueAppend: Preparethe clip for playout. The clip will start automatically when the current clip
ends.

® Take: Performs adirect take on the selected page.

® Continue: Continues the playout of an element.

® Take Out: Takesthe element out (hard cut).

® Read: Readsthe element.

® Prepare: Prepare the clip in the pending player without affecting the current clip, so it is ready to be
played out. The clip will not start automatically after the current clip. Requires Viz Engine 3.3 or
later.

® |nitialize Playlist or I nitialize Element.

® Cleanup: Cleansup al renderersthat have an item in the current playlist (i.e. clears all loaded
graphics from memory for those channels). To clear all renderers, go to the Main Menu > Viz Engine
Menu > Cleanup Renderers

® Schedule Playlist: Activatesthe playlist. If for example Begin time has been set, the playlist must be
scheduled before the changes take effect.

® Stop Playlist: Stops apreviously scheduled playlist.

® Set external GPI cursor: Setsthe external cursor for aselected element. The cursor indicates the
element that will be taken if, for example, a*“take and advance” General Purpose Input (GPI) action
is executed.

® Auto Preview: Automatically enable preview of next element from selected.

® Sync with Program Channel: Sync the preview with what's showing on the program channel. Say
you have alower third on the preview and are showing a fullscreen video on the program channel.
See how they add up in the preview.

® Configure VDCP: Open the Video Disk Control Protocol (VDCP Tab).

® Remove: Delete the selected item(s).

® Create Group: Create a new group. The new group will be created above the currently selected
item. Groups cannot be created when multiple items are selected.

® Tree: Organize the elementsin the current playlist and change the font used

Tip: Right-click the column headers and select Stor e as Default to use these settings and to set
layout preferences for all new playlists. See Playlist Columns for more information.

8.3.2 Playlist Cursors

A cursor visibly indicatesthe item, if any, being acted on in a playlist. When aplaylist is active and
playing, the current item playing will be indicated with agreen arrow.

When GPI is enabled, the external GPI system’s cursor will be displayed in any client that is using the
same profile as the external system. Thered arrow indicates which item in the playlist is next, according
to the external automation system.

8.3.3 Playlist Tool bar

. n E “E @ E Q'T-I EQJ ﬂ Basic ¥

Stop Pause  Cue Take Continue Take out Init playlist | CleanUp =
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® Stop video, if running. Icon active (dark black) if video running.

® Pausevideo, if running. Icon active (dark black) if video running.

® Cue: Preparetheclip for playout so thefirst frameisready in the player.

® DirectTake: Performsadirect take on the selected page.

® Continue: Continues the animation on the selected page, or any that isloaded in the same transition
logic layer as the selected page.

® Take out the selected page, or any that isloaded in the same transition logic layer as the selected
page.

® |nit playlist / Init selected (Initialize): Loads the playlist or the selected page(s) on the program and
preview renderer.

® CleanUp (both visibly and loaded memory content) on the Viz Engine renderer.

® Concept: Select the required Concept for the playlist.

8.3.4 Using the Playout Mode

Selecting the Playout Mode as a playlist column the user can can choose between three options; None,
Duration and Timecode.

® Timecode is the default option and the time is set in the Timecode column. It indicates that an
element should be played out relative to the parent group or video.

® To enablelooping of agroup, the Playout Mode must be set to Duration before the Loop column
must be toggled on. The duration must be set on all elements in the Duration column. Remember to
use the Stop button in the Playlist Tool bar in order to stop the loop.

® The None option does not allow for playout.

® Other options besides None/Duration/Timecode that may be shown in this column are read-only.

8.3.5 Playlist Filter and Filter Editor

Qv TM},! Mosart ltems =,. +

| v (1) Playlist Active VDCP OFF

| <no filter=

My Mosart Items |'_," 'i'

Use the Filter option to filter what items the playlist will show. Y ou can create as many filters as required
with the New option and existing filters can be edited or deleted. When you have created filters smply
select the filter to usein the drop-down list. Any items that do not satisfy the filter selected will be hidden
from display, not deleted. Deselect filtering to show all items.

In the example below we create afilter that only shows itemsin the playlist where the description
mentions the word Mosart:
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Edit Filter

Filter name: | My Mosart ltems |

o All conditions match :_:' One of the conditions matches :_:' Mone of the conditions match

|| Hide empty groups |_| Filter on group

Mot | Property | Condition | Caze | Walue | _| _|
(] |Description % | | Contains s | |Mosart | |+ |
1 |Channel | [Startswith  #| [ |News | [+] [-

Use this filteras default [ ] [ 0K ||| cancel |

Use the drop-down entries and check-boxes to create afilter as required, based on the template attributes.

Note: To filter by the category assigned to the template, you must select Subcategory in the drop-
down. This selection will list all categories created using the Template Wizard client to help filter data
elements assigned to a given category. See also Categories and Channels.

8.3.6 Playlist Search
Search the playlist. Thisisasimple search, not afilter. Go to the next match by pressing Enter.

8.3.7 Thumbnail View

Change the thumbnail size.

Q| Y <nofiter> # |4 El.l () Playlist Active VDCP OFF

— Small lcons

Medium lcons

o
Large lcons

8.3.8 Playlist Status

If thereisa VDCP handler for the playlist in the Media Sequencer, this button will display the status.
Click the button to set the playlist to active/inactive.

8.4 MOS Playlists

MOS playlists (newsroom playlists) can be opened in Director once the Viz Gateway Connection has been
configured in Tools > Media Sequencer Configuration > MOS Tab.

An additional MOS status bar is displayed at the bottom of the playlist window when aMOS playlist is
open.
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Once Director requests the monitoring of aMOS playlist, it is presented as a playlist. Director then
monitors the playlist and receives updates from the newsroom system. The graphics can then be taken on
air from Director.

P =

& News 4 16:00 [OCTOPUST] =R
Q.T_I E—&J ﬂ <no concept> #
Init playlist | CleanUp

Description | Template Id | Channel | Concept | Variant | Available |
b This Story @ 100%
v @ PIRATES @ 100%
B test 10045 [PROGRAM] [Basic] [Default] @ 100%
& banner 10662 [PROGRAM] [TransitionLogic]  [Default] 0 1003

Mos: G Active HOST:10.211.111.127  starT: 2009-04-20T14:00:00 puramion: 00:11:09 urDaTeD: 12:00:00 PM

Q, Y | <nofilter> % |4

- (1) Playlist Active VDCP OFF

8.4.1 Request or Release aMOS Playlist

When aMOS playlist isfirst opened in Director, it is empty. Monitoring needs to be requested in order to
populate the playlist.

Right-click on the MOS Status Bar to request or release aMOS playlist:

® Request: Begin monitoring, and populate the Director playlist with the elements from the newsroom
system. Once the monitoring is active, al subsequent updates done to the newsroom rundown will be
reflected in the active Director playlist.

® Release: Director will stop monitoring the newsroom system. A list of elements will still appear in
the Director playlist, but any subsequent updates to the Newsroom rundown will not be reflected in
the inactive Director playlist.
"IMPORTANT! Any elements that are manually added to the playlist by Director will disappear

if areleased playlist is requested again.

Note: If using Director to take items on air, be mindful that the cursor position in Director may
change if the related item is deleted from the newsroom rundown. That is, the Current Element
cursor would move to the following item, and the Next Element cursor would be removed.

8.4.2 MOS Status Bar

The information available in the rundown monitor bar is as follows:

® MOS: The current MOS status for the playlist (Active/lnactive).
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Host: |P address of the Media Sequencer that has requested the playlist.

Start: Playlist start time, according to the Newsroom system.

Duration: Playlist duration, according to the Newsroom system.

Updated: Last update time

Cleanup and Auto Preview and will work on playlists that are either active or inactive. Initialize will
work once the MOS playlist has been populated with content.
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9 Template Wizard

Template Wizard is atool for auto-generating basic templates, and for creating customized graphics
templates using arich set of components combined with advanced client-side scripting logic.

Templates for Viz Pilot are created in Template Wizard as custom control and content entry interfaces for
graphics scenes. The templates can be customized with a range of components and scripting tools.

This section contains the following topics:

* Workflows

® Configuration

® Getting Started

® Main Menu

* Wizard

® Viz Engine Preview in Template Wizard
® Categories and Channels

® Keyboard Configuration and Macros

¢ Component Palette

® Export and Import in Template Wizard
® Toolbar

® Resource Panel

® Viz Pilot News Test Page

Template Wizard has several editors for creating templates, logic and custom execution logic:

® Template Editor

Script Editor

® Update Script Editor

® Execution Logic Editor

9.1 Workflows

Template Wizard supports the following workflow:

9.1.1 Broadcast

The basic broadcast workflow from graphics design to aworking template is as follows:

® Scenesare madein Viz Artist. Multiple scenes can make up one template, categorized under
different Variants.

® Objectsin the scene, that the graphics designer wants to make editable in the finished template, are
given the appropriate control plugins.

® Templates are made in Template Wizard, after importing the scene(s) over.

® Exposed objects from the scene are used to automatically create a basic template.

®* Thetemplate designer creates additional logic using graphical components, and two types of script
logic:
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1. The Script Editor makes it possible to add scripts inside the template to aid the usersin
filling out or using the template in a best-practice way.
2. The Update Script Editor allows the designer to add scripts that will be executed by Update
Services on the server side, and not on the client side through Director.
® Thetemplate istested and saved, preferably to a descriptive concept, and assigned to a category
using the Template Manager tool. (Concepts group templates that are used together in a show or
broadcast).
® Templates are made available to the newsroom and control room systems.
® Ajournalist or editor, using Viz Pilot News, fills the graphics template with any of the needed
information to make up a complete graphic. This can include: text, numbers, images, person
information, videos (from the Viz One system) and maps (from the Viz World system). The template
is saved into the Viz Pilot system creating a data element that is added to the newsroom story.
® The Viz Pilot operator monitors the newsroom playlist (rundown) and plays the graphics on-air at the
correct time in the broadcast. This can be achieved by external GPI commands, keyboard shortcuts,
button boxes, mouse clicks and so on.

9.2 Configuration

Various attributes and settings for Template Wizard are configurable. Template Wizard uses the
ContentPilot.ini file to store these settings.

Please refer to the section on Initialization Files, as well as information about all of the ContentPilot.ini
parameters and how to edit them using the Initialization File Editor.

9.3 Getting Started

Template Wizard is a stand-alone application that can be started from the program menu, a desktop
shortcut or from Director if it isinstalled on the same machine.

This section contains the following topics:

® To start Template Wizard
® To specify command line parameters for Template Wizard
® To start Template Wizard from Director

9.3.1 To start Template Wizard

*

I‘?I

1. Open the program from the Windows Start Menu (T emplate Wizard), or the desktop icon.

9.3.2 To specify command line parameters for Template Wizard

1. Right-click the Template Wizard desktop shortcut, and select Properties
2. Inthe Properties window select the Shortcut tab.

218



3. To start multiple instances of Template Wizard add - dupl i cat es to the Target path.
® "ofprogranfiles(x86)%vizrt\Viz Pilot x.y\VizTenpl at eW zar d.
exe" -duplicates

Note: When starting a duplicate instance you will most probably receive a socket error.
Confirm it and you will be able to run duplicate instances of Template Wizard.

4. To specify the Media Sequencer to connect to, add - nse <host > to the Target path.
® "Ofrograntil es(x86)%vizrt\Viz Pilot x.y\Vi zTenpl at eW zar d.
exe" -mse <host>
5. To specify the database to connect to, add - db <connect st ri ng> tothe Target path.
® "Ofrograntil es(x86)%vizrt\Viz Pilot x.y\Vi zTenpl at eW zar d.
exe" -db <connect string>
6. To specify theinifiletouse, add-i ni fil e <inifil e>totheTarget path.
® "Ofrograntil es(x86)%vizrt\Viz Pilot x.y\Vi zTenpl at eW zar d.
exe" -inifile <inifile>

9.3.3 To start Template Wizard from Director

1. Either, select Template Wizard on the T ools menu,
2. Or, right-click atemplate in the template list, and select Edit Template on the context menu.

Lowerdd Edit Template I
Quote_image Find CtrL')\&F

Show Images

9.4 Main Menu

Template Wizard has six Main Menu options, as described below:

®* File

® Edit

®* View

® VizEngine
® Tools

® Help

9.4.1File

The File menu has the following options:

® New (CTRL+S): Creates anew blank template.

® | oad...: Opens a previous template made in Template Wizard.

® Load from file...: Opens atemplate from file.

® Save (CTRL+S)...: Save Templates the template to the database.

® Saveto File...: Isused for saving atemplate to afile, for exporting to another database, to usein Viz

Trio or to have a backup. See Save Template to File.
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9.4.2 Edit

Close: Closes the current templ ate.

Wizard...: Opens the Wizard to select scenes and exposed scene objects for template creation.
Use Script Unit ...: Includes a script unit in atemplate script.

Refresh Scripts: Loads updated script units from the database.

Reconnect to database: If the database connection is lost, this option tries to reconnect to the
template database.

Exit: Exits the Template Wizard program.

The Edit menu has the following options:

Change Scene: Use this option to Change Scene for the template’ s scene in design mode. To change
scenes for templates used during playout, the Scene name property set by the Template Manager in
the Variants pane must point to a different scene.

Undo (CTRL+Z): Undoes the latest change.

Redo (CTRL+Y): Redoes the latest undo.

Select All (CTRL+A): Selects all components in the template.
Bring to Front: Moves an object on the template to front.

Send to Back: Moves an object on the template into the background.

9.4.3 View

The View menu has the following options:

Command Editor: Shows the command editor.

Script Editor: Opens the Script Editor.

Update Script Editor: Opens the Update Script Editor.

Execution L ogic Editor: Opens the Execution Logic Editor.

Snap to Grid: Enables template components, when added or moved, to automatically adjust (snap)
itself to the template’ s grid.

9.4.4Viz Engine

The Viz Engine menu has the following options:

Select Viz Engine: Select Viz Engine to connect and render to.

Set On Aiir: Setsthe connected Viz Engine renderer in On-Air mode.

Show Bounding Box: Shows the boundaries of the scene’ s objects when previewing.

Show Commands On: Displays the “ Show commands’ console on the renderer.

Show Commands Off: Closes the “ Show commands’ console on the renderer.

Cleanup Renderer: Clears al scenesloaded on the renderer.

Remote Preview (CTRL+P): Launches the remote Remote Preview in Template Wizard window.
This option requires aremote Viz Engine to be in On-air mode.
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Local Viz Preview: Launchesthe Local Preview in Template Wizard window. This option also
starts the Viz Engine instance.

9.45Tools

The Tools menu contains the following options:

9.4.6 Help

Categories & Channels...: Opens the Categories and Channels window to add categories and
channels and define a mapping between them. Templates can then be added to a category, and
thereby be assigned to a default output channel.

Customize Keyboard...: Opens the Keyboard Configuration window.

Show Command Console: Opens the Template Wizard Macro Commands window.

Refresh Scene Info: Enables the user to Refresh Scene Information if the scene information has
changed after the template was created or updated the last time. This updates the template with
changes to control objects and background scenes.

Note: Since existing data elements refer to the background scene in the template, these will also
change. i.e. the background scene will be updated for the template and all it's data elements
every time this menu option is pressed.

Component Palette: Opens the Component Palette, enabling the user to select which components to
be displayed in the drop-list and on the toolbar.

Script Repository: Shows all script unitsin the Script Repository Browser (database), and which
templates and data elements that are using it.

Template Manager ... Opens the Template Manager window.

Export: Export templates to an archive file (see Export and Import in Template Wizard).

Import: Import templates from an archive file.

Template Wizard Help (F1): Opens the online version of the Viz Pilot User’s Guide (this
document). A local copy can be accessed from the Windows Start Menu.
About: Opens the About window, that contains information about the installed Viz Filot version.

221



Save Template

OTS5

®* Template Name: Setsthe template name for the template.

® Concept: Setsthe concept name for the template.

® New Concept...: Opens the New Concept dialog box for creating new concepts.

® Tag: Allowsthe template to be tagged, by selecting from a user-defined list. (See Tags).

® |Live Update: Enablesthe template to use Live Update for last-minute updates before playout (e.g.
weather or stock updates). This requires template scripting.

Note: Live Update has been superseded by Update Services. If you need to use Live Update, you
must also use the Legacy Playlist.

® Save AsNew (Alt+S): Savesthe template and closes the dialog.

® Overwrite Existing (Alt+0O): Overwrites the existing template with the existing name or a new
name.

® Close: Closesthe save dialog without saving the template.

Note

It is possible to save atemplate created in Template Wizard and run it as a graphical user interface,
including scripts, either:

® insideViz Trio (caled "Active TW template") or,
® inside Ticker Client, instead of the default message editor (called "presentation fil€").

9.4.7 Save Template to File

Saveto Fileisused for saving atemplate to afile, for exporting to another database, to usein Viz Trio or
to have a backup.

It isimportant to select the correct extension when saving:

® *_ vtw: Template Wizard template. Used for normal templates.
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* *_ vtwc : Template Wizard control template. Used for templates that are based on a scene with
control object plugins.
When saving a. vt we control template, a*. vt wc. cont r ol page fileisaso saved, which
contains the description of the scene that the template controls (i.e. the internal TrioPage instance).
Both files should be kept, as both are required if the template isto be loaded from file in future.

IMPORTANT! Saveto File does not preserve Tags or Variants information or Script Units. To
preserve these values, use Export and Import in Template Wizard.

9.4.8 Change Scene

Change scene is normally used to change the scene atemplate is referencing while designing.

Templates that are not control object based (e.g. templates built in Template Wizard versions prior to Viz
Pilot 5) can change the scene and convert the template to use control objectsif the scene has been rebuilt
using control object.

If atemplateis created without referencing a scene, or is based on a scene that does not use control object,
aconversion is not needed. Hence, a conversion can only take place if the new scene uses the control
object plugin.

Converted templates will show exposed objects as a tree structure with nodes, and not the complete Viz
Artist scene tree with containers.

To change a scene for design
® Click Change Scene on the Edit menu, and add the new scene using the Wizard.
To change a scene for playout

1. Start Template Manager.
2. Select the template variant to edit and click Edit.
3. Set the new scene and click Save.

To convert atemplate using a control object based scene

[ oy

Confirm

You have selected a Control Objeck scene, but this template is not Control Object based,
"“"‘r/ Lo wou wish ko comvert it?

Mo Cancel

1. Select the Change Scene option on the Edit menu.
2. Select ascene using the Wizard.
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3. Confirm if the template should be converted to a control object based template.

Note: Changing a scene without changing the scene name in Template Manager under the
Variants section will only change the scene used during design.

localhost

locathost .

ooz

_ ok | concal

Machines not visible in the Select Viz Engine drop-down list must be added during installation or to the
_ContentPilot.ini _file under the SGI section.

To select Viz Engine

® Sdlect Select Viz Engine on the Viz Engine menu, and from the dialog box select the Viz to use, and
click OK.

Description Type

o1 group float
~2.material graLp material
~1.material groLp material
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When editing atemplateit is possible to edit a scenein Viz Artist and make changes to the template’ s
scene. Any changes made to the scene can be updated directly by the template designer.

Currently the template will be updated when a scene’ s field identifier for a specific component has
changed by adding a new component to the template; however, the old component with the old field
identifier will still be present. Asthe Exposed Objects’ list is updated correctly it is safe to delete any
unused component(s).

To refresh the scene information

1. Start Viz Artist.
Open the template’ s scene, edit and save the changes.
3. Open Template Wizard, and click Main Menu > Tools > Refresh Scene Info.

N

Note: Clicking Refresh Scene Info updates the template with changes to control objects and
background scenes. Since existing data elements refer to the background scene in the
template, these will also change. i.e. the background scene will be updated for the template
and all it's data elements every time this menu option is pressed.

4. Click OK to add and/or delete exposed objects.
5. Optional: Remove any unused components that may have been made obsolete by the update.

9.4.11 Script Repository Browser

£ Script Repository Browser =JoJEd
Scripts: Close
Lnit name | created by ] Created date | Modified by | Modified date
iscript_unit.vbs PILOTS3  22.10.2009 14:08:24 PILOTS3  22.10.2009 14:08:24
Templates using this script unit: Data elements using this script unit:
Lower3rd

The script repository browser gives an overview of the available scripts and the templates and data
elements that are using the scripts. It is aso possible to delete script units from the repository browser;
however, thiswill affect the templates that use the scripts. A warning dialog box will appear if the script is
used by atemplate.

9.5 Wizard

This section contains the following topics:
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® Using the Template Wizard
® To enablethe Prefix and Customize options

9.5.1 Using the Template Wizard

The easiest way to create atemplate is to use the Wizard (opened from the File menu), however, it is also
possible to create a template from scratch without adding a sceneto it.

1. Thefirst step of the Wizard enables the user to select a iz Engine renderer to connect to.

IMPORTANT! This step only appearsif you have not selected a rendering engine. If no
rendering engineis available one needs to be added (see Configuration) during installation
and configured using the Viz Pilot Configuration Tool.

B3 Wizard page 1 of 3 (1B O X

| [ — %
— | EEa| — Choose Viz Engine host

Note: The ‘Launch Viz Preview’ button only appearsif a preview engine has been installed
and configured on the Template Wizard client machine, see Local Preview in Template
Wizard.

2. The Wizard's second step is where the template scenes are selected. The folder structure (left)
shows what is available on the currently connected Viz Engine. The scene(s), displayed in the
middle pane, can be dragged and dropped from the scene display pane onto the Selected Scenes
pane (right).
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Tip: If asceneisloaded on Viz, it will not take into account any changes made by the scene
designer after it was loaded; hence, it is good practice to clean up or restart Viz Engine before
adding scene(s) for template generation.

barnel_wvatants g

® Objectify All / Objectify Selected: Generate GEOM objects from all or the selected
transition logic front scenes. The GEOM objects are used by the background scene. If
transition logic scenes are exported to a different Viz Graphic Hub, and there already exists a
template for them, the GEOM objects must be regenerated for the scene to work properly
when played out or previewed. This feature does not require the template to be rebuilt.

® Finish: Finishes the template creation with a default layout and selection of exposed objects.

3. TheWizard'sfinal step shows alist of exposed and editable objects. The objects are numbered
and each object property can be shown, and later accessed, in the template.

[rame= [ e serpnen [Type [ ada ]
=Dl Haadling
o1 richbmt L
karmirsg faat
o Dagignation
oz rickibat -
karmineg fiaak

® Name: Shows the names of the objects properties.

® Description: Shows the descriptions of the objects properties. The text is fetched from the
description fields of the corresponding Control pluginsin the scene.

® Type: Shows the data types of the objects properties.

® Add: Setswhich properties to include in the template.
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® Prefix charactercount: Setsthe number of prefixes to be used when generating atemplate
with atable style layout. A template using the prefix character count is basically for scenes
that are not using control plugins like Control List or Control Chart for table creation. For
example, if a scene consists of four groups, and each group has three sub-containers, each
with text and images, it might be desirable to auto-generate a table layout representing the
sub-groups rather than having along list of form elements on the template form. Remember
to set the Field Identifiers for each group. For example: Group 1 with 011,012,013, and
Group 2 with 111, 112, 113 and so on.

I H B! " sagr o G
Exire To Front
e Serd To Back

e = [ s

Creation Coder...

C] Drefault Layout l,:} Line Layout Prafix charactercossts |2 5 Custormie. .. I g

® Customize: Arranges the components before the template is generated.
9.5.2 To enable the Prefix and Customize options

® To enablethe prefix and customize options add the key linelayout_visible _to the ContentPilot.ini
file under the Template Wizard section with the value y (Y es).

9.6 Viz Engine Preview in Template Wizard
This section contains the following topics:
® Remote Preview in Template Wizard: Remote Preview is the recommended preview mode for
Template Wizard, where a Viz Engine installed on another remote machine is used for preview
purposes.

® |ocal Preview in Template Wizard: Local Preview uses aViz Engineinstalled locally on the
Template Wizard machine for preview purposes.

9.6.1 Remote Preview in Template Wizard
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Remote Preview meansthat a Viz Engineisinstalled remotely on another machine for preview purposes.
Remote Preview is the default preview mode for Template Wizard. Unlike Local Preview it does not
require alocal installation of Viz Engine; hence, it is aso the recommended preview option. For more
information on configuring Remote Preview see Configuring Remote Preview in Director.

Note that remote preview of templates with video clips requires afull Viz One video workflow and the
use of Viz Pilot in order to trigger the transfer of video clipsto Viz Engine.

This section contains the following topics:

® Properties and Parameters
® To preview atemplate

Properties and Parameters

® Refresh: Refreshes the scene preview displaying a snapshot of the scene at its current animation
position. This enables you to fetch new snapshots of the scene while it is rendered on aremote Viz
Engine without seeing the full animation in the preview window.

® Back: Setsthe animation back to the last stop point.

® Continue: Continues the animation to the next stop point.

® Copy: Places acopy of the snapshot on the clipboard.

® Animate: Animates the scene in the remote preview window. The animation is based on a series of
snapshots of the scene rendered on the remote Viz Engine. Click the Animate button to start the
animation, and click it again to stop it.

® Size: Setsthe size of the preview window. There are two default settings, one for PAL and one for
NTSC, and one custom.

® Close: Closesthe preview window.

* Add totemplate: Adds a snapshot of the previewed graphics to the template. The snapshot is
appended to a Static Image Component component.
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To preview atemplate

1. Open atemplate and change to Run mode.
Select Preview on the View menu, or press CTRL +P to open the preview window.

3. Click the Load (F7) button and then the Refresh button in the Viz Engine window to see a
snapshot of the rendered scene.

4. Click Animate to see a series of snapshots.

N

9.6.2 Local Preview in Template Wizard

Local Preview meansthat aViz Engineisinstalled locally on the Template Wizard client machine for
preview purposes. Unlike the default installation mode it requires alocal installation of Viz Engine; hence,
it is not the recommended preview option.

Local Preview must be selected by enabling the Viz Engine Preview plugin in the Viz Pilot Configuration
Tool. For more information on configuring Local Preview see Configuring Local Preview.

Note that preview of templates with video clips requires afull Viz One video workflow and the use of
Director in order to trigger the transfer of video clipsto Viz Engine.

Theinterface is the same as used in Viz Pilot News and Director, see Loca Preview in the Newsroom.
To preview atemplate in local preview mode

1. Open atemplate and change to Run mode.
2. From the main menu select Viz Engine > L ocal Preview
3. InTemplate Wizard click the L oad button to load and preview the scene.
® The Start/Take button in the Local Preview window will not load the scene on Viz Engine.

Once loaded by Template Wizard the scene can be previewed using the control buttonsin the
Local Preview window.

9.7 Categories and Channels

The Categories and Channels option on the Tools menu opens an editor window for adding template
category and channel assignments for those categories.

9.7.1 Categories and Channels Editor

Categories and Channels
J Custom channel | Categories Channels
|Categnr1,r |Cust|:|m Channel |
Fullscreen Viz Engine #1
Locators Yiz Engine #1 1\(
Lower3rd . . .
Wiz Engine #£1
M.aps Wiz Engine #2
Tickers VIZ Engine #e
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Note that the channel name must correspond with the output channel configured in Director. In some
situations a user might want certain types of graphicsto be played out on a specific output channel, for
instance lower thirds on one channel and full screens on ancther. By adding a template to a specific

category it will get the category’s channel as default output channel when the template’ s data elements are
added to aplaylist in Director.

'IMPORTANT! Legacy templates that do not use Control Object are unableto assignitself tothe
correct program channel; hence, it will always default to the default program channel in the profile
configuration, and disregard information in the Categories and Channels setup.

Categories and Channels
Customn channel | Categories Channels
Cateqgories:
YIEullscresn rRename Category
vl Locatars Old narne:
¥ Lower3rd |Fu||5|::reer‘|
v Maps
v Tickers Mew name:
|FuIIFrame

Renarme

—add Category

Mew name:

Breaking Mews

i

Add

Close

The Categories and Channels editor contains three tabs:

® Custom channel: Setsthe default channel for each of the defined categories.
® Categories: Adds and renames categories.

® Channels: Adds and renames output channels. Note that the channel name must correspond with the
channels configured in Director.
For more information on how to set categories for templates, see the Template Manager’s Variants
editor.

9.7.2 To delete a category or channel

® Select a category/channel and press the Delete key.
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9.8 Keyboard Configuration and Macros

This section contains the following topics:

® Keyboard Configuration
® Template Wizard Macro Commands

9.8.1 Keyboard Configuration

& Keyboard Configuration
Shortcut Keycode Commands | <
- gui

togagle_vtw_commands

show_shortcuts_dlg

new_template Ctrl+N

load_template_from_file

save_template_to_file

customize_palette

show preview Ctrl+P i

Import... Export... Ok Cancel

The Keyboard configuration window allows the user to select and define macros and assign them to
specific key combinations, predefined functions and VB Scripts.

To open the Keyboard Configuration window select the Customize K eyboard option on the T ools menu.

This section contains the following topics:

® Keyboard Configuration Window
® Towork with macros and shortcuts
® Macro Shortcut

® Predefined Functions for Keyboard Configuration

Keyboard Configuration Window

The columnsin the window are:

® Shortcut: Displays the macro name.
® Keycode: Displays the keyboard shortcut.
® Commands: Displays the shortcut command.

The buttons available are:
® |mport: Opensthe Open window where a previously exported KBD (keyboard) file can be

imported.
® Export: Opens the Save Aswindow where the current settings can be exported as aKBD file.
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® OK: Savesthe keyboard shortcut configurations, and closes the window.
File location: %°ROGRAMDATA% Vi zrt\ Vi z Pil ot x.y\Config\vtw keyboard. kbd
® Cancel: Closes the window.

The context menu contains the following options:

Add M acro: Opens the Macro Shortcut window, where a new macro can be created.

Delete Macro: Deletes the currently selected macro. Alternatively, click the keyboard shortcut
CTRL+Délete.

Remove Shortcut: Deletes the shortcut key code of the currently selected macro. Alternatively, click
the keyboard shortcut Delete.

To work with macros and shortcuts

To add amacro command, select Add Macro... .from the context menu to open the Macro Shortcut
window, then enter the key combination, macro category:macro name and commands
To edit amacro command, double-click it to open the Macro Shortcut window.

To delete amacro command, select it and then either pressthe CTRL+DEL keys, or select Delete
M acr o from the context menu

To remove a macro command shortcut, select the macro and then either pressthe DEL key, or select
Remove Shortcut from the context menu

Macro Shortcut
9 Edit Macro Shorteut [

Enter Key: |Ctr|+5hif‘t+N| |

Macro name: |man:rc:s:New w/ Script Editor |

Global [%]

I Description: |New Template and Show Script Editor |

Macro commands

Macro Commands | VB Script

gui:new_template -
gui:show_scripteditor

Show Macros... Save as New 0K Cancel

The New/Edit Macro Shortcut window is opened by selecting Add Macro from the Keyboard
Configuration Window context menu, or double-clicking an existing macro.

The Macro Shortcut window contains the following fields and buttons:

233



Enter Key: Setsthe keyboard shortcut for the macro. Place the cursor in thisfield and press the
desired shortcut keys to set the key value.

Macro Name: Displays the macro category (e.g. macros., gui:, viz: ) and the name of the macro. If a
folder was selected when the Macro was opened, the category name will automatically be displayed
in the Name text box. The category name can be set or changed in the Name field by adding the
category and macro name separated by a colon (<macro category>:<macro name>).

Note: If acategory is not added to the name it will be placed in the macros category. It isaso
possible to add new categories by defining them in the macro (e.g. foo:bar).

Global: Makes the macro work aso when atemplate is open.

Description: Description of the macro.

Macro Commands:. The names of the selected Predefined Functions for Keyboard Configuration are
displayed.

VB Script: A text field where script code can be entered. This provides the possibility to further
enhance and adapt the commands.

Macro Commands | VB Script

1 snb BEunScript

2 '=nter cods here

2 buffer clear

4 buffer put "-1 RE}-IDERER’TREE’ETLELES_sh;ft’Z‘RA‘-ISFCR
5 SET 0 43 OV

13

7

end sub

IMPORTANT! The function stub named RunScript must be used as the main script or entry
point for other scripts; hence, it cannot be renamed or removed.

Show Macros: Opens the Predefined Functions for Keyboard Configuration window.
Save As New: Saves the macro as a hew instance.

OK: Saves the macro, either as a new or modified macro.

Cancel: Closes the window, without saving any changes.
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Predefined Functions for Keyboard Configuration

N

EF Commands main:call_macro
- gui name:restString
* macro

'?"."E'i" Call {(invoke) a named macro

- apropos(search:string)

s call_macro(name: string

“define_local_macro(name: g -

In the Predefined Functions window alist of the Commands that can be added to a keyboard shortcut is
presented.

Note: Only the commands relevant for creating shortcuts are presented in this window. A more
extensive list of predefined functions is available when using the Script Editor (see Script Editor

9.8.2 Template Wizard Macro Commands

Enables the user to execute predefined functions without using keyboard shortcuts and macros.

i B
B Commands AIEIQM

guiicustomize_palette
ui:load_template from_file @

guiisave_template_to_file
guiiselect_viz_engine
gui:show_load_template
gui:show_preview

gui:show _scene_ wizard i

9.9 Component Palette

This section contains the following topics:

® Selecting Components
® To add a component
® To change a component
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9.9.1 Selecting Components

O[] [= ] [EF

=l EN[E]

txtHeadline: TTWLUnIEd

A standardized subset of componentsis available from the dropdown list. The full list of components can
be viewed by selecting Tools > Component Palette.

| 4| Component palette g@

Customize the palette by drag drop (have to restart to take effect)

|Image |CI.355 name .

+ [Standard]

+ [Additional]

+ [Data access]

+ [Data controls]

+ [Database]

+ [Mini Weather]

+ [Functions]

+ [Cormrmmunication] |E|
Save Cancel Load default |

The Component Palette lists al of the available components. Y ou can organize your own palette by
dragging items around. Components added to the Unused category will not be visible in the toolbar.

Any customizations to the component palette are saved to: %°ROGRANMDATA% Vi zrt\ Vi z Pil ot Xx.
y\ Confi g\ cust om conmponent s. cfg

To return to the default settings, click L oad default.

9.9.2 To add a component

Components that are used in conjunction with scripting, such as database components, dialog boxes, com
ports, and so on, are added simply by selecting them from the components toolbar and clicking once on
the template.

1. Select acomponent palette (e.g. Standard) from the dropdown list on the menu bar.
2. Click acomponent button.
3. Click once on the template to add it to the template.
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9.9.3 To change a component
e

(e | EE]E] | &) [E

- 5 [Headkne) a
-':'1 + ‘Headlne
i : [Headline
= am [\SM”I i S“E"f““ .............. kerming Banchors [ﬂkl.ﬂﬁ.mﬂlﬂ-]
oz i |El.:.' ir | EiAaSae =
keming i ) ContralObpectMame 01 kerning =

1. Deletethe existing component on the template.

2. Select anew component from the component palette, and click once on the template to add it to
the template.

3. From the Exposed Objects pane select, drag and drop the object’ s exposed property onto the
newly added component.

9.10 Export and Import in Template Wizard

Export and import in Template Wizard is similar to export/import in Director, with some differences
related to playlists:

® Toimport playlists you must first specify a Media Sequencer for Template Wizard to connect to,
using theini file or the command line. If noneis specified, Template Wizard will try to connect to
localhost for the playlist import. See Configuration and To specify command line parameters for
Template Wizard.

Note: The Viz Engine must be On Air before Template Wizard starts, in order for the Export
tool to work correctly.

For afull description of the import and export tools, see Export and Import in Director.

9.11 Toolbar

There is one toolbar that operates in two different modes, one for template design (Design mode) and one
for testing (Run mode).

In addition, the Viz Indicator on the toolbar indicates Template Wizard’ s connection status to Viz Engine.

The Run/Design button toggles the two modes:

==

® Run (F9): Switchesto Run mode. This mode requires that a template is open.
® Design (F9): Switchesto Design mode. This mode is the default mode.
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9.11.1 Run mode

» [P 2] (1] [B][E] e 111

® | oad: Loadsthe scene on Viz and starts the preview.

® Continue: Continues the scene animation if the scene contains stop points.

® Take Out: Takes the scene off-air.

® Back: Resets the scene to its starting position.

® Refresh: Refreshes the scene with new data without reanimating the scene.

® Preview: Loadsthe scene on Viz and starts the preview.

® Camera (1-4): Previews the scene from 4 camera angles (configured in Viz).

9.11.2 Design mode
®\| = = ‘

® New: Opensthe Wizard to select scenes for automatic template creation.
® Open: Browses for and opens an existing template.
® Save: Opensthe Save Template dialog.

Viz Indicator

lozalhost lozalhost

The Viz indicator located in the upper right corner shows which output machine Template Wizard is
connected to.

9.12 Resource Panel
The resource pand lists all available templates, and the exposed objects or scene objects when atemplate
is opened.

This section contains the following topics:

® Templates

® Exposed Objects
® Scene Objects
® | ayer Pand
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9.12.1 Templates

Select template:

|Name |
EQ| chart
EQ| Lower3rd
EQ) Top3rd
weather_3days

® Concepts: Listsall concepts. Available options are All, Unassigned and all visible user created
concepts. Hidden concepts must be made visible by checking them off in the Template Manager.
®* Name: Listsall templates for the selected concept.

Templates Context Menu

Name
I | r—
i Open . s
EqQ. Show template concepts
Ed Remowve from concept
Ed Delete
! Refresh
Q- Rename

® Open: Opensthetemplate in the editing area

® Show templates concepts: Opens the template manager tool displaying the selected template's
associated concept(s)

¢ Remove from concept: Removes the template from the selected concept and permanently deletes
the template' s associated data from the database

* Delete: Deletes the template(s) and all associated data from the database

® Refresh: Updates the template list

® Rename: Renames the template

To open atemplate

® Double-click or drag and drop atemplate onto the workspace to open the template in a Template
Wizard editor.
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9.12.2 Exposed Objects

Exposed Objectsw

r[Lﬁru'«ﬂa.-rBrlr.!] - SCENE®*02_GFX/VizContentPilot

-850 Name) T
Eo1 LEE g T I
ey ¢ [TTwWuUniEdit1 |::%::::::::::

=/ &4 02 [Designation) Designation: | 11l i Il
Eoz [TTWuUniEdit2 |
Kesmaiag T llllliiiLiliiliiiiiiiin

The Exposed Objects view displays a selected template’ s exposed objects. Exposed objects can, as with an
old-style Scene Objects template, be dragged and dropped onto the template for further customization.

With atemplate loaded, the Exposed objects window will show alist of all exposed objects and properties
of ascene.

Selecting a component on the template highlights the object it refersto, and if selecting an objects
property from the Exposed objects list, the corresponding component will be highlighted on the template.
In both cases the Template Wizard Components opens, revealing the component’ s properties. For
example, the object Name has one component on the template; atext box (01) for the Name object, a
second text box component can be added for kerning (01.kerning).

To add a component from the Exposed Objects pane

® Simply drag and drop the exposed object onto the template and a default component will be added
based on the data type of the property.

9.12.3 Scene Objects

Scene Objects W

-r [Weather_3days] - SCE

The Scene Objects view displays the scene tree displaying its scene objects, available control channels and

directors. Scene objects can, as with an Exposed Objects template, be dragged and dropped onto the

template for further customization.

‘Note: Exposing scene objects s commonly used with Viz Pilot version 4 and older asthey donot
have support for control plugins.
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9.12.4 Layer Panel

Layer Description

Scene

-'Banner
4015 _wvariant=0BJECT Bt w/3d-ohject
02 GFX/VizTrio/TRANSI Add scene % I5 variant=0BJECT

Ch
- sidepanel ange scene
) Remove scene )

4210_wvariant=LEFT !Wlth 30 models
02 GFYVIzTrio/ TRANSTT Open in Viz Artist L0 variant=LEFT
4210 _variant=RIGHT =mreparre| with 30 models

02 GF¥NVizTrio/TRANSITION LOGIC/TL RedBanner/4210 wvariant=RIGHT

When creating templates based on transition logic scenes, the layer panel is displayed (lower-l€eft). The
layer panel is shown when editing transition logic templates, and enables the template designer to see the
logical layers of the template and all front scenes within a specific layer. The panel also allows the user to

change the description of the front scene, open it in Viz Artist for editing, to add, change or remove afront
scene.

In atemplate, each layer is represented with a drop-down with all front scenes that can be taken on-air for
that specific layer.

Add scene: Adds afront scene to the template either as part of an existing layer or as part of anew
layer. Additional front scenes must refer to the same background scene as the other scenes.

® Change scene: Changesthe front scenein the selected layer.

® Remove scene: Removes the front scene from the selected layer.

® Openin Viz Artist: Opensthefront scenein Viz Artist for editing.

Also note that transition logic templates that reside in two or more concepts are kept synchronized
when adding or changing scenes. Concepts that do not contain the same set of front sceneson Viz or
have a different background scene are not in sync. If this situation occurs, the user isinformed with
an explanation of what iswrong, and the operation is canceled.

Out of sync situations may occur if atransition logic template that resides in two or more conceptsis
opened, front scenes are changed or added that is only to be found in one of the concept’s scene paths or a
scene with a different background scene.

9.13 Viz Pilot News Test Page

Thisweb page loads Viz Pilot News within Internet Explorer (IE) so that it can be used for testing Viz
Pilot’s newsroom connection properties and functionality.

Open the test page from the Start Menu > Viz Pilot News Test Page.
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To edit the connection settings, reinstall Viz Pilot.

Note: When the Viz Pilot News Test Page is opened, |E may issue awarning and ask the user to allow
it to run within IE. To alow the test page to run without this warning, open IE, and go to Tools >
Internet Options > Advanced > Security, and then check the option called Allow active content to run
in fileson My Computer.

9.14 Template Editor

The template editor is used to create and edit atemplate’ s user interface. Templates can be created from
scratch, or by using the Wizard to select the scene the template should control. The latter adds a default set
of components to the template during scene import.

This section contains the following topics:

® Template Editor Functions
® Standalone Templates

® Transition Logic Templates
® Template Testing

® Align

® Sizeand Scale

® Tab Order

® Creation Order
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® Background Images
®* Tags

9.14.1 Template Editor Functions

The components added when using the Wizard tool are based on the Exposed Objects information in the
scene; however, components can be replaced and new ones added to extend or change the functionality of
the template and to change the appearance and behavior of the scene.

Note that the template name (square brackets) and the scene path is visible in the template window’ s title
bar. For standard scenes the scene name is used; however, for transition logic scenes the background scene
name is used.

Align Tos Grid
c+ A0 ... .| Bring ToFront
|5 Send To Back rd ADO scripting example Wizt

Bl m B  Fieids Eavor... I-:;;:;;:;;;:;;._;;_.;;::;;:::_::.:::.::_::.:::.::_

Align...

Scale...

Tab Crder..,
Creation Order. ..

The context menu in the Template Editor contains the following functions:

® Edit Image...: Adds a Static Image Component to be used as for example a template background.
Only available when using the Static Image Component component.

IMPORTANT! When using the static image component, use compressed image types such as
JPG or lossless ones such as PNG to conserve space. It does not need to be asmall imagein
pixel size. The whole template is streamed to the database as a BLOB, and the image data will
not be touched, so a JPG or PNG will use alot less space than a BMP that is not compressed.

® Fields Editor: Adds string components to represent database fields using an active database
connection. Only available when using specific Database Components.

® Alignto Grid: Aligns the template' s selected component to the template grid.

® Bringto Front: Brings the template’ s selected component to front of all stacked components.

® Send to Back: Brings the template's sel ected component to the back of all stacked components.

® Align: Enables the user to set the Alignment of the template’s components.

® Size: Enablesthe user to set the size of the template’ s components (see Size and Scale).

® Scale: Enablesthe user to set the scale of the template’ s components (see Size and Scale).

® Tab Order: Enablesthe user to set the Tab Order for the template’ s components.

® Creation Order: Enables the user to set the Creation Order for the template’s components.
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9.14.2 Standalone Templates

[Mew Template] - SCENE*02_GFX/VizContentPilot/Basics/8010 - Running

FirstName
|BIARNE |

Lastname

|BERG |

Standal one templates are only based on a single scene as opposed to Transition Logic Templates.
To generate a standalone template

1. Select Wizard on the File menu.

2. Add the scene.

3. Click Next

4. Select the exposed objects that should be added to the template automatically.
5. Click Finish.

9.14.3 Transition Logic Templates

This section contains the following topics:

® Transition Logic Scenes
® To generate atransition logic template
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Transition Logic Scenes

[Mew Template] - SCENE*02_GFX/VizContentPilot/MAIN_TL/VIZ_NEWS - Running
L3_TEXT i
|BAR GRAPH |

One line banner
Line 1

WELCOME TO VIZRT

Two line banner
Line 1 Line 2

|VIZ TEMPLATE WIZARD | |CREATING TRANSITION LI

Question - Bar graph
Question Top Position

[THE QUESTION GOES HE|  |AGREE | |75

Bottom Positian

[DISAGREE | |25

Mald_BaMMNER

MAIN BANMER IN - |

<|grores |
AN BAHHER [M %
kAl BANMER OUT

|RED SUE 2 IM =]

A transition logic scene consists of a background scene and a set of front scenes. When the front scenes
are used to create atemplate in Template Wizard, the front scenes are created as GEOMSss (objectified).
The objects are added to the background scene in their respective placeholders called layers; hence, once
thetemplateis used to play out the scenes the actual front scenes are not used, but their objectsin the
background scene.

When generating a transition logic template the logical layers, visiblein the Layer Panel, are placed on the
template in separate group boxes. Each group box also has a drop-down menu with all the GEOMs (i.e.
the front scenes) for that layer. The currently selected front sceneis reflected by the Activel ayer | D
property for the TVTW.L ayer Control component.

'Note: The Itemindex property is similar to the ActiveL ayer| D, however we recommend usingthe
ActiveLayerID, asit preserves the links to items regardless of changes to the index order or

description names in the scene's control object.
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A background scene can contain many logical layers. A layer isa placeholder for front scene objects
(graphical elements) that are supposed to be on air one at the time. To have independent elements that can
be on-air simultaneously, new logical layers must be added to the background scene.

Each layer can have several states, being anything from position on screen to layout variants, and of f
screen. The visibility of certain controlsin templatesistied to the currently selected layers.

By using this method several independent graphical elements can be on air at the same time and they can
be taken in and out independently. Transitions can be built into the background in order to obtain a smooth
transition between the different states.

Field Identifiers

To make Template Wizard generate transition logic templates correctly there is one important design
convention that needs to be followed. As ageneral rule, al scenes must have unique Field identifiersfor
all Control plugins. The identifier can be both text and numbers but there must be no spaces.

Thereis one exception whereit is allowed and also useful to have the same Field identifier on multiple
Control plugins. Thisisfor scenesthat use the same logical layer, which means that they will not be on-air
at the same time, the same Field identifier for values of the same data type can be used. In the template
these values can be set in one editor instead of by several, one set for each scene when using unique Field
identifiersfor all.

The description label for the editor will be the same so it must work logically for both objects, otherwise
the user might be confused.

An example where using the same identifier is meaningful:

® When having two OTS graphics with an image and atext in the same logical layer, one on the left
side and one on theright side, it is possible to name both Control Text plugin Field identifiers for
OTS Text, and the Control Image plugin Field identifiers OTS Image.
With common identifiers for the two OTS text elements and the two OTS image el ements, the Wizard
will only generate one set of components. This setup will work nicely since they will never be on the
screen at the same time.

To generate atransition logic template

Select Wizard on the File menu.

Add the front scenes that are controlled by the background scene.

Click Next

Select the exposed obj ects that should be added to the template automatically.
Click Finish.

agkrwbdpE

Note: The background scene cannot be selected! If abackground scene is selected an error
message is shown, telling that the scene cannot be selected.
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9.14.4 Template Testing

It is good practice to create procedures on how To test templates. The procedure below is an example of
how to best test templates before using them in a production environment.

To test templates

Design and test scene(s) in Viz Artist.
Double check al Control Objectsin Viz Artist.
Design, with the help of the Wizard tool, the template and save it in atest Concept.
Clean-up the template layout and do a manual and final design.
Test template in Template Wizard.
® Playout and Control Objects
® Scripts
® Special Characters
6. Testtemplatein Viz Pilot News.
® Tab order of al components
® Default save name (& Save Template window on/off if used)
® Variants
® Optional: Crop Tool
7. Test playout of data elements from a control room with Director.
8. Deploy template to journalists.

arwNeE

9.14.5 Align

Components can be positioned manually by drag and drop, or by selecting multiple components and use
the built in alignment functions. It is also possible to snap components to the template grid.

This section contains the following topics:

® To position components
® To position components by snapping them to the grid

To position components

o Sy
Alignment
Horizontal Wertical
¢ Mo Change: * Mo Change
" Left Sides " Taops
(" Centers (" Centers
" Right Sides " Bottams

(" Space Equally

" Center in window

(" Space Equally

" Center in window

Ok Cancel
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1. Select the component(s) to align.
2. Right-click on the template and select Align.
3. Set the horizontal and vertical alignments and click OK.

To position components by snapping them to the grid

® Position components to the template grid automatically by selecting Snap to Grid on the View
menu.

9.14.6 Size and Scale

Setting the size and scale of components can be done per component or by selecting a group of
components, and can be used to make text boxes and other components of the same type have the same

size and/or scale.

This section contains the following topics:

® Sizeand Scale
® To set the component(s) size
® To set the component(s) scale

Size and Scale

® Size: Width/Height: Setsthe width or height for the selected component(s).

Size
width Height
* g Change ™ Na Change
" Shrink to smallest " Shrink to smallest
" Grow to largest " Grow to largest
" width; |0 C Height: [0
(8134 Cancel |

No Change: No changes are applied to the width or height of the selected component(s).
® Shrink to smallest: Shrinks the size of all components to the same as the smallest.
® Grow tolargest: Grows the size of all components to the same as the largest.
® Width/Height: Sets a custom width/height for the selected component(s).

® Scale: Scaling Factor: Sets the scaling factor in percentage.

Scale

Scaling Factor:

1100

k. Cancel |
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To set the component(s) size

1. Select the component(s) to size by pressing SHIFT and clicking the component(s).
2. Right-click the template, and on the context menu select Size.
3. Set the Width and Height properties and click OK.

To set the component(s) scale

1. Select the component(s) to scale by pressing SHIFT and clicking the component(s).
2. Right-click the template, and on the context menu select Scale.
3. Set the Scaling Factor (percentage) and click OK.

9.14.7 Tab Order

s = |

Tab order

TYTW LayerControll}
TTwniMernol
TTwUniMernoz
TTwUniMerno3
YdomComboBoxl

8],4

Cancel

This option enables the template user to press the TAB key to move between the different fields (i.e.
components) on the template.

To set the tab order

1. Right-click on the template and on the context menu select Tab Order ... .

2. Arrange the order by selecting items and using the arrow buttons, or drag and drop, to move them
up and down.

3. When doneclick OK.

9.14.8 Creation Order
' Creation Order
OpenDialog;
Savelialogl =
FindDialogl Cancel
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Use the Creation Order dialog to specify the order in which the template creates non-visual components.
The order is used when the form is loaded at design time or run time. A non-visual component isa
component that is visible when designing, but has no appearance at runtime until it is called (e.g.
SaveDialog), or simply has no appearance at al at runtime (e.g. TWComPort).

The Listbox only displays non-visual components on the active template, their type, and their current
creation order. The default creation order is determined by the order in which the non-visual components
are placed on the template.

9.14.9 Background Images

Use of large size (bytes) background images in templates are not recommended. This is made possible by
the Static Image Component component; however, for every data element that uses the template, a copy of
thetemplateis created and saved on the database, including the background image.

9.14.10 Tags

Tags are administered through the Pilot Data Server Web Interface. Templates can then be tagged by
selecting atag in the Save Template dialog.

This section contains the following topics:

® To accessthe Tag settings

® Todefine anew tag

® Torenameatag

®* Todeeteatag

® Toassign atagto anew template

® Toassign or modify the tag of an existing template
® Toremove an assigned tag

To access the Tag settings

1. Select the Pilot Data Server Web I nterface from the Windows Start Menu
2. Click the Settingslink
3. Click the Tag settings link

To define anew tag

1. Click the Add tag button on the Tag settings page.
2. Enter anamefor thetag in the New Tag field.
3. Click OK.

Torename atag

1. Onthe Tag settings page, click the Rename icon next to the desired tag.
2. Enter anew name for the tag in the Rename Tag field.
3. Click OK.
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To delete atag

1. Onthe Tag settings page, click the Delete icon next to the desired tag.
2. Click OK to confirm the deletion.

To assign atag to anew template

Create anew template.

Click Save

Enter Template name and Concept as required
Select atag in the Tag dropdown.

Click Save as New.

o rcwbNPE

To assign or modify the tag of an existing template

1. Open an existing template.

2. Click Save

3. Select atag in the Tag dropdown.
4. Click Overwrite existing.

To remove an assigned tag

1. Open an existing template.

2. Click Save

3. Select <None> in the Tag dropdown.
4. Click Overwrite existing.

9.15 Script Editor

Object inspector b

[] Enable script

There are two ways of adding scripts to atemplate. Scripts that are specific to the template can be added in
the Main script tab, or as separate scripts (from the Main script) created as Script Units.

Tip: Script Units can be stored as reusabl e scripts for more than one template and can be used as a
means of organizing scripts into functional and logical pieces.

This section contains the following topics:

® Context Menu

® Script Editor Toolbar
® Script Units

® |LiveUpdate
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® Viz Trio Template

9.15.1 Context Menu

4 ADOConnectionl.Connected = True e
5 |[|aDOCueryl.Active = True Hew Edit Window
[3 Open...
7 |If ADOQueryl.State = 1 Then Insert From File...
a8 H=gBox ["Recordset opened succesfully.™) Save Chri+3
g9 [End If Save As...
10 Save to Repostory  Chri+R
11 (TWUnilListBoxl.Clear Close Strl+Fd
12 |TWUniLiscBoxi.Clear Select Al Chrl+a
13 |TWDniLiscBox3.Clear Undo Ctrlezr
1% Riado Chrley
15 [MagBox (ADOQueryl. RecordCount)
16 Copy Ctrl+C
17 IDim i Cuk Chrl+i
18 Paste Chrlv
19 [For i = 0O To ADOQueryl.RecordCount -1 Toggls Book N
20 TEUniliscBoxl. Items. Add (ADOCuerylidl . Texe) Cobi Backinaris r
21 TUnili=scBoxz. Items. Add (ADOQuerylheadlinel. Texy
22 TWUniLlistBox3. Items. hdd (ADOQuerylsourcel. Texc) Find... Ctri+F
23 [MHext Replace...
24

Uiz Sriph Unat. ..
Z£5 |ADOConnectionl.Connected = False e

Refresh Scripts
26 |ADOQuervl.Active = Falsesub chriscerfunc -
£ | »

The context menu of the Script Editor contains the following items:

® New edit window: Opens atab with anew script editor.

® Open: Opens ascript filein a separate tab. See al'so how To reopen used script units.

® Insert from file...: Inserts script file, adding it as a script unit to the script that was open at the time
of the operation.

® Save (CTRL+S): Saves a script unit to the computer (not to repository).

® Save As: Savesascript unit with anew name to the computer (not to repository).

® Savetorepository (CTRL+R): Saves edited script units to the database repository.

Note: When atemplate with script unitsis saved, a dialog appears asking for script units to be
saved to the existing database. Use the Save to Repository menu option to save script units to the
database without saving the template.

Note: The options Save, Save As, Save to Repository and Close are only available for Unit
scripting window(s) (i.e. they are disabled for the Main scripting window).

® Seect All (CTRL+A): Selects al text in the script.

¢ Undo (CTRL+Z): Undoes the latest change.

® Redo (CTRL+Y): Redoesthe latest undo action.

® Copy (CTRL+C): Copies selected text in the script.
® Cut (CTRL+X): Cuts selected text in the script.

® Paste (CTRL+V): Pastes content from the clipboard.
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® Toggle Bookmarks: Adds and remove a bookmark in the script at the line where the cursor is by
toggling bookmarks on and off.

® Goto Bookmarks: Makes the cursor jump to a bookmark.

® Find... (CTRL+F): Search for atext string.

® Replace: Search for atext string and replace it by another string.

® Usescript unit..: Makes the main script use a script unit. A string of the form: * USEUNI T
<nyscri pt >, inthe main script shows that a unit is used. The script units are saved back to the
repository when atemplate is saved and the local copies are updated every time the programis
started. Script units are often created to be generic and reusable.

® Refresh Scripts: Loads updated script units from the database.

9.15.2 Script Editor Toolbar

| fal ] =|[=] - | E -
myFunctionOne

myFunctionTwo
myProcedurelng

® Open Script Unit: Opens ascript filein a separate tab. See also how To reopen used script units.
* Predefined Functions: Shows the predefined functions and variables that are available, together
with a brief description. Use the Add button to add the selected function to the script.

EJ predefined Functions I,iE-J

Functions:

13

+-variables Called when user presses save in the message

+ Functions editor. Code will be executed before the

- VTW-Command template is stored to MSE

t Updatehub

- TickerClient 1
= Events

InitForm

m

-

Add | Close

® Show Library Scripts: Displays available Script Units that are not already used as script unitsin the
currently open script.

Note: If scriptsthat are added to alocal folder will be permanently used, they should be added to
the database repository, see To save script units to the repository.

® Syntax Check: This button checks the syntax of the scripts and reports errors. Errors are shown
below the script pane.

® Saveto Repository (CTRL+R): Saves edited script units to the database repository. For details, see
To save script units to the repository.

® Close Unit (CTRL+F4): Closes the selected script unit. See aso how To reopen used script units.

® Change Font: Change the font type and font size for the script editor.
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® Drop-list: Thedrop-list lists all functions and procedures that are declared in the script. Select an
item from the list to jump to the point in the script where that function or procedure starts.

9.15.3 Script Units

All script units are stored on the database. When Template Wizard is started, al script units from the
database repository are downloaded to alocal folder.

* OFPROCGRAMDATA% Vi zrt\Viz Pilot x.y\Scripts
New script units can be saved to the database when the template is saved. If the script unit is updated
and aready exists on the database, a dialog with three options appears, asking if the database script
unit should be updated with the local copy. The following options are;

® Yes: Savesthe template, and updates the script unit(s) on the database.

® No: Savesthe template, but does not update the script unit(s) on the database.

® Cancel: Cancels al save operations for the template and script unit(s).
Script units that are saved back to the repository when a template is saved updates the local script
unit copies every time the program is started.

This section contains the following topics:

® Toinsert alocal script into the main script

® To use ascript unit from the repository

® To reopen used script units

® To save script unitsto the repository

® Toretrieve script units from the database

® Toresolve conflicts between local and repository script units
® To export atemplate that uses script units

Toinsert alocal script into the main script

SlmlE =] | |

FUSEUNTIT MyScriptUnit
| Sc

1

1. Place the marker in the current script where the contents of the new script should be placed.
2. Right-click the .Script Editor vTrunk and on the Context Menu select Insert from File ... .
3. Inthe Open dialog box, select the script and click Open.

To use a script unit from the repository

1. Click the Show library scripts button to open the Use Unit dialog box.
2. Search for and select the script unit to add, and click OK.
® A new tab will open in the Script Editor, showing the script unit.
® A dtring of theform* USEUNI T <myscri pt > will be added into the main script to
indicate that the selected script unit is being used.
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Tip: To stop using a script unit, delete the relevant * USEUNI T comment from the main

To reopen used script units

A template with script units will not by default display the script unit tabsif the template is closed and
later reopened. To reopen used script units do either of the following:

1. Placethe marker in front of the® USEUNI T <nyscri pt > tag and pressthe CTRL+ENTER

keys on the keyboard.
Or:

1. Right-click the .Script Editor vTrunk and on the Context Menu that appears, select Open ... .
2. Inthe Open dialog box, select the used script unit and click Open.

To save script units to the repository

-7 S-cript editor [2@

| unitz=
JJJJJ ] | -]
InitForm £
WOniButtonl.Color = clGreen

1
2
3 nd Suob
4
5
£

| ¥
Syntax OK

Line: 3; char: 8

Open the .Script Editor vTrunk.

Right-click the editor, and on the Context Menu select New Edit Window.
Write/Add the script that will be saved to the repository.

Click the Save button (CTRL+R)

In the Save As dialog box enter the File name and click Save.

akrcwNpE

Tip: Create and save atest script and delete it from the local Script Units folder. Restart
Template Wizard to test that the script is uploaded correctly.

To retrieve script units from the database

This procedure can be used to download new or updated scripts (for example on other clients) while
Template Wizard is running.

® Onthe File menu, select Refresh Scripts.
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To resolve conflicts between local and repository script units

.,

| 4| Repository conflict detected

Conflicting units - check to ovenarite from repositorn:
newtest.vbs

Select all |

Un=elect all |

When new files are uploaded to the client, there might be cases where repository files are different from
local files. To handle situations like these, a user can do one of two things:

1. Overwritethelocal file with the repository file, or

2. Renamethelocal file and then overwrite.
It isalso possible to use a file comparison tool (diff tool) to compare the file in the repository with
your local file. When specifying which tool to use, add the entry di f f _t ool in the ContentPilot.
ini file. Thedi f f _t ool entry should also be followed by the path to the tool itself.

To export atemplate that uses script units
To export atemplate that uses script units, use the export/import functionality in Template Wizard, see
Export and Import in Template Wizard.

Save Template to File can be used to save templates, but it does not save the included Script Units. If
using Save to File, the script unit files must be copied separately.

9.15.4 Live Update

IMPORTANT! Live Update has been superseded by Update Services. If you need to use Live
Update, you must also use the Legacy Playlist.

Live Update can be used to update data by adding the OnLi veUpdat e function to the Script Editor. This
function is called at regular intervals when the template is on air after being run from the playlist in
Director. The function can be used to continuously update the scene with new data (e.g. stock quotes).

Using the OnLi veUpdat e function requires that the template is Save Templated with the Live Update
check-box checked.
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Note: The update intervals are set in the ContentPilot.ini file.

It isaso possibleto do “live updates’ using the OnAct i onEvent function, however, thisfunction is not
called at regular intervals, but when specific actions are performed in Director (e.g. Start, Continue €etc.).

The Live Update mechanism relies on Director executing the scripts. This means that you will haveto
have a Director up and running at all times when there are Live Update templates in the playlist.

For other control applications such as Viz Trio thisis not an optimal workflow; hence, the Update Script
mechanism is recommended as it works on the Media Sequencer alone, and is therefore available to all
products connecting to the Media Sequencer. See Update Script Editor.

Caution: Having a Director up and running at all times when there are numerous Live Update
templates in the playlist will cause Director to load all templatesin the background and consequently
use alot of memory.

9.15.5Viz Trio Template

It is possible to create templates that can be used in Viz Trio. This following example and procedure
explains what to in order to create a custom user interface for Viz Trio. Note that the Script Example uses
specific Viz Trio macro commands. Template Wizard is unable to fully test Viz Trio templates; hence, a
Viz Trio client is needed.

Script Example
The OnClick event (i.e. defined as “Button1Click”) triggers the macro command TrioCmd with the
parameters to read, set avalue, and take page 1000 on air.

Sub ButtonldC i ck(Sender)
TrioCnd( " page: read 1000")
TrioCnd(" page: set_property 01 ") & yourval ue
Tri oCmd( " page: t ake")

End Sub

For more information on macro commands, see the Viz Trio User’s Guide.
To create atemplate for Viz Trio

Choose File and New to create a blank template.

Add components and define script events as needed (see Script Example).

Add Viz Trio macros to the code that will be triggered by the events.

Save the template to afile, and copy it to the Viz Trio client machine's vtwtemplates directory or
shared directory.

5. Start the Viz Trio client and set the template to active in the Show Settings.

P wWDNPE
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9.16 Update Script Editor

This editor allows you to add scripts that will be executed by update services on the server side, and not on
the client side through Director.

Unlike the Live Update mechanism that relies on Director executing the scripts, update services work on
the Media Sequencer alone, and are therefore available to all products connected to the Media Sequencer.

The update script does not have access to components in the template, only the data, so the template does
not need to be loaded by Director (asisthe case for Live Update scripts).

This section contains the following topics:

® Using the Update Script Editor
Update Services

Update Service Scripting

® Viz DataFormat (VDF)

9.16.1 Using the Update Script Editor
The Update Script Editor consists of the Script and Actions tabs.

Script

[ =

4 Update Script (modified) =N =

J Script Actions

[[] use Update Service [] use External Update Service

—External Update Service

— Update Script

1 Sub OnUpdatePayload (Data) -
2 For i=0 to Data.Count-1

= Set field = Data.Fieldat (i)

4 field.Value = "Hew wvalue from script” E
= Hext

& End Sub

7

8 -
] 1] 3
Syntax OK

Check Syntax

The Script tab allows you to select which of the Update Services you want to use. Either Viz Pilot system’
sown Update Service or an externa (third party) update service.
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Actions

| & Update Script E'@

Script Actions |

Action Timeout

[%] Taka 5000 | [ update at regular intervals while on air
[] read 5000 -

¥

[¥] Update 5000

4

¥

[¥] cue 5000 :

The Actions tab allows you to select which actions should be triggered during an update and set the
timeout for each action.

Script actions are based on Read, Take, Cue and Update events that are triggered on the Media Sequencer.

When the Take action is selected, the Update at regular intervalswhileon air option is enabled. If this
is checked, then the Media Sequencer will periodically send updates to the update service. Theinterval is
specified by the parameter | | ve_updat e_i nt er val , and the minimum value is 2 seconds.

Note: The functionality to Update at Regular Intervalsisonly availableif Template Wizard is
connected to a database with schema Viz Pilot 6.0 or later, and Media Sequencer 3.0 or later.

9.16.2 Update Services

Update services are mechanisms that |et the template designer decide when to update data in the template,
and also which fields to update. Thisis useful for data that should be updated right before going on air.
Typical examples are stock values, player statistics etc.

Wiz Pilot Database F‘% Diata Server
|

Wiz Pilot client Media Sequencer Hq Seript Runner
I

| Update Service

e mmmm o e e m—

Viz Engine

In Template Wizard you have two options:

259



1. Viz Pilot’s Update Service (Script Runner): Using this mechanism means that you can write a
script updating the data that will be run by Script Runner during playout.

2. External update service: Alternatively you can point the template (no script) to an external
update service (e.g. third party), that can return updated data using the Viz Data Format (VDF). In
order to implement an external update service, you need to parse and return aVDF document to
the Media Sequencer. The document is posted to the external update service by the Media

Sequencer.
Wiz Pilot client Media Sequencer External Update
Sarvices
Wiz Engine

9.16.3 Update Service Scripting

The entry point for using Viz Pilot’ s update service (Script Runner) isamethod called
OnUpdat ePayl oad. The method has the following signature: Sub OnUpdat ePayl oad( Dat a) .

The Dat a parameter contains the incoming data and the data can be modified in the OnUpdat ePayl oad
script.

Properties and methods

Data Properties Description

Data.Count Number of fieldsin the Data.

Data. FieldAt(index) Returns a PayloadField at the given index.

Data("1") Returns the PayloadField with the given name. "1" in this example.
PayloadField properties Description

Name The name of thefield.

Vaue The name of thefield.

Example

A sample script that updates all the incoming fields and set their values to “New value from script”:

Sub OnUpdat ePayl oad( Dat a)
For i =0 to Data.Count-1
Set field = Data. Fiel dAt (i)
field.Value = "New val ue fromscript"
Next
End Sub

Tip: Datatreated outside the OnUpdat ePay| oad function (e.g. fetching external data from files or
databases) must be returned before the OnUpdat ePayl oad function ends.

260



9.16.4 Viz Data Format (VDF)

Viz Data Format (VDF) refersto format specifications created for the purpose of datainterchange
between Vizrt software components. They form the basis of integration points, interoperability, reusable
components and content portability.

The Viz Data Format (VDF) Payload and Model Specification can be accessed through the Pilot Data
Server’s Documentation page.

Example VDF:

<?xm version="1.0" encodi ng="utf-8"7?>
<payl oad nodel ="http://|ocal host:8177/tenpl at es/ 18110/ nodel " xm ns="F
ttp://ww. vizrt.conltypes">
<fi el d name="-concept-vari ant - choi ce" >
<field nane="concept">
<val ue>Deno</ val ue>
</field>
<field name="variant">
<val ue>Def aul t </ val ue>
</field>
</field>
<field name="1">
<val ue>Pi | ot </ val ue>
</field>
<field name="2">
<val ue>rocks :)</val ue>
</field>
</ payl oad>

9.17 Execution Logic Editor

Execution Logic commands are saved as part of atemplate. This allows data elements based on the
template to use the same execution logic commands.

For example, adding an execution logic script to the Media Sequencer command Take, will replace the
Take command for al data elements based on that template.

A benefit of using Execution Logic is that the script can be run without the need for Director to be open. It
ispossible to utilize alimited set of commands - or any Viz Engine command - straight on the Media
Sequencer to issue instructions or emulate button presses for each created Data Element.

This section contains the following topics:

® Execution Logic Editor
® Working with Execution Logic

9.17.1 Execution Logic Editor

This section contains the following topics:
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Execution Logic Editor Features
To enable the execution logic editor
To add execution logic to atemplate

Execution Logic Editor Features

.

| & Execution Logic (=]
Command: take

read 1 <relative>

cut 2 <env command="take" timecode="00:00:00:00":>

continue 3 cref>/path/to/the/element</ref>

cue 4 < fenv>

out <env command="continoe" timecode="00:00:05:00">
<ref>/path/to/the/element</ref>

update /path/to/the/

</envs

<env command="ont" timecode="00:00:10:00":>
<ref>/path/to/the/element</ref>

10 <fenv>

11 cfrelativeﬂ

w o m =1 &y

ﬁ Find: | | = Find Mext | & Find Previous

Ok | Cancel |

The Execution Logic editor consists of three panes; alist of commands, a command editor and a list-view
displaying syntax errors. In addition the editor has a search feature.

Command list: Displays the available commands. Available context menu options are Clear selected
command and Clear all commands.
® Clear selected command: Clears the execution logic for the selected command.
® Clear all commands: Clearsal execution logic for all commands.
Command editor: Displays the currently selected command and its execution logic. Available
context menu options are Insert default action and Find.
® |nsert default action: Inserts the default command <r ef >/ | ogi ¢/ el enent/ run</ref >.
® Find (CTRL+F): Opensthe Find tool.
Syntax error list: Displays any syntax errorsin any of the commands. It is not possible to close the
window with changes to any command before al syntax errors are resolved.
Find (CTRL+F): Searches the currently open command’ s execution logic.
OK: Save changes and close the execution logic editor.

IMPORTANT! If the Execution Logic Editor is closed using the Exit button or by selecting File
then Close, then any changes will NOT be saved. In addition, if the templateis saved and closed
without first saving the execution logic, the execution logic will not be updated in the template.

Cancel: Close without saving.
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¢ XML tagssuggestion dropdown: Type < to open the suggestion dropdown.

B Execution Logic [&=]

read

cut
XML Tags

. - |
<elements

<elzer

<entry

BN

<equalsy

<handler:

£groups

¢log:

<playlizt:

<refr

<zets

<thenr

<timematch:

vars

<videos

vz

continue
cue

out
update

To enable the execution logic editor
® Goto View > Execution Logic Editor
To add execution logic to atemplate

1. Open the Execution Logic Editor.

2. Click on one of the existing commands (I&ft pane)

3. Add thelogic in the editor (right pane) and click OK.
For more information on how to create execution logic, see the Media Sequencer manual on how
to use the Media Sequencer’ s logic building blocks.

9.17.2 Working with Execution Logic

This section contains the following topics:

® Send basic commands

® Example - Play, Continue, Take Out

® Example - Forked Execution

® Example - Commands generated by atemplate

Send basic commands

The <vi z> handler is used to send commands to the Viz Engine.
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The following example sends the RENDERER SET_OBJECT SCENE*. .. command to channel “A” in
the current profile:

<env vi z="A">
<vi z>RENDERER SET_ OBJECT SCENE*...</viz>
</ env>

Multiple commands can be sent by separating each command with <br / >, for example:

<vi z>RENDERER SET_OBJECT . .. <br/>RENDERER* STAGE START</vi z>

Instead of setting the command directly, a more powerful approach is to use the contents of afield in the
template. The field (a hidden textbox for instance) can then be filled with the Viz commands that need to
be sent.

This example shows how the contents of adatafield in a data element can be retrieved by using the
<ref >construct ("fi el d_01" isthe ControlObjectName of the datafield):

<env viz="A">
<ref ><var >el ement </ var>/data/fiel d_0l</ref>
</ env>

To send commands to several channels, duplicate the command:

<env viz="A">

<ref ><var >el enent </ var>/data/fiel d 0l</ref>
</ env>
<env vi z="B">

<ref ><var >el ement </ var >/ data/fi el d_02</ref>
</ env>

Note: Forked execution is required when a channel contains multiple engines, otherwise the
commands will only apply to the first enginein achannel.

Example - Play, Continue, Take Out

This example shows how execution logic can be used to play an element, do a Continue after five (5)
seconds, and then a Take Out after ten (10) seconds.

In the Execution Logic Editor, select the “take” command. Add the logic into the editor (right pane). This
means that when a“take” isissued on a data element based on this template, the Media Sequencer will
execute the logic.
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The commands are modifiedtodo a"t ake", "cont i nue" andthenan" out " . Thetimecode for each
operation must be set.

<rel ative>
<env conmmand="t ake" ti mecode="00: 00: 00: 00" >
<ref>/1o0gic/el ement/run</ref>
</ env>
<env command="conti nue" tinmecode="00: 00: 05: 00" >
<ref>/1ogic/el ement/run</ref>
</ env>
<env command="out" ti necode="00:00: 10: 00" >
<ref>/1o0gic/el ement/run</ref>
</ env>
</relative>

Note: The running/outer context takes precedence over attributes on the “ref”. Instead of adding
attributes on the “ref” node, you use an “env” node as in the example above.

Example - Forked Execution

These examples show how the "take" command can be modified to make the template override the
standard logic and instead send RENDERER* STAGE START.

Here the command will be sent to the channel assigned to the data el ement:

<f or ked_exec>
<entry name="execution_group"><var>channel </ var></entry>
<vi z>RENDERER* STAGE START</vi z>
</ forked_exec>

To send commands to a specific channel in the current profile, replace <var >channel </ var > with the
name of the channel you want to send to, asfollows:

<f or ked_exec>
<entry name="execution_group">My_CHANNEL</ entry>
<vi z>RENDERER* STAGE START</vi z>
</ forked_exec>

Example - Commands generated by atemplate

By using the information from the preceding examples, we can create logic that will send custom Viz
commands that are generated by the template.

One way would be to add a VValue Control Component to the template, and set the Control ObjectName to
"vi zcrds" . Then create aregular script that sets the ControlValue of the TWVaueControl to whatever
command needs to be sent.
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Alternatively, use a standard memo box, and set the ControlObjectNameto " vi zcnds" . Then enter the
Viz commands (or script what the contents should be). The memo box’ s visibility can be set to false so the
user can't seeit. In the Execution Logic you can then add the following:

<f or ked_exec>
<entry name="executi on_group"><var>channel </ var></entry>

Vi z>
<r ef ><var >el enent </ var >/ dat a/ vi zcnds</r ef >
</viz>

</ forked exec>
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10 Template Wizard Components

This section contains the Template Wizard' s components and their properties:

® Object Inspector

¢ Standard Components

® Additiona Components

® Database Components

®  Communication Components

® Dialog Components

® Import Components

® Viz Control Components

® Other Components

® Component Properties
Y ou can use the Component Palette to customize which components appear in the dropdown list at
the top of Template Wizard.

10.1 Object Inspector

TTWUniMemo1: TTWURiMemo
[] Enable script all
Basic All Events
Align alMone e
HAanchors [akLeft,akTop]
| ControlObjectMame 01 B3
Enabled v
Enablespellcheck |
EvObjects (TStrings)
ElFont (TFont)
Height -12
Mame Verdana
Height 40
HideObjects (TStrings)
HideQOnEmpty |
Left 10 W
ControlObjectd ame
Used to set the ID of the Control Plug-in from the Viz| Artist

SCENE.

Doubleclick to change thumbnail...
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The Object Inspector basically displays Component Properties which enables the designer to configure
them, and add Component Events through scripting. All properties use the Control ObjectName property
that ties the Exposed Objects or Scene Objects (see the Resource Panel) from the graphics scene to the
template.

The majority of components have alot of properties where most are only used in special cases; hence, the
inspector’ s separated properties view.

It isaso possible to sort properties by category or name by clicking the sort buttons. By default properties

are sorted by name.
It is aso possible to use the inspector to change the Template Thumbnail.
‘Note: The property editor in Template Wizard does not support Unicode directly. To edit properties
like"UTF8Text", the user needs to press the ellipsis button (...) and then edit the text.

= 5 1 [Headlne]
i 0:

keming |I-|ea|:||m.e ............ | Basic All Events
= Em [ﬁtﬁllﬂl Su\tﬂfﬁﬂ .............. kern.nq Bﬁrbd‘mﬂ tﬂkl.ﬂ&.mﬁp]
oz r |‘5|.:_' ing | El AtoSae W
keming | | ContrelObjectNama 01 kerming =

All components that support graphic scenes with Control plugins have the Control ObjectName _property
which shows the exposed object property it is connected to. The value is linked to the structure and
numbering of the exposed objects. The value below the 01 (Headline) entry named 01 holds the default
value since its name is the same as the main entry (01(Headling)). In this case it isatext string. The
ControlObjectName for this value isthen 01. The kerning value for the text string is grouped under the 01
node and gets the Control ObjectName 01.kerning. The naming convention is objectname.propertyname.

Note: It isgood practice for scene designers to name the scene’s Field Identifiers as 01, 02, and 03
instead of 1,2,3,4 ... 11,12 and so on. The latter will cause data to be assigned to the wrong fields
when using the Import Components components because the Media Sequencer will place 11 and 12
before 2 and so on.

To see acomponent’ s properties

® Start Template Wizard, add a component to the template, and use the Object Inspector on the right to
browse through the different properties.

See Also
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® Resource Panel

10.1.2 Component Events

If scripting is enabled for atemplate (see Template Wizard Components ), each component will show the
Eventstab. The Eventstab lists all possible events that can call scripts when certain user actions,
functional or procedural events are triggered.

Examplel

Scenario; A user clicks abutton on atemplate and an OnCl i ck event triggers a new event that loads a
piece of datainto adialog box.

Script editor
Main _ [Mew Template] - Designing

o)l =] | |

1 Sub BEuttonlclick (Sender) -
2 M=gBox [(Jender.Font.Name £ " " & Sender.Name |E‘
3 £ " " g Sender.Width) 3
4 nd sub v
[i] 11l ] [i]
Syntay Ok

| Line: 4, char: 8 |

The above image depicts a solution to the scenario with an OnClick Event where the button’s Sender
object isan argument to the Sub procedure But t on1C i ck. The event name is comprised by the Name (

But t on1) property and the event type (OnCl i ck). The Sender object contains al the component
properties of the sender.

Note: Do not mistake the Name property for the Caption property. The Caption property iswhat is
displayed on the button, and the Name property iswhat is used to referenceit.

Fun mode

[Mew Template] - Running

_ Yerdana Buttonl 100 Ga Yiz!

A click on the button triggers the OnCl i ck event, and displays a message box with the button’s font type,
name, width in pixelsand its label.
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Examplell

Scenario; A user adds two numbers to summarize a score result.

The scenario from Example | can be used to extend to fit scenario of Example Il by using the same event
on several components, linking them to the same piece of code. The example uses a small piece of code
with one global value, two procedures and a function to calculate the value.

D m gl obal Tot al Val ue
Sub cl eard i ck(Sender)
gl obal Tot al Val ue = 0
t xt Val uel. Text "
t xt Val ue2. Text "
txtSum Text = ""
End sub
Sub addVal ue( Sender)
cal cul ate(Cl nt ( Sender. Text))
End sub
Functi on cal cul at e(val ue)
gl obal Tot al Val ue = gl obal Tot al Val ue + Val ue
t xt Sum Text = gl obal Tot al Val ue
End Function

Calculate

" alue 1 10
alue 2 20
Total 30 Clear

The two text fields are named Value 1 and Value 2, and they both have the OnExi t event defined as
addVal ue. Entering avauein field 1, and exiting it, will trigger the event addVal ue which sends the
value (Sender . Text ) to the calculate function. The calculate function cal culates the value and sets the
new gl obal Tot al Val ue inthetext field, named t xt Sum The two vaue fields share this small piece
of code.

To add an event

1. Check the Enable script option in the Object Inspector (CTRL+F12) to enable scripting
2. Click the Eventstab, and double-click an the empty field to the right of the event. This createsa
default event name and inserts a script framework (sub procedure) into the script editor.
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10.1.3 Template Thumbnail

. «

Doubleclick to change thumbnail...

All templates use the thumbnail generated when the scene was saved in Viz Artist. Multi-scene templates
(e.g. Transition Logic) use the thumbnail from the first scene that is added to the Wizard' s Selected scenes
pane (Wizard's step 2).

It isaso possible to select a custom image (e.g. jpeg, bmp) by double-clicking the Thumbnail image
(lower-right) in Template Wizard; however, these cannot be based on Viz Artist scene icons.

Thumbnails are visible in Director and Viz Pilot News.

10.1.4 Scripting Support

Visual Basic Scripting (VBScript) is supported by Template Wizard. The supported version is dependent
on the installed version on the computer(s). To find the VBScript version that isinstalled, localize and see
the properties of the vbscript.dll file.

For auser’s and language reference guide on VBScript, see the Microsoft Developer Network (MSDN).

As part of the component descriptions, some VB Script examples are given to show how the components
can be used with scripting.

To enable scripting

® Check the Enable script option in the Object Inspector (CTRL+F12) to enable scripting

10.2 Standard Components

Standard components are the most commonly used components. This section contains the following
topics:

® Unicode Label Component

® Unicode Edit Component

® Unicode Memo Component

® |Image Component

® World Maps Editor Component
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® Panel Component

® Unicode Button Component

¢ Unicode CheckBox Component

® Unicode Radio Button Component
¢ Unicode ComboBox Component
® Unicode ListBox Component

¢ Unicode GroupBox Component

® Static Image Component

® Page Control Component

® Template Information Component
® Person Information Component

® Feed Linker Component

10.2.1 Unicode Label Component

Label adds a basic text label to the template.

Notable Properties

® Caption: Changesthe label text.
® Font: Setsthe font type and size.

Script Example

TWUniLabel1l

TWUni Label 1. Font . Col or = cl Red

10.2.2 Unicode Edit Component

=1

Edit adds a basic text field editor to the template.
Notable Properties

® EnableSpellCheck: Enables spell checking for the text field.
® Name: Setsthe name of the text field.
® UTF8Text: Setsthetext in the text field.
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Script Example

Today's date: |15/07/2013

The text field can be set asfollows: TWUni Edi t 1. UTF8Text = Date
or, dternatively, using: Set Uni codeVal ue TTWUni Edit1, Date

where Set Uni codeVal ue takesthe unicode input parameter, UTF8-encodesit and setsthe .
UTF8Text property.

Cet Uni codeVal uereadsthe .UTF8Text property from components, UTF8-decodes it and returns, for
example:

Sub TWUni But t onl1d i ck( Sender)
MsgBox Get Uni codeVal ue( TWUni Edi t 1)
End sub

Another example using the Unicode Edit field is described in this Script Example (Image with Name,
Unicode Edit and Template Info).

To enable spell checking in Unicode Edit and Unicode Memo fields

1. Usethe Wizard to create a new template.
2. Add aUnicode Edit Component or Unicode Memo Component field to the template.
3. Check the EnableSpellCheck property for each field that requires spell checking.
4. Savethetemplate.
"Note: The actual spell checking will only occur when the template is saved asadataelement
in the Newsroom System or Director.

Memo is awrapper for amultiline edit control. Multiline edit boxes alow the user to enter more than one
line of text. They are appropriate for representing lengthy information.

Notable Properties
® EnableSpellCheck: Enables spell checking for the text field.

® Name: Setsthe name of the multiline text field.
® UTF8Text: Setsthetext in the text field.
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* WordWrap: Wraps a section of words, adding line breaks (this property islisted in the All tab).
Refer to the example below for more information.

Script Example

TwiniLabell
TWlniLabell

TWUniLabel1 [T¥UniLabell]

TWUni Label 1. Font. Col or = ¢l Red

TWUni Edi t 1. Text = TWUni Label 1. UTF8Text

TWUni Menol. UTF8Text = TWJni Label 1. UTF8Text & vbCrLf &
TWUni Label 1. UTF8Text

When enabling the WordWrap property, the width of the template’ s text box decides where the line breaks
in the graphics will be. Hence, the output on the renderer might not be as intended. If the template’ s text
box is narrower than what the scene alows, the output will have line breaks according to the text box, and
not according to the scene design. To solve this, either use the Wrap Fixed Unicode Memo component
without WordWrap, or add a script that can remove al line breaks. The example below is most useful for
scenes with only one text paragraph.

tenpl = TWUni Menol. UTF8Text
templ = replace(tenpl, chr(10), "")
tenpl = replace(tenpl, chr(13), "")

TWUni Menol. UTF8Text = tenpl

10.2.4 Image Component

2

The TTWImage component (also known as | mage with Name And Title Linking Component) has a
several uses. It can of course be used for setting images in Viz Engine scenes, but it can also be
configured to control backgrounds, objects and materials. In addition it has a special feature making it
possible to add a video instead of an image.

274



Notable Properties

® AllowCropAspectOverride: Enables usersto select a different aspect ratio than the one given by the
DestHeight and DestWidth properties, when using Crop Service. Default value = False. See Preset
Image Size.

® AlwaysUseCropTool: Enables the user to always use the crop tool by default when animageis
added to the template when using the islmageMediaSearch, isFileOpen and isPaste image source
options. See To enable the crop tool.

® ControlObjectName: Links the component to an exposed scene object.

® DestWidth/DestHeight: Sets the destination width/height of the image, forcing the size of the image
used in the scene to be of a specific width/height. For details, see Preset Image Size.
When set to values greater than O (zero), it will enable the crop tool. The parameters set a fixed
height and width for the crop tool. Using this setting will force the user to use the configured height
and width, and the aspect. Meaning, if the selection is greater than then actual height and width
parameters, the image will be scaled to fit.

¢ DisallowedK eywor ds. Defines the disallowed keywords used when searching for media content.
When a user searches and finds an image, they are not allowed to select the image if it contains a
keyword that is present in the DisallowedK eywords property.
"Note: The DisallowedK eywords property is available for RestVOS and Viz One searches, but

not for Object Store searches.

® EvObjects: Add the path to more object containers to receive the same value as the object defined in
ObjectPath. Add the name of containers with “$containername” or the full Viz Engine path. Other
objects must have the same keyframe name as the main object.
® HideObjects: Define other objects that should be hidden when the main image object is hidden.
®* HideOnEmpty: If selected, the object is set to hidden in the scene if no image is loaded.
® | mageSour ces. Sets one or multiple image source locations. The default settings are islmage and
islmageMediaSear ch; however, in most cases the actual control object properties of the scene will
decide what components and settings to use.
® isAdvancedCuriousMap: Allows the user to search and select a map from the Viz World
Client using the Classic Edition Editor.

Note: The isAdvancedCuriousMap property is deprecated from Viz Pilot 5.7 and only
available for backward compatibility. Use the World Maps Editor Component component
instead.

® sCuriousMap: Allows the user to search and select a map from the Viz World Client using the
Lite Edition Editor.
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Note: The isCuriousMap property is deprecated from Viz Pilot 5.7 and the Lite Edition
editor is not the recommended editor. These features are only available for backward
compatibility. Use the World Maps Editor Component component instead.

® isFileOpen: Allows the user to search and select an image from disk. Note that the image must
be available on the Viz Engine using the same shared path.

® isimage: Allowsthe user to search the Viz image pool for images through Director’s Viz
resource tab. Viz 3.x images are stored on the Viz Graphic Hub while Viz images are stored on
its data root.

® islmageM ediaSear ch (previously named isDatabase): Allows the user to search and select a
till image from the configured service providers (eg. Object Store, Viz One).

® isMaterial: Allowsthe user to select amaterial from the Viz material pool through Director’s
Viz resource tab.

® isObject: Allowsthe user to select an abject from the Viz object pool through Director’s Viz
resource tab.

® isPaste: Allows the user to paste images from the Windows clipboard by right-clicking the
Image icon and selecting Paste... on the context menu. Pasting will open the Crop Image tool.
Pasted images should be added to a shared drive accessible to Viz Engine. The crop tool save
path is set in Director’ s Preferences window under General settings. isPaste does not add
images to Object Store, and does not preserve apha values.

® isProximity: Allows the user to search and select images or clips from Proximity’s Artbox.
Requires the Proximity Artbox asset management system.

® sRGB: Allowsthe user to select an image from the Viz RGB pool through Director’s Viz files
tab.

® sScene: Allows the user to select a scene from the Viz scene pool through Director’s Viz
resource tab.
® isVideoM ediaSearch (previously named isVideoHub): Allows the user to search and select a
video from the configured service providers (eg. Object Store, Viz One). When selected, it
allows the user of the template to preview avideo item using the Timeline Editor within
Director or Viz Pilot News.
®* RequiredKeyWords: Defines the required keywords used when searching for media content. See
Required Keywords.
* RequiredKeywordsM ode: Setsthe options Requi r eOne or Requi r eAl | . Searches can be
performed with information from the RequiredK eyWords field.

Events
¢ Onlmagel nfoChanged: Enables Object Store To add person information to the template. Person

information is often registered in Object Store with images of personsin order to easily get the right
name of the person in question. See Person Information Component.
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® CreatingMediaOrder: Used with Order Management. This event israised just before the Order
Management window is shown. Its signature looks like:

Sub TW rmagel nf 1Cr eat i ngMedi aOr der ( Sender, CustonPar aneters,
Reser vedPar anet er Keys)

® Sender issetto theimage control itself.

® Cust onmPar anet er s isakey-value collection where you can add items. For example:
Cust onPar anet er s. Add( "t hi s=1")

® ReservedPar anet er Keys isalist containing all the keys that are set by the client for
various purposes. It has the following values. keywords, asset_type, destination_width,
destination_height, template_name, concept_name, variant_name. If any of these keysisset in
Cust orPar anet er s then it will be ignored and the value provided by the client will be used
instead.
For example:

Sub TW rmagel nf 1Cr eat i ngMedi aOr der ( Sender, Cust onmPar anet er s,
Reser vedPar anet er Keys)

' Add key val ue paraneter pair

Cust onPar anet ers. Add " Par anil=Val uel"

" Get index of key

Cust orPar anet er s. | ndexOf Nanme(" Paraml”) ' returns 0 (-1 if
nane i s not found)

" CGet the key for a given index

Cust onPar anet ers. Nanes(o0) ' returns "Paraml"

' Cet the value for a key

Cust onPar anet ers. Val ues( "Paraml" ) ' returns "Val uel"
End sub

Script Example (Image with Name, Unicode Edit and Template Info)

The following example describes how to include the Object Store image name in the data element name.

[New Template] - Designing

1. Add aUnicode Edit Component field (namet xt | mageNane) and set it to beinvisible.

2. Add a Template Information Component component and add int xt | mageNane as one of the
save name fields.

3. On any of the image components (here named "i mage") add the following script on the
OnFi | enaneChanged event:

Sub i mageFi | enameChanged( Sender)
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t xt I mageName. UTF8Text = "" ' ear the save nane before
starting
\gFirst test if the returned inmage is froma Viz One server
if Left(image.picFilenane, 8) = "https://" then
t xt | mageNane. UTF8Text = "Viz One | mage"

else '...it should be an Object Store inmage
\gGet the nunber of arrays if the picfilenane divided by "\"
mar k
Number OF El emrent s = UBound( Split (i mage. pi cFi |l enane,
")

i f Number Of El emrents > 0 then
t xt | mgeNane. UTF8Text = Split (i mage. pi cFi |l enane,
"\") (Nurmber O El enent s)
End if
End if
End sub

Preset Image Size

A scene designer can design a scene to use an image of a specific size. By setting a specific width and
height the template designer can, in accordance with the scene design, control the aspect. When selecting
an image, a crop tool, with a preset aspect ratio, is automatically opened requiring the user to crop the
image. Images from Object Store will use the legacy Crop Tool while images fetched with RestV OS from
Object Store or Viz One will be cropped using Crop Service.

Cursor crDefault
DrestHeight 100
DrestWidth 200
1 T Dizallowediey (TTntStrings)
DragCursor |crDrag
Dragkind dkDrag
oot DragMode dmManual

DestWidth and DestHeight is used as parameters to preset the crop tool and to scale the image further
after save, if needed.

If the property AllowCropAspectOverrideistrue, users can select a different aspect ratio than the one
given by the DestHeight and DestWidth properties. Thisis only supported for images cropped with Crop
Services.

Required Keywords

The properties RequiredK eyWords and RequiredK eywordsMode allow the Object Store (VOS), RestVOS
or Viz One search to be restricted by keyword in two ways.

RequiredKeywordsMode = RequireOne:

® The media search will return images containing ONE OR MORE of the keywords specified in the
RequiredK eyWords property in the template.
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® When using the template in Viz Pilot News, deselecting some of the keywords is possible, and will
narrow down the search. Selecting additional keywords will broaden the search.
RequiredKeywordsMode = RequireAll:

® Themediasearch will ONLY return images containing ALL of the keywords specified in the
RequiredK eyWords property in the template.

® When using the template in Viz Pilot News, deselecting a required keyword is not possible. Selecting
additional keywords will narrow down the search.

Note: The functionality of Viz One and RestVOS allow multiple keywords in the Viz One or
RestVOS to map to a single keyword in the interface. If such mappings exist, any RequireAll
searches that include such keywords, will be run as RequireOne searches. The result of thisis
that the user will see more results than is strictly correct. However the user will not be able to use
any of theincorrect images as the "OK" button will only be enabled when an image with all the
required keywords is selected. To avoid this situation, the keywords in the Viz One or RestVOS
should be labeled with unique names.

To enable the crop tool

If the image component uses AlwaysUseCropTool, DestHeight or DestWidth, then the crop tool will be
called.

1. In Template Wizard open atemplate with an image component.
2. Select theimage component and set one or both of the following properties:
® AlwaysUseCropTool: Use the crop tool by default.
® DestHeight and DestWidth: When set to values greater than O (zero), it will enable the crop
tool. The parameters set a fixed height and width for the crop tool.
3. Select one or several image sources.
® |mageSources: Valid sources for the crop tool are islmageMediaSearch, isFileOpen and
isPaste.
4. Savethetemplate.

To add person information to the template

In addition to fetching the person information and adding it to the proper text fields, the following
procedure will use the SC_SaveNane function to fill the Save dialog box with a save name based on the
image' sfile name.

Start Template Wizard.

Create a new template of a scene with an image.

Select the image component (TTW nagel nf 1) that was added to the template.

Check the Enable script option in the Object Inspector (CTRL+F12) to enable scripting

Select the Events tab, and double-click the Onlmagel nfoChanged event to add the procedure to
the Script Editor.

6. Add the following script:

a s wbdpE

option explicit
dim | evel
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di m savenane
function SC_SaveNane
SC Savenane = savenane
end function
Sub TTW magel nf 11 magel nf oChanged( | magel nf oLi st, Personl nfoLi st,
Keywor dsLi st)
dimi
TWUni Menol. Li nes. Cl ear
TWUni Meno2. Li nes. d ear
TWUni Meno3. Li nes. C ear
for i = 0 to ImagelnfoList.Count - 1
TWUni Menol. Li nes. Add( | magel nfoLi st (i))
next
for i = 0 to PersonlnfolList.Count - 1
TWUni Meno2. Li nes. Add( Per sonl nfoLi st (i))
next
for i = 0 to KeywordsList. Count - 1
TWUni Meno3. Li nes. Add( Keywor dsLi st (i))
next
savenane=Il magel nf oLi st . Val ues("Fi | eNane")
End sub

7. Savethetemplate and open it in Director or Viz Pilot News to test it.

To use additional fields

1. Addthe Imagel nfoChanged event to your script:

Sub TTW magel nf 11 magel nf oChanged( | magel nf oLi st, Personl nfoLi st,
Keywor dsLi st)

TTWUni Edi t 1. Text = | nmagel nfolLi st. Val ues("Nationality")
End sub

10.2.5 World Maps Editor Component

<

World Maps Editor adds a map placeholder to the template.

Note: The World Maps Editor component requires aViz World Client installation locally and a
connection to one or more Viz World Server(s) or a Server Allocator.

The World Maps Editor component has a different workflow from an image component. In the Maps
component, additional content is present in the MapXML field in the template saved on the Viz Pilot
system, which makes it possible to script standard start points (e.g. for zooms). It also alows the correct
Viz World project template to be selected, avoiding the default project error message when the maps
editor opens.
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Note that in Viz Pilat, it is not possible to fine tune the zoom, latitude, longitude, pan or tilt after making
your map selection.

Notable Properties

® ControlObjectName: Links the component to an exposed scene object.
® MapXML: Storesthe XML that is returned from the Viz World Server once the user has selected a
map.
® VizWorldEditor: Defines the editor to be launched when amap is added to the templ ate.
® vwClassic_Edition: Classic isthe default editor. All the map features are exposed and the user
has full control over the map selected.
® vwSecond_Edition: Second Edition is the next generation map editor. It is more user friendly
and will soon have afull set of features.
For more information on how to work with maps, please refer to the Viz World User’ s Guide.

10.2.6 Panel Component
(]

The Panel component adds a panel that can be used to group a set of components.

Notable Properties

® Caption: Setsatext string to identify the panel to the user.
® Name: Setsthe name of the panel to use as a reference when scripting.
¢ Height and width: Sets the size of the panel.

Script Example (Panel and Unicode Button)

This example shows how a panel can be switched on and off using the Visible property. The color of the
buttons change accordingly.

Show |

TWUniLabel1 [The Sky Hook

kareem Abdul-labbar

Sub I nitForm

281



TWUni Label 1. Font. Col or = cl Red
TWUni But t onl. Col or = cl Li ne
TWUni Butt onl. Capti on = " Show'
Panel 1. Visible = fal se
End Sub
Sub TWUni Butt on1d i ck( Sender)
i f TWUni Buttonl. Color = clLinme then
Panel 1. Visible = true
TWUni But t onl. Col or = cl Red
TWUni Buttonl. Caption = "Hide"
el se
Panel 1. Visible = fal se
TWUni Buttonl. Col or = cl Li ne
TWUni Butt onl. Capti on = " Show'
end if
End sub

Tip: Seethe Speed Button Component, or the Unicode Radio Button Component, for how to create
buttons that can work together as a group, and present mutually exclusive choicesto the user.

10.2.7 Unicode Button Component

Unicode Button is a push button control, and it introduces several propertiesto control its behavior in a
dialog box setting. Choose button controls to initiate actions.

Notable Properties
® Name: Specifiesthe name of the control as referenced in code.

Script Example

An example using Unicode Buttons is described in this Script Example (Panel and Unicode Button).

10.2.8 Unicode CheckBox Component
(=]

CheckBox represents a check box that can be on (checked) or off (unchecked).

Notable Properties

® Checked: Specifies whether the check box is checked.
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Script Example

The following script example uses a sub procedure and a function. Components used are; one Unicode
button, three Unicode edit fields and two Unicode check boxes.

TWlniButtont | [TWUREditD | [TwuniEdit | I~ TwUniCheckboT
[TwUnIEditD | ¥ TwUniCheckban2

The Sub procedure TWUNni But t on1Cl i ck callsthe function set Text using the text string of the
TWUNni Edi t O edit field as argument.

Sub TWoni Butt on1d i ck( Sender)
set Text ( TWUni Edi t 0. UTF8Text)
End sub

The setText function tests to see if the corresponding check boxes are checked. If they are, newText is
assigned to the edit fields.

Functi on set Text (newText)
I f TWUni Checkboxl1. Checked Then
TWUni Edi t 1. UTF8Text = newText
End If
I f TWUni Checkbox2. Checked Then
TWUni Edi t 2. UTF8Text = newText
End |f
End Function

10.2.9 Unicode Radio Button Component

@

Radio buttons present a set of mutually exclusive optionsto the user (i.e. only one radio button in a set
can be selected at atime). When the user selects aradio button, the previously selected radio button
becomes unsel ected.

TrtGroupBox1
" TwlniRadioButtonl € (« T'WlniRadioButton3

To manage more than one set of radio buttons the Unicode GroupBox Component can be used.
Notable Properties

® Checked: Determines whether the option represented by the radio button is selected.
® Enabled: Controls whether the radio button is enabled or disabled.
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10.2.10 Unicode ComboBox Component

The ComboBox component is an edit box with a drop-down list. Users can select an item from the list or
type directly into the edit box.

Notable Properties

® UTF8Text: Displaysthe current combo-box selection.
® UTF8Items:. Liststheitems (strings) in the list portion of the combo box. Use the methods of Items

to add, delete and clear items, for example:

TWUni ConboBox1. |t ens. Add( TWUni Edi t 1. Text)
TWUni ConboBox1. | t ens. Del et e( TWUni ConboBox1. | t eml ndex)
TWUni ConboBox1. Itens. O ear

Script Example
See the Unicode ListBox Component for a scripting example that can be used with the ComboBox.

10.2.11 Unicode ListBox Component

El

The ListBox displays a collection of itemsin alist that you can scroll. Useit to display alist of items that
users can select, add, or delete.

Notable Properties

® UTF8Iltems: Liststhe items (strings) in the list box. Use the methods of Items to add, delete and
clear items, for example:
TWUNI Li st Box1. I tens. Add( TWUni Edi t 1. Text)

TWni Li st Box1. | tens. Del et e( TWUni Li st Box1. | t el ndex)
TWni Li st Box1. I tens. Cl ear

Script Example
The following script example uses a sub procedure and a function. Components used are; one Unicode
button, two Unicode edit fields, one Unicode check box and a Unicode listbox.
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TwUniButtond | [TWUNEGItD | TWURIEDtD
TWUNIEitO
Murnber of copies: |5 | v TwlriCheckbox] |TWUNIEIED
TWRIEditO
TWilniEdito

The setText function tests to see if the checkbox is checked. If it is, newText is added to the listbox the
number of times given in the “Number of copies’ text field (e.g. 5). If not checked the text is added once
to the listbox.

The Sub procedure TWUni But t on1d i ck callsthe function set Text using the text string of the
TWUni Edi t O edit field as argument.

Function set Text (newText)
TWUni Li st Box1. d ear
I f TWUni Checkbox1. Checked Then

For i = 0 To TWUni Edi t 1. UTF8Text -1
TWUni Li st Box1. Itens. Add( newText)
Next
El se
TWUni Li st Box1. It enms. Add( newText)
End If

End Function
Sub TWUni Butt on1d i ck( Sender)

set Text (TWUni Edit0. Text)
End sub

10.2.12 Unicode GroupBox Component

(]

The GroupBox component represents a standard group box, used to group related controls on aform.
When another control component is placed within a group box, the group box becomes the parent of that
component.

See the Unicode Radio Button Component component for an illustration of GroupBox.

10.2.13 Static Image Component

&
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A static image is often used as a background on the template or asakind of illustration, for example a
snapshot of the Viz Artist scene.
There are two ways of adding a static image to atemplate. One option is to add a static image component
to the template and select an pre-saved image from the computer, or aternatively create a snapshot of the
scene and add it to the template using Viz Engine. The snapshot is automatically appended to a static
image component.

To add or edit an image, right click the static image component’ s anchored frame to open the context
menu and click Edit Image... .

War ning: When using the static image component, use compressed image types like JPG or lossless
ones like PNG to conserve spacein the Viz Pilot database. Each template and data element will save a
unique copy of the image used, so keeping the image small in size isimportant. It does not need to be
asmall image in pixel size. The whole template is streamed to the database as a BLOB, and the image
datawill not be touched, so a JPG or PNG will use alot less space.

10.2.14 Page Control Component
)

Add amulti page panel view with tabs. Select a page by clicking the page’ s tab that appears at the top of
the control. To add a new tab sheet to a PageControl object at design time, right-click the PageControl
object and choose New Page. Each tab sheet that is added get its own list of parametersin the Object
inspector.

10.2.15 Template Information Component

Add the Template Information component to the template to customize the Save dialog for data elements
in Viz Pilot News and Director.
It can be also disabled altogether and data el ement names can automatically be based on text in Unicode
Edit, Unicode Memo and/or Wrap Fixed Unicode Memo components (using the UTF-8Text property). If
other template information elements are required in the save name, they need to befilled into a text
component by a script. Alternatively the SC_SaveNane function can be used, as described in To add
person information to the template.

Notable Properties

* AllowEditingOfDefaultName: Determinesif the user should be allowed to edit the suggested name
in the save diaog.
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® DefaultSaveName: Set by the SaveNameTextFields and Separator properties.

® Prefix: Used to set a prefix for save names.

¢ SaveNameTextFields: Click the ellipsis button to bring up an editor to select the edit boxes that
should be used for generating a save name.

® Separator: Set a separator (for example a space, dot or underscore). Thisis used to separate text
strings added to the DefaultSaveName from the edit boxes selected in the SaveNameTextFields
property.

® ShowsSaveDialog: Determines whether Director should show the save dialog when saving the
template.

Advanced Properties

Some of the Template Information properties are used to set a default start time and duration for a data
element when it is saved using Viz Pilot News. The properties described below are primarily used with
automation systems, and can only be used with Viz Pilot News.

e 1

Save

| Save az new

[ Finizhed [ Add to library
v iGraphic Event Timing

I at: I;I
Event Lenath: I;I

Cancel

® DefaultStartTime: (mm:ss) Sets the start time of the data element in the playlist. The start timeis
relative to the start time of the playlist.
¢ DefaultDuration: (mm:ss) Sets the duration of the data element in the playlist.

Note: DefaultSartTime _and _DefaultDuration always contain the current timing information for
adata element. So, for example, a script could access these values and include timing
information in the name of the data element when saving it.

® ShowGraphicEventTiming: Can be set asfollows:
® stShow: Display the Graphic Event Timing checkbox when Saving an Element in Viz Pilot
News. Thetiming properties relate to DefaultDuration and DefaultSartTime.
¢ gstHide: Do not display the Graphic Event Timing checkbox when Saving an Element in Viz
Pilot News. In this case you can script the values and use them as part of the template.
¢ stDefault: Usethe Database Parameters (ax_dat ael enment _ti ner _enabl ed) to
determine whether to show or hide the Graphic Event Timing checkbox.

Note: The stShow and the stHide value will override the database setting on atemplate by
template basis.

®* TimingMode: Flag indicating the value of the Graphic Event Timing checkbox. This property only
takes effect if the Graphic Event Timing checkbox is shown.
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® tmManual: Graphic Event Timing is not checked.
® tmAutomatic: Graphic Event Timing is checked.

Script Example
See the Script Example (Image with Name, Unicode Edit and Template Info).

10.2.16 Person Information Component
==

The Person Information component connects to Object Store, and retrieves all available person
information. It can be used to select and link information such as a person’s TV name and title to other
text fields using the predefined component properties LinkName and LinkTitle. It can also be used with
scripts, or ssimply by replacing and reassigning the Control ObjectName of the scene property to the
Person Information component.

Notable Properties

® UTF8Text: Displaysthe current drop-list selection.
® LinkName: Setsthe TV name property to the component selected.
® LinkTitle: Setsthe Title property to the component selected.

Using a Person Information component in atemplate

Fun mode

&l [ef D‘[}?D‘ D

1)[E]E] e 11| e

[Hew Template] - SCEME*Vizrt_Internal/TradeShows/Viz...

Headline
|LDUiSE Ella Refresh Datasource |
. . Searchfield ¥ FLLL_MAME

Designation TV _NAME

| CEO j| FIRST_MAME
MIDDLE_MAME
LAasST_MaME
TITLE

The component also has some features that are available to the template user. A context menu appears
when right-clicking the drop-down list. The options are:

® Refresh Datasour ce: Refreshes the data source, making new database entries available to the user.
® Searchfield: Displays a sub menu with the following options:
® FULL_NAME: Displaysall available full namesin the drop-list.
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® TV_NAME: Displaysal available TV namesin the drop-list.

® FIRST_NAME: Displaysal available first namesin the drop-list.

* MIDDLE_NAME: Displaysal available middle names in the drop-list.
® LAST_NAME: Displays all available last namesin the drop-list.

® TITLE: Displaysall availabletitlesin the drop-list.

10.2.17 Feed Linker Component

%ﬁh

The Feed Linker button is a push button control. When a Feed Linker button in atemplateis clicked, the
Feed Browser window is opened and lists the items from the feed source defined in the template. For
more details see Field Linking and Feed Browsing.
When an entry is selected by the user, the data is mapped to fields in the template. This allows the user to
pick an item from a feed and have the corresponding data applied to fieldsin the template, instead of
manually typing in information. The template designer uses scripting to map the feed datato fieldsin the
template.

The Feed Linker supports ATOM feeds as well as feeds with Viz Data Format (VDF) payloads, allowing
datato be fed from sources such as Twitter, Flickr, Viz World Server or Pilot Data Server. Vizrt's Social
TV Solution also creates feeds that can be accessed using the Field Linker.

Tip: Vizrt's Socia TV Solution captures content from Twitter, Facebook, Instagram, Y ouTube,
Flickr, Picasa, Weibo and Tudou “out of the box”, and can be configured to capture content from
almost any service that provides content in the form of XML or JSON feeds. For more information,
see the Social TV Solution User’s Guide.

This section contains the following topics:

® Notable Properties

® Events

® To usethe Feed Linker component

® Technica

® The Following Fields can be Linked

® The Following Fields cannot be Linked
® Elementsin atom feed

® Elementsin atom entry

® Script Example 1 - Mapping data

® Script Example 2 - Mapping a name

® Script Example 3 - Mapping Title, MediaContent and XML
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Notable Properties

® Source: Specifiesthe URI of the feed the user will be able to select items from.
See also The Following Fields can be Linked and The Following Fields cannot be Linked

Events

® OnFeeditemSelected: Specifies the properties and methods that are avail able for mapping the feed
datato fields in the template.
Properties:

Title

Summary

ContentType

M ediaContent(<attribute>): Returns the value of the given attribute from the main media
content of theitem. See Script Example 3 - Mapping Title, MediaContent and XML.

Xml: Returns an XML representation of the selected entry. The template designer can then
extract any additional values from the item as desired by using theent ry. xm property. See
Script Example 3 - Mapping Title, MediaContent and XML.

Payload: If the item contains a payload as the main content, it can be accessed using this
property. The data parameter in the OnUpdatePayload method represents a payload. See Script
Example 2 - Mapping a name.

Methods:

GetLinkWithRelation. See Script Example 1 - Mapping data.

To use the Feed Linker component

1
2.

3.
4,
5.

Add the Feed Linker component to atemplate.

In the Object Inspector set the Sour ce property to the URI of afeed.

eg. http://site. exanpl e. coni f eeds/ post s

See how To add an event.

Double-click the event OnFeedltemSelected.

In the script editor, map feed data to template fields, see Script Example 1 - Mapping data.

Technica
The following XML Namespace Prefixes are used when referring to XML elements:

Prefix URL

atom http://www.w3.0rg/2005/Atom

viz http://www.vizrt.com/types

vaext http://www.vizrt.com/atom-ext
media http://search.yahoo.com/mrss/

thr http://purl.org/syndication/thread/1.0
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Prefix URL

opensearch http://a9.com/-/spec/opensearch/1.1/

Example: The notation <at om ent r y> isto be interpreted as referring to the same element as

<entry xm ns="http://ww.w3. org/ 2005/ At o' >.

The keywords MUST, MUST NOT, REQUIRED, SHALL, SHALL NOT, SHOULD, SHOULD NOT,
RECOMMENDED, MAY, and OPTIONAL in this document are to be interpreted as described in RFC
2119.

The Following Fields can be Linked

® <at om aut hor >
The personal details of the author of the selected <at om ent r y>, which might be an individua
person or an organization. The datais provided in child elements as follows:
® <at om nane>: The name of the author. The value of the <at om nane> element inside the
first <at om aut hor > element that applies for the entry is recorded as the field value. This
child element isrequired if you are specifying the <at om aut hor > element.
® <at om uri >: A URL associated with the author, such as a blog site or a company web site.
The value of the <at om ur i > element inside the first <at om aut hor > element that applies
for the entry isrecorded as the field value. This child element is optional.
® <at om enmi | >: The email address of the author. The value of the <at om enmai | >
element inside the first <at om aut hor > element that applies for the entry is recorded as the
field value. This child element is optional.
® <atom content>
<atom content>...</atom content >
<atom content src="..." />
® Either inline or URL content is supported.
® Thereisno type match, soitisup to the Viz Pilot operator to figure out what content can be
used.
® For URL content the resource is downloaded first and then applied as the value. If you just
want the URL use<at om | i nk>.
® <atomentry>
The whole entry XML.
¢ <atom|link>
This element defines a reference from an entry to a Web resource; in other words thisis the value of
the hr ef attribute.
® <vaext:| ocator>
The text of the Vizrt Atom Extension <vaext : | ocat or > element which hasavaext : t ype
attribute equal to the mediatype attribute of <vi z: f i el ddef > element in the model.
® <at om publ i shed>
This element is a Date construct indicating the initial creation or first availability of the entry. The
value of the <at om publ i shed> element in the entry is recorded as the field value.
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® <atom sunmmary>

Thiselement is a Text construct that conveys a short summary, abstract, or excerpt of an entry. The

content of the <at om sunmar y> element in the entry is recorded as the field value.

® <atomt hunbnail >

® Thevalue of the URL attribute of the first thumbnail element in the entry is recorded as the field
value.

® catomtitle>

Thiselement is a Text construct that conveys a human-readabl e title for an entry or feed; the title of

the selected <at om ent ry>.
® <at om updat ed>

This element is a Date construct indicating the most recent instant in time when the selected <at om
ent r y>was modified. The value of the <at om updat ed> element in the entry is recorded as the

field value.
The Following Fields cannot be Linked

® <atom category>
® <atomid>

® <atomrights>

® Any other elements.

Elements in atom feed

Elements that should be present in the <at om f eed> for the full user experience:

® OpenSearch link:
<atomlink rel ="search" type="application
/ opensear chdescri ption+xm " href="http://exanpl e.com
/ opensear chdescri ption. xm "/ >

® Optional, needed for support for server side searching.

® The opensearchdescription xml file must contain a template node that returns search results as

an atom feed:
<opensearch: Url type="application/atomxm" tenplate="
http://..." [>
® or more details see http://www.opensearch.org/ Specifications/OpenSearch/1.1
® Uplink:
<atom |l ink rel ="up" type="application/atomtxmn ;type=feed” href="
http://..." I>
® Optional, needed for nested collections.
® Theup link should link to the parent folder feed for hierarchical feeds.
® Theup link must have atype string equal to " appl i cat i on/ at omtxmi ; t ype=f eed" .

Elementsin atom entry

Elements that should be present in the <at om ent r y> for the full user experience:
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Self link:
<atomlink rel="self" type="application/atomtxnl;type=entry" href="
http://..." |>
The self link must link to the URL that will return the <at om ent r y> xml.
® Thesdf link must have atypevalueequal to " appl i cati on/ at omtxmi ; t ype=entry".
® Needed for refresh/update of values from the item to work.
® Needed in combination with the up link for remembering and showing the selected feed entry in
ahierarchy of feeds (folder structure). Not needed for remembering selection in flat feeds since
thentheat om i d will be used.

Up link:
<atom |l ink rel ="up" type="application/atomtxm ;type=feed” href="
http://..." I>

The up link must have a href value that is the URL of the feed the entry isin.
® Theuplink must have atype value equal to " appl i cat i on/ at omtxm ; t ype=f eed".
® Needed in combination with the self link for remembering and showing the selected feed entry
in afolder structure.

Down link:
<atom |l ink rel ="down" type="application/atomtxnl ;type=feed" href="
http://..." I>

Needed if this<at om ent r y> isto be considered a subfolder instead of anormal <at om
entry>.
® Thedown link must have atype value equal to " appl i cat i on/ at omtxm ; t ype=f eed".
® Thedown link must haveahr ef valuethat isthe URL of the feed (folder) the entry
represents.
® Link may containt hr: count attribute (RFC4685) indicating how many children there are. If
thevaueof t hr: count is0 (zero) then the folder will not be loaded since it is empty. Thisis
an optimization.
Thumbnail link:
<medi a: t hunbnail url="http://..."/>
Needed for thumbnail icons to display on the entriesin the feed browser.
® The URL value must reference a JPEG or PNG image resource.
® |f many thumbnails are defined the first one will be selected as the default. Thisis according to
Media RSS Specification Version 1.5.0.
L ocator
<vaext: |l ocator type="application/vnd.vizrt.viz.geonl>GEOWWVi zrt
[Tutorials/VizPilot/...</vaext:|ocator>
Needed to be able to link atabfield to alocator. A locator is a path that is not representable with the
URI hr ef inan<at om | i nk>. The selected value is the text node in the locator, so it can in
theory be used for any kind of text.
® For Viz Pilot it is meant to be used to select paths to resources that are not URIs, like the
resources on the Graphic Hub that is currently in use.
® Thet ype must match the tabfield type.
® The value from the first locator that matches will be used.
® |f nolocators matches an error message will be logged in Viz Pilot.
® TheViz Enginetypes are:
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® TEXT:text/plain
® RICHTEXT: application/vnd. vizrt.viz.richtext+xm
® MATERIAL: application/vnd. vizrt.viz.materi al
® DUPLET: application/vnd. vizrt.viz.dupl et
® TRIPLET: application/vnd.vizrt.viz.triplet
® FONT:application/vnd.vizrt.viz.font
® CLOCK: application/vnd.vizrt.viz.clockcommands
® GEOM: application/vnd.vizrt.viz.geom
® |IMAGE: application/vnd. vizrt.viz.inmage
® AUDIO: application/vnd.vizrt.viz.audio
® VIDEO: appl i cation/vnd. vi zrt. vi z. vi deo
® MAP: application/vnd.vizrt.curious. mp
® TRIOSCROLL: application/vnd.vizrt.trio.scrollel ements+xm
® Other links:
<link rel="..." href="http://..." type="..."/>
® Needed in order to select the URL to external resources. This can be images, videos, text, and so on.
® Limitation 1: The atom 1.0 specs alow multiple links with the same relation, but when linking
atabfield toalink in Viz Pilot, only thefirst link will be selected.
® Limitation 2: Viz Pilot can only usethe hr ef URL asthe value. It cannot download the
resource at the URL and use its contents as the value. The Viz Engine control plugin for the
property hasto be able to understand the URL and download the resource.

Script Example 1 - Mapping data

Link data (Title, Summary, ContentType) from a news feed to editbox fieldsin atemplate, including
getting the link of the feed item itself using GetLinkWithRelation.

[ |

[Mew Template] - Running

BlogFeedl

Title
|Gnng|e+ app for iPad available now |

Summary

ContentType
[htmi |

Self Link
|http:f,-’www.blngger.cumffeedsfluaﬁ 1780/posts/default/439997y=2 |

Sub TWFreedLi nker 1Feedl t entel ect ed(entry)

Set Uni codeVal ue TTWUni Edit1, entry.Title

Set Uni codeVal ue TTWUni Edit2, entry. Sumrary

Set Uni codeVal ue TTWUni Edit 3, entry. Cont ent Type

Set Uni codeVal ue TTWUni Edi t4, entry. GetLi nkWthRel ation("self")
End sub
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Script Example 2 - Mapping a name

Link aperson’s TVname in a person feed to an editbox in the template.

" =

[1 - Running

Select Person |

TV Name

Title | |

Firstname | |

Middlename| |

Lastname| |

Sub TWFeedLi nker 1Feedl t enSel ect ed(entry)
set payl oad = entry. Payl oad
tvnaneedit.text = payload.lten("tvnanme"). Val ue
titleedit.text = payload.ltem("title"). Val ue
firstnaneedit.text = payload.ltem("firstnanme"). Val ue
m ddl enaneedit.text = payload.|tem("m ddl enane"). Val ue
| astnaneedit.text = payload.ltenm("lastnane"). Val ue

End sub

Note: The TTWUni DbPersonComboBox component can also be used to map person hame, but it only
supports data from the Object Store. The Feed Linker component supports all asset search providers (e.
g. RestVOS and Viz One).

Script Example 3 - Mapping Title, MediaContent and XML
Link text, images and XML from feed datato atemplate.

[ =

[1- Running

Image feed ... |

Title

URL

Text

Sub TWreedLi nker 1Feedl t entel ect ed(entry)
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TTWUni Edit1. Text = entry. Title

set media = entry. Medi aCont ent

if not isnull(nmedia) then
TW rmagel nf 1. pi cFi | enanme = nedi a. Ur |
TWUni Edit1. Text = nedia. Ul
TW nagel nf 1. Updat eThunbnai |

end if
TWUni Menol. Text = entry. xm
End sub

Note: If images are linked in using the method in this example script, then all Viz Engines must have
internet access. See the Viz Artist and Viz Engine guides for more information on supported image
formats.

10.3 Additional Components

Additional components are components with more specialized properties and features, and are not used as
much as the standard components.

This section contains the following topics:

® Wrap Fixed Unicode Memo Component
® TrackBar Component

® Mask Edit Component

® Speed Button Component

® DateTime Picker Component

® Timer Component

10.3.1 Wrap Fixed Unicode Memo Component

This component is much like the Unicode Memo. However, thereis a significant difference between the
two. Asthe Unicode Memo storesitstext as alist of strings, the Wrap Fixed Unicode Memo saves the
text in the UTF8Text string property as one long text string. This avoids the problem of line breaks being
added to the text provided that WordWrap is disabled. Line breaks added by the user is not removed.

10.3.2 TrackBar Component
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The TrackBar represents a position along a continuum using a slider and, optionally, tick marks. A track
bar can also display a selected range and set minimum and maximum values. The selected rangeis
marked by triangular ticks at the starting and ending positions of the selection.

Notable Properties

® Max: Specifies the maximum size of aninterval.

® Min: Specifies the minimum size of an interval.

® SelEnd: Specifiesthe position of the end point of the selection range.

® SelStart: Specifiesthe position of the starting point of the selection range.
® Position: Contains the current position of the slider.

10.3.3 Mask Edit Component

Allows a user to enter and edit data, similar to an edit component, but provides a means to specify
particular formats, such as a postal code or phone number. Mask Edit shares the properties of other Text
controls.

Notable Properties

® EditMask: Specifies the characters auser can enter into the masked edit control to valid characters
and formats.
® Text: Contains the formatted text based on the mask set by the EditMask property.

10.3.4 Speed Button Component

¥

Use TSpeedButton to add a button to a group of buttonsin aform. T SpeedButton introduces properties
that can be used to set graphical images that represent the different button states (sel ected, unsel ected,
disabled and so on). Use other properties to specify multiple images or to rearrange the images and text
on the button.

onme | othn

TSpeedButton also introduces properties that allow speed buttons to work together as a group. Speed
buttons are commonly grouped in panels to create specialized tool bars and tool palettes.
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Notable Properties

® Grouplndex: Buttons with the same property value (other than 0), work together as a group and can
present mutually exclusive choices to the user.

Script Example

Sub I nitForm
SpeedBut t onl. Col or
SpeedBut t on2. Col or

End Sub

Sub SpeedButt onld i ck( Sender)
SpeedBut t onl. Col or cl Li me
SpeedBut t on2. Col or cl Gay

End sub

Sub SpeedButt on2d i ck( Sender)
SpeedBut t onl. Col or cl Gray
SpeedBut t on2. Col or cl Red

End sub

cl Gay
cl Red

10.3.5 DateTime Picker Component

The TDateTimePicker component is used for entering dates or times. In dmComboBox date mode, it
resembles alist box or combo box, except that the drop-down list is replaced with a calendar illustration;
users can select a date from the calendar. Dates or times can a so be selected by scrolling with Up and
Down arrows and by typing. Usethe . Dat e and . Ti nme property to access the selected date/time from
script.

Notable Properties

® Date: Indicates the date entered by the user.

® DateFormat: Determines whether the date format is long or short.
DateM ode: Can be used with a drop-down calendar or by the Up/Down arrows with which the user
can adjust the date. (Applies only when Kind is dtkDate.)

¢ Kind: Determinesif date or timeis shown.

® Time: Indicates the time entered by the user.

10.3.6 Timer Component

@
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Notable Properties

Use the Timer component to trigger an event after a measured interval. Write the code that is supposed to
occur at the specified time inside the timer component’s OnTimer event.

® Interval: Determines how frequently the OnTimer event occurs. Specified in milliseconds. Default is

1000 (one second)

® Enabled: Determinesif the timer is active or not. The OnTimer event only occurs when the Enabled

property is True

Script Example

The Timer event gets called at the interval specified (1000 = 1 second) and the current date and time is set
in atext box.

IZ_ZZEZZZZIIIIIIIZZZZZZZZIIIIIIIZZZZZZZZZ BasiE

Events

When the template is loaded it will bein Start mode

Sub Initform
Ti mer 1. Enabl ed = Fal se
TWCol or Butt onl. Col or = cl Li me
TWCol orButtonl. Caption = "Start"
End Sub

|| ﬂ| Start

When started, the Timer1Timer event adds the time Now to the combo box

Sub Ti mer 1Ti mer ( Sender)
TWUni ConboBox1. |t ens. Add( Now)

End sub

a/26/2007 1:os:10eM - | [
4/26/2007 1:24:07 PM |~

4/26/2007 1:24:08 PM

4/26/2007 1:24:09 PM

4/26/2007 1:24:10 PM

4/26/2007 1:24:11 PM

4/26/2007 1:24:12 PM

4/26/2007 1:24:13 PM

4/26/2007 1:24:14 PM_[¥

TimerlTimer

When the button is clicked, it either sets Timerl to true or false, and at the same time changes color and

caption.

Sub TWCol or Butt on1d i ck( Sender)
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if (Timerl. Enabled = True) Then
Ti nmer 1. Enabl ed Fal se
TWCol or Butt onl. Col or = cl Li e
TWCol or Buttonl. Caption = "Start™
El se
Ti mer 1. Enabl ed = True
TWCol or But t onl. Col or = cl Red
TWCol or Butt onl. Capti on = " St op"
End | f
End sub

10.4 Database Components
cllE R E R

Database components provide the means to connect to any database that can be used with the Open
Database Connectivity (ODBC) API.

There are basically two ways of setting up database communication. Either by using the ActiveX Data
Objects (ADO) components or by writing scripts without using database component. The latter is often a
preferred solution as it enables users to find more elaborate and compl ete script examples on the Internet
than what is covered in this user manual.

Note: A lot of examples on the Internet use the Server. notation as alot of scripts are used for
accessing aweb server. Thisis not needed with Template Wizard.

The most common ADO components available are ADO Connection Component, ADO Query Component
, ADO Command Component, ADO Table Component, and ADO DataSet Component.

Not all components are needed at once to establish a database connection and to retrieve or store data. To
understand their purpose and area of use, please read the following subsections.

Note: An ADO provider represents one of a number of types of access, from native OLE DB drivers
to ODBC drivers. These drivers must be installed on the client computer. OLE DB drivers for various
database systems are supplied by the database vendor or by athird-party.

This section contains the following topics:

® Setting Up a Basic Database Connection
¢ ADO Connection Component

¢ ADO Query Component

® ADO Command Component

®* ADO Table Component

® ADO DataSet Component

10.4.1 Setting Up a Basic Database Connection

Two ways of setting up a basic database connection are described below:
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® Examplel - Using scripting

¢ Examplell - Using components
Both scripting examples use a standard Microsoft Access database. The database contains a table
(dbTable) that consists of the following fields; id, headline and source.

The template itself has three labels and listboxes corresponding to the database table fields.

Example | - Using scripting
In this example, database components are not used, as using them would not show all the possibilities of
scripting.

I Headline Saurce
|5 ||"Ji2|TempIate Wizard ADD scripting example ||"Ji2rt |

1. Initialize variables and values. Option Explicit requires that all variable names be defined (with
the Dim statement). Const is similar to a variable, except that its value cannot be changed at
runtime.

Option Explicit

Const adCmdText = 1
Const adStateQpen = 1
DimcnVi zrt

D m cndQuery
DmrsVizrtStory

2. Create a database connection using the Connection object.
Set cnVizrt = Create(bject (" ADODB. Connection")

3. A minimum set of connection properties can be set. In this case the Provider and Data Source. In
this case User ID and Password is also provided. If none is required the sentence can be removed.

cnVi zrt. ConnectionString = _
"Provider=M crosoft.Jet. OLEDB. 4.0; " & _
"User | D= SoneUser; Password; SonePassword; " &
"Data Source=C:\test. ndb"

4. Open the database.
cnVi zrt. Open
5. Create aquery string using the Command object.

Set cnmdQuery = Creat eQbj ect (" ADODB. Cormand")
Wth crmdQuery
Set . ActiveConnection = cnVizrt
. CommandText = "SELECT id, headline, source " & _
"FROM dbTable " & _
"WHERE source = 'Vizrt'"
. CommandType = adCndText
Set rsVizrtStory = . Execute
End Wth
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6. Test to seeif the database connection was successful.

If rsVizrtStory. State = adSt at eOQpen Then
MsgBox( " Recor dset opened successfully.")
End If

7. Clear redundant data from the listboxes

TWUni Li st Box1. C ear
TWUni Li st Box2. d ear
TWUni Li st Box3. d ear

8. Add data from the database to text fields.

Do While Not rsVizrtStory. EOF
TWUNni Li st Box1. I tens. Add(rsVizrtStory. Fields("id"))
TWUni Li st Box2. Itens. Add(rsVi zrt Story. Fi el ds("headl i ne"))
TWUni Li st Box3. Itens. Add(rsVi zrt Story. Fi el ds("source"))
rsVizrt St ory. MoveNext

Loop

9. Destroy all objects from memory that no longer is needed.

rsVizrtStory. C ose

Set rsVizrtStory = Nothing
Set cmdQuery = Not hi ng
cnVizrt. Cl ose

Set cnVizrt = Not hing

Example Il - Using components

Setting up a database connection is also possible using database components. A simple setup can be
described asfollows:

1. Add an ADO Connection component to the template and set the following properties:
® ConnectionString: Information needed to connect the ADO Query component;

Provi der=M crosoft. Jet. OLEDB. 4. 0; Data Source=C:\test. ndb;

® Provider: This property is auto generated based on the connection string property.
2. Add an ADO Query component to the template and set the following properties:

® Connection: Select the ADO Connection name from the drop-list.

® SQL: Click the browse button and enter the query string. For example:

SELECT id, headline, source FROM dbTabl e WHERE source = 'Viz
t'

3. Check the Connected property in the Object Inspector for the ADO Connection component. A
Database login window appears asking for User Name and Password. If oneis not set, click OK.
4. Check the Active property in the Object Inspector for the ADO Query component.
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5.

10.

11.

12.

-~

ADoQueryt.Fietds || |[=|[O0JE3
3 + no-

i

headline

source

TaukoIncField

Open the ADO Query context menu by right clicking the component icon on the template editor.
Click the Fields Editor ... menu option.

"+

Select fields by clicking the “arrow and plus’ button in the Fields Editor window. If the
connection is not active a dialog appears asking for User Name and Password.

= =

[dbtest] -

.[U------Headlina-------------------------------Eeurcr—:---------

B

Add Unicode |labels and listboxes to the templ ate.
The following script will list the result from the ADO Query component in the listboxes.

Option Explicit

Di m i ndex

ADOConnecti onl. Connected = True
ADOQueryl. Active = True

Test to see if the database connection was successful.

If ADOQueryl. State = 1 Then
MsgBox (" Recordset opened successfully.")
MsgBox( ADOQuer y1. Recor dCount )

End |f

Test to see how many records found based on the SQL statement.
MsgBox( ADOQuer y1. Recor dCount)
Clear listboxes.

TWUni Li st Box1. C ear
TWUni Li st Box2. d ear
TWUni Li st Box3. d ear

Before iterating arecord set it is recommended to reset the cursor in order to start from the top
when running the script several times.

ADOQuer y1. Fir st
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13.

14,

The For statement iterates according to the RecordCount -1 adding data to the listboxes. Since the
loop starts at 0 the RecordCount method must be set to -1. This prevents the loop from giving a
copy of the last record.

For index = 0 To ADOQueryl. RecordCount -1
TWUNi Li st Box1. UTF8I t ens. Add( ADOQuer y1i d1. Text)
TWUni Li st Box2. UTF8I t ens. Add( ADOQuer ylheadl i nel. Text)
TWUni Li st Box3. UTF8I t ens. Add( ADOQuer ylsour cel. Text)

ADOQuer y1. Next

Note: The field names (e.g. ADOQuer ylheadl i nel) are auto-generated names. All
database fields, selected from the Fields Editor, are added as template components.

Disconnect the database connection and deactivate the query component.

ADOConnecti onl. Connected = Fal se
ADOQueryl. Active = Fal se

The ADO Query component can establish a connection directly using its ConnectionString
property, but it is often desirable to use an ADO Connection to share a single connection among
several ADO components. This can reduce resource consumption, and allows for transactions to
be created that span multiple data sets.

10.4.2 ADO Connection Component

(]

The ADO Connection component connects to an ADO data store. It encapsulates the ADO connection
object. The connection provided by a single ADO Connection component can be shared by multiple ADO
command and data set components through their Connection properties. This can reduce resource usage,
and allows for transactions to be created that span multiple data sets.
ADO Connection alows for control of the attributes and conditions of a connection to a data store. Use
the ADO Connection properties to control attributes such as record locking scheme (optimistic versus
pessimistic), cursor type, cursor location, isolation level, and connection time-out.

Notable Properties

® Connected: Specifies whether the connection is active.

® ConnectionString: Specifies the connection information for the data store.

¢ DefaultDatabase: Indicates the database the ADO connection uses by default.

® | oginPrompt: Specifies whether alogin dialog appears immediately before opening a new
connection.

® Provider: Specifiesthe provider for the ADO connection. Entering a valid ConnectionString usually
generates this input.
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10.4.3 ADO Query Component

&

ADO Query provides the means for issuing SQL against an ADO data store. As ADO Query isaquery-
type data set it can encapsulate an SQL statement, enabling applications to access the resulting records.

Notable Properties
® Active: When checked sets the query component active. If the SQL query failsit will not be set to
active.

® Connection: Use Connection to specify an ADO connection component to connect to a data store.
® SQL: SQL query parameter.

10.4.4 ADO Command Component

3

ADO Command represents an ADO command object. Use ADO Command for issuing commands against
a data store accessed through an ADO provider.
The ADO Command component executes the command specified in its CommandText property. One
command may be executed at atime. Parameters, if the command includes them, are specified in its
Parameters property. The command is executed by a call to the Execute method.

ADO Command can either use a ADO Connection object to connect to a data store (through its
Connection property) or connect directly to the data store if the connection information is specified in the
ConnectionString property.

ADO Command is most often used for executing data definition language (DDL) SQL commands, or to
execute a stored procedure that does not return aresult set. For SQL statements that return aresult set,
ADO DataSet, or ADO Query is better suited. The Execute method of ADO Command is, however,
capable of returning arecord set. To use that record set, however, you will need a separate ADO data set
component.

10.4.5 ADO Table Component

ADO Tableis atable-type data set that represents all of the rows and columns of a single database table.
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The component encapsul ates a table accessed through an ADO data store. It can access datain asingle
database table using ADO. It provides direct access to every record and field in an underlying database
table, but can also work with a subset of records within a database table using ranges and filters.

Notable Properties

® Active: When selected, the component is active.

® Connection: Specifies the ADO connection component to use.

®* Name: Specifies the name of the control as referenced in code.

® ReadOnly: When checked the database connection is set to be read only.
® RecordCount: Indicates the total number of records in the record set.

® Recordset: Provides direct access to the ADO record set object.

10.4.6 ADO DataSet Component

&

ADO DataSet isageneric ADO data set control, and can be used in place of ADO Query. It enables data
representation from one or more tables in a database and allows data-aware components to manipul ate
data by connecting with a DataSource (non-Unicode) component. The data source component is the link
between the visual components displaying the data and the database.

Unlike the other ADO data set components, ADO DataSet is not a table-type, query-type, or stored
procedure-type data set. Instead, it can function as any of these types.

As atable-type data set (ADO Table), ADO DataSet is able to represent rows and columns of asingle
database table. To useit like this, set the CommandType property to cmdTable and the CommandText
property to the name of the table.

Asaquery-type data set (ADO Query), ADO DataSet can specify asingle SQL command that is executed
when adata set is opened. To useit like this, set the CommandType property to cmdText and the
CommandText property to the SQL command to be executed.

Notable Properties

® Active: When checked it sets the query component active. If the SQL query fails, it is not possible to
set it active.

® Connection: Use Connection to specify an ADO Connection object to use to connect to a data store.

® ConnectionString: Set ConnectionString to specify the information needed to connect the ADO
Connection component to the data store.

¢ DataSource: Linksthe edit control to the data set that contains the field it represents.

10.5 Communication Components

Use the Communication components to enable communication with other computers.
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This section contains the following topics:
® Com Port Component

® Generic Com Port Component
® Client Socket Component

10.5.1 Com Port Component

The TTWComPort component is used to send and receive data through a com port.

Notable Properties

® Baud: Set the baud rate at e.g. 19200.
® ComNumber: Set the com port number.

Script Example
The TTWComPort has the following methods for sending data:

® PutString(" Hello"): sends the string "Hello"

® PutChar(Asc("A")): sendsthe character "A"
To receive data, data triggers must be registered on the TTWComPort. The data trigger will be fired
whenever the incoming data matches a given trigger.

Tip: A protocol message can start with "START" and end with "END". Register "START" and
"END" astriggers so that the user is notified whenever the incoming data matches either "START" or
n EN Dll.

Toregister adatatrigger call the AddDataTrigger function of the TTWComPort. The method is like this:

AddDataTrigger (trigger_text, case _sensitive): Thetrigger_text is the text to match and case_sensitive
isaboolean value. The result value of the function is atrigger handle that should be stored. In this
exampleit is named like this:

SOHDat aTri gger
ECHDat aTri gger

TWConPor t 1. AddDat aTri gger ( SOHText, fal se)
TWConPort 1. AddDat aTri gger (ECHText, fal se)

OnTrigger Data(CP, Trigger Handle): Is called whenever the incoming data matches one of the triggers.
The TriggerHandle contains the handle of the trigger that matched the trigger data. It can be tested like
this:

i f TriggerHandl e = SCHDat aTri gger then
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nmsgbox " SCH recei ved"

end if

i f TriggerHandl e = ECHDat aTri gger then
nmsgbox "EOH recei ved"

end if

The OnTriggerData only tests that the incoming data matches one of the registered triggers. To receive the
actual data use the event called OnTriggerAvail. This event is called whenever there is new incoming
data. The event looks like this:

OnTriggerAvail (CP, Count), where count is the number of new characters received.

Implement this function to gather al the incoming data:

Sub TWConPort 1Tri gger Avai | (CP, Count)
\g---- Data is available, read it into the sMessage buffer----
for i=0 to Count-1
sMessage = sMessage & Chr ( TWConPort 1. Get Char)
next
End sub

10.5.2 Generic Com Port Component

<

TTWGenericComPort is a speciaized version of the TTWComPort and has a predefined start and end of
message characters, 0x01 and 0x04 respectively, and also a start of transmission character 0x02.

Events

It also has an event called OnDataAvailable that is triggered whenever a new message is received. The
event looks likethis:

® OnDataAvailable(Sender, M essageHeader, StringList)
® Sender: Isthe TTWGenericComPort component
® MessageHeader: Isthe data between 0x01 and 0x02.
® StringList: IsaTstringList with the data between 0x02 and 0x04. Each field in the datais
separated with a pipe character '|'.
A message looking like this:

0x01 "My header' 'Fieldl|Field2|Field3 0x04

would cause the OnDataAvailable event to be triggered and the M essageHeader would contain \ qMy
header' the StringList would contain the strings:

Fiel dl
Fi el d2
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Fi el d3
The StringList items can be accessed like this:

for i:=0 to StringList.Count-1
msgbox StringList.Strings(i)
next

10.5.3 Client Socket Component

i

The TClientSocket component is used to connect to a TCP/IP server. It manages the connection when it is
open, and terminates the connection when the template is through.

Notable Properties

® Host: Host name or | P address of the server to connect to.

® Port: Port used to connect to the server.

® Active: Indicates whether the socket connection is open and available for communication with other
machines.

Basic Methods

® Open: Call Open toinitiate the socket connection. Open sets the Active property to True.
® Close: Call Close to shut down the socket connection. Close sets the Active property to False.
® Socket.SendText(<Text>): Use Socket.SendText to write a string to the socket connection.

Script Example

Below is an example showing how to use the TClientSocket component to send afew commandsto Viz
Engine.

Trying to connect to the host specified:

Sub cbConnect d i ck( Sender)
Cli ent Socket 1. Acti ve = Fal se
dient Socket 1. Host = t xt Host . Text
Cient Socket 1. Active = True

End sub

A valid connection is established. Enable the send button:

Sub d i ent Socket 1Connect ( Sender, Socket)
cbSend. Enabl ed = True
End sub
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10.6 Dialog Components

The following section describes standard Windows dialog boxes such as opening, saving and printing of
files.

To use the dialog components they must be linked to a button or ancther function with VBscript. Some
scripting examples follows below.

This section contains the following topics:

® Open & Save Components
® Font, Color, Print, PrintDisplay, Find and Replace Components

10.6.1 Open & Save Components
BE=

Open displays afile-selection dialog. Save displays a"Save As' dialog for saving files.

Notable Properties

® DefaultExt: Specifies a default file extension.
® FileName: Indicates the name and directory path of the last file selected.
® [nitialDir: Determines the current directory when the dialog opens.

Script Example

ThisisaOpen and Save dialog example that opens afile reading the content into a multiline edit box. The
template uses the OpenDialog and SaveDia og components. Note the settings of the Filter and Title
propertiesin the Object Inspector. To invoke a dialog, cal its .Execute method. Execute opens the file-
selection diaog, returning True when the user selects afile and clicks Open or Save. If the user clicks
Cancel, .Execute returns False.

const For Readi ng
const ForWiting
const For Appendi ng =
\'qg OpenDi al og exanpl e
Sub TWUni Butt on1d i ck( Sender)
i f OpenDi al ogl. Execute then
TWUni Menol. Li nes. LoadFronti | e( OpenDi al ogl. Fi | enane)
end if
End sub
\'g SaveDi al og exanpl e
Sub TWUni But t on2d i ck( Sender)
i f SaveDi al ogl. Execute then
TWUni Menpl. Li nes. SaveToFi | e( SaveDi al ogl. Fi | enane)
end if
End sub

I N -

8
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Further is an Open dialog example using the File System Object to read the content of the chosen file.
Documentation on the File System Object can be found at: http://www.microsoft.com/scripting.

Sub TWUni But t on3C i ck( Sender)
i f OpenbDi al ogl. Execute then
Set fso = CreateObject("Scripting.FileSystenbject")
Set ts = fso. OpenText Fi | e(Openhi al ogl. Fi | enane, For Readi ng)
\g The file has been opened, now read the content
TWUni Menol. Text = ts. ReadAl |
\g Close the file
ts.cl ose
\g Cean up
set ts = nothing
set fso = nothing
end if
End sub

10.6.2 Font, Color, Print, PrintDisplay, Find and Replace Components
33 A=

The Font, Color, Print, PrintDisplay, Find and Replace dialogs all displays generic Windows dialogs to do
operations specific to their properties and methods.

Notable Properties

® Color: Specifies the background color of the control.
® Font.Name: Identifies the typeface of the font.

Script Example

The following script uses one button and executes the Font and Color dialog.

Sub TWUni Butt on1d i ck( Sender)
Font Di al ogl. Execut e
TWUni Butt onl. Font . Nane = Font Di al ogl. Font . Nane
Col or D al ogl. Execut e
TWUni But t onl. Col or = Col or Di al ogl. Col or
End sub

Aswith the Open and Save dialogs the Execute method is used. This small script enables the user to select
and set the font and color for the button component.

10.7 Import Components

The Import components are used when importing playlists from newsroom systems and when creating
macros to fill automatically fill templates. Imports can be done manually or automatically with the use of
scripts and macros.
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It isgood practice for scene designers to name the scene’s Field Identifiers as 01, 02, and 03 instead of
1,2,3,4 ... 11,12 and so on. The latter will cause data to be assigned to the wrong fields when using the
Import components because the Media Sequencer will place 11 and 12 before 2 and so on.

This section contains the following topics:

® Story Importer Component
® Direct Story Importer Component

10.7.1 Story Importer Component

A template using the TStorylmporter can either be manually or automatically filled using a macro or by
importing an external data source (XML).
When filling atemplate, atemplate is specified with an External 1D and datais added to the template. The
order in which the dataiisfilled is defined by the order of the Control ObjectName property which refersto
the Field Identifier set by the scene designer.

This section contains the following topics:

® Externd ID

® XML example

® Script Example

® To create amacro using External 1Dsin Director

® To create data elements based on External 1Ds

® Touseascript to control thefilling of datain the template
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External 1D

When atemplate is created, it is saved and typically added to a concept. In Template Manager the
template can be given an external 1D (see Variants) for use with the Import components.

This D isthen used when creating data elements by triggering macrosin Director, adding playlists to
Director manually from newsroom systems (see To create a macro using External IDs in Director).
External 1Ds are also used with newsroom systems that create data elements based on * cg commands;
however, the Import component does not support this workflow.

XML example

The XML example below contains the name of the playlist, a group and three elements with an External
ID (t enpl at el D). The XML playlists are generated by newsroom system(s), and manually imported by
Director's XML Filler.

<?xm version="1.0"?>

<playlist>
<nane>Nane of playli st</name>
<group visible="true" name="G oup nane">
<event> <tenpl atel D>100</t enpl at el D>
<dat aNanme>Dat a El ement 001</ dat aNane>
<comment />
<dat a>
<fi el d>Fi rst Nane Last Nane 001</fi el d>
<fi el d>Desi gnati on 001</fiel d>
</ dat a>
</ event >
<event >

313



<t enpl at el D>100</ t enpl at el D>

<dat aNane>Dat a El enent 002</ dat aNane>
<conmment/ >

<dat a>

<fi el d>First Nane Last Nane 002</fi el d>
<fi el d>Desi gnati on 002</fiel d>

</ dat a>

</ event >

<event >

<t enpl at el D>100</ t enpl at el D>

<dat aNane>Dat a El enent 003</ dat aNane>
<comment/ >

<dat a>

<fiel d>Fi rst Name Last Name 003</fiel d>
<fi el d>Desi gnati on 001</fiel d>

</ dat a>
</ event >
</ group>
</ playlist>
Script Example
[Storyimport Ex01] M Slﬂipt Editor
Z;Héa;jiiﬁé:ﬁﬁﬁﬁ::ﬁ:ﬁﬁﬁ:Ilﬂain |
{Headline |
..................... B || ol = —_—
e Name I b || R =
Lo Mame
e 1 |Sub ScoryImporterlitoryData(Sender, Data)
[5 5 e :Ij R TR 2 if Data.Count > 0 then
e 'D“"::‘" ":” """"" Wz TTWUniEditl.Text = Data.Strings(0)
EEERR - c=lansucn 4 TTWUniMemol.UTFEText = Data.Strings (1)
p2eeen S TTWUniMemoz . UTF&Text = Data.Strings(2)
R R | |- end if
.......................... L | ——

The component triggers its OnStoryData event to start filling the template with Data.

Sub Storyl nmporter1StoryDat a( Sender, Dat a)
if Data.Count > 0 then
TTWUni Edi t 1. Text = Data. Strings(0)
TTWUni Menol. UTF8Text = Data. Strings(1)
TTWUni Menp2. UTF8Text = Data. Strings(2)
end if
End sub

To create amacro using External IDs in Director

1. Start Director.
2. Onthe Options menu select Keyboard Configuration... .
3. Select and right-click the macr os category, and from the context menu select Add Macro... .
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4. Click Show Macros... to open the Predefined Functions window.
5. Select the create data element function under templates.
Director v6.0.0 - User. N- Database: bgovcp1/vizridb - MSE: localhost

Predefined Functions

' script -
i template

templates:create_data_eleme

= templates This command creates a new dat:
" close The data element is based on the
~close_all

The template must have a StorylIr

~create_data_element(Extern The SaveName parameter specifie

~open_data_by_name(MName:

~open_last_saved_data_elem
~open_template(TemplatelD:

- open_template_by_dbid(DBI
~open_template_by_extid(Ext
- preview_data_element{Data:
~set_concept{ConceptMame: :
[+ il

+ video i

The Data parameter contains the
For instance AM&#47:PM would b

copy to clipboard
dim dataID

datall = VepCommand ("templai
VepCommand "templates:open_ i

1o G R)

6. Click the hyperlink named copy to clipboard, and click Close.

7. Inthe New Macro Shortcut window select the VBScript tab, and paste the newly copied script
into the script editor

8. Edit the script

dimdatal D

datal D = VcpConmmand("t enpl at es: create_dat a_el enent 400
MyNewEl enent Headl i ne/ Titl e/ Desi gnati on")

VcpCommand "tenpl at es: open_tenplate -1 " & datalD

Note: The number 400 represents the external 1D added in Template Manager.
MyNewElement is the name of the template, and Headline, Title and Designation are data that
will befilled into the template by the template script.

9. Select the Enter Key field, and press the key combination for the macro.
10. Enter aMacro Name, and click OK.

To create data elements based on External IDs

1. InDirector pressthe newly assigned key combination to trigger the macro (see how Script
Example).

2. Enter the information needed.

Click the Save button to save it as a data element.

4. Add the data elementsto the playlist.

w
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To use ascript to control the filling of datain the template

StoryImporterl: TStoryImporter W

[SteryImporter_Ex01] - SCEME*QA/NCPSS0,/TL,

Coolooriiriiiiiiiiiiiiiiiii| O Enable script
Bl Headline - - co ot
i_s_»Headline | EEEESE Al Events
'ZNE'I.IL“_'.ZZZZZZZZZZZZZZZZZZZZZZ OnStoryData | StoryImporteriStoryDatal v
T IName Ll

Sub StoryImporterlStoryDat:
if Data.Count > 0 then
TTWOniEditl.Text = D¢
ITTWUniMemol .UTF8Text
TTWUniMemo? . UTF8Text
end if
[End sub

=] o 0o L R

1. In Template Wizard open the Object Inspector and check the Enable script option to enable
scripting (CTRL+F12)

2. Add the TStorylmporter component to the template

3. Add the following script:

Sub Storyl nmporter1StoryDat a( Sender, Dat a)
if Data.Count > 0 then
TTWUni Edi t 1. Text = Data. Strings(0)
TTWUni Menol. UTF8Text = Data. Strings(1)
TTWUni Meno2. UTF8Text Dat a. Strings(2)
end if
End sub

4. Select the TStorylmporter component in the template and set the OnStoryData value to the name
of the script

10.7.2 Direct Story Importer Component

The TDirectStorylmporter component is used for fetching template data from external sources such as
XML files. Thisis similar to the Story Importer Component; however, the Direct Story Importer
component is different in that it has an editor for mapping template text fieldsto index IDs, and is
therefore easier to use without scripting. If advanced scripting is heeded, the Story Importer Component
component is recommended.
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To understand the logic and use of the component in Director, see the previous section on Story | mporter
Component.

Notable Properties
® StoryActions. Opensthe Story Actions Editor for linking text fields to index values.
To use the TDirectStorylmporter component

1. Addthe TDirectStorylmporter component from the | npor t component palette to the template.

2. Click the€lipse(...) button to open the Story Actions Editor.
[ StoryActions  (TStorvactions) =

3. Link edit fields to index values such that they correspond with the sequence of data coming from
the external system.

Edit box: I
| B | add
Edit box | 1D
TWEdit1 0
TWEdit2 1
4. Click OK.

5. Savethetemplate.

10.8 Viz Control Components

This section has information on the following topics:

® Drag Edit Component

® Value Control Component
® Audio Control Component
® Targa Control Component
® Triplet Editor Component

10.8.1 Drag Edit Component

aBT

The TDragEdit component is used to set numeric values, either by entering the values using a numeric pad
or using the mouse by clicking the text box and dragging in a horizontal direction to adjust the value.

Notable Properties

® Enabled: Enables the control.
¢ ReadOnly: Enables the value to be read only.
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® Text: Setsthe text string associated with the control.

10.8.2 Vaue Control Component

Il

The TWVaueControl component is a generic component used for scripting to control values outside the
scope of Template Wizard's default components. It is therefore a good candidate in those situations where
Template Wizard does not offer a default component for certain exposed Control plugins and properties.

Value Control can only be used with scripting, and is therefore (to the operator) a hidden component.
However, you can expose it by using other components that can be used to assign values to the Value
Control’s Cont r ol Val ue property.

Notable Properties

® ControlObjectName: Sets the exposed Control plugin property that Value Control should control (e.
g. 01.kerning).

® ControlValue: Setsthe value that Control Object in Viz should receive in order to control the
exposed Control plugin property.

Script Example
Sub TWoni Butt on1d i ck( Sender)

TW/al ueControl 1. Control Val ue = TWJni Edi t 1. Text
End sub

10.8.3 Audio Control Component

The VizAudioCtrl component is used to selected audio clips from a defined directory (e.g. share).
Supported file formats for this control are mp3 and wav.

Notable Properties

® InitialDir: Setsthe default directory/share from where the audio clips should be located.
Channell D: Setsthe Channel 1D used by the scenein Viz for playing out audio.

® Director: Setsthe name of the director in the scene that controls the audio animation.
Filename: Sets the audio filename.

Keyframe: Specifiesthe Viz keyframe to control.
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10.8.4 Targa Control Component

[

The VizTargaCtrl component is used to selected video clips from a defined directory (e.g. share).
Supported file formats for this control are dif, avi and dv.

Notable Properties

® |nitialDir: Setsthe default directory/share from where the video clips should be located.
Channell D: Setsthe Channel 1D used by the scenein Viz for playing out video.

® Director: Setsthe name of the director in the scene that controls the video animation.
Filename: Sets the video filename.

Keyframe: Specifies the Viz keyframe to control.

10.8.5 Triplet Editor Component

aBT

The TripletEditor component is used to set control values exposed from Viz such as position and scaling
that require control of three values (e.g. X, Y and 2).

Notable Properties

® Max, Min: Setsthe maximum and minimum values.
® XValue, YValue, ZValue: Setsthe parameters X, Y and Z.

10.9 Other Components

This section describes some components that are not part of the default setup, or are based on specialized
Viz plugins used by designers to enable operator control over elements in the scene:

¢ Table Editor Component

10.9.1 Table Editor Component

The TTWTableEditor component is derived from the Control List plugin; hence, it isonly possible to use
if the Control List plugin is part of a scene. The Table Editor component allows the Table Editor to be
used when the sceneis edited in Viz Pilot News or Director.

Notable Properties

® ControlObjectName: Refersto the Field Identifier set for the Control List plugin.
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® Name: Setsthe name of the table object.

Functions

® GetTableController: Getsthe table controller which can be assigned to avariable.

GetTableController functions and procedures

Name

Description

setCellValue

procedure setCellValue(rowldx: Integer; colldx: Integer; const value:
WideString);

row! dx: the O based row index to use.
coll dx: the 0 based column index to use.

value: The new Cell value.

getCellVaue

function getCellValue(rowldx: Integer; colldx: Integer): WideString;
rowl! dx: The 0 based row index to use.
colldx: The 0 based column index to use.

Returns the current cell value at the supplied index.

getRowCount

function getRowCount: SYSINT;

Returns the number of rows

getColumnCount

function getColumnCount: SYSINT;

Returns the number of columns.

insertRow

procedure insertRow(ldx: Integer);
Idx: The 0 based row index to use.

Inserts an empty row at index Idx.

deleteRow

procedure deleteRow(ldx: Integer);
Idx:The 0 based row index to use.

Deletes the row at index 1dx.

moveRow

procedure moveRow(Oldldx: Integer; Newldx: Integer);
Oldldx: The 0 based row index to move from.
Newl dx: The 0 based row index to move to.

Moves arow from old Idx to Newldx
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Script Example

If the name of the Table Editor component is Table, the table controller can be used to assign the table
object to avariable. The GetTableController functions and procedures can be used to manipulate the table.

Sub Set Val ued i ck( Sender)
Di m Tabl eControl | er
Set Tabl eControll er = GetTabl eControl |l er(Tabl e)
Tabl eControl | er.setCel |l Value 0, 1, TWUni Edi t 1. Text
End Sub

10.10 Component Properties

The following section describes properties of the standard components, exposed in the Object Inspector.
For simplicity and ease of use, it islisted in aphabetical order.
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10.10.1 Component properties listed in the Object I nspector

Designates the action associated with the control.

Action

A Use Active to determine or set whether adata set is populated with data.
When Activeisfalse, the data set is closed; the data set cannot read or
write data and data-aware controls can not use it to fetch data or post
edits. When Active istrue, the data set can be populated with data. It can
read data from a database or other source (such as a provider).

ActivePage Specifies the page currently displayed by the page control.

AliasName (Database) Specifies the Borland Database Engine (BDE) alias used by this database
connection

Align Determines how the control aligns within its container (parent control).

Alignment Controls the horizontal placement of the text within the label.

AllowEditingOfDefaultName Determinesiif the user should be allowed to edit the suggested name in the
save dialog.

AllowGrayed Determines whether check box can bein a*“grayed” state.

Specifies whether all speed buttons in the group that contains this speed

AllowUp
button can be unselected at the same time.

Specifies how the control is anchored to its parent. Use Anchors to ensure
that a control maintains its current position relative to an edge of its
parent, even if the parent is resized. When its parent is resized, the control
holds its position relative to the edges to which it is anchored. If a control
is anchored to opposite edges of its parent, the control stretches when its
parent is resized.

Anchors

Set Attributes to specify whether a connection object performs retaining
commits or retaining aborts. The two behaviors are independent of each
other. Attributes can contain one of the two TXactAttribute values
(xaCommitRetaining and xaAbortRetaining), both values, or neither
value.

Attributes

At s Determines when the OnCalcFields event istriggered. Set AutoCalcFields
to control when the OnCalcFields event is triggered to update calculated
fields during data set processing. A calculated field is one that derivesits
value from the values of one or more fields in the active record,
sometimes with additional processing.

AutoCalcFields (Table) Determines when the OnCalcFields event is triggered.

AutoCloseUp When AutoCloseUp is true, the drop-down closes up automatically when
the user selects an item.

When AutoComplete is true, the combo box responds to user keystrokes
by searching the Items property array for the first item that matches the
string entered so far. When AutoComplete is false, this feature is disabled.

AutoComplete
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AutoDropDown When AutoDropDown is true, the combo box automatically drops down
its list when the user starts typing a string while the combo box has focus.
When AutoDropDown is false, the user must explicitly use the drop-down
button to drop down the combo box list.

AutoEdit Determinesif a data source component automatically calls adata set’s
Edit method when a data-aware control associated with the data source
receives focus.

AutoRefresh Specifies whether server-generated field values are automatically re-
fetched.

AutoScroll Use AutoScroll to specify whether the page scroller scrolls when the
mouse hovers over one of its arrows.

S Determines whether all the text in the edit control is automatically
selected when the control gets focus.

AutoSize Determines whether the size of the label automatically resizesto
accommodate the text.

BevelEdges Use Bevel Edges to get or set which edges of the control are beveled. The
Bevellnner and Bevel Outer properties determine the appearance of the
specified edges.

Eevelline Determines the style of the inner bevel of a panel.

BevelKind Use BevelKind to modify the appearance of a bevel. BevelKind influences
how sharply the bevel stands out.

BeveOuter Determines the style of the outer bevel of a panel.

BevelWidth Determines the width, in pixels, of both the inner and outer bevels of a
panel.

BiDiM ode Specifies the bi-directional mode for the control. Use BiDiMode to enable
the control to adjust its appearance and behavior automatically when the
application runs in alocale that reads from right to left instead of left to
right.

Border Style Determines whether the edit control has a single line border around the
client area.

BorderWidth Use BorderWidth to specify how wide the border around the panel should
be. A value of 0 (zero) means no border should appear.

CadE S Set CacheSize to control how many rows the ADO data set’ s provider
keeps cached in its buffer and how many to retrieve at one time into local
memory. Default value of CacheSize is 1 and the minimum allowed value
isl.

CachedUpdates Specifies whether cached updates are enabled for a data set.

CalAlignment Set CalAlignment to dtaleft or dtaRight to align the drop-down calendar

on theleft or right side of the component. This property is applicable only
if the Kind property is dtkDate and the DateM ode property is
dmComboBox.
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CalColors

Use the CalColors property to get or set the calendar’ s background color,
month background color, text color, title background color, title text color,
and trailing text color.

Determines whether the button’s OnClick event handler executes when

Cance
the Escape key is pressed.

Caption Specifies atext string that identifies the control to the user.

Center When the image does not fit perfectly within the image control, use
Center to specify how the image is positioned. When Center istrue, the
image is centered in the control. When Center is false, the upper left
corner of theimage is positioned at the upper left corner of the control.
The default value for Center isfalse. Note

ChannellD Specifies the Viz Engine channel that should be used.

CharCase Determines the case of the text within the edit control.

Elbad Specifies whether the check box appears checked.

cmd Deprecated (no longer in use).

Collate Collate is true whenever the Collate check box is selected in the Print
dialog. To make the dialog open with the check box selected, set Collate
to true in the Object Inspector or in program code.

Color Specifies the background color of the control.

1S (o Use Columns to specify the number of columns, in a multi-column list

box, that are visible without having to use the horizontal scroll bar.

CommandTimeOut

Use CommandTimeout to specify the amount of time, in seconds, that can
expire before an attempt to execute a command is considered
unsuccessful. The default value is 30 seconds.

Connected

Set Connected to true to establish a connection to an ADO data store
without opening a data set. Set Connected to false to close a connection.
The default value for Connected is false.

Connection

Use Connection to specify an ADO connection object to use to connect to
an ADO data store.

ConnectionString

Set ConnectionString to specify the information needed to connect the
ADO connection component to the data store. The value used for
ConnectionString consists of one or more arguments ADO uses to
establish the connection. Specify multiple arguments as alist with
individual arguments separated by semicolons.

ConnectionTimeOut

Use ConnectionTimeout to specify the amount of time, in seconds, that
can expire before an attempt to make a connection is considered
unsuccessful. The default value is 15 seconds.

ConnectOptions

Set ConnectOptions to specify whether the connection established by the
TADOConnection is synchronous or asynchronous. The default value for
ConnectOptions is coConnectUnspecified.
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Constrained

Indicates whether updates and inserts, that don not conform to the result
set generated by a SELECT statement, are permitted for Paradox and
dBASE tables.

Constraints

Specifies the size constraints for the control.

Constraints (DataSet)

Specifies record-level constraints that must be met when editing the data.

ControlObjectName

Used to map the Field Identifier ID set for the scene. See also
Control ObjectName and Control plugins.

The value that the control object in Viz Engine should receive.

ControlValue

Copies If CopiesisOor 1, thedialog will have 1 in the Number of Copiesfield.
To make the dialog open with 2 or more copies selected, set the value of
Copiesin the Object Inspector or in program code.

CtI3D Determines whether a control has a three-dimensional (3-D) or two-
dimensional look.

Cursor Specifies the image used to represent the mouse pointer when it passes

into the region covered by the control

CursorL ocation

Use CursorL ocation to indicate whether the cursors that use the
connection object to connect to the ADO datastore use a client-side or
server-side cursor library. CursorLocation only affects connections
opened after the property is set. The default value for CursorLocation is
clUseClient.

CursorType

Set CursorType to indicate the type of cursor the ADO data set uses for
the record set when it is opened. CursorType must be set prior to
activating the data set component. Among other cursor aspects,
CursorType affects directional scrolling through arecord set and the
visibility of changes made by other users. The default value of
CursorTypeis ctKeyset.

CustomColors

Each custom color is represented as a string of the form
ColorX=HexVaue. For example, the following string sets the first custom
color

Specifies the name of the database associated with this data set.

DatabaseName

Oata=IEd Specifies the field from which the edit control displays data.

DataSet Specifies the data set for which the data source component serves as a
conduit to data-aware controls. Set DataSet to the name of an existing data
set component either at design time, or at runtime. By changing the value
of DataSet at runtime an application can effectively use the same data-
aware controlsto display and edit datain different data sets.

DataSetField Use DataSetField when the data set is the nested detail set of another data

set, such as an Oracle8 nested data set. Read DataSetField to access the
data set field component in the master data set that includes this data set as
adetail. Set DataSetField to afield component in the master data set to
assign this data set as the value of that field.
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DataSour ce

Links the edit control to the data set that contains the field it represents.

DataSource

Specifies the data source component from which to extract current field
values to use with same-name parameters in the query’s SQL statement.

Date

Use Date to get or set the date that is marked on the calendar. The value of
Date must lie within the range specified by the MaxDate and MinDate
properties. If MultiSelect is true, the selected range of dates goes from
Date to EndDate.

DateFor mat

If DateFormat is set to dfShort, the date is formatted using the short date
format specified in the Windows control panel. By default, it appears like
this

DateMode

If DateMode is dmComboBox, the component has a drop-down calendar
illustration from which the user can select adate. If DateModeis
dmUpDown, the component has Up/Down arrows with which the user can
adjust the date. (Applies only when Kind is dtkDate.)

Default

Determines whether the component’s OnClick event handler executes
when the Enter key is pressed.

DefaultDatabase

Set DefaultDatabase to indicate the database the ADO connection objects
usesif the connection to the database specified in ConnectionString is
unavailable, the connection cannot be made, or the database is not
specified in the connection string.

DefaultExt

DefaultExt specifies afile extension that is appended automatically to the
selected file name, unless the selected file name aready includes a
registered extension. If the user selects afile name with an extension that
is unregistered, DefaultExt is appended to the unregistered extension.

Defaultlndex (Table)

Specifiesif the datain the table should be ordered on a default index when
opened.

The destination height of the image in Viz Engine. If set to <> 0 acrop

DestHeight
tool will appear if the selected image does not adhere to the aspect given
by DestHeight and DestWidth.

DestWidth The destination width of theimagein Viz Engine. If set to <> 0 acrop
tool will appear if the selected image does not adhere to the aspect given
by DestHeight and DestWidth.

Device Use Device to specify whether the dialog should list screen fonts

(fdScreen), printer fonts (fdPrinter), or both screen and printer fonts
(fdBoth).

DisallowedK eyWords

Defines the disallowed keywords used when searching for media content.
When a user searches and finds an image, they are not allowed to select
theimage if it contains a keyword that is present in the

DisallowedK eywords property. Note

DockSite

Specifies whether the control can be the target of drag-and-dock
operations.

Down

Specifies whether the button is selected (down) or unselected (up).
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Director Specifiesthe Viz Engine director.

DragCur sor Indicates the image used to represent the mouse pointer when the control
isbeing dragged.

DragKind Specifies whether the control is being dragged normally or for docking.

DragM ode Determines how the control initiates drag-and-drop or drag-and-dock
operations. Enable automatic dragging by setting DragMode to
dmAutomatic.

DropDownCount By default, the drop-down list islong enough to contain eight items

without requiring the user to scroll to see them all. To make the drop-
down list smaller or larger, specify a number larger or smaller than eight
as the DropDownCount value. If the DropDownCount value is larger than
the number of itemsin the Items property, the drop-down list will be just
large enough to hold all the possible choices and no more. If the
DropDownCount value is smaller then the number of item in the Items
property, the drop down list will display a scroll bar.

Driver Name (Database)

Specifies the name of the BDE driver for the database.

EditM ask

Use EditMask to restrict the characters a user can enter into the masked
edit control to valid characters and formats. If the user attempts to enter an
invalid character, the edit control does not accept the character. Validation
is performed on a character-by-character basis by the ValidateEdit
method. Setting EditMask to an empty string removes the mask.

EnableBCD

Use the EnableBCD property to specify how fields are mapped to field
classes. If EnableBCD istrue, (the default value) adDecimal and
adNumeric fields are mapped to the TBCDField class when field objects
are created. If EnableBCD isfalse, the fields are mapped to the
TFloatField class.

Enabled

Controls whether the control responds to mouse, keyboard, and timer
events.

EnableSpellCheck

Enables the user to spell check the text content of atemplate.

EvObjects

A list of paths to other objectsin Viz Engine that should be controlled like
the current control.

ExecuteOptions

Set ExecuteOptions to control the characteristics of acommand (a data
retrieval operation) executed from the ADO data set component.

ExecuteOptions.
eoAsyncExecute

The command or data fetch operation is executed asynchronously.

ExecuteOptions.
eoAsyncFetch

The data set first fetches the number of records specified by the CacheSize
property synchronously, then fetches any remaining rows asynchronously.

ExecuteOptions.

eoAsyncFetchNonBlocking

Asynchronous data fetches or command execution do not block the
current thread of execution.
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ExecuteOptions.
eoExecuteNoRecor ds

A command or stored procedure that does not return data. If any rows are
retrieved, they are discarded and not returned.

Exclusive (Database)

Enables an application to gain sole access to a database.

Exclusive (Table)

Enables an application to gain sole access to a Paradox or dBASE table.

ExtendedSelect

Determines if the user can select a sequential range of itemsin the list
box.

FieldDefs (DataSet/Table)

Points to the list of field definitions for the data set.

FileDenyBrowseUp

If set when FileStartDir is set, this says that selecting from anywhere else
(limiting instead of suggesting) is not permitted.

The FileName property contains the name and compl ete directory path of

FileName
the most recently selected file. The value of FileName is the same as the
first item in the Files property.

FileStartDir If set, this contains the path to the folder (or its subfolders) from which
images are selected. For example c:\Users\Public\Pictures\ (final
backslash optional).

Eilier The file-selection dialog includes a drop-down list of file types under the

edit box. When the user picks afile type from the list, only files of the
selected type are displayed in the dialog.

Filter (DataSet/Query)

Specifies the text of the current filter for a data set.

Filtered (DataSet/Query)

Specifies whether filtering is active for a data set.

Filter Options (DataSet
IQuery)

Specifies whether filtering is case insensitive, and whether or not partial
comparisons are permitted when filtering records.

FilterIndex

Filterindex determines which of the filetypesin Filter is selected by
default when the dialog opens. Set FilterIndex to 1 to choose the first file
typeinthelist asthe default, or set FilterIndex to 2 to choose the second
file type as the default, and so forth.

FindText

FindText contains the text string that the user wants to search for. When
the user clicks the Find Next button, the text in the dialog’ s edit box is
automatically assigned to FindText. To make a default text string appear
in the edit box when the dialog opens, assign avalue to FindText in the
Object Inspector or in program code.

Flat

Determines whether the button has a 3D border that provides araised or
lowered look.

FocusControl

Designates a windowed control associated with the label. Set
FocusControl to the windowed control that should receive focus when the
user presses the accelerator key specified by the label. Specify an
accelerator key by preceding a character in the label text with an
ampersand (&) and setting the ShowA ccel Char property to True.

Font

Controls the attributes of text written on or in the control.
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Font.Char set

Specifies the character set of the font.

Specifies the color of the text.

Font.Color

Font.Heigth Specifies the height of the font.

e NETTE I dentifies the typeface of the font.

Eont.Bitch Specifies whether the charactersin the font all have the same width.

Font.Size Specifies the height of the font in points.

Font.Style Determines whether the font is normal, italic, underlined, bold, and so on.

For ceDotAsDecimal Seper atorDetermines if local specific decimal separator should be ignored and .
used as separator.Deprecated - The decimal separator will now always be
adot.

Eop Format specifies custom format string for the date-time display,
overriding the control panel strings. A custom format can include both
date and time fields, but time fields are not editable unless the Kind
property is dtk Time.Examples

Frequency Use Fregquency to specify the spacing of the tick marks, using the logical
units used by the Position property. For example, a Frequency of 5 setsa
tick mark at every fifth possible increment.

FromPage The FromPage property corresponds to the From field in the Print dialog.

FullRepaint Determines how the panel repaints itself when it isresized. When
FullRepaint istrue, the entire panel, including the beveled border repaints
when the size changes. When FullRepaint is false, only the areainside the
beveled border repaints.

Global Determinesiif the targa clip should be controlled on aglobal lever or on
Viz Engine director level.

Glyph Specifies the bitmap that appears on the bitmap button.

Groupl ndex Buttons with the same property value (other than 0), work together as a

group and can present mutually exclusive choices to the user.

HandleShared (Database)

Specifies whether or not to share a database handle.

Specifies the vertical size of the control in pixels.

Height

HelpContext HelpContext supports help systems that use numeric topic IDs. For help
systems that use topic keywords, see HelpKeyword. To enable context-
sensitive help for acontrol, set HelpType to htContext and set
HelpContext to anumeric topic ID. A topic ID of O (default) means that
no help topic is provided for the control.

HelpK eyword
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HelpKeyword supports help systems that use topic keywords. For help
systems that use numeric topic IDs, see HelpContext. To enable context-
sensitive help for acontrol, set HelpType to htKeyword and set
HelpKeyword to a keyword string. No keyword (zero-length string;
default) means that no help topic is provided for the control.

Set HelpType to specify whether the control identifies its context-sensitive

HelpType
help topic by ID or keyword. When HelpType is htContext, the
HelpContext property identifies the control’s help topic. When HelpType
is htkeyword, the HelpKeyword property identifies the control’ s help
topic.

R EE s Determinesiif the File Selector icon should be hidden.

HideObjects A list of pathsto other objectsin Viz Engine that should be hidden if this
control is hidden. See HideOnEmpty.

HideOnEmpty If the current control is empty, meaning there is no text, no image selected
etc then the control will hidden in Viz Engine.

Hiecaection Determines whether the visual indication of the selected text remains
when focus shifts to another control.

Hint Contains the text string that can appear when the user moves the mouse

over the control.

Hor zScrollBar

HorzScrolIBar properties.

Hor zScrollBar .ButtonSize

Size of the horizontal scroll bar button.

Hor zScrollBar .Color

Color of the horizontal scroll bar.

Hor zScrollBar .| ncrement

Scroll increment.

Hor zScrollBar .ParentColor

To have a control use the same color asits parent control, set ParentColor
to true. If ParentColor isfalse, the control uses its own Color property.

Hor zScrollBar .Position

Indicates the current position of the scroll bar.

Hor zScrolIBar .Range

Determines how far the scrolling region of the associated control can
move.

Hor zScrollBar.Visible

Determines if the horizontal scroll bar should be visible or not.

Determines whether |abels on the tab under the mouse are automatically

HotTrack
highlighted.
I magel nfo Information about the image selected from Object Store
I magel nfoK ey Deprecated (no longer in use).
I mageK eywor ds Keywords for the image selected from Object Store
I mageSour ces Use the ImageSources property to set the sources the user should be able

to pick images from.

The user can search and select amap from the Viz World Client.
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I mageSour ces.
isAdvancedCuriousM ap

I mageSour ces.isArdome

The user is allowed to search for clipsin Ardome.

I mageSour ces. Deprecated.

isBackground

I mageSour ces. The user can search and select a map from the Viz World Client
isCuriousM ap (simplified version).

I mageSour ces. The user can select an image from Object Store.

islmageM ediaSear ch
(previously named
isDatabase)

ImageSour ces.isFileOpen

The user can select afile from the file system.

I mageSour ces.isl mage

The user can drag and drop images from the image pool found under the
Viz tab in Director.

I mageSour ces.isM aterial

The user can drag and drop materials from the materia pool found under
the Viz tab in Director.

I mageSour ces.isObject

The user can drag and drop objects from the “geom” pool found under the
Viz tab in Director.

I mageSour ces.isPaste

The user is allowed to paste images from the clipboard.

I mageSour ces.isPr oximity

The user is allowed to select images or video clips from Proximity’s
Artbox. Requires the Proximity Artbox asset management system.

ImageSour ces.isRGB

The user can drag and drop files from the RGB-files tab in Director.

I mageSour ces.isScene

The user can drag and drop scenes from the scene pool found under the
Viz Engine tab/button in Director.

ImageSour ces.
isVideoM ediaSear ch
(previously named

The user can select avideo from one of the configured providersin the
Media Search.

isVideoHub)

ImeM ode Determines the behavior of the input method editor (IME). Set ImeMode
to configure the way an IME processes user keystrokes. An IME is afront-
end input processor for Asian language characters.

ImeName Specifies the input method editor (IME) to use for converting keyboard
input to Asian language characters.

Imported Boolean telling us if the current was opened and filled externally.

e Determines the increment.

Incremental Display
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Specifies whether successive approximations of the image should be
drawn during slow operations. Set Incremental Display to True on large
compressed images that take along time to load or on images that may be
atered by a computationally slow process. When Incremental Display is
True, partia renderings of the image are drawn periodically during slow
operations such as loading.

IndexDefs (Table)

Contains information about the indexes for atable.

IndexFieldNames (Table)

Lists the columns to use as an index for atable.

IndexFiles (Table)

Specifies one or more dBASE index file(s) to use for a dBA SE table that
uses non-production indexes.

IndexName (Table)

Identifies a secondary index for the table.

Determinesiif the control will only use integer values.

Integer M ode

ISzl Initial Dir determines the default directory displayed in the file-selection
dialog when it opens. For example, to point the dialog at the /home
/company/docs directory, set the value if Initial Dir to /home/company
/docs. If no valueis assigned to Initia Dir, or if the specified directory
does not exist, theinitial directory isthe current working directory.

IntegralHeight Determines whether the list box displays the partial items.

Internal Spacing Determines the spacing, in pixels, between each field.

Interval Interval determines how frequently the OnTimer event occurs. Each time
the specified interval passes, the OnTimer event occurs. Use Interval to
specify any cardinal value astheinterval between OnTimer events. The
default value is 1000 (one second).

I e Use IsolationLevel to specify the transaction isolation level for a
connection. The transaction isolation level determines how atransaction
interacts with other simultaneous transactions when they work with the
same tables, and how much atransaction sees of the work performed by
other transactions. The default value for IsolationLevel is
ilCursorStability.

ItemHeight Specifies the height in pixels of an item in an owner-draw list box.

Itemsindex Indicates which itemin the list is selected.

s Contains the strings that appear in the list box.

KeepConnection (Database)

Specifies whether an application remains connected to a database even if
no data sets are open.

Keyframe

Specifiesthe Viz Engine keyframe to contral.

Kind

Use Kind to specify the appearance of the component’ s control and its
response when the user clicks the button.
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L ayout Specifiesthe vertical placement of the text within the |abel.

L eft Specifies the horizontal coordinate of the left edge of a component
relative to its parent.

Lines Contains the individua lines of text in the memo control.

LinkName When selecting an image connected to a person in Object Store, the name
of the person can be automatically put into an edit box. Use LinkName to
set the edit box that should receive the name of the person

Ll rile When selecting an image connected to a person in Object Store, thetitle
of the person can be automatically put into an edit box. Use LinkTitle to
set the edit box that should receive the title of the person.

LircEam Use LineSize to specify the distance along the slider that represents a
single unit. The current Position is marked by a dider.

L ocked Determines whether a panel that is used as atoolbar is replaced by a
toolbar supplied by an OLE server.

LockType Use LockType to specify the lock type to use when opening a data set.

LockType determines whether the row locking scheme for arecord set
will be pessimistic, optimistic, or read-only. To be effective, LockType
must be set prior to activating the ADO data set component.

L oginPrompt

Specifies whether alogin dialog appears immediately before opening a
new connection.

Margin

The margin is the space between the image edge and the button edge.

MarshalOptions

Use Marshal Options when the data set component uses a client-side
cursor and data changes are to be sent back to the server. Marshal Options
specifies which recordsin the local record set are sent to the middle tier or
server. A value of moMarshaAll resultsin all recordsin the local record
set being packaged and sent back. A value of moMarshalModifiedOnly
sends back only those records that have actually been changed in the local
record set The default value for Marshal Options is moMarshal All.

Master Fields (Table)

Specifies one or more fields in a master table to link with corresponding
fieldsin thistable in order to establish a master-detail relationship
between the tables.

Master Sour ce (Table)

Specifies the name of the data source for a data set to use as a master table
when establishing a detail-master relationship between this table and
another one.

Specifies the maximum size of aninterval, see Min.

M ax

M axDate Use MaxDate to get or set the maximum date to which users can scroll the
calendar. The values of the Date and EndDate properties cannot exceed
MaxDate.

M axFontSize Assign avaue to MaxFontSize to limit the font sizes available in the

dialog. MaxFontSize is inoperative unless the fdLimitSize flag is set in
Options.
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MaxL ength Specifies the maximum number of characters the user can enter into the
edit control.

e e Use MaxRecords to control the number of rows the provider for the ADO
data set component returns from the data source. Set MaxRecords to
indicate the maximum number of rows. The default value for MaxRecords
is 0 (zero), which places no limits on the result set.

Maxvalie Specifies the maximum value allowed, see MinValue.

Min Specifies the minimum size of an interval, see Max.

MinDate Use MinDate to get or set the minimum date that can be selected.

MinEontSize Assign avaue to MinFontSize to limit the font sizes availablein the
dialog. MinFontSize isinoperative unless the fdLimitSize flag is set in
Options.

A e Specifies the minimum value allowed, see MinValue.

M odalResult Determines whether and how the button closes its (modal) parent form.

Mode Read Mode to determine the permissions available to the connection after
the connection has been activated. The permissions expressed in Mode
govern the types of operations (such as reading and writing) can be
performed through the connection. They also control how these operations
are affected by and affect other concurrent users.

MilGNhe Determines whether the tabs can appear on more than one row.

MultiSelect Determines whether the user can select more than one element at atime.

M ultiSelection Indicatesif the user is allowed to multi select or not.

e Specifies the name of the control as referenced in code.

NumGlyphs Specifies the bitmap that appears on the bitmap button.

ObjectPath Reference to the object to control in the Viz Engine scene. Enter the path

to the object in the scene. Use full Viz Engine-path or the name of the
container with adollar-sign ($) in front (the container must then have a
unique name in the scene tree).

ObjectView (DataSet

Specifies whether fields are to be stored hierarchically or flattened out in
the Fields property.

/Query)

OEM Convert Determines whether characters typed in the edit control are converted
from ANSI to OEM and then back to ANSI.

Options Use the Options property to customize the appearance and functionality of

the dialog. By default, all options are off.

Options.cdAnyColor

Allow the user to select non-solid colors (which may have to be
approximated by dithering).

Display custom color options when the dialog opens.
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Options.cdFullOpen

Options.cdPreventFullOpen

Disable the Define Custom Colors button in the dialog, so that the user
cannot define new colors.

Options.cdShowHelp

Add aHelp button to the color dialog.

Options.cdSolidColor

Direct Windows to use the nearest solid color to the color chosen.

Options.fdAnsiOnly

Displays only fonts that use the Windows character set. Symbol fonts are
not listed in the dialog.

Options.fdApplyButton

Displays an Apply button in the dialog, whether or not there isan
OnApply event handler.

Options.fdEffects

Displays the Effects check boxes (Strikeout and Underline) and the Color
list box in the dialog.

Options.fdFixedPitchOnly

Displays only monospaced fonts in the dialog. Proportionally spaced fonts
are not listed, nor are TrueType fonts that do not have the fixed-pitch flag
set in the style header.

Options.fdFor ceFontExist

Allows the user to enter only fonts that are displayed in the dialog (that is,
listed in the Font combo box). If the user tries to enter another font name,
an error message appears.

Options.fdLimitSize

Enables the MaxFontSize and MinFontSize properties, limiting the range
of font sizes that appear in the dialog if these properties have values.

Options.fdNoFaceSel

Causes the dialog to open without a preselected font name in the Font
combo box.

Options.fdNOOEM Fonts

Removes OEM fonts from the dialog’s combo box. Lists only non-OEM
fonts.

Options.fdNoSimulations

Displays only fonts and font stylesthat are directly supported by the font
definition file. GDI-synthesized bold and italic styles (for bitmap fonts)
arenot listed.

Options.fdNoSizeSel

Causes the dialog to open without a preselected size in the Size combo
box.

Options.fdNoStyleSel

Causes the dialog to open without a preselected style in the Font Style
combo box.

Options.fdNoVector Fonts

Removes vector fonts from the dialog’s combo box; lists only non-vector
fonts. (Vector fonts are Windows 1.0 fonts, such as Roman or Script,
which resemble pen-plotter output.)

Options.fdScalableOnly

Displays only scalable fonts in the dialog. Non-scalable (bitmap) fonts are
removed from the list.

Options.fdShowHelp

Displays a Help button in the dialog.

Options.fdTrueTypeOnly

Displays only TrueType fontsin the dialog. Other fonts are not listed.

Options.fdWysiwyg

Displays only fonts that are available to both the printer and the screen.
Device-specific fonts are not listed in the dial og.

Disables (grays) the Match Case check box in afind dialog.
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Options.
frDisableM atchCase

Options.frDisableUpDown

Disables (grays) the Up and Down buttons, which determine the direction
of the search.

Options.
frDisableWholeWord

Disables (grays) the Match Whole Word check box of find dialog.

Options.frDown

Selects the Down button by default when the dialog opens. If the frDown
flagsis off, Up is selected when the dialog opens. (By default, frDown is
on.)

Options.frFindNext

Thisflag is turned on when the user clicks the Find Next button and
turned off when the dialog closes.

Options.frHideMatchCase

Removes the Match Case check box from the dial og.

Options.frHideUpDown

Removes the Up and Down buttons from the dial og.

Options.frHidewholewWord

Removes the Match Whole Word check box from the dialog.

Options.frMatchCase

Thisflag is turned on (off) when the user selects (desel ects) the Match
Case check box. To select the check box by default when the dialog
opens, set frMatchCase at design time.

Options.frReplace

Appliesto TReplaceDiaog only. Thisflag is set by the system to indicate
that the application should replace the current occurrence (and only the
current occurrence) of the FindText string with the ReplaceText string.
Not used in search routines.

Options.fr ReplaceAll

Appliesto TReplaceDiaog only. Thisflag is set by the system to indicate
that the application should replace all occurrences of the FindText string
with the ReplaceText string.

Options.frShowHelp

Displays a Help button in the dialog.

Options.frwholeword

Thisflag is turned on (off) when the user selects (desel ects) the Match
Whole Word check box. To select the check box by default when the
dialog opens, set frwholeWord at design time.

Options.of AllowM ultiSelect

Allows usersto select more than one file in the dialog.

Options.of CreatePrompt

Generates awarning message if the user tries to select a nonexistent file,
asking whether to create a new file with the specified name.

Options.
ofDontAddToRecent

Prevents the file from being added to the list of recently opened files.

Options.
of Enablel ncludeNotify

(Windows 2000 and later.) Sends CDN_INCLUDEITEM netification
messages to the dialog when the user opens afolder. A notification is sent
for each item in the newly opened folder. It is aso possible to use these
messages to control which items appear in the folder’ sitem list.

Options.ofEnableSizing
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(Windows 98 and later) Letsthe Explorer-style dia og be resized with the
mouse or keyboard. By default, the dialog allows this resizing regardless
of the value of thisoption. It isonly required when a hook procedure or
custom template is provided (old style dialogs never permit resizing).

Options.
ofExtensionDiffer ent

Thisflag isturned on at runtime whenever the selected filename has an
extension that differs from DefaultExt. Remember to reset it if thisflag is
used in an application.

Options.of FileM ustExist

Generates an error message if the user tries to select a nonexistent file.
(only appliesto Open dialogs).

Options.
of For ceShowHidden

Ensures that hidden files are visible in the dialog.

Options.ofHideReadOnly

Removes the Open As Read Only check box from the dialog.

Options.ofNoChangeDir

After the user clicks OK, resets the current directory to whatever it was
before the file-selection dialog opened.

Options.
ofNoDer eferencelinks

Disables dereferencing of Windows shortcuts. If the user selects a
shortcut, assigns to FileName the path and file name of the shortcut itself
(the .LNK file), rather than the file linked to the shortcuit.

Options.of NoL ongNames

Displays 8.3-character file namesonly. Thisoptionisonly valid if
Options aso includes of OldStyleDial og.

Options.
of NoNetwor kButton

Removes the Network button (which opens a Map Network Drive dialog)
from the file-selection dialog. Applies only if the of OldStyleDialog flag is
on.

Options.
of NoReadOnlyReturn

Generates an error message if the user tries to select aread-only file.

Options.of NoT estFileCreate

Disables checking for network file protection and inaccessibility of disk
drives. Applies only when the user triesto save afile in a create-no-
modify shared network directory.

Options.of NoValidate

Disables checking for invalid charactersin file names. Allows selection of
file names with invalid characters.

Options.of OldStyleDialog

Creates the older style of file-selection dialog.

Options.
of OverwritePrompt

Generates awarning message if the user tries to select afile namethat is
already in use, asking whether to overwrite the existing file. (Use with
save dialogs.)

Options.of PathM ust Exist

Generates an error message if the user tries to select afile name with a
nonexistent directory path.

Options.ofReadOnly

Selects the Open As Read Only check box by default when the dialog
opens.

Options.of ShareWare

Ignores sharing errors and allows files to be selected even when sharing
violations occur.

Options.of ShowHelp

Displays a Help button in the dialog.
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Options.
poDisablePrintToFile

Disables (grays) the Print To File Check box. (Applicable only if the
poPrintToFileflag is set.)

Options.poHep

Displays a Help button in the dialog. May not work in some versions of
Windows 95.

Options.poPageNums

Enables the Pages radio button, allowing the user to specify a page range.

Options.poPrintToFile

DisplaysaPrint To File check box in the dialog.

Options.poSelection

Enables the Selection radio button, allowing the user to print selected
(highlighted) text.

Options.poWarning

Generates awarning message if the user tries to send ajob to an
uninstalled printer.

Use the OptionsEx property to further customize the file open dialog

OptionsEx
beyond the options covered by the Options property.

OptionsEx. Setting of ExXNoPlacesBar to True hides the “Places Bar”. The “Places

ofExNoPlacesBar Bar” provides shortcuts to places on the computer or the network from
which afile can be opened, such as the History folder, the desktop, or My
Network Places.

Orientation Specifies whether the track bar is horizontal or vertical.

ownebDran Set OwnerDraw to true to enable events that allow the control to draw
itself by overriding any default painting behavior.

PageSize Specifies the amount Position is changed when the PageUp or PageDown

key is pressed, or when the bar is clicked.

ParamCheck (Query)

Specifies whether the parameter list for aquery isregenerated if the SQL
property changes at runtime.

At design-time, use Parameters to access the parameters for the SQL

Parameters
statement used by the ADO component. Use the properties and methods
of Parametersto set and get individual parameter values or to set or
inspect parameter attributes. At runtime, use the Parameters property
editor to access the collection of parameters.

Params (Database) Contains database connection parameters for the Borland Database Engine
(BDE) dlias associated with the database component.

Params (Query) Contains the parameters for a query’s SQL statement.

Par entBackground Determines whether control uses parent’ s theme background. If

ParentBackground is true, the control uses the parent’ s theme background
to draw its own background. ParentBackground has no effect unless XP
themes are enabled.

ParentBiDiM ode

Specifies whether the control usesits parent’s BiDiMode.

ParentColor

Determines where a control looks for its color information. To have a
control use the same color asits parent control, set ParentColor to True. If
ParentColor is False, the control usesits own Color property.
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ParentCtI3D Determines where a component looks to determine if it should appear
three dimensional.
[ Determines where a control looks for its font information. To have a

control use the same font as its parent control, set ParentFont to True. If
ParentFont is False, the control uses its own Font property.

ParentShowHint

Determines where a control looksto find out if its Help Hint should be
shown.

Enables the OnUserlnput event. If Parselnput is true, the OnUser|nput

Par sel nput
event occurs whenever the user types into the component’ s edit box.

Saesme Sy Indicates the character, if any, to display in place of the actual characters
typed in the control.

[ List with information about the person selected from Object Store.

picFilename Contains the path to the image/map/video that the control contains.

Bl Specifies the image that appears on the image control.

Pool The Viz Engine pool that the item selector should display (like SCENE,
GEOM, FONT etc).

PopupMenu I dentifies the pop-up menu associated with the control.

Bosition Contains the current position of the slider of a TTrackBar.

ST Specifiesthe prefix for a save name.

Prepared Set Prepared before calling the Open method to specify whether ADO
prepares the command used to create the data set’ s record set. If Prepared
is set to true and the data set component is connected to a data store, ADO
prepares the command before executing it. If Prepared is set to false, ADO
does not prepare the command. The default value of Prepared isfalse.

PrintRange The value of PrintRange corresponds the All, Selection, and Pages (From
/To) radio buttonsin the Print dial og.

B T PrintToFile is true whenever the Print To File check box is selected in the

dialog.

Proportional

Indicates whether the image should be changed, without distortion, so that
it fits the bounds of the image control.

Set Provider to indicate the provider the ADO connection object uses. The

Provider
provider a connection isto use can also be specified in the string entered
in ConnectionString. If Provider isleft blank and the provider specified
through ConnectionString, when the connection is activated the Provider
property is automatically set indicating the provider used.

RaggedRight Specifies whether rows of tabs stretch to fill the width of the control.

EESTET s Use RDSConnection to specify the RDS connection component to use to

obtain the record set when the TADODataSet is opened. This property is
mutually exclusive of the Connection property.
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ReadOnly

Determines whether the user can change the text of the edit control.

ReadOnly (Database)

Specifies that the database connection provides read-only access.

ReplaceText

ReplaceText, taken from the Replace With edit box, contains the text
string that will replace FindText.

RequestLive (Query)

Specifies whether an application expects to receive alive result set from
the Borland Database Engine (BDE) when the query executes.

RequiredKeyWords

Defines the required keywords used when searching for media content.
Thisis currently relevant for Object Store searches only.

RequiredK eyWordsM ode

Sets the options RequireOne or RequireAll. Searches can be performed
with information from the RequiredK eyWords field.

RTL

Right to left reading.

RTL .rtIReading

Specifies that the text is displayed with right to left reading order.

RTL .rtIReading

Thetext isright-aligned.

ReverseSorting

Indicatesif reverse sorting is active.

SaveNameT extFields

Click the dlipsis button to bring up and editor where you can select the
edit boxes that should be used for generating a save hame.

ScrollBars

Determines whether the memo control has any scroll bars.

ScrollOpposite

Determines how the rows of tabs are scrolled in a multiline tab control.

Specifies the width, in pixels, by which the list box can scroll

ScrollWidth
horizontally.
SdEnd Specifies the position of the end point of the selection range.
SAlectePah The Viz Engine path of the selected item.
SalStart Specifies the position of the starting point of the selection range.
SendsJIS Sends the text in the text box as SJIS (character encoding for the Japanese
language).
SendUTFS Sends the text in the text box as UTF-8 (universal character encoding).
Seper ator Specifies the size of the tabsin e.g. alist box or page control.
SessionName (Query I dentifies the name of the session with which this data set is associated.
/Database)
ShowAccelChar Determines how an ampersand (&) in the label text is displayed. Set

ShowA ccelChar to Trueto alow the label to display an underlined

accelerator key value. When ShowAccelChar is True, any character
preceded by an ampersand appears underlined. If the FocusControl

property is set, the windowed control specified by the FocusControl
property receives input focus when the user types that underlined
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character. To display an ampersand when ShowAccelChar is True, use
two ampersands (& &) to stand for the single ampersand that is displayed.
Set ShowA ccelChar to False to display the label text with all ampersands
appearing as ampersands. When ShowA ccel Char is False, the value of the
FocusControl property is not used.

ShowHint

Determines whether the control displays a Help Hint when the mouse
pointer rests momentarily on the control.

ShowProximitySelector

Specifiesif the control should show a Proximity selection button.

ShowSaveDialog

Determines whether Director should show the save dialog when saving
the template.

ShowTimeStamp

Indicates if the control will show timestamp.

Specifies whether the dider should be visible or not.

SliderVisible

SortByDate Sort entries by date.

SortByName Sort entries by name.

Sorted Specifies whether the itemsin alist box or combo box are arranged
aphabetically.

Source Deprecated (no longer in use).

Spacing Spacing determines the number of pixels between the image (specified in
the Glyph property) and the text (specified in the Caption property). The
default valueis 4 pixels.

SQL (query) Contains the text of the SQL statement to execute for the query.

State Indicates whether the check box is selected, deselected, or grayed.

StoreDefs (Table) Indicates whether the table’ s field and index definitions persist with the

data module or form.

StoryActions

Click the elipsis button to bring up and editor where you can select and
order the edit boxes that should get the data we receive externally.

Indicates whether the image should be changed so that it exactly fits the

Stretch
bounds of the image control.

Strings List of strings.

Style Determines the style of alist box or combo box.

TableDirect Use TADOTable to access datain a single database table using ADO.
TADOTable provides direct access to every record and field in an
underlying database table. An ADO table component can also work with a
subset of records within a database table using ranges and filters.

e N Use TableName to specify the base table in a database on which the ADO

table component operates. Data s retrieved from and changes written to
this base table. Before setting or changing the value of TableName,

341



deactivate the ADO table component by calling its Close method or
setting its Active property to false. At design-time, if avalid connection to
a database can be established, the Object Inspector provides a drop-down
list of names of available tables.

TableType (Table)

Indicates the database table structure for the table that this component
represents.

Specifies the size of the tabsin e.g. alist box or page control.

TabHeight

el R Specifiesthe order of thetabsin e.g. alist box or page control.

TabOrder Indicates the position of the control in its parent’ s tab order. TabOrder is
the order in which child windows are visited when the user presses the
Tab key. In most applications, the control with the TabOrder value of O is
the control that has the focus when the form first appears. In Pilot News
however, it is the text box with the smallest TabOrder that has the initial
focus.

TabPasition Specifies the position of the tabsin e.g. alist box or page control.

TabStop Determines if the user can tab to a control.

TabWidth Specifies the size of the tabsin e.g. alist box or page control.

Tag Stores an integer value as part of a component. Tag has no predefined
meaning. The Tag property is provided for the convenience of developers.
It can be used for storing an additional integer value or it can be typecast
to any 32-bit value such as a component reference or a pointer.

T Contains atext string associated with the control.

ThumbL ength Specifies the size of the dlider.

T 2l Specifies where the slider ticks are shown.

TickStyle Specifies how tick marks are placed on the track bar.

Title Use Title to return or set the title caption for the dialog box.

Top Specifiesthe Y coordinate of the top left corner of acontral, relative to its
parent or containing control in pixels.

ToPage The ToPage property correspondsto the To field in the Print dialog.

Transl solation (Database)

Specifies the transaction isolation level for transactions managed by the
Borland Database Engine (BDE).

Transparent (L abel)

Specifies whether controls that sit below the label on aform can be seen
through the label.

Transparent

Specifies whether the background of the image obscures objects below the
image object.

TWImagel nfComponent

Deprecated (no longer in use).
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UHPathl sRelative

If true, then the path in UpdateHubPath is considered relative to the
current position in the UpdateHub tree. Otherwise, it istreated asan
absolute path.

The path in the UpdateHub that control edits or displays.

UpdateHubPath
UTFES8ltems Theitemsin the control represented as alist of UTF-8 strings.
UTFS8Text Defines the character encoding. UTF-8 is a variable-length character

encoding for Unicode, representing any universal character in the Unicode
standard, and contains virtually all charactersin common use.

UniDirectional (Query)

Determines whether or not Borland Database Engine (BDE) bidirectional
cursors are enabled for aquery’ s result set.

UnixShare

Deprecated (no longer in use).

UpdateM ode (DataSet
/Query/Table)

Determines how the Borland Database Engine (BDE) finds records when
updating to an SQL database.

UpdateObject (DataSet
IQuery)

Specifies the update object component used to update a read-only result
set when cached updates are enabled.

UseDockM anager

Use UseDockManager to get or set whether a docking manager isused in
drag-and-dock operations.

UseUTF8UnicodeProperty

When the DirectStoryl mporter receives data and sets text into the various
text boxes, this property determinesif it will use the .text or the .utf8text
property of the edit fields.

Value

Specifies the value.

VertScrollBar

Vertical scrollbar properties.

VertScrollBar. ParentColor

To have a control use the same color asits parent control, set ParentCol or
to true. If ParentColor is false, the control uses its own Color property.

VertScrollBar.Position

Indicates the current position of the scroll bar.

VertScrollBar.Range

Determines how far the scrolling region of the associated control can
move.

Visible

Determines whether the component appears on screen.

VizDenyBrowseUp

Indicatesif the user should be allowed to navigate up in the Viz Engine
tree when selecting a Viz resource in an image control. Note that
VizDenyBrowseUp isignored in Director. This means that while users of
Viz Pilot Newsinside a Newsroom System are limited by the
VizDenyBrowseUp property, users of Director are considered graphics
/video/maps super users and can use any image in the Director template.

VizStartDir

Starting location in the Viz Engine tree when selecting a Viz resourcein
an image control. Only considered if there is no pre-selected valuein the
control and, in Pilot News, also when VizDenyBrowseUp is set and the
pre-selected value is not within the folder specified here.
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VizText Deprecated (no longer in use).

R TR Determines whether the user can insert return characters into the text.

WAt abs Determines whether the user can insert tab charactersinto the text.

Width Specifies the horizontal size of the control or form in pixels.

WordWrap Determines whether the edit control inserts soft carriage returns so text
wraps at the right margin.

sl Valuefor X.

YValue Vauefor Y.

7value Vauefor Z.




11 Template Manager

Template Wizard' s template manager tool organizes templates and their scenes into concepts, templates
and variants of templates.

The template manager’s user interface consists of three panes for browsing, and a fourth pane that is
exposed when managing the concepts, concept templates and variants of templates.

The Concepts - ALL, Concept templates and Template variants panes are used for creating concepts,
adding templates to a concept and defining variants of atemplate within a concept, respectively. It isalso
possible to edit and delete existing concepts, their templates and variants.
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This section contains the following topics:

® Concepts
® Templates
® Variants

11.1 Concepts

11.1.1 Why Concepts Are Used

When working with concepts there are afew things to keep in mind. First of all, a concept is a placehol der
for a set of templates, like afolder. Secondly, concepts are about reuse of data.
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A news concept for the afternoon show might look different than the concept for the evening news,
however, if you rerun a story from the afternoon show you most probably would like to reuse the datain
your evening show. Switching concepts and thereby the look and feel of your graphics, but reusing the
data makes alot of sense. Another use case is to output the same news story to multiple channels at the
same time (see Forked Execution).

To achieve this you need to create your concepts in Template Manager and add all relevant templatesto it.
Once your first concept is finished you simply duplicate the concept for your next concept, swap the
scenes used by the templates in the concept, and you are done.

This workflow allows you to build a single set of templates for multiple concepts. However, this workflow
also requires the graphics designer to create an identical number of scenes with identical properties
exposed for each concept in order for your templates to be reused. So, design wise the scenes may differ,
but property wise not (i.e. the exposed properties’ name, type, and order). For example; if aone line lower
third is created for the afternoon show, there has to be a one line lower third for the evening show with the
exact same set of properties exposed for your template to work.

11.1.2 Working with Concepts

The Concepts - ALL pane lists all available concepts stored on the database. Checked concepts are visible
tothe users. It isaso possible to create, update and delete concepts using Template Manager.

Concept Settings

Selecting a concept from the Concepts -ALL pane will automatically display the templates that belong to
the selected concept in the Concept templates pane.

If you are creating concepts for broadcast and online publishing you should consider applying a naming
convention that will make a distinct separation between the two concepts. This will help users avoid those
concepts that are clearly marked for a different use case then theirs. Most often graphics will be different
in terms of animation and aspect and will not necessarily work in both situations. For more information,
see Variants.

Also note that concept names created for online publishing have to match the concept names defined in
the online publishing system.

Concept settings

Name Description

Name of concept Sets the name of the new concept.

Id Is automatically set when the concept is saved.

Active Toggles (activelinactive) the visible state of the concept template in the

Viz Pilot system’s applications. This can also be done by checking or
unchecking the checkbox beside the concept listed in the Concepts - ALL
pane.
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To create a new concept

1. Click the New button in the Concepts - ALL pane to open the New concept editor.
2. Enter aname for the concept in the Name of concept field.
3. Click Save.

To edit a concept

1. Select aconcept and click the Edit button in the Concepts- ALL pane to open the Edit concept
editor.

2. Edit the Concept settings and click Save.

To delete a concept

® Select aconcept and click the Delete button in the Concepts - ALL pane and in the confirmation
dialog box click Yesto confirm the deletion.

11.2 Templates

Templates are basically fill-in forms for your graphics. In addition they can be reused for variations of the
graphics within the same concept and copied to other design Concepts for reuse. All use cases support
reuse of data, meaning that the user only needs to fill in data once.

This section contains the following topics:

® Templates View
® Working with Templates

11.2.1 Templates View

Templates are listed in the Concept templates list. Checked templates are visible to the users. To view a
concept’ stemplates just select a concept from the Concepts list. Templates can be added, copied, edited or
deleted from a concept.

Selecting atemplate will automatically list the template’ s variants in the Template variants pane.
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Concept template settings

Name Description

Template Name Sets the selected template to be added to the concept.

Template ID Displaysthe ID of the selected template.

Active Toggles (activelinactive) the visible state of the concept template in the

Viz Pilot system’ s applications. This can also be done by checking or
unchecking the checkbox next to the concept template listed in the
Concept templates pane.

Scene folder Sets the path to the folder that contains the scene(s) for the template. If a
template’ s scene folder is changed, the scenes for every variant of that
template (in a specific concept) will be re-imported from Viz.

Thumbnail Placeholder for the scene' s thumbnail.

11.2.2 Working with Templates

To add atemplate

]

. , ]
SCENE=02_GFX/VizContentPilot/Concepts/concer u

Select a concept from the Concepts- ALL pane the template should be created in.
Click New in the Concept templates pane.

Select atemplate from the Template Name drop-list.

Browse the Viz directory for the scene to use with the template, and click OK.
Click Save.

agkrwbdpE

Note: For transition logic concept templates the procedure is a bit different. See how To add a
transition logic template.

To add atransition logic template

1. Select aconcept from the Concepts- ALL pane the template should be copied to.
2. Click New in the Concept templates pane.
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3. Select atransition logic template from the Template Name drop-list.

4. Browsethe Viz directory for the transition logic scenes to use with the template. Make sure the
selected scenes are tagged OK, and click OK.

5. Click Save.

To copy an unassigned template from the resource panel

1. Inthe Resource Panel select the <Unassigned> concept in the template view.

2. In Template Manager select the desired concept from the Concepts- ALL pane.

3. Drag and drop the template from the Resource Panel to the Concept templates panein Template
Manager.

4. Click Yesto confirm the action.

To copy atemplate from one concept to another

L

‘7 Defalt
1. Select aconcept to copy atemplate from.
2. From the Concept templates pane, drag and drop the template onto one of the concepts in the
Concepts- ALL pane.

[lowess_third_spait |

¥ lower_Third
fower third sport |

¥ maDs
¥ maps_largabemplate
¥ pErsamnfo

IMPORTANT! Thiskind of copying does not result in two independent templates. In fact,
the new template will have the same Template ID as the original, and changes made to either
template will be reflected in both.

To copy atransition logic template from one concept to another

Select the template from the Concept templates pane that will be copied to the new concept.
Drag and drop the template onto the designated concept listed in the Concepts- ALL pane.
Confirm that the template should be copied to the new concept.

Browse the Viz directory for the transition logic scenes to use with the template. Make sure the
selected scenes are tagged OK, and click OK.

5. Click Save.

AW PRE

To edit atemplate

1. Select atemplate from the Concept templates pane, and click the Edit button to open the Edit
template editor.

349



2. Set new properties for the Active and Scene folder settings.
® |f you have copied atemplate from one concept to another you can use the Scene folder to
set the path for your new design concept.
3. Click Save.

To delete atemplate

1. Sedlect atemplate and click the Delete button located in the Conceptstemplate pane.
2. Click Yesin the confirmation dialog box.

11.3 Variants

With a concept’ s template selected the template’ s variants are displayed in the Template variants pane that
allows you to add, edit and delete variants controlling standard scenes.

11.3.1 Variant View

With a concept’ s template selected the template’ s variants are displayed in the Template variants pane that
allows you to add, edit and delete variants controlling standard scenes.

Transition logic variants can only be edited for setting an external 1D, description, category assignment
and stop points. Transition logic does not support variants as transition logic is meant to provide the
variants al in one, and with seamless transitions between them. Hence, transition logic templates will only
have a Default template variant.

Variants of atemplate used for online publishing must be saved with variant names (

<wi dt h>x<hei ght >) according to the resolution of the image required by the publishing template (e.g.
285x170, 620x350, 720295 and so on). It also has to be saved to a concept that is used for online
publishing (see Concepts)

Variants for standard scenes are basically a set of similar scenes that can be controlled using the same
template. For thisto work, all scenes must be built the same way. They must have the same path to the
objects that are controlled by the template, or aternatively they can be set up with equal control channels.
Scene objects that are controlled by atemplate must be of the same kind for the template to work across
different scenes.

For example: A template controlling atext object with Field Identifier=1 in one scene cannot
automatically control an image object with Field Identifier=1 in another scene.
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Template Variant Settings

Name

Description

Description of variant

Sets adescription for the variant. The name will show up asalist itemin
the Template variant list.

Template ID Displaysthe ID of the selected template.

Active Toggles (activelinactive) the visible state of the template variant in the
Viz Pilot system’s applications. This can also be done by checking or
unchecking the checkbox next to the template variants listed in the
Template variants pane.

Scene folder Sets the path to the folder that contains the scene(s) for the template
variant. If atemplate’'s scene folder is changed, the scenes for every
variant of that template (in a specific concept) will be re-imported from
Viz.

Scene name Lists all scenesavailable in the Scene folder.

Stop points (Default) Sets the number of stop pointsin the scene. Thisis done to show the

operator during playout how many times Continue has to be executed
when the variant is played. It is also used by automation systems to enable
automatic execution of the Continue commands.

Custom ID (Optional)

Assigns a custom ID to avariant. Thisis only needed if some external
logic is to be executed with the variant or a selection of variant with the
same ID are to be extracted and processed.

External 1D Assigns aunique ID used for integration with external systems such asa
newsroom system. The List button opens a window that shows the
external IDsin use. Right-click an ID to edit the variant with that ID. See
also External I D used with Import Components components.

Category Sets the category for which the template variant can be filtered. See

Categories and Channels.
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11.3.2 Working with Variants
To add or edit avariant

1. Click the New or Edit button in the Template variants pane to open the New variant or Edit
variant editor.

Enter anamein the Description of variant field.

Select a scene from the Scene name drop-list.

Optional: Enter an External ID.

Optional: Set a Category.

Click Save.

© Uk wd

To delete avariant

® Click the Delete button in the Template variants pane, and confirm the deletion.
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12 Crop Service and Crop Tool

The Crop Tool and the Crop Service are tools that allow for basic cutting, zooming and rotating of images.
They provide an efficient way for journalists and editors to quickly add new images to a data el ement.

The Crop Service makes it possible to crop RestV OS images and images from any Viz One server. The
Crop Service will be automatically used for all images except for those from the original Object Store,
which will still be handled by the Crop Taool.

The Crop Tool alows cropping of images from Object Store. The Crop Tool islegacy and may be
deprecated in future versions of Viz Pilot. Object Store and the Crop Tool are not supported when using a
Graphic Hub Database.

This section contains the following topics:

® Features of Crop Service and Crop Tool
® Setting up Crop Service and Crop Tool
® Using Crop Service

® Using Crop Tool

12.1 Comparison of Crop Tool and Crop Service

Feature Crop Tool Crop Service
Supportsimages from Viz One No Yes
Supports images from No Yes
RestVOS

Supportsimages from (legacy) Yes No
Object Store

Images are saved as PNG Yes Yes
Will re-size the image to Yes Yes(*)
template and image properties

Will keep the aspect of the Yes Yes
cropped area

Needs a shared drive/lUNC Yes No
path for storing stills

Can paste images directly from Yes No

the clipboard into a template

Canrotate sourceimages90  Yes No
degreesin both directions

Black will be used asfillingto No No

be able to use the whole image

width or height
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Feature Crop Tool Crop Service

Re-crop of imagesispossible No No
(asimage sourceislinked in)

Note: (*) Where destHeight and destWidth are defined in the template then, in most cases, Crop
Service will resize the image to match these properties. If the selection is smaller than destHeight or
destWidth then awarning is shown, but the selection may still be used. Note that if

destWidth* destHeight < 10,000 pixels 2, then the image is not resized, but the selection may still be
used.

All edited images from both Crop Tool and Crop Service are saved as Portable Network Graphics (PNG)
images, and saved with the same image and person information as the original image, if that exists. The
new fileis given adefault prefix crop_paste<random characters>_. Images with apha or key values are
preserved.

Crop Service caches cropped images on file on the Pilot Data Server, aswell as on the Viz Engine.

Crop Tool saves the cropped image to the VOS-Hile-share, and from there it is handled the same as any
other VOS image.

12.2 Setting up Crop Service and Crop Tool

Some configuration is required in order to make use of the Crop Tool or Crop Service.

12.2.1 To configure the Crop Service

"Note: Before configuring the Crop Service, a Pilot Data Server must be installed, configured and
running (one per separate schema used in the Viz Pilot Database). See To install the Pilot Data Server

and To install the Crop Service.

1. If Crop Service and Pilot Data Server are installed on different machines, see how To configure
the connection from Crop Service to Pilot Data Server.
2. If performing Viz One searches from Viz Pilot News, see To configure search providers (Viz One)

3. If performing RestV OS searches from Viz Pilot News, see To configure search providers
(RestVOS).

4. Configurethe Viz Pilot system to use the Crop Service. See To set the VCP Parameters for the
Crop Service.

12.2.2 To configure the connection from Crop Service to Pilot Data Server

Note: When Crop Service isinstalled on the same machine as Pilot Data Server, the steps below are
not required because Crop Service is configured this way by default.

If Crop Serviceisinstalled on a different machine than Pilot Data Server, configure the connection to Pilot
Data Server asfollows:
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1. InWindows, open the Services dialogue and stop Crop Service.

2. Open the Crop Service configuration file. This must be done "As Administrator"”.
For example, run Notepad (as administrator), and in Notepad open the config file:
c:\Program Files\Vizrt\Crop Service\CropServiceHost.exe.config

3. Inthe configfile, find the following section:

<user Setti ngs>
<CropServi ceHost . Properties. Settings>
<setting nane="Pil ot DataServerUri" serializeAs="String":
<val ue/ >
</setting>
</ CropServi ceHost. Properties. Settings>
</ user Settings>

4. Replace<val ue/ > with
<val ue>http:// YOUR - PDS\ - HOST\ - HERE: 8177</ val ue>
and save your changes.
5. Start Crop Service.
6. Verify that the configuration is correct by viewing the log file at
c:\ProgramData\Vizrt\L ogs\CropService\cropservice.log
If you see an error similar to:
_ERROR: Failed to get payload from: http://localhost:8177/vcp/parameters, Error: Unable to
connect to the remote server _
the configuration isincorrect, and you need to repesat steps 1-6.

12.2.3 To configure the Crop Tool

® Set the desired Crop Tool Save Path in General Preferences.

12.2.4 To enable image cropping in atemplate (Crop Tool and Crop Service)

1. Start Template Wizard.
2. Open atemplate with an image component.
3. Select the image component and set one or both of the following properties:
® AlwaysUseCropTool: Enablesthe user to always use the crop tool/service when an imageis
added to the template.
® DestHeight and DestWidth: When set to values greater than O (zero), it will enable the crop
tool/service. The parameters set a fixed height and width for the cropped image. Using this
setting will force the user to use the configured height and width, and the aspect. Meaning, if
the selection is greater than the actual height and width parameters, the image will be scaled
to fit, allowing the user to select a greater area, and conversely.
4. Select one or more image sources:
® |mageSources: Valid sources for the crop tool are islmageMediaSearch, isFileOpen and
isPaste.
5. Savethetemplate.
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"Note! T Use'an Tmage from the clipboard With ' Viz Oné or REstVOS, and Crop Service, the
image must first be ingested into Viz One or RestV OS, and then used in Crop Service.

12.3 Using Crop Service

952 x 952

12.3.1 Crop Service Functions

The Crop Serviceisdivided into two areas; a menu bar, and an edit area.

The menu bar contains the following functions:

® Preview: Opens apreview window to display the selected crop.

® Target Ratio: Select aratio from the drop-down list and then select a crop in the edit area. (Manual
ratio, Original ratio, 4:3, 169, 1:1).

® Selection Size: Displays the pixel dimensions of the selected crop.

® OK: Usethe selected crop.

® Cancd: Resets editing and closes the Crop Service window.

The edit area allows the following functions:

® Drag the anchored frame to move the selected crop area.
® Resize the anchored frame to change the selected crop area.

356



12.3.2 To crop an image with Crop Service

1. If AlwaysUseCropTool or DestHeight and * DestWidth * are set in the template, then Crop
Service will open automatically when an image is dragged to the image placehol der.
2. Select the desired area
® Optional: Click Preview to preview the selection
3. Click OK to confirm the selection

Tip: The maximum size of the images created by the Crop Service can be configured. Any
crop that is bigger than this limit will be resized, respecting the aspect ratio of the crop. If the
DestHeigth or DestWidth properties on the image component are used, then the smaller
constraint will be used (see Crop and Scale Image). Maximum size applies even if no
cropping is done. For more information see how To set the VCP Parameters for the Crop
Service or how to set Viz Pilot Database Parameters.

12.4 Using Crop Tool

| %) Crop Image Qﬂ

=] B 2] [C] quen-

Save Cancel Left20° Right90®

Size: 637x478 Zoom: 64.84 Selection: 425x324

This section contains the following topics:

® Images

® Crop Tool Functions

® To crop an image with Crop Tool

® To use an image from the clipboard
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12.4.1 Images

Depending on the design of the template, the Crop Tool can make use of images from Object Store, any
local computer file location, or the Windows Clipboard.

Note: A cropped image can only be used once, that is, a user cannot re-crop or search for an already
cropped image. To create a new cropped image, the user must find the original image and add it to the
Windows Clipboard again.

A crop tool isaso used in Object Store; however, when used within Viz Pilot News, images are not saved
to the Object Store database. Hence, even if an image from Object Storeis used, the original imagein
Object Store will not be affected.

Note: Crop Tool images differ from Object Store and Viz Oneimagesin that it is not possible to fully
control what images are used, hence policies on using such things as copyrighted images must be
clear.

12.4.2 Crop Tool Functions

The Crop Tool isdivided in three areas; amenu bar, an edit area (Ieft), and a preview area (right).

H ﬁ \D Cﬂ' I::lz::uzum v

Save Cancel Left90°  Right 90

The menu bar contains the following functions:

® Save: Savestheimage to the image directory set in the crop tool save path.

® Cancd: Resets editing and closes the Crop Tool window.

® | eft 90: Rotates the image 90 degrees to the left.

® Right 90: Rotates the image 90 degrees to the right.

® Zoom: Zoom the editable version of the image to asize of; 500%, 200%, 150%, 100%, 75%, 50%,
25% and 10% of the original image size. In addition there is an option to Fit the image to the
available space. Zoom can also be performed by using the mouse wheel. Zoom does not resize the
saved image.

12.4.3 To crop an image with Crop Tool

Open atemplate or adata element.

Click the image placeholder.

Search for a stored image.

Drag the image to the placehol der.

Adjust the anchored frame and/or rotation of the image, and click the Save (CTRL+S) button on
the tool bar.

o rcwbNeE
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12.4.4 To use an image from the clipboard

Clear

Paste...

&7

Open atemplate or a data el ement.

Search for and copy an image (e.g. web-based systems or file shares).

Right-click the image icon and select Paste.

Adjust the anchored frame and/or rotation of the image, and click the Save (CTRL+S) button on
the tool bar.

AwWwDdPRE

See Also

® General Preferences preferences - Crop Tool Save Path
® Enable Fullscreen Stillstore Images

® Object Store Crop Tool

® Sceneand Template Design

12.4.5 Images Edited with Crop Tool
All edited images are saved as Portable Network Graphics (PNG), which is a bit-mapped image format

that employs lossless data compression.

An edited image is saved with the same image and person information as the original image. The new file
isgiven adefault prefix “Crop” . The image Description field is also updated by adding the following text:
“_Crop of: Description” where the phrase Description represents the image description from the origina
image. Images with key is also preserved.

12.4.6 Scene and Template Design

Calling Crop Tool from a Template

A scene can be designed to use an image of a specific aspect ratio. Thisis donein Template Wizard, by
using the Image Component and its parameters DestWidth and DestHeight to set the width and height.

If an image is selected which does not match the parameters, the Crop Tool will be automatically opened,
forcing the user to edit the image according to the pre-configured parameters.
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Crop and Scale Image

If the crop uses the DestWidth/Height ratio, the cropped image will be rescaled to fit the DestWidth
/Height values.

T

Example - Setting Image Size
For example, if the template designer has set the DestWidth and DestHeight to 200 x 100 pixels (aspect 2:
1) to set the aspect ratio and image size, and we have an original image of 2000 x 1500 pixels (4:3),
then:

® |f thetemplate user selects an area of 1250 x 625 pixels (2:1), the image will be cropped and scaled

down to 200 x 100 pixels.

* |f the template user selects an area of 200 x 100 pixels (2:1), the image will be cropped to 200 x 100
pixels.

* |f the template user selects an area of 100 x 50 pixels (2:1), the image will be cropped and scaled up
to 200 x 100 pixels.

Note: In this case awarning isissued, but the image can still be used. The image will be scaled
up and may look pixelated on air.

Example - Setting Aspect Ratio
If the DestWidth x _DestHeight _result in a value less than 10000, then the Crop Tool will use the aspect
ration of the width/height vales, but the image will not be resized.

For example, atemplate designer may set the DestWidth and DestHeight to 16 and 9 to for ce an aspect
ratio of 16:9. Instead of resizing the cropped image to a size of 16x9 pixels, it will use the size of the
selection. For example, if we have the original image of 2000 x 1500 pixels, then:
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® |f the template user selects an area of 800 x 450 pixels (16:9), the image will be cropped to 800 x 450
pixels. No resizing will occur.
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13 Pilot Data Server

The Pilot Data Server acts as an application server for accessing Viz Pilot’ s database and other services.
The Pilot Data Server must be installed in order to use features such as Crop Service, Template Tagging,
Update Service, Person Search, search on Viz One, Thumbnail Generator and Timeline Editor. It isaso
necessary when using Graphic Hub as the Viz Pilot database, or for integrating with Viz Story.

This section contains the following topics:

® Pilot Data Server Use Cases

® Pilot Data Server Configuration

® Pilot Data Server Log File

® Pilot Data Server Web Interface

® Setting Parameters using Pilot Data Server
® RestVOS

® Change Natifications

See Also

® Working with Viz One
® Thumbnail Generator

13.1 Pilot Data Server Use Cases

A Viz Pilot system has the following use cases for using the Pilot Data Server:

® Using the Timeline Editor.

® Using the Update Service (see Update Script Editor).

® Searching for and using images and videos from Viz One.

® Using the person search from the Mediatab.

® Adding and updating Tag Settings. Tags are assigned to templatesin Template Wizard, and then
used in Viz Pilot News to organize templates.

® Using the Crop Service (see Using Crop Service).

® Using the Pilot Data Server’'s REST API to alow third party systems to read and fill templates and
data el ements from the Viz Pilot database.

® Configuring Order Management.

® The PFilot Data Server exposes all the data needed by the Media Sequencer through its REST
interface. It also provides Change Notifications using the Stomp protocoal. It is possible to configure
the Media Sequencer to connect to the Pilot Data Server instead of the Pilot database. (Requires
Media Sequencer 4.0 or later).

13.2 Pilot Data Server Configuration

This section describes the configuration of the Pilot Data Server.
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See Also

® Pilot Data Server Instalation
® Change Notifications

13.2.1 Connection to Viz Pilot Database

The Pilot Data Server requires a connection to a Viz Pilot database with a schema of 5.7 or later. You also
need a Pilot Data Server for each database instance, meaning you cannot share a Pilot Data Server.
Configure using afull connection string with hosthame and SID.

13.2.2 To setup the Pilot Data Server user account

The Pilot Data Server service can be run from two different user accounts, depending on where it will
access files.

If the Pilot Data Server is used without any Object Store storage, or if the Object Store storage is on the
same computer as the Pilot Data Server, then set up as follows:

1. Runthe Pilot Data Server service under the default L ocal System Account.
Alternatively, if the Pilot Data Server requires access to remote files, and the computersarein a
domain, then set up asfollows:

1. Create anew Domain User Account. This needsto have:
® Administrator access to the computer that runs the Pilot Data Server,
® Share access on the computer that hosts the Object Store files,
® File system access to the actual filesin the share.
2. Change the service configuration to run the service as the Domain User.
3. Set acomplex password for this user, and set it to never expire. If the password expires, the
service needs to be reconfigured to run with the new password.
4. Runthe Pilot Data Server service under the new Domain User Account.

Note: The scenario where the Pilot Data Server requires access to remote files, but the
computers are not in adomain, is not supported.

13.2.3 To configure the Script Runner

Update Services are mechanisms that allow template data to be updated right before going on air, e.g.
stock values, player statistics etc. Viz Pilot’ s update service is called Script Runner.

‘Note: A customer can write Visual Basic scripts to modify the data, and these will run on the Script
Runner. Or the customer can create their own external update service. For more information see

“Externa Update Service” in the Media Sequencer Manual .

The Script Runner will use port 1981 by default. To change this, do the following:
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1. Onthe Pilot Data Server machine, open the configuration file in atext editor:
. ® UPrograntil es%vizrt\Data
Server\ Pi | ot Scri pt Runner Host Servi ce. exe. config
2. Change the port by modifying the following line:

<add baseAddress="http://Iocal host: 1981" />

3. Savethefile
4. Restart the service Vizrt Script Runner from the Windows Services window.

13.2.4 To configure the Pilot Data Server for Safe mode

If Safe modeis enabled, all endpoints of the Pilot Data Server can be accessed using the HTTPS protocol.
To enableit, do the following:

1. Open the configuration file in atext editor:
e o ® c:\Program Files\vizrt\Pilot Data
Server\ Pi | ot AppSer ver Host Servi ce. exe. confi g

2. Change the following:
<setting nane="SecurePort" serializeAs="String">

<val ue/ >
</setting>

with:

<setting nane="SecurePort" serializeAs="String">
<val ue>7373</ val ue>
</setting>

The port 7373 is used as an example value only.

13.2.5 To modify the Pilot Data Server database settings

1. Runtheinstaller, and select the Change option.
2. Update the database connection information:
® Connect string, Username and Password.
3. Click Close.
4. Restart the service Vizrt Pilot Data Server from the Windows Services window

IMPORTANT! If database settings are changed in the configuration files manually, any
subsequent changes done through the installer will overwrite the manual changes. It is
strongly recommended that users do not manually change anything related to the database in
the configuration file.
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13.2.6 Redundancy and Failover for Pilot Data Server

Pilot Data Server has been designed without built-in redundancy, however it does support being used with
off-the-shelf third party HTTP load balancers.

Example: The Barracuda |load balancer has been successfully used in front of the Pilot Data Server. See
https.//www.barracuda.com/products/l oadbal ancer

13.3 Pilot Data Server Log File

The Script Runner and Pilot Data Server services log warnings and errors to the Windows Application
Event Log.

The full path of the Pilot Data Server log fileis:

® c:\ProgranData\Vizrt\Logs\Pil ot Dat aServer\server.| og

The full path of the Script Runner log fileis:

® c:\ProgranData\Vizrt\Logs\ScriptRunner\scriptrunner.|og

13.4 Pilot Data Server Web Interface

The Pilot Data Server has a Web Interface which can be used to access several of the Pilot Data Server’'s
features, including the Service Document, Template and Data Element Feeds, Viz Pilot Settings and
REST API documentation.
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13.4.1 To access the Pilot Data Server Web Interface

® Select the Pilot Data Server Web I nterface from the Windows Start Menu.

¢ Alternatively, start the Pilot Data Server in abrowser, using the host name of the machine running
the Pilot Data Server, and port 8177.
eg. http://dataserver. exanpl e: 8177

The Pilot Data Server Home page has links to the following resources:

® Service

® Template Feed

® DataElement Feed
® Settings

® Examples

® Documentation

13.4.2 Service
The Service Document resource (eg. ht t p: / / <dat aser ver. exanpl e>: 8177/ servi ce)isan
Atom Service Document which can be used by aclient to discover the capabilities of a Pilot Data Server
and the locations of the available Atom Publishing Protocol collections hosted on it.

13.4.3 Template Feed

The Template Feed resource (eg. ht t p: / / <dat aser ver. exanpl e>: 8177/ t enpl at es) isan
atom feed which contains entries for each template stored in the Pilot Data Server.
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Metadata may include details of the template such as description, creation date, link to athumbnail image
and link to the Viz Data Format (VDF) model document describing the template.
13.4.4 Data Element Feed

The Data Element Feed resource (eg. ht t p: / / <dat aser ver. exanpl e>: 8177/ dat ael enent s)
isan atom feed which contains entries for each data element stored in the Pilot Data Server.

Metadata may include details of the data element such as description, creation date, link to thumbnails and
link to the Viz Data Format (V DF) payload document describing the data el ement.

13.4.5 Settings

The Settingspage (eg. ht t p: / / <dat aser ver . exanpl e>: 8177/ set ti ngs) isused to configure
V CP Parameters and Tag Settings. See Setting Parameters using Pilot Data Server for afull description of

the Settings tab.

13.4.6 Examples
The Examples page (eg. ht t p: / / <dat aser ver . exanpl e>: 8177/ exanpl es) contains examples
on how to interact with the Viz Pilot system.

13.4.7 Documentation

The Pilot Data Server Documentation page (eg. ht t p: / / <dat aser ver . exanpl e>: 8177/ hel p)
describesthe REST API provided by the Pilot Data Server. It includes information on the Resource Types
and Content Types that are used in the interface.

The API itself has several features, for example, getting template information, image search and person
search. It provides a programming interface for other systems.

13.5 Setting Parameters using Pilot Data Server

The Settings tab is used to configure the following values:
* Database Parameters
* Search Providers

* Tag Settings

'Note: Google Chrome is phasing out support for NPAPI plugins, which means the Pilot Data Server
configuration page might not work in your version since it requires Silverlight. We recommended
using Internet Explorer if you run into thisissue.
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13.5.1 Database Parameters

[VCP parameters Search Providers Tag settings

leset A Filter:

MName Valus | Description

If turned on, the Mewsroom Compeonent will not fetch
ax_dont_fetch_thumbnails thumbnzils for the templates and data elements when in
list wiew made, only if in "show icons" view.

Enables the "Add to Rundown" option in the media

ax_enablaMediaSendToRundown
search.

Show the refresh button in the ActiveX external praview
ax_enabla_refresh_button form. Will refresh the preview without resending the data
to the preview server

In the VCP Parameters tab the user can configure settings for the Viz Pilot system’ s applications. A
description of useful database parametersislisted here.

This section contains the following topics:

® To give applications access to the Pilot Data Server
® To give applications access to the Preview Server

® To give applications access to the Update Service

® To set the Database Parameters for the Crop Service
® To enablethe built-in Object Store search

® To configure Order Management

To give applications access to the Pilot Data Server

1. Seehow To access the Pilot Data Server Web Interface

2. Click the Settingslink

3. Select the app_server setting, and add the parameter for the machine you installed the Pilot Data
Server on (i.e. <DataServer>:8177)

4. Click Save

® Thiswill give al applications with a connection to the database access to the Pilot Data Server.

To give applications access to the Preview Server

1. Seehow To access the Pilot Data Server Web Interface
2. Click the Settingslink
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3. Select the preview_server _uri setting, and add the parameter for the machine you installed the
Preview Server on (i.e. http://<hostname>:54000)

* This machine, with Viz Engine and Preview Server installed, istypically identified as your frame
server.
4. Click Save

® Thiswill give all applications with a connection to the database access to the Preview Server.
To give applications access to the Update Service

1. Seehow To access the Pilot Data Server Web Interface

2. Click the Settingslink

3. Select the script_runner_uri setting, and add the parameter for the machine running the Update
Service (e.g. http://<hostname>:1981)

* This setting is needed if templates run scripts that use the update service
4. Click Save

® Thiswill giveall applications with a connection to the database access to Script Runner.

IMPORTANT! If you change the script_runner_uri parameter (after setting it the first time) you need
to restart the Media Sequencer for it to take effect.

To set the Database Parameters for the Crop Service

1. See how To access the Pilot Data Server Web Interface

Click the Settings link

3. Select thecrop_service uri setting, and add the parameter for the machine you installed the Pilot
Data Server on:

N

* http://<cr opservicehostname>:8178 /

4. Optional: Set the MediaSearch_|temPer Page = Number of items per page to get from
MediaSearch.

5. Optional: Set the croptool_max_image area to adjust the maximum size of a cropped image that
will be served by the Pilot Data Server.
If the image size (*) is larger than croptool_max_image_area, then the image will be resized,
while still respecting the aspect ratio of the crop. The maximum image size applies even if no
cropping is done.
* |mage size = image width x height in pixels.

6. Click Save

To enable the built-in Object Store search
The built-in Object Store search is turned off by default. To enable or disableit:

1. Seehow To access the Pilot Data Server Web Interface
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2. Click the Settingslink
3. Select thedisable built_in_vos search setting,

* To use built-in Object Store search, set disable _built_in vos searchto false
* To use RestVOS search, set disable built_in_vos search to true
4. Click Save

To configure Order Management

This procedure assumes that you have a Viz One system installed and running the Order Management
system. For more information on how to configure order management on Viz One, see the section on
‘Tasks and Order Management’ in the Viz One Administrator’s Guide.

1. Seehow To access the Pilot Data Server Web Interface

2. Click the Settingslink

3. Select theorder_mgt_uri_template setting, and add the address of the Viz One machinewhichis
hosting the order management system, eg:
http://<fully-qualified-domai n-name-of -viz-one>:8084/tasks/ 2user={ user}
&locale=en_US& theme=light#create;tl=work_order;form=create wo_activex;asset-type=ITEM;
upl oad=true;external-hooks=viznewsroom;closewin=fal se;set-attr=REQ_TY PE-{ asset_type}

13.5.2 Search Providers

VCP parameters Search Providers Tag settings

Asset search providers

Active Service Document URL Short name Description (fetched from server) Errors
http://demo-gh2:19398 GH
http://bgodocengine1:8177/service PDS

http://bgogavizonel/thirdparty Wiz One

| Add || Delete]

Pre-authenticated hosts

Host URL UserMName Password
http://bgogavizonel admin admin
http:/fdemo-gh2:19398 Admin WizDb

| Add || Delete]

Both Director and Viz Pilot News get their Viz One connection parameters from the Viz Pilot database.
The Media Sequencer must be configured using your control application.
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Asset search providers can set to active or inactive. Disabling a search provider means that it will not be
used when searching for assetsin atemplate.

This section contains the following topics:

® To configure search providers (Viz One)
® To configure search providers (RestV OS)
® Authentication for Feed Browser

To configure search providers (Viz One)

See how To access the Pilot Data Server Web Interface

Click the Settings link

Click the Search Providerslink

Under Asset sear ch providers click the Add button and enter the host’ s service document URL

pwWDNPRE

* For Viz One 5.4 and later: https://<viz_one>/thirdparty/
* For Viz One 5.3: https://<viz_one>/api/

Note: Make sure you enter the correct protocol. For example, if aViz Oneis set up on httpsit
will require an https URL.

5. Add a Short nameto help identify the asset’ s location, for example in search results.

* eg. VizOne

Note: If you change the short name you need to restart the server for the changes to take effect
(see To modify the Pilot Data Server database settings).

The image below shows the Search Provider Short Name as displayed in search results:

birds.jpg

@@E@ WizOne

6. Under Pre-authenticated hosts click the Add button and enter the host’s URL, username and
password in order to authenticate your search

* URL of the hogt, e.g.: https://<viz_one>/

» Username and password of the pre-configured user on the Viz One system (configured in the
Studio admin web interface)

» Thisisrequired for Viz One (not Object Store)
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WARNING! The username and password used here are available in clear text to anyone who
has access to the Settings page. The Viz One user entered here should therefore be given as
few rights on the Viz One as possible.

7. Click Save

To configure search providers (RestV OS)

By default, Viz Pilot 6.0 and later uses the RestV OS search, and a search provider representing the current
Pilot Data Server is configured automatically. This requires that the correct value (i.e. a public name that
points to the current Pilot Data Server) has been stored in the app_server parameter in the database
parameters. Changes to this value are picked up during restarts.

The auto-added search provider can be renamed or made active/inactive on the Search Providers page.
The uri cannot be changed.

Note: Upgrading from Viz Pilot 5.7 to Viz Pilot 6.0 can result in two search providers with the same
URL (i.e. the one that existed before and the new one). The new one is disabled so it will not interfere,
but if you want to clean up the list you can delete the old one and activate the new one.

Authentication for Feed Browser

The Pre-authenticated hosts configured in the Pilot Data Server also apply to the Feed Browser when
hosted in a Viz Pilot system application (see Feed Browser Authentication ).

13.5.3 Tag Settings
VCP parameters Search Providers [Tag settings)
© Add tag

Tag Number of templates Modified Rename Delete
L3 0 06/11/2013 11:27:53 & i
CLOCK 4 20/06/2014 12:02:13 & i
0TS 5 06/11/201311:27:53  # m
Showing 1 to 3 of 3 entries

The Tag Settings page is used for administering tags. The tags are assigned to templatesin Template
Wizard, and then used in Viz Pilot News to organize templates.
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To access the Tag settings

1. Seehow To access the Pilot Data Server Web Interface
2. Click the Settings link
3. Click the Tag settings link

13.5.4 Tag Settings functions

Function Description

Add tag Click the Add Tag button and enter a name for the new tag.

Click the Rename icon to rename the selected tag

Click the Delete icon to delete the selected tag.

Note: Deleting atag will not delete the templates that refer to that tag.

13.6 RestVOS

13.6.1 RestVOS versus conventional VOS (Viz Object Store) access

The fundamental difference isthe protocol used to search for images and deliver the results to the client.

When accessing an Object Store in the conventional way, the client application goes directly to the
database and the network share in order to get the data.

When using RestV OS, the client accesses the same images and storage, but viathe Pilot Data Server. This
uses the HTTP protocol, the same protocol that is used when talking to Viz One systems.

From the point of view of the client applications, accessing RestVOS is no different to accessing aViz
One or any other “asset search provider”.

The existing Object Store application is used to manage the images and storage, whether using standard
VOS or RestVOS.

13.6.2 Advantages of RestVOS

® Flexibility: HTTPisan easier protocol to use and manage. By using the Pilot Data Server and the
OpenSearch protocol, other applications can also do the same searches, and there is no need to make
the network share available on all clients.

® Extended features: Some features such as Crop Service (see Using Crop Service) and Filter Media by
Person Name, are only available when using RestV OS.

® Future: Asdevelopment on RestV OS continues, features such as load balancing and failover
capabilities will be added, which will benefit image transfers. Once direct database access from Viz
Pilot Newsis no longer required, management of Oracle clients will not be needed. Conventional
access to VOS will be phased out at some stage.

See Also
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® Save Pathsin VOS and RestVOS

13.7 Change Notifications

Change notifications are available through the REST API and the STOMP protocol on the Pilot Data
Server.

13.7.1 REST API

List of database changes ordered from most recent to least recent.

® |ocatedathttp://pdshost: 8177/ changel og
® Parameters:
® startld: ThelD of theleast recent change, or -1 for no limit. Default is -1.
® | ast Knownl d: The ID of the most recent change, or -1 for no limit. Default is -1.

13.7.2 STOMP API

InaViz Pilot system, the text based message protocol STOMP (Streaming Text Oriented Messaging
Protocol) is used to subscribe to change natifications from Graphic Hub REST and Pilot Data Server. It
provides push notifications of new changes.

® | ocated at:
stonp: // pdshost: 9876/ ?dest i nati on=/ changel og& ast Knownl d=-1
® Parameters:
® | ast Knownl d: Mandatory, should be the ID in the STOMP link that is provided by the REST
API.
For example, when the data stored in the Pilot database changes, a message is delivered to all of
the STOMP clients that are subscribed to the server.

13.8 Proxy Support

The Pilot Data Server can be installed along with a proxy/reverse-proxy server.

The proxy server must populate the following headers in order for the Pilot Data Server to serve the
appropriate hostname, port and protocol in its responses:

¢ X- Forwar ded- Host

¢ X- Forwar ded- Port

® X-Forwarded-Proto
Use a proxy server with the above-mentioned headers configured. If the X- For war ded headers are
not configured in the proxy server, then the proxy server must be configured to pass the Host
header it received from the client to the Pilot Data Server.
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13.8.1 URL Path Prefix Support in Pilot Data Server

The purpose of a URL path prefix isto be able to host a Pilot Data Server with a different hosting URL
than the default one. One use case isto make the Pilot Data Server able to work under a reverse-proxy
server.

Toinstall aPilot Data Server with a prefix, theinstaller has to be executed in the following manner:
C.\>nsiexec /i c:\tenp\PilotDataServerlnstaller-x64.nmsi CONNECTI ON_METH

Here the prefix is pds which is specified by the BASE_PATH switch.
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14 Object Store

B Object Store - Database: VIZ-xwd300/DOC - Videohuk: bgovh

= | B

a =l [g]

2] & [ 0 @

| Preview MNew MNew Crop  Cancel Settings Import  Export Help About _
Still Search | Person Search Image Information | Person Information
|merke|
[ use advanced image search Directory | |
Keyword: .
| Filename | |
Key-Filename | |
3 hits - File date | |
5 :
; Image size | |
Person |Angela Dorothea Merkel =
| sEeEEE ABORTION «| 12| [PoLITICS
i e ’ ABUSE —
1045969_o.ipg ACADEMIES ==
: ACCIDENTS <
>: ACCIDENTS AT SEA
ACCIDENTS AT WO ~| =2
Source AF
Description German Chancellor Angela Merkel, left, and
_ former South African President Nelson Mandela
980784_k.jpg react as they arrive for a photo call at the
MNelson Mandela Foundation building in
Country South Africa -

Object Storeisatool to add, edit and search for still images (stills), person information and videos from a
database. By letting you organize your own media library by adding custom meta data fields, Object Store
aso helps you customize your workflow, and help you create your stories fast and efficiently.

Note: Object Store was previously known as Viz Object Store, so the acronym VOSis still inusein

some places.

This section contains the following topics:

® Getting Started with Object Store
® Object Store Workflow

® Object Store Configuration

® Object Store Settings

® Object Store Toolbar

® Object Store Search Options

® Object Store Information Panels
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® Object Store Status Bar
® Object Store Crop Tool
® Object Store Export and Import

14.1 Getting Started with Object Store

Object Storeisinstalled using the Viz Pilot system installer (see Viz Pilot System Installation). Object
Store is dependent on arunning Viz Pilot database, an image file share and/or aViz One for access to
content.

14.1.1 Starting

Object Storeitself is a standal one application that can be started from the program menu or a desktop
shortcut.

1. Open the program from the Windows Start Menu (Object Store), or the desktop icon.

CIE BEX)

L] (2] (B [2) X
Start

Back Load Continue TakeOut Save | Cloge

Concept: [Deme | ~|| Variant: [Deiau ~|

Headline pua8l=l{ist
Subtext g UniEdit2

ST TTWUNIE ditd

Name [TTWUNIEdit3

Object Storeis also accessible through Director, Viz Trio, Template Wizard, Viz Pilot News and
others. The integrations only allow for searching the Viz Pilot database (in addition to Viz One).

14.2 Object Store Workflow

The basic workflow from graphics design to template and content creation is as follows:
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® A graphicssceneiscreated in Viz Artist.

® A template, based on a scene, is created in Template Wizard.

® A story istypically created in a newsroom system where atemplate is used to open Object Store for
adding stills, person information, audio and video.
The story is placed in aplaylist which in turn isread and played out by a control application such as
Director or Viz Trio.

14.3 Object Store Configuration

Configuration parameters are set after installation (see Initialization Files and Save Paths).

14.3.1 Object Store Initialization File

Object Store depends on an initialization file to read and connect to its database. On installation, Object
Store will use the ContentPilot.ini. However, Object Store also supportsusing obj ect st ore. i ni . If
you use a separate initialization file for Object Store you only need to add the database settings.

IMPORTANT! If Director is started with the - i ni fi | e command line option, then valuesin
obj ectstore.ini areoveridden by Cont ent Pi | ot . i ni . Director will not read Object Store
connection datafrom obj ect st ore. i ni .

14.3.2 Parameters

® |ogin - User ID for the database connection

® pwd - Password for the database connection

® utf8- Setswhether the program and database should use UTF8 font encoding.

® nis lang - If UTF-8isused for the database, the NLS_LANG environment setting must be here.

® name - Thisentry must contain the connection string for the database in the form: “hostname
/instance name”. If adatabase client (e.g. Oracle Client) is used enter the TNS name.

14.3.3 Configuration

Object Store configuration is simple. Using the Initialization File Editor, make sure that the Database
Parameters in the Object Store Initialization File are according to your preferences. Next, configure the
Save Paths.

See Also

® Configuration
® [nitialization Files

14.4 Object Store Settings

To access the Settings window, click the Settings button on the Object Store Toolbar.

The Settings window consists of six tabs:

® Genera
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* Keywords

¢ Additional Fields
® Save Paths

® Organizations

® Countries

14.4.1 General

The General settings tab contains the Object Store environment variables. For example the ability to
enable and disable the different search options.

To access the General tab, click the Settings button on the Object Store Toolbar.
14.4.2

14.4.3 General Settings

® Mouseclick options: Select to use single or double-clicks when opening an image or person in the
information panels. By default these are set to double-click.
® Start-up options: Switch on or off search and information options, Start Object Store maximized
and select a Default start tab. The options are:
® Show standard search and information.
® Show person search and information.
® Start Object Store maximized.
® Default start tab: Sets one of the search options as defaullt.
® Show long description field: The Image information panel contains two description fields;
Description and Long description. Select this check box to show the Long description field.
® Useautopagesizeor set it here: Check thisoption to if Object Store should automatically adjust
the number of hits displayed, or set the number of hits a search will show per page. If the number of
hits exceed the page size, Object Store creates new pages.
® Set Password: Click the Set Password... button to change the Object Store password. A dialog box
appears asking for the current password. Enter and confirm the new password and click the Apply
button or Cancel to dismiss any changes. See also Password and Access Control.

Password and Access Control

If apassword has been set for restricting access to the settings (that are saved to the Viz Pilot database), an
access control dialog box will appear asking for avalid password. Restrictions apply to all settings except
General settings which allow users to customize the appearance of the Object Store client.

Note that access control is by default disabled; however, it can be enabled by setting a password. The
same dialog is used to change the password, but not to disable it which is done from Director’s Preferences
window.

To enable access control

1. Start the Object Store client.
2. Click the Settings button on the toolbar to open the Settings window.
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3. Click the Set Password... button under the General tab to open the Change password dialog.
4. Enter the new password, confirm it, and click Apply.

To disable access control

1. Goto the Pilot Data Server Web Interface

2. Click the Settings tab

3. Click the VCP Parameters tab

4. Selectthe VOS PASSWORD and delete the encrypted password in the Vaue column.

Caution: The VCP Parameters tab displays different database settings related to different Viz
Pilot system applications. All changes are effective once they are applied.

14.4.4 Keywords, Additional Fields, Organizations and Countries

Settings &

General Keywords Additional Fields Sawve Paths Organizations Countries

Available keywords —Keyword
¥ MOUNTAIN CLIMBING « |||New Entryi |
[v] MOUNTAINS

[¥] MUNICIPAL Add

|v| MURDER ATTEMPT
[ MUSEUMS Renarme
¥l MusIC
[ MUSIC FESTIVALS Deleta
MNARCOTICS / DRUGS
[ MATIONAL BUDGET
[ MATIONAL CONGRESS Delete unused
[¥] MATIONAL INSURAMNCE

[ MATIONAL SUMMARIES

[+ MATO

[ MATURAL SCIENCE

5| MATURE

[ MATURISM

[v] MAVY

[ MAZISM >

(] show only active keywords in search

oK Cancel

The Keywords, Additional Fields and Organizations settings al have similar functions. To access these
tabs, click the Settings button on the Object Store Toolbar.

Actions

¢ Add: Addsanew entry. If an entry already exists the Add button is automatically disabled.

® Rename: Renames the selected entry. If an entry already exists, the Rename button is automatically
disabled.

® Delete: Deletes the selected entry.
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Note: Note that deleting an entry will removeit from thelist, aswell as all still images using it.

Keywords

Keywords are used to categorize images. Object Store provides a default set of categories, but new ones
can be added and old ones deleted and renamed. Images or persons registered with keywords that are
deleted will lose the keyword. Images or persons with keywords that are renamed will get the renamed

keyword.

¥ WORLD CHAMPIONSHIP WORLD CHAMPIOMNSHIP

Available keywords for new image registrations can be selected. Disabled keywords can still be used in
searches. To disallow disabled keywords from searches, select the “ Show only active keywords in search”
option.

Additional Fields

In addition to the default set of information fields provided, users often need additional customizable
fields. To add new fields click the Settings button on the toolbar and select the Additiona fields tab.

v Weight Weight

Available additional fields for new image registrations must be checked. Disabled additional fields are not
available for new registrations, but are still available as search options.
When importing images from other Object Store databases, users may experience that field names are
different from one Object Store installation to another. To overcome this issue Object Store adds new field
names according to the XML file used when importing images. By default al new field names are enabled
in the Image information panel.

Organizations

Organizations are used as part of Person information to describe what kind of organization a personis
linked to. Add new organizations by using this setting.

v UNITED NATIONS UNITED NATIOMNS

Checked organizations are available when registering new persons. Unchecked organizations are not
available for new registrations, but are still visible as search options.
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Person information showing organizations that are not available for new registrations, will lose the

registered organization when the Person information is edited and saved. Until then the organization
information is visible to the user.

Countries

Countries are used as part of Image information to set the country in which the image was taken. Add,
rename and del ete countries by using this setting.

Morthern Mariana Islands
INOrw Ay
2man

All countries are available at all times. Countries that should not be shown as part of the list must be
deleted.

14.4.5 Save Paths

Settings ﬁ

General Keywords Additional Fields | Save Paths |Organizations

Countries

Available save paths
¥\ \exampleservershare\foldername,

132

I'\\Lexampleser'.rer'kshare‘-lfclIdemame IJ Add | Delete I Re.namel

oK | Cancel |

Save paths are paths to directories where images are stored, preferably on a shared file server. Object

Store can add, rename and del ete save paths. The number of images stored in each save path is indicated
in the right-hand column.

When images are added to Object Store, athumbnail image and data related to the image is saved in the
database (see Database Configuration). The original full sizeimage is saved according to the Save Path
setting. All images that are registered to the database will store the save path as metadata.

To access the Save Paths tab, click the Settings button on the Object Store Object Store Toolbar.
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Working with Save Paths

'IMPORTANT! When using aremote server for storing data, the Universal Naming Convention
(UNC) name must be used. Therefore, the save path set in the Object Store client should use the UNC

path rather than the mapped-drive letter. For example\ ser ver \ shar e\ f ol der nane.

® *Add: *Adds asave path.
To add a save path, browse for the folder you want the still images to be stored in and press Add.
¢ *Delete: *Deletes a save path.

Note: When moving from old VOS to RestV OS, you will need to rename the path in order to
swap from amapped drive to a UNC path.

To rename a save path, browse for the folder of the new location where the still images are stored
and press Rename.

Active and Inactive Save Paths

Multiple save paths can be added to keep track of the available paths, but only one path can be active at a
time. To activate a new save path, click the checkbox next to it and confirm the change of the active path.

Note: Although it is possible to use images from multiple mapped sources for playout, it is
recommended to store al images on a single shared file server.

When a save path is not selected as the active path, the images stored on it are still searchable in Object
Store; however, it is not possible to add or edit images to/from a deactivated save path.

Save Pathsin VOS and RestVOS
When using conventional VOS (ie. not through the Pilot Data Server) the save path needs to be accessible
from both the Viz Pilot system’s clients and the Viz Engines.

When using RestV OS, the save path only needs to be accessible from the Pilot Data Server. The Pilot
Data Server then sends the image data to the client who requested it.

14.5 Object Store Toolbar
X = 2] P2 2 [ |8 8|
Preview New  MNew Edit Crop Mew like this Settings  Import  Export  Help

® Preview Image: Previews the image shown in the Image Information panel in the Image Preview
window.

383



® New Image (CTRL+N): Opens afile browser and a new Image Information panel for adding a new
image to the database.

® New Person: Opens a new Person Information panel for adding a new person to the database.

® Save (CTRL+S): Saves Image Information or Person Information to the database and shared file
server.

¢ Edit (CTRL+E): Edits the selected still image or person for editing Image Information or Person
Information, respectively.

® Crop:* Opens the image shown in the Image Information panel in the Object Store Crop Tool.

® Cancel: Cancels New or Edit operations for Image Information or Person Information.

® New Like This: Adds a new image by using the same meta data as an already opened image. Y ou
can choose to delete the “old” image or not. Meta data that is reused is Person information,
Keywords, Source, Description, Country and City.

® Settings: Opens the Object Store Settings window.

® |mport: Opens the Object Store Import window for browsing and selecting exported files.

® Export: Opensthe Object Store Export tab for exporting images.

® Help: Opensthe Viz Pilot User’'s Guide _(this document).

® About: Displaysthe Object Store version information.

14.6 Object Store Search Options

| Still Search | Person Search

The search panel consists of two tabs; Still Search and Person Search. The tabs can be enabled or disabled
through the Object Store Settings window.
Still searches are used for image and image information searches. Person search are used for person
information and related image and image information searches. Both searches will search for related
information on Viz Pilot’ s database.

When searching for an image or person, it is possible to double-click a search result item to preview and
view the metadata in the corresponding information tab. Any linked image and person information is also
available by selecting the respective information tab.

The Context Menus available in the results pane can be used to sort, filter and delete images and person
information.

14.6.1 Still Search

Still searches are performed two ways. A standard search consists of a search criteria and an optional
selected keyword from the Keyword drop-list, while an advanced search can refine the search narrowing
the hits down to certain dates, multiple keywords, location and custom made additional fields.

Standard Search
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[” Use advanced image search

Keyword:

ANIMALS j
T - -

4 Stills Found

polar_bear.jpg pandaz_given_tg... tigers.jpg firgt_cloned_calfg...

T

e

The standard still search contains a combo box, a check box, and a drop-list. The first search field
searches the image Description, Country and City and the related person’sfirst and last name. The
Keyword drop-list sets a selected keyword that searches the Image information Keywords field.

Advanced Search
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Still Search | Person Search

|Dhama ﬂ| Search

1] Use advanced image search
Keywards:

FLATEOMTALER A = | [POLITICS
FPOISOMN
POLICE
POLICE BEUTALITY -
POLITICS

Ol 1 ITT R

g

Country:
|Ur'|ited States of America ﬂ|
City s

[ |12.00.2008 |
[]|12.00.2008 |

[] Must have all keywords

[]] Partraits only
Additional Fields:

| =
| | _aa |

.y
4 hits

barack_obama_If... barack_obama_If... barack_obama_rf... barack_obama_rf...

Aswith Standard search, Advanced search is capable of doing simple searches. In addition searches can
be refined using more than one search criteria.

® Keyword: Use of multiple keywords enable a more precise search with an unlimited number of
chosen keywords.
® Country and City: Country and City corresponds to the drop-down list and text field used when
registering |mage information.
® Dates: Clicking on the arrow opens a calendar from where dates can be selected. There are two
check boxes for dates to enable search based on dates in three different ways.
® |f only the first check box is selected, images from the selected date to present date will be
searched for.
® |f only the second check box is selected, images before the selected date will be searched for.
® By selecting both check boxes, images within the selected dates will be searched for.
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® Must have all keywords: When selected this option results in hits that contain all the selected
keywords.

® Portraitsonly: Setsthe search to only search for images that are set to be portraits linked to a person
(see Person Information).

® Additional fields: Adds customized additional fields with the option of adding a search criteria.

Clicking the Add button adds the customized search to the standard search field.
Additional fields:

|weight -
. | Eadd
|Mr. Somebody <weight=80= j| Searchl

The additional fields search criteria entered in the example above is appended to the existing search
criteria

Stillswith Key

’ L
-

al_gore_right_... barack_obama... john_sidney_m...

Still images with a key/alpha channel will get the character K as atag in the upper right corner.
See Also

® |mage Information

14.6.2 Person Search

The following fields from the Person information panel are used in Person search; First name, Middle
name and Last name.
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Still Search | Person Search

merkel j| Search
1 hit
First... | Middle name | Last name | TV name
Angela Dorothea Merkel Angela Merkel
< ] 1 [>

10415686.1pg 1045959.7pg 1046035.1pg

Searching for a person works the same way as with Standard Search. The only differenceis that results
are given asalist of persons that match the search criteria.
When clicking alist item, all images linked to that person are shown. Double-clicking alist item will open
the Person Information panel. Double-clicking any of the images opens the Image Information panel
related to the image.

14.6.3 Context Menus

All search options have context menus with options to sort. In addition they have separate and differing
menu options to delete person or image, and restore del eted images from the bin.

Sorting

v Sark by name
Reversed sort by name

Sork by registration date
Reversed sort by registration date
Sort by modification dake
Reversed sort by modification date

Put in bin

Ermpky bin

Restore Al [%
Delete selected From bin
Restore Selected

® Sort by name: Sorts ascending by name.

® Reversed sort by name: Sorts descending by name.

® Sort by registration date: Sorts ascending on registration date.

® Reversed sort by registration date: Sorts descending on registration date.

¢ Sort by modification date: Sorts ascending on modification date.

® Reversed sort by modification date: Sorts descending on modification date.
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Note: The search result is either ordered ascending (a,b,c) or descending (c,b,a).

Caution: Deleting person information is permanent. Images linked to a person are permanently
deleted. Restoring images and information is not possible.

Per son Search:

® Delete person(s): Permanently deletes person(s) from the database. See how To delete person
information.
Still Search:

® Putin bin: Puts selected still(s) in the bin.

® Empty bin: Purges all previously deleted stills from the database and shared file server.

®* Restore All: Restoresall tills from the bin.

® Delete selected from bin: Purges selected still(s) from the database and shared file server.
® Restore Selected: Restores selected stills from the bin.

14.7 Object Store Information Panels

This section explains how to add, view and edit information about still images (stills) or personsin Object
Store.

Image Information Person Information Export/Import

By default, the information panel consists of the tabs |mage Information and Person Information. These

can be enabled or disabled through the Object Store Settings window
The Object Store Export and Import tab appearsin the information panel when doing an Export/Import by
clicking the export or import buttons on the Object Store Toolbar.

This section contains the following topics:

® |mage Information

® Image Preview

® Working with Images

® Person Information

® Working with Person Information

See Also
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® Object Store Export and Import

14.7.1 Image Information

The Image Information panel displays the currently selected image and its meta data. Some fields are auto-
generated by the system, others are auto-filled based on meta data appended to the image itself while some
datais added manually. The latter can be keywords which is often manually added to categorize the image
and to filter the search. Required fields are highlighted with a pale yellow color.

Object Store reads image meta data attributes defined by the International Press Telecommunications
Council (IPTC) and automatically adds it to the appropriate information fields.

Below, a default set of fields are shown. It is possible to add new fields to the Image information panel in
the settings for Keywords, Additional Fields, Organizations and Countries.

Image Information Person Information  Export/Import

image 10
Directory [kAimages), |
Filename |erop_738926 prig |
Key-Filename | |
File date |a/30/2007 |
Image size I?ﬂl ¥ 701 I
Parson |Me-ssa ndro Del Piero _I
Keywards EBORTION A 7o | [FOOTBALL f SOCCER
LBIISE C SPORTS
ACADEMIES =5
ACCIDENTS <
LCCIDEMTS AT SEA =
ACCIDENTS AT WORK o [ )=
Source lap |
Diescription Crop of: alessandro Del Piero, as 2002 Italy National World Cup Soccer Team
player celebrates scoring goal against Mexico during Group G match, Qita, Japan |

Country [rzpan B
City |oita

Date registered [5,30/2007 2:31:56 PM

Date modified  [9/4/2007 11:58:55 AM

Approved O

Weight [ |

Save |

|
|
Registered by Ip[LDT |
|
|

Auto-generated fields:

®* ImagelD: Setsthe D for the filein the database.
® Directory: Setsthefilelocation based on the Save Paths setting.
® Filename: Shows the actual file name.

390



® Key-Filename: Sets a separate filename for matching stills that are keyed.
® Filedate: When the image was last modified.
® Imagesize: In pixels.
® Description: Setsthe filename by default if no other information is embedded with thefile.
® Dateregistered: Setsthe date for when the still wasfirst registered.
¢ Datemodified: Setsthe date for when the still was last modified.
Required fields:

® Keywords: Setsthe keyword for the till image. One keyword is required. If no appropriate
keywords are available, new ones can be added in the Object Store Settings window.
Optional fields:

® Person: Setsthelink to Person Information. Only one Person can be linked.

® Source: Setsthe name of the copyright holder or image origin.

® Country: When selected, gives the still a geographical location by country.

® City: When entered, gives the still a geographical location by city.

® Registered by: Setsthelogged in user is as the registrant when information is saved.

® Approved: When set, indicates that the till isready for use.

® Additional fields: Displays additional fields added in the Object Store Settings window.

® | mage: Displays the uploaded image. Double-clicking the image will open the Image Preview.

14.7.2 Image Preview

Once an image has been selected and is displayed in the Image Information panel, it can be previewed by
clicking the Preview button (CTRL+P) in the Object Store Toolbar, or double-clicking the thumbnail in
the Image Information panel.

2| |= Ha [»| =

Save Clipboard Key  Blended ©Crop  Close

® Clipboard: Putstheimage on the clipboard alowing the image to be pasted into other applications.
®* Key & RGB: Showsthe key and RGB version of the image. If the image has no key an all white
image (full key) is shown. When clicking the Key button the button is replaced by the RGB button.

ke

® Blended: Shows the key image blended with a white background.

® Crop: Opensthe Crop image window.

® Save: Savesacopy of theimage on the computer. The following formats are available: Bitmap,
JPEG, RGB, Targa, TIFF and PNG. By default the format is set to TIFF.

® Close: Closesthe Preview dialog box.
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To preview an image

1. Search for animage.

Double-click the thumbnail to open the Information panel.

3. To preview the image click the Preview button (CTRL+P) in the Object Store Toolbar, or double-
click the thumbnail in the Image Information panel.

N

See Also

® Object Store Crop Tool

14.7.3 Working with Images
To add anew image

1. Click the New I mage button on the Object Store Toolbar, or use the keyboard shortcut CTRL+N.
2. Browse for and select an image from alocal drive or anetwork drive, and click Open.

3. Fill inimageinformation.

4. When done, click the Save button (CTRL+S).

To edit image information

1. Search for theimage using Still Search.

2. Double-click to open the selected image in the Image Information panel.

3. Click the Edit button (CTRL+E) on the Object Store Toolbar to enable editing.
4. When doneg, click the Save button (CTRL+S).

To link a person to an image

1. Open animage and make it editable.

2. Click the ellipse button a2« to search for a new person using Person Search.
3. Double-click thelist item representing the new person to replace the old Person information link.
4. When done, click the Save button (CTRL+S).

Note: Only one person can be linked to an image at atime. Thisisalimitation that relatesto
how portrait images are linked to person information.

14.7.4 Person Information
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Image Information Person Information

First name ICh arles

Middle name IWadE

Last narme IE.arkIE':.r

TV name ISir Charles

Title I

Comment Charles Wade Barkley (born February 20, 19563) is a retired American

professional basketball plaver. Commonly nicknamed "Sir Charles" and
"The Found Mound of Rebound”, Barkley established himself 35 one of
the most dominating power forwards in the history of the National
Basketball Association (MBA],

Organization UM
UMITED MATIOMNS
WIZRT

Place I

m_ Save |

4 irmages linked

Bl

Required fields:

® First name
® | ast name
® TV name Thenamethe TV station uses.

Optional fields:

¢ Middlename

® Title: Can be used to add atitle to the person (for example Lady, Sir, Dr, Mr, Mrs etc.).
® Comment: Can be used as an open text field describing the person.

® Organization: Can be used to link an organization to the person.

® Place: Can be used to place the person geographically.

® |magesLinked: Can be used to link images to a person.

® Bin (icon): Removesimages that are linked to the person.

® Save: Saves new or updated person information to the database.
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14.7.5 Working with Person Information

To add person information

Image Information

Perzon Information

First name
Middle name
Last name
TV name
Title

Comment

Organization

Flace

T

0 images linked

i

|Mahnmud

|
|
|ﬁ.hmadinejad |
|
|

|Mr. President

|President of Iran

Mahmoud Ahmadinejad is the sixth
and current President of the Islamic
Republic of Iran. He became president
after winning the 2005 presidential
election and was re-elected to a
second term in 2009 following a

E

=

|
Save

1. Click the New Person button on the Object Store Toolbar.
2. Fill in the person information.

3. When done,

click the Save button (CTRL+S).

To edit person information

1. Search for aperson using Person Search.
2. Double-click to open the selected person in the Person Information panel.
3. Click the Edit button (CTRL+E) on the Object Store Toolbar to enable editing.

4. When done,

click the Save button (CTRL+S).
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To delete person information

Angela Dorothea Merkel Angela Merkel Chancellor
ianthony iChz “ Sort by name o ¥ Bla_ir Former Prin
Barack Hus resident President ¢
Benjamin Reversed sf:'rtt“’_f name Prime Minis
Gro Har| Sertbyregistration date Harlem Brundtla... Former Prin
lames Gor  Reversed sort by registration date on Brown Prime Minis
Lars Legkl  Sortby modification date Rasmussen Prime Minis
Mahmoud Reversed sort by modification date resident President ¢
Martti Qi I Ahtisaari Former Pre
Micalas Delete Person(s) las Sarkozy President ¢

1. Search for a person using Person Search.
2. Right-click the person list entry, and select Delete Person(s).
3. Click Yesto confirm the delete operation.

Caution: Deleted persons from the database cannot be restored. Images linked to the person
will aso be permanently deleted.

To link imagesto aperson
| Flace

1 @
A ; 1 imageninked

o
1023759.jpg 1031598.jpg 1041347.jpg 1046980.jpg I

Search for a person using Person Search.

Double-click to open the selected person in the Person Information panel.

Click the Edit button (CTRL+E) on the Object Store Toolbar to enable editing.
Search for images using Still Search.

Drag and drop images onto the eye icon visible in the Person Information panel.
When done, click the Save button (CTRL+S).

o ukcwbdpE

To unlink images to a person

1. Search for a person using Person Search.
2. Double-click to open the selected person in the Person Information panel.
3. Click the Edit button (CTRL+E) on the Object Store Toolbar to enable editing.

[T e

5 images linked

. 1
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4,
5.

Drag and drop images that are to be unlinked onto to bin in the Person Information panel.
When done, click the Save button (CTRL+S).

To add an image to a person

o rcwDNPE

6.

Search for a person using Person Search.

Double-click to open the selected person in the Person Information panel.

Double-click the eye icon to open the file browser.

Browse for and select an image from alocal drive or a network drive, and click Open.

Fill inimage information, and click the Save button (CTRL+S) to return to the Person Information
panel.

When done, click the Save button (CTRL+S).

See Also

® |mage Information
® Organizations

14.8 Object Store Status Bar

The status bar consists of two parts; a search progress bar and a bin.
To use the bin, smply drag and drop an image onto the bin icon.

14.9 Object Store Crop Tool
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EJ crop Image =&

Sipe= 150061125 [Zoome 2700 |Selection: 526:865

The Crop Tool isatool for basic cutting, zooming and rotating of images. An edited image will not affect
an already saved image.
For information about using the Crop Tool see Crop Service and Crop Tool.

14.10 Object Store Export and Import

This section describes how to export images and import images. To enable the Export/Import tab click the
Import or Export button on the Object Store Toolbar. Once enabled it will remain visible until Object
Storeis restarted.

Object Store uses an Oracle database and a shared file server to store image and person information.
Original images are stored on the shared file server, and information together with a thumbnail, of the
original image, is stored on the database.

14.10.1 Object Store Export
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P
Object Store - Database: VIZ-xw4300/DOC - Videohuk: bgoorangevh l =

Sava  Edit  Crop

Still Search

|merkel

[] use advanced image search
Keyword:

ed. Use the add buttons
or export.

A Exporting persons...

A .1...
)h el s . Persons exportad.

Exporting keywords...
Keywords exported.
Exporting additional fields...
Additional fields exported.
% """" === Exporting organizations...

| Organizations exported.
Exporting icons...

Icons exported.

Saving file

File saved - C:\Users\jfriappData‘Loc
Creating archive...

i . Moving .xml files to archive...
— —B0 4 2 asns t-1Pd Moving image files to archive...

Bi\Local\Temp\wos72F3_parts\0

4

Access the image export option by clicking the Export button on the toolbar. This can for instance be used
for exporting images and related information to other Object Store installations.
The Export buttons for both export options creates an compressed file with original images, thumbnails
and image data. The compressed file can be opened by atraditional extraction tool, or opened using
Object Store.

The lower right part of Object Store’ s main window shows a step by step status when importing or
exporting images.

® *Export: *Exports all or selected images to a compressed file (e.g. foo.vos).
*Add All: *Adds all images based on the search resullt.

® *Clear: *Removes all images from the drop-zone.

® *Bin: *Removes selected images from the drop-zone using drag and drop.

To export selected images

Click the Export button on the main menu to open the Export/Import tab.

Search for the images to be exported.

Drag and drop pictures onto the drop-zone in the Select pictures for export frame.
Click the Export button.

Enter afile name and click Save.

akrowbdpE
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To export all images

1. Click the Export button on the main menu to open the Export/Import tab.
2. Click the Export button in the Direct Export frame.
3. Enter afile name and click Save.

14.10.2 Object Store Import

Import is traditionally used when moving or copying images and information from one system to another.
While importing the images, Object Store will extract all thumbnails and image data from the attached
XML file, storeit on the Viz Pilot database and place the original images to the location specified in the
Object Store settings.

To import exported images

1. Click the Import button in Object Store and select the compressed file (e.g. foo.vos), or
2. Double-click the compressed file to open Object Store, or
3. Right-click and select Import to open Object Store.

To extract exported images

® Open the compressed file (e.g. f00.vos) using an extraction tool (e.g. 7-zip).
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15 Thumbnail Generator

Thumbnail Generator is aWindows service. As data elements are created or changed, it automatically
generates thumbnails of them. The thumbnails are stored in the Viz Pilot database.

The thumbnails generated by Thumbnail Generator are used in the data element listsin Viz Pilot News
and Director, aswell asthe Legacy Playlist, but they are not used in the new Playlist Window. They are
not used in the Pilot Data Server either, as that includes thumbnail links pointing to the Preview Server in
the data element descriptions it serves out.

For information on installing Thumbnail Generator, see Pilot Data Server Requirements.

15.1 Configuration

Only oneinstance of Thumbnail Generator should be running at any given time. Having two running will
not lead to errors, but extraload on the Preview Server and its Viz Engine, as al thumbnails will be
generated twice.

The Preview Server must be configured in the Pilot Data Server under Settings > VCP Parameters >
previ ew_server _uri . Seethe VizPilot Release Notes for the recommended versions of Preview
Server.

Thumbnail Generator uses the database specified during Pilot Data Server installation. To change the
database, run the Pilot Data Server Installation again and select Change, or click Change from the list of
installed programs in Windows.

15.2 Operation

Thumbnail Generator listens to database change notificationsin order to update thumbnails automatically.
It maintains a queue of data elements to be processed, which will be ordered so that the data elements
most recently updated will be processed first. If there are many simultaneous changes, it may take some
time before the thumbnail of a specific element is generated. Also, to avoid overloading the Preview
Server or the Viz Engine with thumbnail requests, Thumbnail Generator will wait a number of seconds
between consecutive requests.

Thumbnail Generator starts automatically when Windows starts. It handles database connection issues and
doesn't require any kind of maintenance.

15.3 Logging

Thumbnail Generator placesitslog file at:

c:\ProgramData\ Vi zrt\Logs\Viz Pilot Thunmbnail Generator\ Thunbnai l
Generator.|og

When Thumbnail Generator fails to generate athumbnail for a data element it will retry with increasing
intervals. If it fails a certain number of times, the item will not be retried any more, leaving the data
element without a thumbnail.
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16 Drop Desk

0 Drop Desk

This section contains:

® About Drop Desk
® |nstallation and Configuration of Drop Desk
® Working with Drop Desk

16.1 About Drop Desk

Drop Desk makesit easy for journalists to transfer media resources from Vizrt's Media Asset
Management system Viz One. Drop Desk integrates with the INEWS newsroom system as a plugin, and
provides easy drag-and-drop mediatransfer from Viz One to external systems. The Video On Demand
transfer plugin allows the video asset to be transcoded into arange of consumer video formats.

16.1.1 Workflow
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The screenshot above illustrates the workflow. The journalist isworking with astory iniNEWS, and is
using the Viz Pilot News media search to access the Viz One MAM system. When the appropriate video
resource is found, the journalist can drag the video from the Viz Pilot News media search (1) to the Drop

Desk pand (2).

16.1.2 Drop Desk Server and Client

Drop Desk consists of aserver and aclient:

® The Drop Desk client isaweb application that can be opened in a Microsoft Internet Explorer or
Google Chrome browser. A plugin for Windows is provided in order to have Drop Desk running
within the iNews client.
The Drop Desk client is an Active X web component and can run on any modern Windows PC that
is supported by the INEWS client software.

® TheDrop Desk server isinstalled on Viz One and uses the Video On Demand transfer plugin.

16.2 Installation and Configuration of Drop Desk

16.2.1 Toinstall and configure the Drop Desk Server

Installation and configuration of the Drop Desk server component is described in the Viz One
Administrator’s Guide.

16.2.2 Toinstall the Drop Desk Client
Installation steps:

1. Runtheinstaler: Dr opDesk. i NEWS. | nst al | er - <VERSI ON>. nsi
2. When prompted, specify the hostname of the Drop Desk server (i.e. the Viz One server where the
Drop Desk server isinstalled).
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3. Alternatively, use automated installation from the command line, and provide the Drop Desk
hostname like this:

nsi exec. exe /i dropdesk-inews-plugin.nsi /qgn /| install.log
SERVER_HOSTNAME=MyDr opDeskSer ver NaneHer e
Verification:

To verify that Drop Desk client plugin is correctly installed either:

1. Start theiNEWSclient and go to iINEWS> Tools > Plugins > Drop Desk
2. Or, open the Drop Desk service page from your browser to check availability. For example:
http://MDropDeskServer: 14411/ dr opdesk. ht n

16.3 Working with Drop Desk

1. Make surethat Viz Pilot News and Drop Desk iNEWS plugins are visible by selecting them in
iINEWS> Tools > Plugins.

i B 4

1
=
Tewmroa] v ==

T

2. Usethe Viz Pilot News media search to find mediaresourcesin Viz One.
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3. Drag the mediaresource from the Viz Pilot News media search onto the appropriate tab in Drop
Desk.

Drop Desk = |

Drag Media Here

4. The mediatransfer from Viz One will start and any required transcoding will be initiated. The
Drop Desk panel will provide status messages indicating the progress.
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17 Database Administration
The database installation for Viz Pilot is atypical Oracle database server installation.

Vizrt's standard installation of aViz Pilot database uses the service name VIZRTDB. The SQL schema
and table creation scripts add the user PILOT with password PILOT which makes up the schema name
and the default credentials al Viz Pilot system applications are configured to use. All this can be changed
either during installation or after installation.

17.1 Database connection parameters

Par ameter Value

Oracle system identifier (SID VIZRTDB
/Service name)
All system users (default) system/oraclesys/oracle

All users (default) PILOT/PILOT
Database schema (default) PILOT

Pilot DBA (Pilot Database Administrator tool) is used by database administratorsin order to install,
maintain and upgrade the Viz Pilot database system. It also enables the database administrator to check the

current status of the database.

See Also

® For information on installing an Oracle database server, see the documentation supplied by Oracle.

17.1.1 Getting Started - Pilot DBA
Start the Pilot DBA, by:

1. Browse to the location where you extracted the Pilot DBA files. (See Pilot DBA Installation).
2. Double-click the Pilot DBA executable file to start the application.

17.2 User Interface

Starting the client will open the Connect to DB window which istheinitia screen of Pilot DBA. This
screen gives the user several options; the Database L ogin, different Management Options and Advanced

Configuration of user levels.

This section contains the following topics:
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® Connect to DB

® Database Login

® Advanced Configuration
® Schema Status

® Connection Status

® Database Error Logs

17.2.1 Connect to DB

' VCP DBA 1.1 - Revision: 55480 M=)

Adwvanced Config...

Log in to Database

Information about the Database:

In=tall New Schema

Databasze: VIZRTDB [

User: system

Create complete db solution

Ehow Schema Shatis |

Eackip schema

Be=tore Excklp of Schema
|Eulll Eaeieigr wif DiE |
Imp. Al Eehemas i D urmp |
Connect to DB ]
== Baalk | Next -= | Exit |

The Connect to DB tab istheinitia startup window where the user can perform the Database Login, set
user levels and initiate different Management Options.

® Connect to DB/Change DB: Enables the user to log on to the database.

® Advanced Config ...: Enablesthe user to select a default user level or create a custom user level.

® |nstall New Schema: Enablesthe user to install a schema on the specified database. See Install
Schema.

® Upgrade Current Schema: Enables the user to upgrade the current version of the schemato alater
version. See Upgrade Schema.
‘Note: The application first scans the installed schema for critical errors and blocks the optionto

upgrade if any critical errors are found.
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® Show Schema Status: Enables the user to see the status of the currently installed schema. See Show
Schema Status.

® Create complete db solution: Enables the user to create a complete database solution. See Create
Complete DB Solution.

® Backup Schema: Enables a user to export a database dump of the schema. See Backup Schema.

® Restore Backup of Schema: Enablesthe user to import a database dump of a schema. See Restore
Backup of Schema.

® Full Export of DB: Enables the user to perform an export of the entire database. See Full Export of
Database.

® |mp. All Schemasin Dump: Enables the user to import all schemasin dump. See Import All
Schemas in Dump.

17.2.2 Database Login

-~

Specify database, username and passw...

|lzermame |

FPazzward | ***** systemimyE
system@yIZRTDE

Database [VIZRTDE| |

Connect az | Mormal -

] Cancel |

In order to successfully connect to a database, alocal net service name must be configured for the Oracle
database client using Oracle' s Net Configuration Assistant.

® Username: Displaysthe pre-configured system user.

® Password: Setsthe password for the system user.

¢ Database: Setsthe database service name or connection string.

® Connect as. Setsthe connection privileges. Available options are Normal, SY SDBA or SY SOPER.

See Also

® Database Service Names and SID
® Database TNS Alias
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17.2.3 Advanced Configuration

r@ Config E]@]N

Set User Level | Advanced Options

" Basic

Enable Recreate/Recompile options

Enable option to have different name
an tablespace

Enable support imports

Add Destroy=" to all imports

Show preprocessed scripts
and advanced script options
Stop on errors when executing scripts

]33 | Enable advanced options in

extended info

O BE O0OBE B H

Cancel | Allow unstable versions in upgrade

® Set User Level: Showsthe available user modes.

Basic: Thisuser level isfor users who are doing regular maintenance and fresh installations or
upgrades of the database schema.

Support: Thisuser level ismainly used by Vizrt's support personnel and skilled administrators
who are doing specia customizations to an existing installation or fixing common errors found
in schemas.

R&D: Thisuser level isfor use by Vizrt's R& D department when doing development or
searching for bugs that is not solved by customer support.

® Advanced Options: Shows the available options.

Enable Recr eate/Recompile options: This enables the Recreate/Recompile optionsin the
Schema Status window and the button to recreate AQ tables in Extended Info-AQ & Purge Job.
Enable option to have different name on tablespace: Enables the user to select a different
tablespace name. Default is the same as Schema name.

Enable support imports: Enables "support only"-version in the combo box for selecting
version for import. Thisisto import asingle schemawithout first installing a new schema, so
that Vizrt can debug the schema. Also enables"Imp.All Schemasin Dump" option.

Add Destroy=Y to all imports: Overwrites tablespaces if aready found.

Show preprocessed scripts and advanced script options. Shows an extratab before
executing the chosen script where the user can see through the pre-processed script or reload it.
Stop on errorswhen executing scripts: Stops the execution of scripts when errors occur. For
versions 5.1.7 and later this option should be enabled. For older versions than 5.1.7 this option
should be disabled.

Enable advanced optionsin extended info: Enables the buttons to activate/deactivate the AQ
triggers and purge job, and the button to delete all entries in the errlog table older than 3
months.

Allow unstable versionsin upgrade: Allows the schemato be upgraded to/installed as an
unstable version, meant for use by Vizrt staff only.
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17.2.4 Schema Status
@?CP DBA 1.1 - Revision: 55480 E]@ﬁ

Status of Schema: PILOTS53 check complete §elect Action ]

Current installed version: 5.3.0
The database uses UTFS encoding: ALI2UTFS

Result from the test of vcp_message_queus(AQ): {1 Upgrade Application Schema
Test of AQ-triggers: All triggers are enabled.
Error: The following objects did not comply with th (")Run Custom Script (Advanced)

Procedure/Function INSERT_CONTROL_SCEMNE in £
C}Eiew Extended Info (Advanced)
(:} Recreate all constraints (Advanced)

Recreate all sequences and
recompile schema (Advanced)

(:} Recompile schema (Advanced)

O Reinstall packages (Advanced)

< >
Connect tao DB] Select Schema  sStatys I

| Exit |

® Saveicon: Creates a packaged file (zip) with debug information. The file can be sent to support for
external help with the database.

=

Note: If dump files are not created as expected, check that Pilot DBA’ s installation path does not
contain spaces.

® Upgrade Application Schema: Enables the user to upgrade to a new schema.

® Run Custom Script (Advanced): Enables the user to run a custom script, specific to the database.

® View Extended I nfo (Advanced): Enables the user to display extended information about the
schema.

® Recreateall constraints (Advanced): Enables the user to execute a script that recreates all
constraints in the schema. Typically needed after a"support only" import, or if some constraints for
some reason are missing. Missing constraints are reported in the status window.

® Recreateall sequences and recompile schema (Advanced): Enables the user to recreate all
seguences in the schema and then recompiles the entire schema. Thisis usually done by normal
imports, but could be needed if something went wrong during the import, or if “support only" import
was used. Thiswill also fix problems that might appear if for some reason a manual import was
done.
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® Recompile schema (Advanced): Enablesthe user to recompile all packages, triggers, functions and
procedures.

17.2.5 Connection Status
 DB: Connected DB Disconnected

The connection indicator field at the bottom right shows the connection status for Pilot DBA to the
database. It is red when disconnected, and green when connected. If the connection islost try clicking on
thisfield to reconnect to the database.

See Also

® Newsroom workflow without database connection

17.2.6 Database Error Logs
- Errarl

When errors occur during operation, an indicator is shown in the lower right of Pilot DBA’s user
interface. Clicking this warning indicator will open alog window with the following three logs:

® VCPDBA.log: Shows the main application log.
® VCPDBA_SQL .log: Showsthe SQL output from the last script that was executed.
® vcp_ora.log: Showsthelog for the internal Oracle module.

All log files are stored in the same directory as the Pilot DBA application.

Database log files

The dert logs for the Oracle Viz Pilot database are generally found in the following locations, although
this may differ dightly on your system:

® C:\oracl e\di ag\ rdbmns\ <dbnane>\ <SI D>\ al ert\ | og. xm
® C\oracl e\di ag\rdbns\ <dbnane>\ <SI D>\t race\ al ert _<dbname>. t xt

17.3 Management Options

This section describes the different database management options available in the Pilot DBA User
Interface:

® |nstal Schema

® Upgrade Schema

® Show Schema Status

® Create Complete DB Solution
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¢ Backup Schema

® Restore Backup of Schema

® Full Export of Database

® |mport All Schemasin Dump
® Extended Information

® Database Test

See Also

® Database Administration

17.3.1 Install Schema

Install New Schema enables the user to install a new schema, set a schema name, username and password,
and a tablespace name.

If the user level is set to R&D maode (see Advanced Configuration) it is possible to install an unstable
version of the database schema. Thisistypically the latest version in development, and is only
recommended for testing.

Toinstal anew schema

& VCP DBA 1.1 - Revision: 55480 mE x|

Enter information for new schema

Schema Name: Select WCP version:
[PiLOT | 5.3.0 |

Pas=sword for new schema:
|pi|nt |

Confirm password:
|pi|nt |

Tablespace:

|§New Tablespace... ﬂ| (Default: =ame as Schema name)

New tablespace name:
[P1LOT | (Replaces &USER_TBS)

== Boalk | MNext -= | Exit |

1. Click theInstall New Schema button.
2. Inthe New Schemawindow, select the Viz Pilot version to be installed.
3. Optional: Enter the schema name and password
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4. Optional: Enter the tablespace name. Setting a different tablespace name requires this option to be
selected (see Advanced Configuration).

5. Click Next twiceto start the installation.

6. Click Next when finished.

17.3.2 Upgrade Schema

The Upgrade Schema option enables the user to upgrade the schema from the current version to new
versions.

If the user level is set to R& D mode (see Advanced Configuration) it is possible to upgrade to an unstable
version of the database schema. Thisistypically the latest version in development, and is only
recommended for testing.

To upgrade to a new schema

' VCP DBA - Revision: 47868 mEX]

Upgrade Schema

Select Wersion to Upgrade to
(+/5.2.0

" 51.7

516

Connect to DB ] Select Schema ] Status  Upgrade Schema ]

Exit |

1. Click the Upgrade Schema button.
2. Inthe Select Schemawindow, select the schema that should be upgraded, and click Next.
® When Pilot DBA has checked the status of the current schema, the Upgrade Schema window
will list the available upgrade options.
Select the schemaversion, and click Next to see the script that will be executed.
When ready to upgrade, click Next to run the scripts.
5. Click Next when finished.

> w
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® Upgrade Considerations
® Upgrade Limitations

17.3.3 Show Schema Status

Schema status shows the status of the selected database schema. The list gives status information on the
following:

® Theversion of the currently installed schema.

® Text encoding of the database.

® Status of AQ.

* Whether the schema complies with areference of the currently installed version.
If more than one schemaiisinstalled on the same database, a selection dialog is displayed before the
status information window is shown.

The available options depend on the configured user level, see Advanced Configuration. Note that most
features will be blocked if the database text encoding is not UTF-8.

Caution: With the exception of “View Extended Info”, the “ Advanced” options may stop the schema
from working if an error occurs while running the scripts.

To see the schema status

1. Click the Show Schema Status button.
2. Select the schema and enter the schema password.
3. Click Next.

17.3.4 Create Complete DB Solution

Creating a compl ete database solution using Pilot DBA ensures that the database is setup and configured
according to our recommendations. It also installs the latest version of the PILOT schema.

The Oracle Standalone Server is a setup with asingle server and no form of automated backup.

The Oracle Standby Server is a setup with two standard Oracle servers where one is working as the
failover server in case the main server goes down.

The standby server’s failover mechanism is manual, and the backup server isinactive for users when in
standby mode. The standby server setup also requires that the main server is started before the backup
server.

The standby setup is meant to be used with new installations of standby servers. It is created to work with
C: drive as the program disk and D: drive as the data disk.
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To create a complete stand alone server

Click Advanced Configuration and select the support or R&D user level.

Click the Create complete db solution button.

Select the Stand Alone Server (Windows) option.

Select the drives for the software and the data files.

Enter the hostname if the hostname was not detected.

Click Next.

® Clicking Next will launch the Oracle Universal Installer, and a separate command schell.
The Oracle Universal Installer will install the database.

® After theinstallation the Oracle Universal Installer will start to execute the configuration
assistants (e.g. Oracle Net Configuration Assistant and so on).

7. In the separate command shell window click any key to continue after receiving the message "
The installation of Oracl e Database 11g was successful . " fromthe
Oracle Universal Installer.

8. Pilot DBA will now log itself on to the database and install the PILOT schema.

9. Check that the host information in listener.ora and tnsnames.or a use hostnames and not | P-

addresses.

o ukwbdpE

To create a complete standby server

® |tisnot recommended to perform this setup option without consulting your local Vizrt representative
or support person.

17.3.5 Backup Schema

The database backup feature exports a database dump of the schema. If the backup does not produce an
output, it isimportant to check that the Pilot DBA install folder does not contain spaces, and that the
Oracle Administrator client is used.

17.3.6 Restore Backup of Schema

Restore a backup imports a database dump of a schema. If the schema name imported to is not the same as
the schema name that was exported, it is possible to choose to import to a new schema, however, this also
requires that the version of the schemathat was dumped is known. The application will do a complete
install of that schema version, truncate the tables and import the dump.

Setting the user level to Support will enable the option to select the Viz Pilot version Support only. This
version alows araw import of a database schemawhich in turn can be used for debugging. A schema
imported this way will not have AQ, triggers or constraints enabled, and will therefore not be a schema
one can use with the Viz Pilot system applications.
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17.3.7 Full Export of Database

Full Export of Database does an export of the entire database, including all schemasin the database. This
ismainly used for Customer Support Requests.

The database dump file is saved in the Pilot DBA installation folder, eg. exp_conpl et e. dnp.

17.3.8 Import All Schemasin Dump

Import All Schemas in Dump analyses a dump file to find all tablespaces and users before creating them
and importing data from the dump file. Oracle default users and tablespaces are excluded from the
imports.

This option is only available to Support and R& D users.

17.3.9 Extended Information

&d VCP DBA - Revision: 48452 (=Jl

List all tables w/counts] AQ subscribers  AQ & Purge Jeb | Errlog: 3172 | Sys' Error view: 0| VizAdmin leg: 61 | Invalid objects

«| [CONTROL_SCENE_MSG_S_TRG: ENABLED
1| | CONTROL_SCENE_CMD_MEG_ TRG: ENABLED
PLAKAT_DATA_MSG_S_TRG: ENABLED
| [PLAKAT DATA_MSG_TRG: ENABLED
PLAKAT_DATA_CMD_MSG_S_TRG: ENABLED
Act. AQ Triggers | |PLAKAT_DATA_CMD_MSG_TRG: ENABLED

Deact. AQ Triggers

Deact. Purge lob

Act. Purge Job

Recreate AQ Tables |

Connect to DBI Select Schema] Status  Extended info ‘

«- Back | Mext -= | Exit

Extended information can be viewed if the option Enable advanced options in extended info is enabled.

Caution: The different actions in these views could potentially stop the schema from working if an
error occurs while running the scripts.

Information Tabs

All information tabs have the option to refresh the database information result by clicking the Refresh
button.

The following information and options are available:
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® List all tableswith counts: Lists all tablesin the schema and the number of rowsin each.
® AQ Subscribers: Showsalist of the message queue (AQ) Subscribers currently registered.
® AQ & PurgeJab: Liststhe status of and allows the user to activate/deactivate the AQ Triggers and
the Purge Job. This view aso has an option to recreate the AQ tables, which is done by deleting and
recreating the tables.
® Deact. and Act. AQ Triggers: Disables and enables the AQ system if thisisworking properly.
® Deact. and Act. Purge Job: Disables and enables a scheduled job on the database that purges
old messages from the AQ system to avoid these tables clogging the database with obsolete
data. (see, Purge Expired Messages).
® Recreate AQ Tables: Deletesal AQ tables and al datain them, and then creates new tables
and register these with Oracle’s AQ system. This option will delete all messages not received
inthe AQ tables, and if any errors occur the AQ system will not work afterwards. This option
should therefore not be used by users that do not know how to read to error logs and that are not
ableto fix AQ issues manually.
®* Errlog: (#itemsintheerrlog): Liststhelast 100 entriesin the errlog. It aso gives the option to
delete al entries older than 3 months.
® Sys Error view: Listsall errors with the current schema as owner, inthe sys’ all_errors view.
® VizAdmin log: Showsthelast 100 entries of the VizAdmin log table.
® |nvalid objects. Showsall invalid objects in the database.

Purge Expired Messages
When ajournalist creates a new element of atemplate, aMOS message is sent from the database to Viz
Gateway. All MOS messages are stored on the database which again takes up space on the database
server. It istherefore convenient to purge expired messages from the Viz Pilot system’ s message queue.
As expired messages are transferred to the exception queue, they need to be explicitly removed. This can
be done by running ajob at regular intervals (every day). By default thisis done every day.

To see extended information

1. Click__Show Schema Status.

2. Select schema, enter schema user password, and click Next.
3. Select View Extended Info (Advanced), and click Next.
4. Select one of the tabsto view the extended information.

17.3.10 Database Test
Try connecting to Viz Pilot’s database to test if the database is successfully installed and running.

Start acommand-line tool, and then type the following:

® gglplus userid/password@tnsname, or
® gqglplus userid/password@hostname/SID
SQL Plus connection:
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B Command Prompt - sqlplus pilot/pilot@VIZRTDE - o] =|

Ft Windows WF [Version
ight 198%-2881 H

ction on Wed Jun 28 18:49:24 2087

Copyright <c» 1982, 2885, Mracle. All rights reserved.

Connected to:

=le Datahaze 1 ﬂ!_r E:-:|.1:|'-.:'.: = Edition Releaze 1B.2.8.1.8 - Production

;2 Release 10.2.0.1.8 - Production on Wed Jun Z8 18:49:46 2887

Cod 1982, 20805, Oracle. All rights reserved.

18.2.8.1.8 - Production

Check that the output is something like the example output below:

C. >sgl plus pilot/pilot@iz-xw300/xe SQ*Plus: Release 10.2.0.1.0 -
Production on Wed Jun 20 12:17:19 2007 Copyright (c) 1982, 2005,
Oracle. Al rights reserved. Connected to: Oracle Database 10g
Express Edition Release 10.2.0.1.0 - Production SQL>

The example output above shows that the database is placed on a remote machine, named viz-xw4300,
thus the connection string @viz-xw4300/xe is needed (hosthame/S D) or just the TNS name.

C. >sqgl pl us pilot/pil ot @I ZRTDB

Note: The above screenshot and output example use the SID XE. Thisis the default SID for Oracle
10g XE, which isan Oracle ‘test database'.

17.4 Limitations

17.4.1 Current Limitations

® Pilot DBA’singtall path cannot contain spaces.
® Pilot DBA can only login with Oracle' s system user.

17.4.2 Upgrade Considerations

Asageneral rule, the schemaversion should be upgraded to the same version as Director. Although, itis
important to remember in which order to do the upgrade, and to do the actual schema upgrade work at a
convenient time when the system is not in use.

Please refer to the Viz Pilot release notes for recommended schema version for a specific version of Viz
Pilot system.
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Asthe order is crucial for the functioning of the templatesin the Viz Pilot system, the following order of
upgrading is recommended. If instructions are not followed, and a newer version of Template Wizard is
used to save atemplate, the template will most likely not work inside Viz Pilot News or Director.

1. Upgrade Viz Pilot system’ s schemain the Viz Pilot database

2. Upgrade al clients except the Template Wizard client(s)

3. Upgrade the Template Wizard client(s)
The order of 1 and 2 can be switched, but the last component to be upgraded should always be the
Template Wizard. Thisisto avoid saving down templates with new functionality that may come
with the version, which is not supported by older versions of Viz Pilot News or Director.

Test the versions of Viz Pilot News, Template Wizard and Director you want to upgrade to, at least on one
non-live client of each. The test should involve at least opening al templatesin each client, saving down
one data element of each templatein Viz Pilot News, and finally playing al those data elements out from
the updated Director.

Contact local support team with information about the current state of the Viz Pilot database; for example
which version the current Viz Pilot schemais on, what version you want to upgrade to so that support is
aware that the upgrade is happening and can prepare second line and personal follow-up, if needed.

When you start the upgrade process any data elements or new templates saved after this time may be lost
if the upgrade is not successful. The chances of this are small, but it may happen and it should be
incorporated into the plans.

If you have amain and standby setup, check that they are synchronized. If thisis not the case, Vizrt
support must be informed and any schema upgrade cannot go ahead before thisis rectified. If it cannot be
solved, afull recreation of the standby server may be needed before continuing. Also, a set time is heeded
where you can break the synchronization between the two databases.

17.4.3 Upgrade Limitations

When upgrading from aViz Pilot 4.x or older version it is advisable to contact alocal Vizrt representative
or support person so they can advise on how to proceed. Some features found in Viz Pilot 4.x are not
availablein later versions.

When upgrading from a Viz Pilot 5.x version it is advisable to upgrade the database schema to the latest
schema version that is compatible with the software version. When upgrading the database, please use the
Database Administration tool. For more information on supported schema version, see the rel ease notes.
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18 Appendix

This section contains supplementary information related to the Viz Pilot system:

® | egacy Playlist
® |ntegrating Drag and Drop from External Applications

18.1 Legacy Playlist
'IMPORTANT! In Viz Pilot 6.0 and Iater, the new Playiist Window is available. The playlist
described in this section is still available, but is deprecated.

The old playlist can be enabled in the Playlist - General Preferences options.

A Mew playlist 14:14 [bval =

O] o] [ F5] B P ] B - B comue cormre -
Siep e Paude ContemeTaks Oul Chp  Lead  Initiahze  Cleanup !
[wame  Jchannel  [status  Jawailable  [Concept [variant [Finished [Loaded |

i
i@

= 2] [ [E EH B E [T -
Neet  Privious Curiar  Expand © Merge  Splt  Fi
Playlist acte Tor prafie: PGH

-
o
X

18.1.1 Legacy Playlist Toolbars

There are several toolbars available which can be displayed or hidden using the Toolbar Context Menu.
Toolbar Context Menu

Cuskomize Toolbar

| v Ikem Toolbar
1w Plavlist Toolbar
Yideo Toolbar

Cuskaom Toolbar

To access the Toolbar Context Menu, right-click on the toolbar.

® Customize Toolbar: Opensthe Button Configuration dialog box. For details about this dialog box,
see Legacy Playlist Custom Toolbar.

® |tem Toolbar: Displaysthe Legacy Playlist Item Toolbar (enabled by default).

® Playlist Toolbar: Displaysthe Legacy Playlist Toolbar (enabled by default).

® Video Toolbar: Displaysthe Legacy Playlist Video Toolbar (disabled by default).

® Custom Toolbar: Displaysthe Legacy Playlist Custom Toolbar (disabled by default).

See Also
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® To create a custom button

18.1.2 Legacy Playlist Item Toolbar

4 | DrarmoPlaylist Number 1 = | = | ]
— == = :
|:|| | |'H:\| Ly [k B - @ Conectpt: THEME HOUR
Sop  Stadt Pause ContrusTakeOut Chp  lead  ledtilise  Cleanup -
Hame [channel  [eratus  Jawailable lICnn:mt [wariart [inished Jioaded |
NI open-Polish Alrpl... [PROGRAM] [Timelna Editor]  [Defauk]) 1] 0%
ol Fight heft [PROGRAM] 100N (TransisonLoge]  [Default] a 0 %
=] ] - 100 Sl - -
TL-std_left [PROGRAM] 1000880 [TransitonLogic]  [Default] [} 0%
& £5 Sports L |
8 open-Polish Ai... [PROGRAM] 10GSEI [Timeine Edror]  [Delaul] (1] 0 %
[EH [E & S—
Medt Previows Cunier Expand Collapse Merge  Spln Filer

Playhst sctres for profile; PGM

At the top of the playlist window is the Item toolbar:

Stop: Cancelsaplaylist item that has been scheduled to run. Stop is only relevant when groups with
elements with timecode set have been triggered.
Start: Runs the scene from the current time frame.
Pause: Pause the scene at the current time frame. Pauseis only relevant for clip playback.
Continue: Continuesto play the scene from the current time frame. To be able to use the Continue
function, the scene must either have been affected by the Pause function or have a stop point.
Take Out: Clears a scene based item, and takes a transition logic based scene to the out state stop
point.
Clip: Ignores the animation and takes the scene to a defined Clip point. A Clip point is defined by
adding atag named noanim. To learn more about adding Clip points, see the Tag points section of
the VizArtist User’s Guide.
Load: Loadsthe sceneinto Viz Engine.
Initialize: Initializes or re-initializes the entire playlist. Scenes are loaded in memory for the channel
that is defined per data element (see the channel column in the playlist). A statusindicator at the
bottom of the playlist is displayed whileinitialization isin progress.

® [|nitialize Playlist: Initializes or re-initiaizes the entire playlist (default).

® |nitialize Selected: Initializes the selected items in the playlist.
Cleanup: Cleans up al renderersthat have an item in the current playlist (i.e. clears al loaded
graphics from memory for those channels). To clear all renderers, go to the Main Menu > Viz Engine
Menu > Cleanup Renderers
Concept: Sets a concept for the whole playlist. If the valueis set to default, all data elements will
use the concept that is set in the Concept column (see also Legacy Playlist Concept ).

18.1.3 Legacy Playlist Toolbar
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Playlist Toolbar -

N AN lr %E %E %ﬂ |€ ? Filter presets -

Mext Previous Cursor Expand Collapse  Merge  Split Filter

At the bottom of the window is the Playlist toolbar:

® Next: Selectsthe VizBoldCurrent Item cursor (black pointer) to the next element in the playlist.

® Previous: Selectsthe VizBoldCurrent Item cursor to the previous element in the playlist.

® Cursor: Jumpsthe VizBoldCurrent Item cursor to the location of the External GPI cursor (yellow
arrow).

¢ Expand: Expands the groupsin the playlist.

® Collapse: Collapses the groupsin the playlist.

® Merge: Mergesthe current folder, so that the subfolders become unavailable.

® Split: Splitsafolder that is merged.

® Filter: Opensthe Filter dialog box.

Filter

|Shuw |Filter | Ok
= pilot R
Mew Category

[] Hide empty groups

The Filter window is used to enable or disable playlist filters. Each playlist can enable or disable
different filters. Filters are based on how templates are categorized in Template Wizard.

See Also

® Using Categories and Channels in Template Wizard.

18.1.4 Legacy Playlist Video Toolbar

¥ideo Toolbar -

E Auko Cue

on Air | Allacake  OFF Air

The Video toolbar is not displayed by default, and is only available for MV CP integrations.
When selected, the Video toolbar is by default positioned below the Playlist toolbar.
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® On Air: Setsthe playlist in On Air mode. When the playlist is set to On Air an On Air icon
appearsin the MSE Playlists list.

® Allocate: Automatic channel allocation starts, the first clips are cued up, and the External GPI cursor
is set to the first story that contains a video clip.

® Off Air: Setsthe playlist in Off Air mode.

¢ AutoCue

Example

® Enable Auto Cue: Enables the automatic channel allocation.
® Disable Auto Cue; Disables the automatic channel allocation.

If aplaylist uses two channels (A and B) and the playlist is set in On Air mode, the first clips alocated to
these channels will be cued. Channel A istaken On Air by avision mixer GPI (advance and take). This
also takes the studio tally (red light on monitors) high. Thisis received by the Media Sequencer asa G,
and the Timecode Monitor indicates high tally on that channel. The vision mixer cuts to cameraor to
another video source. This takes tally low on that channel, and Media Sequencer receives a GPl low
signal. After 5 seconds, the tally goes low, and the next clip allocated to that channel will be cued.

18.1.5 Legacy Playlist Custom Toolbar

Custom Buttons

-

Ea

[55]

[55]

F5P

FS D

Tile

The Custom toolbar is not selected by default. When selected, the Custom toolbar is positioned above the

Playlist toolbar.

Configuring Buttons

423



Selecting Customize Toolbar from the Toolbar Context Menu will open the Button Configuration window
as depicted above. The customized buttons list is empty by default. If the list contains two or more custom
buttons, the order of the buttons can be rearranged with the Up and Down buttons.

If Show Captionsis enabled, the buttonsin all buttonsin all toolbars will be displayed with their
respective names.

Add Command
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f@ Add Command E]@ﬁ

Image:

Add a command and a description for the button

Description | |

E

() Simple button

(73 IMSE Status button:

Subnode of: | Root j|

MSE nodepath: | |

Value:

Commands sendt..

While down | |J
While up | |J

| | [] Exists

Ok | Cancel

Clicking Add Button in the Button Configuration window will open the Add Command window.

® Description: Add adescriptive text to the new command button.

® |mage: Add animage or icon to visualize the new command button.

¢ Simplebutton: Add a predefined function by clicking the ellipsis (...) button to use macro
commands or Viz Engine commands (see image below).

Command: *Click the ellipsis (...) button to open the Predefined Functions window. Select a
function to add to the button.

® MSE Statusbutton: Depending on the status of a button (i.e. “on” or “off"), it can have different
behaviors and trigger different functions. An M SE button is defined to monitor the Media Sequencer.

Subnode of: Root, Profile or Playlist

M SE nodepath: Setsthe relative path of the sub node.

Value: Any given value in the Media Sequencer.

Exists: When checked the button isturned “on” if the node exists. |ndependent of the value
field.

While down: Command that istriggered while button is down

While up: Command that is triggered while buttonis up

Both the Simple and the M SE buttons can use Predefined Functions. The functions can be user
defined or built-in functions.
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Example

® Examplel: Thebuttonis“on” if the path "/hello” in the Media Sequencer has the value "aaa"
® Subnode of = Root
® MSE nodepath="hello"
® Vaue="aad'
® Example2: Thebuttonis“on” if the path "/config/profiles/Studio/top/sub” in the Media Sequencer
has the value "aaa".
® Subnode of = Profile
® MSE nodepath = "/top/sub"
® Vaue="aad'

To create a custom button

Right-click atoolbar and select Customize T oolbar.

In the Button Configuration window click the Add Button button.

In the Add Command window enter a description for the button in the Description text field.
Select the Simple button option, and click the ellipse (...) button to add Predefined Functions.
Click OK.

akrwbdpeE

18.1.6 The Legacy Playlist Overview

A playlist can contain various groups and elements. Each group and element is presented as arow in the
Playlist.

18.1.7 Legacy Playlist Cursors

New playlist 13:23 [jfr] M=%
0 N ol [z X
b o (B b [# 4
Start Continue Take Qut  Clip Load Initialize Cleanup -
|Name |Channel |Cnncept |‘u’ariant |Resaurce status
=5 New group
3 Test_ 001 [PROG... + [Basic]* [Default] + Ready

EO Test_002 [PROGRAM] Basic Default Ready
¢ Test_ 003 [PROGRAM] Basic Default Ready
EOD Test_004 [PROGRAM] Basic Default Ready
ED Test_005 [PROGRAM] [Basic] [Default] Ready
Test_006 [PROGRAM] [Basic] [Default] Ready

»

< | MEl BB (= T

Mext Previous Cursor Expand Collapse Merge  Split Filter -
Flaylist active for profile: STUDIO A
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There are three cursorsin the Director playlist:
Current Item cursor

® Redarrow "* | thisisthe current selected element.
® |ndicatesthat thisisthe next element that will be taken on-air.

External GPI cursor

®* Yellow arrow the next element that will be focused (selected) when the currently selected
element is taken. Referring to the screenshot above: When Test_003 istaken, Test_ 001 will then be
the next current element and displayed with ared cursor.

® When GPI is enabled, the external GPI system’s cursor will be displayed in any client that is using
the same profile as the external system.

® The Cursor optionsin the Playlist Context Menu apply to this cursor.

Director cursor
® Black pointer in the grey sidebar * . Thisis the orange highlighted row.

® Showstheitem that has been manually selected in the Director playlist.
®* The Next, Previous and Cursor buttons in the Legacy Playlist Toolbar apply to this cursor.
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18.1.8 Legacy Playlist Context Menu

DemoPlaylist Number 1 =N R =™

b
][] o] (2] 0] [B] (83 - concpt riemeron -

Stop  Stat  Pause ContinueTake Out Clip Load  Initialize 2

Name Chan... |5tat... |Availa... |Concapt Variant Finished Loaded
» [0 e r _|melu.n.e- .. * |[Default] | ~ 0 10050
= ransitionL....
£9 My Ne Schedule Playlist
TL-std  Step Playlist ransitionL... [Default] ] 10058
=Ssports gy Ctrl+F
ope oy imeline Edi...[Default] ] 100580
Copy Ctrl+C
Paste Cirl+V
Insert ltem k
Edit ltem...
Delete ltem Del
v Auto Preview

v Sync With Program Channel

Filters...

View F
Settings k
Impart From File...

Export To File k
Tree 3

IE (2] (8 E [ —
Previous Cursor Expand Collapse NMerge  Split  Filter u

Playlist active for profila: PGM

Playlist Context Menu

® Cursors: Shows three options for setting, clearing and resetting the External GPI cursor (yellow
arrow).
® Reset Cursor: Setsthe external cursor back to the point it was before a Set Next was executed.
® Set Next: Setsthe external cursor for a selected element. The cursor indicates the element that
will be taken next if, for example, a“take and advance” General Purpose Input (GPI Tab)
action is executed.
® Clear Next: Clearsthe Set Next cursor. Thisoption isonly available when clearing a cursor set
with the Set Next option.
® Schedule Playlist: Activatesthe playlist. If for example Begin time has been set, the playlist must be
scheduled before the changes take effect.
® Stop Playlist: Stops apreviously scheduled playlist.
® Find: Showsthe Playlist Search area below the Playlist.
ﬁ Find: | | = Find Mext | & Find Previous |
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Typing thefirst letters of the name of a playlist element in the Find text box, marks the closest
element in the playlist (either above or below the current element, depending on whether the Find
Next or Find Previous button is clicked) that corresponds to the letters in the text box. The Find Next
button is selected by default. Clicking the X button hides the Playlist Search area.

® Cut: Removesthe current element from the playlist.

® Copy: Copiesthe current element in the playlist.

® Paste: Addsacopied element above the currently selected element in the playlist.

® |nsert Item

® Group: Adds anew group to the playlist, above the currently selected element. To place an
element into the group, pressthe CTRL key, and then drag and drop the element onto the
desired group. The action isindicated by an angled arrow. Groups can also be organized as sub-
groups.

® Edit Item: Displaysthe editable text elementsin the item editor. Allows last minute changes to text
in graphics.

® Deleteltem: Deletes the current Playlist element. It is only removed from the playlist.

® Auto Preview: Automatically displays selected playlist elements using the preview channel.

® Sync With Program Channel: Thisis an option for the Auto Preview feature available above. If
Auto Preview ison, this setting affects what is shown on the preview channel when a user selects a
new element.

® |f on, the current state of the preview channel is synchronized with the program channel before
the selected element istaken on it. This mainly affects transition logic scenes as this means that
the selected element will be shown in-context with the same elements on-screen asin the
program channel.

* |f off, the preview channel will be cleared before the current element is taken. For example, this
means that a transition logic element will be shown alone on the preview screen regardless of
what is shown currently on the program channel.

"Note: Sync With Program Channel is permanently enabled in situations where the Media
Sequencer does not support clearing before a take.

® Filters: Opensthe Filter dialog box, where types of elements that should be hidden in the playlist
can be selected.
®* View
® Visble Toolbars: Selects which toolbars are visible (Item Toolbar, Playlist Toolbar, Custom
Toolbar).
® Show Item Editor: Shows the Item editor at the right side of the Playlist list. The Item editor
displays editable text for the selected graphicsitem in the playlist. The editor can be expanded,
hidden or closed by clicking the arrow and X buttons in the upper right corner.

Item Editor
|Name |HaMe
01 {Headline} Headline|
0z {Mame) Mame Lastname

03 {Designatio...Designation

Save
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¢ Show Image Bar: Shows a bar with thumbnails of the elementsin the playlist. To hide the
Image bar, click the X button in the upper left corner. Right-clicking the Image bar opens the
Change Image Size dialog box.

8| Change Image Size &
g | Width
Marme Channel  Lay Begin
- . 1 Ok Cancel
Efl Mews_Story5_Graphics1 STUDIO ... [Ma | | 0B/2...
[E Mews_ Story6_Graphics1 STUDIO ... [MAMNT COWETSIU_TT... T... K. [NE... [Ch..
[EH Mews_ Story6_Graphics2 STUDIO ... [MAIN] Lower3rd_M... l... R.. [NE... [D...
b [E0 Mews_Story7_Graphicsl STUD... * [MAIN] Lower2rd_M.. L. R.[N...* [..™

® Auto Width: When enabled, the columns are minimized, so that they fit perfectly to the
content. This setting stores the setting for the current playlist. See also the Store as Default
option.
® Font: Opensadialog for setting font, font style, size and so on. The font settings change the
text in the Playlist list.
® |mage Size: Setsthe thumbnail imagesto the selected pixel size.
® Settings
® Store as Default: Setsthe current settings (selected columns, column widths, filters, etc.) as
default for al new playlists. Remember to disable Auto Width for this function to work
properly.
® Restore Default: Restores the settings to the original setup.
® |mport From File: Opens the Open dialog box, where a previously exported XML file can be
searched for and imported.

Note: The Import from File does not accept characters outside the Basic Multilingual Plane
(BMP). If anon-BMP character is found, the import will stop and return an error message stating
the position of the first non-BMP character.

® Export ToFile:
® Playlist: Opensthe Save Asdialog box, where the entire playlist can be exported.
® Selected Items. Opensthe Save As dialog box, where the selected elementsin the playlist can
be exported.
® Tree
® Sedect All: Selectsal theitemsin the playlist.
¢ Expand All: Expands all groupsin the playlist.
® Collapse All: Collapses al groupsin the playlist.

To group elementsin aplaylist

1. Right-click the Playlist and select Insert Item -> Group from the Legacy Playlist Context Menu.
2. Place an element in agroup by holding the CTRL key down while performing adrag and drop
operation. An angled arrow indicates that the element may be dropped.
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18.1.9 Legacy Playlist Columns

Playlist columns can be displayed or hidden by using the Column Context Menu. Dragging and dropping
the column headings changes the order of the columns.

Many of the columns are presented by default. These are; Name, Channel, Status, Available, Concept,
Variant, Finished and Loaded.

Column Context Menu

The context menu which appears when right-clicking the column headings includes:

® Video: Displaysthe following four video options:
® Auvailable: Displays the status of external resources needed by the Viz Engine (e.g. transferred
video, and if it is available on the video playout engines). This column was previously named

Progress.
|Temp|ate IName |Channel IStatusIAvaiIabIe |C0nc:
DV100_1080i... CHANNEL #3 100 %
DV100_NTSC... CHANNEL #3 100 % W
DV100_PAL_... CHANNEL #3 100 % W
DV100_PAL_... CHANNEL #3 100 % W
» Butterfly CLIP CHANNEL #4 « 100 Sl [test]

® Mark In: Setsmark intimesfor video clips.
® Mark Out: Sets mark out times for video clips.
® Postroll: Sets postroll for video clips. When avideo clip is played, the time and remaining time
are shown in the Timecode Monitor. The remaining time; zero at clip-end if postroll is set to 0.
Normally it is desirable with afew seconds of postroll so that the vision mixer can cut to
another source without risking displaying a freeze frame. With a postroll of 3, the countdown
/remaining time will be zero 3 seconds before clip end and count from zero and downwards for
three seconds.
® Misc: Displays miscellaneous options. Begin, end, timecode and duration can be set directly in the
playlist. Some newsroom systems also propagate timing information to their control applications for
monitoring and playout of newsroom playlists. Such information can for example be sent using the
MOS protocaol.

Note: Director is able to override timing information from newsroom playlists, however, thisis
not recommended.

® Begin: Shows the start time of a group. Hence, begin and end times can only be set for groups
and not elements of a group. To set time for elements, use the Timecode and Duration columns.
See also the Legacy Playlist Time Editor section.

® Category: Shows the category the Sub Category resides under. Default category for Template
Wizard templatesis the pilot category.
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® Channel: Showswhich output channel an element should be sent to. Various elements can be
sent to different output channels. The output channels can be set directly in the column. By
default the main (program) output channel is selected, but this can be overruled by setting an
aternative channel in atemplate (that al data elements made from it will have). This columnis
presented by default.

® Duration: Setsthe length of the element. Thistime isrelative to the Begin and Timecode
parameters.

® End: Showsthe end time for agroup. See also the Legacy Playlist Time Editor section.

® External 1d: The External Id can be set directly in the column. It attaches a data element
execution to a specific external signal that comes from a button box or similar device. An
External 1d is used with the Quick CG feature for adding embedded MOS objectsto a
newsroom story.

® Finished: If adataelement is checked off as finished when saved it can be shown in the
Finished column in the playlist displaying either 1 for finished and O for not finished.

® | oop: Loops afullscreen video clip on the video channel. Default behavior isto play once.

® MOSObjAir: Marksif the newsroom element is marked as ready. The element can only be
taken on air if it is checked (ready). Using the macros pl ayl i st : next _ready and
pl ayl i st: previ ous_r eady will skip those elements that are not ready. Do not use the
macrospl ayl i st: next orpl ayli st: previ ous.

® Name: Showsthe element name as it was saved in the database. Thisis presented by default.

® Resource Status: Indicates if an element is ready for playout. It will also show an error status
if the element was not loaded or made available.

® Status. Shows the status for video clips; cuing, cued, playing, paused, or aborted.

® Story #: Shows the name or number of the Story as used in the NCS. Thisis an optional field
originally intended for use by prompters.

® Sub Category: Shows the category atemplate is assigned to. See Categories and Channelsin
Template Wizard.

® Thumbnail: Shows thumbnails of the scenes.

®* Timecode: Setsthe timecode for the element. This setting affects both graphics and video
elements. The timecode can be set directly in the column. To trigger elements based on
timecode, the elements must be in a group, and the group must be executed. An element’s
timecode must be set within the group’s Begin and End time.

Note: To monitor video elements in graphics using the TimeCode monitor, the Viz Engine
that renders graphics must also be defined in the profile configurations for video playout.

® Graphics: Displays the graphics options.

Template Concept Wariant Resource st...
Lower3rd B Sports|  « Lower * Ready
Lower3rd Lower Feady

& Mews

B Sports

® Concept: Shows which concept(s) the data element is associated with.

¢ Effect: Displaystransition effects that can be set per data element. When the effect is executed
it will have an effect on the data element it was set for, and the next data element taken. See
also how To enable transition effects.
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® Effect Image: Displaysanimage of the transition effect scene.
® |ayer: Allowsloading of graphicsin separate layers on Viz Engine (front, middle, back). For
example, alower third can be shown in front of avirtual studio set or any other background, or
abug can be shown in the front layer while alower third is shown in the middle layer. This
column is presented by default.
® | oaded: Shows the loaded status (in memory) of the scene and images used for a data element
of that scene.
® Template: Shows the name of the template. This column is presented by default.
® Variant: Select aconcept’s variant from the drop-list (see the Concept column).
® |ndex: Setsanindex number for each row in the playlist. This number will always be sorted either
ascending (lowest to highest). If arow is moved or deleted the index changes accordingly.
® Auto Width: When enabled (selected), Auto Width expands the columns and distributes them
evenly.

To enable transition effects

1. Configure a program channel that hasaViz in On-air mode.
2. Make sure the scene effects folder in Viz is named transitions and placed at the root level of the
scene directory.

To add atransition effect

1. Right-click the playlist’s column headers, and select Graphics, and then Effect and Effect Icon
(last isonly for visual reference)
2. Click the arrow button in the Effect column and select, from the drop list, the transition effect.

See Also

® To create a custom button

18.1.10 Legacy Playlist Concept

In most cases Director playlists are created in Newsroom Computer Systems (NCS). A playlist created
using an NCS client, can consist of data elements within a specific concept. For example a News or Sports
concept.
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) New playlist E]@

T =k =
> D> D-p Concepk: Demoz -
Skart Conkinue Take Qut | Initialize Cleanup -
Marme Channel Thumbnail Concept Wariant
» - EDmaps_new [MAL,, - j{Derru:u] v%[II:lefauIt] -
EDI13_demostor... [MAIN] [Dermoz] [Lower]
Ed top_third [MAIN] [Demoz] [Top]
ED maps [MAIM] ; I‘sﬁ [Demo2] Default
ED lower_third [MAIN] [Dermoz] [Top]
Ed lower3rd [MAIN] [DemoZ] [Default]
>
v & M BB B ki
Mext Prewious Cursor Expand Collapse Filker -
Ma Profile

Director is able to override a playlist’s concept. Data elements, saved to a specific concept, can belong to
several concepts. Thus, a data el ement that does not belong to the overridden concept is highlighted in

yellow.
Some newsroom systems support the use of master concepts (e.g. ENPS) set by the newsroom system
itself. A master concept is able to override a concept set when creating a data el ement.

Concepk: A Mews -
Template Concept Wariant Resource status
- -
Lower3rd B Sports Lower Feady
Wisuwal Data Tools [B Sports] [Bars] Feady
“isual Data Tools [A Hews] [Line] Feady

When a concept is overridden, the playlist will, when opened in Director for monitoring and playout,
show all data elements with the concept they were saved with, but played out using the Master Concept.
Hence, if a data element was saved with a Sports concept, and the master concept is News, the News
concept is used.
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Concepk:  Cuskomers -

Template Cancept Wariant Resource status
- -

Lower3rd B Sports Lower Feady

“isual Data Tools [B Sports] [Bars] Feady

Wisuwal Data Tools [& Mews) [Line] Feady

If the Master Concept is changed, and the data elements are not part of the master concept, the data
element’s concept column will be highlighted with ayellow color.

If adata element’s concept is manually changed in Director, the master concept will not override the new
concept, and awarning is not issued since the concept is manually overridden.

The concept a data element is saved with is depicted with square brackets* [ ]*. A data element’s concept
and variant, that are manually changed in Director, do not show the concept and variant name with square

brackets.

MOS Graphics Concept

The concept implementation of the MOS protocol, that is supported by Director and Viz Gateway, can be
used by any newsroom system that use the MOS protocol. However, the feature must be implemented.

Below is an excerpt of a MOS message sent from the newsroom system when a playlist is created with a
master concept.

<nosExt er nal Met adat a> <nmosScope>PLAYLI ST</ nosScope> ..
<nosPayl oad> C <G aphi cConcept >A News</ G- aphi cConcept >
</ nosPayl oad> </ nosExt er nal Met adat a>

Termnplates |Sti||s Clips

r Lower3rd Concept: |,-:-., Mews ﬂ|\.ﬂariant: |T|3p ﬂ|JE
Program NewRundown| |
Name Start Date: (11/13/2007

Designation End Date: 11/13/2007
13:30:00

fest i
30:00

Duration:

A Mews

‘Dglaliun based |?|

Blank Bundown

2007-11-13T13:00:00

Scripts: Blank Script j
Go | Cancel |

435



In ENPSit is possible to set the concept (or style) when creating a rundown (playlist). Set the rundown
property Viz Graphics Style to the same as the graphics concept used.

Note: The naming convention must be the same for the scene design and the playlist created in the
newsroom system.

® To create a custom button

18.1.11 Legacy Playlist Time Editor

EE N SN

o | coneer || creormervr__

The Time Editor is displayed when clicking the ellipsis (...) button in the Begin or End columns. In this
window, a group can be set to run between a start- and stop date and time. It can also be set to run on
specific weekdays. Once a start and stop time has been set, the date and time is shown in the Begin and
End column.

18.1.12 Legacy Playlist Status Bars

The playlist displays two types of status bars at the bottom of the window, depending on the type of
playlist that is open (Director playlist or MOS playlist). These two status bars operate independently from
one another.

The Profile Bar is available for all playlists, while the Rundown Monitor Bar is only available for MOS
playlists.

See Also

® Profile Status Bars

18.1.13 Legacy Playlist Profile Bar
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Flaylist active for profile: MyProfile

The Profile Bar isavailable for al playlists. It shows whether the playlist is active or inactive, and if
active, the name of the profileit isactivein.

Thisinformation is stored in the Media Sequencer, so can be accessed by all Directors that are connected
on the same profile.

Context Menu - Profile Bar

When aplaylist is opened, it retains the active/inactive status it had before it was closed. The context
menu can be used to change the status.

® Activatein current profile: Activates and monitors the selected playlist in the current profile, and

enables the Media Sequencer to trigger transfer of video clipsto al Viz Enginesin the current
profile.

® Deactivate: Deactivates and stops monitoring the playlist.

‘Note: If the active profile is changed or renamed, the playlist must be reactivated inthenew
profile by deactivating and then activating the playlist.

Cleanup and Auto Preview will work on playlists that are either active or inactive. Initialize will only
work on active playlists.

18.1.14 Legacy Playlist Rundown Monitor Bar

Flaylist active for profile: MyProfile

Host: Start: Duration: MOS: Last Updated:
10.200.100.100 |[16/05/2013 09:(/00:30:00 Active 11:38:21

The Rundown Monitor Bar is available for MOS playlists (also known as newsroom playlists). It is used
in Vizrt's MOS integration, and shows the current MOS status for the playlist.

When aMOS playlist isfirst opened in Director, it is empty. Monitoring needs to be requested using the
context menu so that the playlist can be populated.

Once Director requests the monitoring of aMOS playlist, it can be presented as a playlist in Director.

Director can then monitor the playlist and receive updates from the newsroom system and Director. The
operator can then take the graphics on air from Director.

Status Information

The information available in the rundown monitor bar is as follows:
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Host: IP address of the Media Sequencer that has requested the playlist.
Start: Playlist start time, according to the Newsroom system.

® Duration: Playlist duration, according to the Newsroom system.

® MOS: The current MOS status for the playlist (Active/lnactive).

Context Menu - Rundown Monitor Bar

® Request: Begin monitoring, and populate the Director playlist with the elements from the newsroom
system. Once the monitoring is active, al subsequent updates done to the newsroom rundown will be
reflected in the active Director playlist.

® Release: Director will stop monitoring the newsroom system. A list of elementswill still appear in
the Director playlist, but any subsequent updates to the Newsroom rundown will not be reflected in
theinactive Director playlist.

IMPORTANT! Any elements that are manually added to the playlist by Director will disappear
if areleased playlist is requested again.

Note: If using Director to take items on air, be mindful that the cursor position in Director may
changeif the related item is deleted from the newsroom rundown. That is, the Current Element
cursor would move to the following item, and the Next Element cursor would be removed.

Cleanup and Auto Preview and will work on playlists that are either active or inactive. Initialize will
work once the MOS playlist has been populated with content.

Example Scenarios

If two Directors use the same Media Sequencer and MOS Gateway, and have the same playlist Requested,
then they will both get all updates.

If two Directors use the same MOS Gateway, but different Media Sequencers, and they both activate the
same MOS rundown. The last Director to activate the rundown will get any MOS updates that come from
the Newsroom system.

See Also

® | egacy Playlist Profile Bar
® MOS Integration Workflow

18.2 Integrating Drag and Drop from External Applications

External applications can, if needed, integrate with the Viz Pilot system to provide resources such as
images and videos using “Drag and Drop”. A typical scenario would be usingaMAM (Media Asset
Management) system to locate media resources and using Drag and Drop to ingest the resourcesto a
templatein aViz Pilot workflow. The required data formats and drag and drop parameters are described in

this document.
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https://confluence.vizrt.com/display/VP/.Workflow+vTrunk

Note: The Drag and Drop integration in the Viz Pilot is not designed to accept common image and
video files that typical applications work with. Its purpose is for developers to be able to support it by
API integration. Consequently, this section isfairly technical and isintended audience is developers
planning to integrate Drag and Drop (hereafter: DnD).

The integration uses the standard Microsoft Windows functions for OLE Drag and Drop, see https.//msdn.
microsoft.com/en-ug/library/96826a87.aspx. For general information about the Windows Clipboard see
MSDN Clipboard Formats.

The drop target of a DnD operation will always be an image control (TTWImage) on atemplate. Not
every image control will accept drops. The accepted custom clipboard formats (https://msdn.microsoft.com
/en-ug/library/838a3whf.aspx), along with when each one is accepted, are listed in the following table:

Clipboard format Accepting | mageSour ces Media Type
CF_VIDEO_ASSET_ENTRY_XdWideoMediaSearch video
CF_IMAGE_ASSET_ENTRY _XNiageMediaSearch image

All the accepted custom clipboard formats are registered ones (see MSDN Registered Clipboard Formats).
They are text formats, with the same characteristics as CF_UNICODETEXT.

The actual content needs to be an Asset Entry XML, describing avideo, or an image asset, respectively.

The Asset Entry media type extends the Atom Entry media type defined by RFC 4287 and RFC 5023, by
defining additional markup and additional processing rules. An Asset Entry has the Internet Media Type
application/atom+xml with the RECOMMENDED type parameter type=entry.

Pilot Data Server Documentation should be consulted for the Asset Entry media types.
‘Tip: Assuming the Pilot Data Server is running on localhost, browseto _http://localhost:8177/help_
and _http://localhost:8177/AssetSearchDocumentation/_.

18.2.1 API Integration

The only Windows data transfer types accepted as input are enumeration values TYMED_HGL OBAL
with DVASPECT_CONTENT. The accepted * DROPEFFECT* s are DROPEFFECT_COPY and
DROPEFFECT_LINK.

Linksto MSDN definitions for the required enumeration values and constants (these links could change
over time):

®* TYMED_HGLOBAL
® DVASPECT_CONTENT
¢® DROPEFFECT

Tip: If thereisan error while processing dropped content an error message will be logged, as
well asthe "Errors' button will appear if it wasn't already visible. If this happens during
development, you should check the error log as a trace of why the dropped resource was rejected
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will be logged. If the media container does not accept a drop, most likely because the resource
being dropped is not a supported type, thiswill be indicated by the mouse pointer icon format
showing a“stop sign”.

Tip: Tools such as ClipSpy (to see what datatypes are provided by the DnD operation, see
http://www.codeproject.com/Articles/168/ClipSpy), can be valuable while devel oping the
integration.

18.3 Supported Versions and Operating Systems

This section outlines supported operating systems and software versions for Viz Pilot 7.2.

® Minimum client system requirements

® Supported client operating systems

® Supported server operating systems

® Minimum supported versions of software components Pilot depends on

18.3.1 Minimum client system requirements

Windows 7

® 1 GHz 32-hit (x86) or 64-bit (x64) processor

®* 1GB RAM (32-hit) or 2 GB RAM (64-hit)

® 40 GB hard drive with at least 15 GB of available space

18.3.2 Supported client operating systems

® Windows 10 Enterprise

® Windows 10 Pro

® Windows 8 Enterprise 64-bit

® Windows 8 Pro 64-bit

® Windows 7 Professional 64-bit (recommended)
® Windows 7 Enterprise 64-bit

® Windows 7 Ultimate 64-bit

18.3.3 Supported server operating systems

® Windows Server 2012 R2 Update
® Windows Server 2012 R2
® Windows Server 2012

Note: A specific version and service pack of an operating system will not be supported after the
official Microsoft support end date. Thisisthe latest date of support from Vizrt. Earlier support
end dates will be announced in release notes for new versions of Viz Pilot.
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18.3.4 Minimum supported versions of software components Pilot depends on

¢ Asthe Pilot Database, either Graphic Hub 3.0 (with Graphic Hub REST 2.0) or Oracle 11g
® Media Sequencer 4.0
® VizEngine3.3
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